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Legal InformaƟon

About this Document
● This Document includes instrucƟons for using and managing the Product. Pictures, charts,

images and all other informaƟon hereinaŌer are for descripƟon and explanaƟon only.
● The informaƟon contained in the Document is subject to change, without noƟce, due to
Įrmware updates or other reasons. Please Įnd the latest version of the Document at the
Hikvision website ( https://www.hikvision.com ). Unless otherwise agreed, Hangzhou Hikvision
Digital Technology Co., Ltd. or its aĸliates (hereinaŌer referred to as "Hikvision") makes no
warranƟes, express or implied.

● Please use the Document with the guidance and assistance of professionals trained in
supporƟng the Product.

About this Product
This product can only enjoy the aŌer-sales service support in the country or region where the
purchase is made.

Acknowledgment of Intellectual Property Rights
● Hikvision owns the copyrights and/or patents related to the technology embodied in the

Products described in this Document, which may include licenses obtained from third parƟes.
● Any part of the Document, including text, pictures, graphics, etc., belongs to Hikvision. No part

of this Document may be excerpted, copied, translated, or modiĮed in whole or in part by any
means without wriƩen permission.

●  and other Hikvision's trademarks and logos are the properƟes of Hikvision in
various jurisdicƟons.

● Other trademarks and logos menƟoned are the properƟes of their respecƟve owners.

LEGAL DISCLAIMER
● TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THIS DOCUMENT AND THE

PRODUCT DESCRIBED, WITH ITS HARDWARE, SOFTWARE AND FIRMWARE, ARE PROVIDED "AS
IS" AND "WITH ALL FAULTS AND ERRORS". HIKVISION MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION, MERCHANTABILITY, SATISFACTORY QUALITY, OR
FITNESS FOR A PARTICULAR PURPOSE. THE USE OF THE PRODUCT BY YOU IS AT YOUR OWN RISK.
IN NO EVENT WILL HIKVISION BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL,
INCIDENTAL, OR INDIRECT DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, OR LOSS OF DATA, CORRUPTION OF SYSTEMS, OR
LOSS OF DOCUMENTATION, WHETHER BASED ON BREACH OF CONTRACT, TORT (INCLUDING
NEGLIGENCE), PRODUCT LIABILITY, OR OTHERWISE, IN CONNECTION WITH THE USE OF THE
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PRODUCT, EVEN IF HIKVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR
LOSS.

● YOU ACKNOWLEDGE THAT THE NATURE OF THE INTERNET PROVIDES FOR INHERENT SECURITY
RISKS, AND HIKVISION SHALL NOT TAKE ANY RESPONSIBILITIES FOR ABNORMAL OPERATION,
PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER-ATTACK, HACKER ATTACK,
VIRUS INFECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, HIKVISION WILL PROVIDE
TIMELY TECHNICAL SUPPORT IF REQUIRED.

● YOU AGREE TO USE THIS PRODUCT IN COMPLIANCE WITH ALL APPLICABLE LAWS, AND YOU ARE
SOLELY RESPONSIBLE FOR ENSURING THAT YOUR USE CONFORMS TO THE APPLICABLE LAW.
ESPECIALLY, YOU ARE RESPONSIBLE, FOR USING THIS PRODUCT IN A MANNER THAT DOES NOT
INFRINGE ON THE RIGHTS OF THIRD PARTIES, INCLUDING WITHOUT LIMITATION, RIGHTS OF
PUBLICITY, INTELLECTUAL PROPERTY RIGHTS, OR DATA PROTECTION AND OTHER PRIVACY
RIGHTS. YOU SHALL NOT USE THIS PRODUCT FOR ANY PROHIBITED END-USES, INCLUDING THE
DEVELOPMENT OR PRODUCTION OF WEAPONS OF MASS DESTRUCTION, THE DEVELOPMENT OR
PRODUCTION OF CHEMICAL OR BIOLOGICAL WEAPONS, ANY ACTIVITIES IN THE CONTEXT
RELATED TO ANY NUCLEAR EXPLOSIVE OR UNSAFE NUCLEAR FUEL-CYCLE, OR IN SUPPORT OF
HUMAN RIGHTS ABUSES.

● IN THE EVENT OF ANY CONFLICTS BETWEEN THIS DOCUMENT AND THE APPLICABLE LAW, THE
LATTER PREVAILS.

© Hangzhou Hikvision Digital Technology Co., Ltd. All rights reserved.
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Chapter 1 Overview

1.1 IntroducƟon
iVMS-4200 Client SoŌware is designed to conĮgure and manage Hikvision devices in a uniĮed and
intuiƟve manner, including DVRs, NVRs, IP cameras, encoders, decoders, security control panels,
video intercom devices, access control devices, etc.

The soŌware provides mulƟple funcƟonaliƟes, including real-Ɵme live view, video recording,
remote search and playback, Įle backup, alarm receiving, person management, access control,
video intercom, security control, Ɵme & aƩendance, etc.
This user manual describes the funcƟons, conĮguraƟons and operaƟon steps of the client
soŌware. To ensure the properness of usage and stability of the soŌware, refer to the contents
below and read the manual carefully before installaƟon and operaƟon.

1.2 Summary of Changes
The followings are the changes of this version.

Video Tracing
Adds the Video Tracing module. Supports the following:
● Link cameras with each workstaƟon to record videos and conĮgure general seƫngs such as ID

length, code-scanning interval, and voice prompt.
● Scanning Record Search: The search results will display ID, start Ɵme, end Ɵme, device, and video

recordings.
● Playback & Download: Supports video playback, download of logisƟcs records, and customizable

watermark opƟons.

System ConĮguraƟon
● On the General page, adds the feature User Experience Program. If you enable it, with your

consent, we will collect user operaƟon records and soŌware usage data (including main panel
operaƟons, soŌware excepƟons). All data is only used for product enhancement. Upon Įrst login
to the Client, a pop-up will appear inviƟng you to join the Program. See Set General
Parameters .

● Supports automaƟc new version detecƟon on the Client. This feature requires an acƟve WAN
connecƟon prior to use. See Set General Parameters and OperaƟon and Maintenance .

● Supports submiƫng feedbacks by Įlling in Įelds including Ɵtle, problem type, descripƟon,
aƩachment, device, and email. This feature requires an acƟve WAN connecƟon prior to use. See
OperaƟon and Maintenance .
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1.3 Symbol ConvenƟons
The symbols that may be found in this document are deĮned as follows.

Symbol DescripƟon

Danger
Indicates a hazardous situaƟon which, if not avoided, will or could
result in death or serious injury.

CauƟon
Indicates a potenƟally hazardous situaƟon which, if not avoided, could
result in equipment damage, data loss, performance degradaƟon, or
unexpected results.

Note
Provides addiƟonal informaƟon to emphasize or supplement
important points of the main text.
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Chapter 2 Service Management

iVMS-4200 Service is mainly applicable for data storage, data management, and data calculaƟon.
With conƟnuous running and processing, it can manage the data, such as event records and
aƩendance records, received by the iVMS-4200 Client SoŌware. iVMS-4200 Service also provides
management for user permissions, devices, groups, logs, etc.

You can view the module running status, and click Edit Port to edit its ports. You need to restart the
iVMS-4200 Service to take eīect.
Check Auto-Launch to enable launching the iVMS-4200 Service automaƟcally aŌer the PC started
up.

The iVMS-4200 Service will not show aŌer running it. Enter the system tray and click  to open
the service management window.

Note
● AŌer closing the service window, the client will log out and return to the login page. You need to

run the service and then log in again.
● The client can be run by no more than one operaƟng system user at the same Ɵme on the same

computer.
● The Service should run on the same computer with the client.
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Chapter 3 Device Management

The client supports various types of devices including network camera, DVR (Digital Video
Recorder), NVR (Network Video Recorder), security control panel, video intercom device, access
control device, etc.

Example
You can view live view or playback aŌer adding encoding devices to the client; you can arm or
disarm zones of a security control panel, receive alarm noƟĮcaƟons aŌer adding a security control
panel to the client; and you can control entrance & exit and manage aƩendance aŌer adding
access control devices to the client.

3.1 AcƟvate Devices
For the inacƟve devices, you are required to create a password to acƟvate them before they can be
added to the soŌware and work properly.

Before You Start
Make sure the device to be acƟvated is connected to the network and on the same subnet with the
PC where the client runs.

Steps

Note
This funcƟon should be supported by the device.

1. Enter the Device Management page.
2. Click Device on the leŌ.
3. Click Online Device to show the online device list at the boƩom of the page.

The searched online devices are displayed in the list.
4. Check the device status (shown on Security Level column) and select an inacƟve device.
5. Click AcƟvate to open the AcƟvaƟon dialog.
6. Create a password in the password Įeld, and conĮrm the password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case leƩers, lower case leƩers, numbers, and special
characters) in order to increase the security of your product. And we recommend you change
your password regularly, especially in the high security system, changing the password monthly
or weekly can beƩer protect your product.
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Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

Note
For the NVR device, you are required to create a password in Network Cameras' Default
Password Įeld and conĮrm the password for acƟvaƟng network camera(s) connected to the
NVR.

7. OpƟonal: Enable Hik-Connect service when acƟvaƟng the device if the device supports.
1) Check Enable Hik-Connect to open the Note dialog.
2) Create a veriĮcaƟon code, and conĮrm the veriĮcaƟon code.
3) Click Terms of Service and Privacy Policy to read the requirements.
4) Click OK to enable the Hik-Connect service.

8. Click OK to acƟvate the device.

Note
If the device supports reseƫng password via the reserved email, security quesƟon, or GUID, you
can conĮgure them aŌer acƟvaƟng the device.

9. OpƟonal: Click  in the OperaƟon column to edit the network informaƟon (including IP
address, port number, gateway, etc.) for the online device.

3.2 Add Device
The client provides various device adding modes including IP/domain, IP segment, cloud P2P, ISUP
protocol. The client also supports imporƟng mulƟple devices in a batch when there are large
amount of devices to be added.

On the right Maintenance and Management area, click Device Management.
On the leŌ, click Device → Device .

3.2.1 Add Single or MulƟple Online Devices

The client can detect online devices which are in the same network as the PC running the client.
You can select a detected online device displayed in the online device list and add it to the client.
For detected online devices sharing the same user name and password, you can add them to the
client in a batch.

Before You Start
● The device(s) to be added are in the same network as the PC running the client.
● The device(s) to be added have been acƟvated.

Steps
1. On the Device page, click Online Device to show the online device area.

The searched online devices are displayed in the list.
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Figure 3-1 Online Device
2. In the Online Device area, check one or more online device(s), and click Add to open the device

adding window.
3. Select the adding mode to OTAP.
4. Enter the required informaƟon.

Name
Enter a descripƟve name for the device.

IP Address
Enter the device's IP address. The IP address of the device is obtained automaƟcally in this
adding mode.

Port
You can customize the port number. The port number of the device is obtained automaƟcally
in this adding mode.

Note
For some device types, you can enter 80 as the port No. This funcƟon should be supported by
the device.

User Name
By default, the user name is admin.

Password
Enter the device password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
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Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

5. OpƟonal: Check Transmission EncrypƟon (TLS) to enable transmission encrypƟon using TLS
(Transport Layer Security) protocol for security purpose.

Note
● This funcƟon should be supported by the device.
● If you have enabled CerƟĮcate VeriĮcaƟon, you should click Open CerƟĮcate Directory to

open the default folder, and copy the cerƟĮcate Įle exported from the device to this default
directory to strengthen the security. See CerƟĮcate VeriĮcaƟon for Transmission EncrypƟon
for details about enabling cerƟĮcate veriĮcaƟon.

● You can log into the device to get the cerƟĮcate Įle by web browser.
6. Check Synchronize Time to synchronize the device Ɵme with the PC running the client aŌer

adding the device to the client.
7. OpƟonal: Check Import to Group to create a group by the device name, and import all the

channels of the device to this group.

Example
For encoding device, its encoding channels and alarm inputs/outputs will be imported to this
group.
For access control device, its access points, alarm inputs/outputs, and encoding channels (if
exist) will be imported to this group.

8. Click Add.
9. OpƟonal: Click Export Device, select the saving path and device type, and click OK to export the

device informaƟon to your PC.

Note
Currently, the plaƞorm only supports exporƟng the informaƟon of video intercom devices,
including door staƟons, indoor staƟons, and main staƟons.

3.2.2 Add Device by IP Address or Domain Name

If you know the IP address or domain name of the device to add, you can add devices to the client
by specifying the IP address (or domain name), user name, password, etc.

Steps
1. On the Device page, click Device tab on the top of the right panel.

The added devices are displayed on the right panel.
2. Click Add to open the Add window, and then select IP/Domain as the adding mode.
3. Enter the required informaƟon.

Name
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Create a descripƟve name for the device. For example, you can use a nickname that can show
the locaƟon or feature of the device.

Address
The IP address or domain name of the device.

Port
The devices to add share the same port number. The default value is 8000.

Note
For some device types, you can enter 80 as the port No. This funcƟon should be supported by
the device.

User Name
Enter the device user name. By default, the user name is admin.

Password
Enter the device password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

4. OpƟonal: Add the oŋine devices.
1) Check Add Oŋine Device.
2) Enter the required informaƟon, including the device channel number and alarm input

number.

Note
AŌer adding the oŋine device to the client, the device network status will be displayed as
"Oŋine"; When the device comes online, the device network status will turn to "Online", and
the client will connect it automaƟcally.

5. OpƟonal: Check Transmission EncrypƟon (TLS) to enable transmission encrypƟon using TLS
(Transport Layer Security) protocol for security purpose.
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Note
● This funcƟon should be supported by the device.
● If you have enabled CerƟĮcate VeriĮcaƟon, you should click Open CerƟĮcate Directory to

open the default folder, and copy the cerƟĮcate Įle exported from the device to this default
directory to strengthen the security. See CerƟĮcate VeriĮcaƟon for Transmission EncrypƟon
for details about enabling cerƟĮcate veriĮcaƟon.

● You can log into the device to get the cerƟĮcate Įle by web browser.
6. Check Synchronize Time to synchronize the device Ɵme with the PC running the client aŌer

adding the device to the client.
7. OpƟonal: Check Import to Group to create a group by the device name, and import all the

channels of the device to this group.

Example
For encoding device, its encoding channels and alarm inputs/outputs will be imported to this
group.
For access control device, its access points, alarm inputs/outputs, and encoding channels (if
exist) will be imported to this group.

8. Finish adding the device.
- Click Add to add the device and back to the device list page.
- Click Add and New to save the seƫngs and conƟnue to add other device.

9. OpƟonal: Perform the following operaƟon(s).

Remote
ConĮguraƟon

On the device list page, click  in the OperaƟon column to perform
remote conĮguraƟon for a device. The  is in the rightmost column of
the Device page. For details, refer to the user manual of device.

Device Status Click  in the OperaƟon column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
InformaƟon

Click  in the OperaƟon column to edit the device informaƟon, such as
IP address, user name, and password.

Check Online User Click  in the OperaƟon column to check the online users who access
the device, such as user name, user type, user's IP address, and login
Ɵme.

Refresh Click  in the OperaƟon column to get the latest device informaƟon.

Delete Device Select one or mulƟple devices and click Delete to delete the selected
device(s) from the client.
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3.2.3 Add Devices by IP Segment

If the devices share the same port No., user name and password, and their IP addresses ranges in
the same IP segment, you can add them to the client by specifying the start IP address and the end
IP address, port No., user name, password, etc of the devices.

Steps
1. On the Device page, click Add to open the Add window.
2. Select IP Segment as the adding mode.
3. Enter the required informaƟon.

Start IP
Enter a start IP address.

End IP
Enter an end IP address in the same network segment with the start IP.

Port
Enter the device port No. The default value is 8000.

Note
For some device types, you can enter 80 as the port No. This funcƟon should be supported by
the device.

User Name
By default, the user name is admin.

Password
Enter the device password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

4. OpƟonal: Add the oŋine devices.
1) Check Add Oŋine Device.
2) Enter the required informaƟon, including the device channel number and alarm input

number.
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Note
AŌer adding the oŋine device to the client, the device network status will be displayed as
"Oŋine"; When the device comes online, the device network status will turn to "Online", and
the client will connect it automaƟcally.

5. OpƟonal: Check Transmission EncrypƟon (TLS) to enable transmission encrypƟon using TLS
(Transport Layer Security) protocol for security purpose .

Note
● This funcƟon should be supported by the device.
● If you have enabled CerƟĮcate VeriĮcaƟon, you should click Open CerƟĮcate Folder to open

the default folder, and copy the cerƟĮcate Įle exported from the device to this default
directory to strengthen the security. See CerƟĮcate VeriĮcaƟon for Transmission EncrypƟon
for details about enabling cerƟĮcate veriĮcaƟon.

● You can log into the device to get the cerƟĮcate Įle by web browser.
6. Check Synchronize Time to synchronize the device Ɵme with the PC running the client aŌer

adding the device to the client.
7. OpƟonal: Check Import to Group to create a group by the device name, and import all the

channels of the device to the group.
8. Finish adding the device.

- Click Add to add the device and back to the device list page.
- Click Add and New to save the seƫngs and conƟnue to add other device.

9. OpƟonal: Perform the following operaƟon(s).

Remote
ConĮguraƟon

On the device list page, click  in the OperaƟon column to perform
remote conĮguraƟon for a device. The  is in the rightmost column of
the Device page. For details, refer to the user manual of device.

Device Status Click  in the OperaƟon column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
InformaƟon

Click  in the OperaƟon column to edit the device informaƟon, such as
IP address, user name, and password.

Check Online User Click  in the OperaƟon column to check the online users who access
the device, such as user name, user type, user's IP address, and login
Ɵme.

Refresh Click  in the OperaƟon column to get the latest device informaƟon.

Delete Device Select one or mulƟple devices and click Delete to delete the selected
device(s) from the client.

3.2.4 Add a Device via OTAP

Some devices can be added via the OTAP.
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Before You Start
Make sure the device is acƟvated.

Steps
1. On the Device page, click Add to open the Add window, and then select OTAP as the adding

mode.
2. Enter the required informaƟon.

Name
Create a descripƟve name for the device. For example, you can use a nickname that can show
the locaƟon or feature of the device.

Address
The IP address or domain name of the device.

Port
The devices to add share the same port number. The default value is 8000.

Note
For some device types, you can enter 80 as the port No. This funcƟon should be supported by
the device.

User Name
Enter the device user name. By default, the user name is admin.

Password
Enter the device password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

3. OpƟonal: Check TLS to enable transmission encrypƟon using TLS (Transport Layer Security)
protocol for security purpose.

Note
● This funcƟon should be supported by the device.
● If you have enabled CerƟĮcate VeriĮcaƟon, you should click Open CerƟĮcate Directory to

open the default folder, and copy the cerƟĮcate Įle exported from the device to this default
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directory to strengthen the security. See CerƟĮcate VeriĮcaƟon for Transmission EncrypƟon
for details about enabling cerƟĮcate veriĮcaƟon.

● You can log into the device to get the cerƟĮcate Įle by web browser.
4. Check Synchronize Time to synchronize the device Ɵme with the PC running the client aŌer

adding the device to the client.
5. OpƟonal: Check Import to Group to create a group by the device name, and import all the

channels of the device to this group.
6. Finish adding the device.

- Click Add to add the device and back to the device list page.
- Click Add and New to save the seƫngs and conƟnue to add other device.

3.2.5 Add Device by Hik-Connect

If the device supports Hik-Connect and its Hik-Connect funcƟon has been enabled, you can add it
to both the client and Hik-Connect account by Hik-Connect mode; for devices already added to the
Hik-Connect account, you can add them to the client aŌer logging into the Hik-Connect account.

Before You Start
Make sure you have registered and logged into a Hik-Connect account Įrst.

Steps
1. On the Device page, click Cloud P2P Device → Add to open the Add window.
2. Enter the device serial number.

- Enter the serial number which you can Įnd on the device label.
- If the IP address of the device is in the same local subnet with the client, click Online Device

and select an online device to get its serial number automaƟcally.
3. Enter the veriĮcaƟon code of the device.

Note
You can create the veriĮcaƟon code when acƟvaƟng the device and enabling the Hik-Connect
service, and is the same with the veriĮcaƟon code created when enabling stream encrypƟon.
You can also create it on the device conĮguraƟon page.

4. OpƟonal: Check Enable DDNS to access the device by Hik-Connect Domain.
Domain

Customize the device domain name, which is used to get the IP address and port of the
device registered on Hik-Connect server.

UPnP Mode
Auto

Select Auto as the UPnP Mode to get the port number of the device automaƟcally.
Manual

Select Manual as the UPnP Mode, and you need to input the port number of the device
manually.
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User Name
Enter the device user name. By default, the user name is admin.

Password
Enter the device password, which is created when you acƟvate the device.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

Note
If DDNS funcƟon is disabled, you cannot do some operaƟons for the added device through
client, such as viewing the device status, downloading the video Įles during remote playback,
generaƟng QR codes of devices, etc.

5. OpƟonal: Check Import to Group to create a group by the Hik-Connect account name, and
import all the channels of the device to the group.

6. Add device to the client soŌware and Hik-Connect account.
- Click Add to add the device and return to the device list.
- Click Add and New to add the device and conƟnue to add the next device.

7. OpƟonal: Perform the following operaƟon(s).

Remote
ConĮguraƟon

On the device list page, click  in the OperaƟon column to perform
remote conĮguraƟon for a device. The  is in the rightmost column of
the Device page. For details, refer to the user manual of device.

Edit Device
InformaƟon

Click  to edit the device details.

Delete Device Select one or mulƟple devices and click Delete to delete the selected
device(s) from the client.

3.2.6 Import Devices in a Batch

You can add mulƟple devices to the client in a batch by entering the device parameters in a pre-
deĮned CSV Įle.

Steps
1. Enter the Device Management module.
2. Click Device tab on the top of the right panel.
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3. Click Add to open the Add window, and then select Batch Import as the adding mode.
4. Click Export Template and then save the pre-deĮned template (CSV Įle) on your PC.
5. Open the exported template Įle and enter the required informaƟon of the devices to be added

on the corresponding column.

Note
For detailed descripƟon of the required Įelds, refer to the introducƟons in the template.

Adding Mode
Enter 0 or 1 or 2.

Address
Edit the address of the device.

Port
Enter the device port number. The default port number is 8000.

User Name
Enter the device user name. By default, the user name is admin.

Password
Enter the device password.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case leƩers, lower case leƩers, numbers,
and special characters) in order to increase the security of your product. And we recommend
you change your password regularly, especially in the high security system, changing the
password monthly or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

Add Oŋine Device
Enter 1 to enable adding an oŋine device.
AŌer adding the oŋine device to the client, the device network status will be displayed as
"Oŋine"; When the device comes online, the device network status will turn to "Online", and
the client will connect it automaƟcally. Enter 0 to disable adding an oŋine device.

Import to Group
Enter 1 to create a group by the device name. All the channels of the device will be imported
to the corresponding group by default. Enter 0 to disable this funcƟon.

Channel Number
If you enable Add Oŋine Device, enter the channel number of the device. If you disable Add
Oŋine Device, this Įeld is not required.
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Alarm Input Number
If you enable Add Oŋine Device, enter the alarm input number of the device. If you disable
Add Oŋine Device, this Įeld is not required.

6. Click  and select the template Įle.
7. Click Add to import the devices.
8. OpƟonal: Perform the following operaƟon(s).

Remote
ConĮguraƟon

On the device list page, click  in the OperaƟon column to perform
remote conĮguraƟon for a device. The  is in the rightmost column of
the Device page. For details, refer to the user manual of device.

Device Status Click  in the OperaƟon column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
InformaƟon

Click  in the OperaƟon column to edit the device informaƟon, such as
IP address, user name, and password.

Check Online User Click  in the OperaƟon column to check the online users who access
the device, such as user name, user type, user's IP address, and login
Ɵme.

Refresh Click  in the OperaƟon column to get the latest device informaƟon.

Delete Device Select one or mulƟple devices and click Delete to delete the selected
device(s) from the client.

3.3 Restore/Reset Device Password
If you forgot the password of the detected online devices, you can restore the device's default
password or reset the device's password through the client.

3.3.1 Reset Device Password

If you forgot the password of the detected online devices, you can reset the device password via
the client.

Steps
1. Enter Device Management page.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area.

All the online devices sharing the same subnet will be displayed in the list.
4. Select the device from the list and click  on the OperaƟon column.
5. Reset the device password.

- Click Export to save the device Įle on your PC and then send the Įle to our technical support.
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Note
For the following operaƟons for reseƫng the password, contact our technical support.

- Click Generate to pop up the QR Code window and click Download to save the QR code to
your PC. You can also take a photo of the QR code to save it to your phone. Send the picture
to our technical support.

Note
For the following operaƟons for reseƫng the password, contact our technical support.

- Select the Safe Mode according to actual needs.

Note
For the following operaƟons for reseƫng the password, contact our technical support.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case leƩers, lower case leƩers, numbers, and special
characters) in order to increase the security of your product. And we recommend you change
your password regularly, especially in the high security system, changing the password monthly
or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

3.3.2 Restore Device's Default Password

If you forget the password of the detected online devices, you can restore their default password
via the client.

Steps
1. Enter Device Management page.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area at the boƩom of the page.

All the online devices sharing the same subnet will be displayed in the list.
4. Select a device and click  on the OperaƟon column to open the Reset Password window.
5. Restore the device password.

- Enter the security code, and then you can restore the default password of the selected device.

Note
For geƫng the security code, contact our technical support.

- Click Export to save the device Įle on your PC and send the Įle to our technical support.
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Note
For the following operaƟons for reseƫng the password, contact our technical support.

What to do next
The default password (12345) for the admin account is for Įrst-Ɵme login purposes only. You must
change this default password to beƩer protect against security risks, such as the unauthorized
access by others to the product that may prevent the product from funcƟoning properly and/or
lead to other undesirable consequences.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case leƩers, lower case leƩers, numbers, and special
characters) in order to increase the security of your product. And we recommend you change your
password regularly, especially in the high security system, changing the password monthly or
weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the service
provider and/or end-user.

3.4 Upgrade Device Firmware Version
When there is a new Įrmware version available for the added device, you can upgrade its Įrmware
version via the client.

Note
● The device should support this funcƟon.
● You can conĮgure upgrading mode in System ConĮguraƟon. See Set General Parameters for

details.

Enter the Device Management module, and then click Device tab to show the device list.
Perform the following operaƟons according to diīerent upgrading modes.

Disable
On the Device for Management panel, if there is a new Įrmware version available, the status in the
Firmware Upgrade column of the device will turn to Upgradeable.
Select the upgradeable device and click Upgrade to start upgrading the device Įrmware.

Note
The upgrade progress will show. When the upgrade is completed, the status in the Firmware
Upgrade column of the device will turn to Upgraded.
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Prompt Me If Download and Upgrade
If there is a new Įrmware version available, a prompt window will pop up. Click Upgrade All to
start downloading and upgrading.

Download and Prompt Me If Upgrade
A dialog will pop up for selecƟng whether to upgrade aŌer downloading package of new version.
Click Upgrade All to start upgrading the device Įrmware.

Figure 3-2 Device Upgrade Prompt

Note
AŌer clicking Upgrade All, a prompt will pop up for viewing details. If you are not in Device
Management page, click View Details to jump to Device Management page; if you are in Device
Management page, close the prompt.

Upgrade Status
On the device management page, the following upgrade status will be shown in the Firmware
Upgrade column.
No Available Version

No new Įrmware version available.
Upgradeable

A new Įrmware version available.

Note
Move the cursor on  to view the current version, latest version, and upgrade content of the
Įrmware version.

WaiƟng
The device is waiƟng for upgrade.
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Downloading
The client is downloading the package of the new Įrmware version.

Upgrading
The upgrading of the device Įrmware is going on.

Upgraded
Hover the cursor on Upgraded to show the version aŌer upgrading.

Upgrading Failed
When the upgrade fails, a prompt will pop up for viewing details. If you are not in Device
Management page, click View Details to jump to Device Management page; if you are in Device
Management page, close the prompt. Hover the cursor on Upgrading Failed to show the error
details, and click Upgrade Again to try again.

3.5 Manage Added Devices
AŌer adding devices to device list, you can manage the added devices including ediƟng device
parameters, remote conĮguraƟon, viewing device status, etc.

Table 3-1 Manage Added Devices

Edit Device Click  to edit device informaƟon including device name, address, user
name, password, etc.

Delete Device Check one or more devices, and click Delete to delete the selected
devices.

Remote ConĮguraƟon On the device list page, click  in the OperaƟon column to perform
remote conĮguraƟon for a device. The  is in the rightmost column of
the Device page. For details, refer to the user manual of device.

View Device Status Click  to view device status, including cameras, recording status, signal
status, hardware status, etc.

Note
For diīerent devices, you will view diīerent informaƟon about device
status.

View Online User Click  to view the details of online user who access the device,
including user name, user type, IP address and login Ɵme.

Refresh Device
InformaƟon

Click  to refresh and get the latest device informaƟon.
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Generate QR Code Check one or more devices, and click QR Code to generate a QR code of
the added device(s). You can add device(s) to the Mobile Client via
scanning the QR code.

Note
Devices added by Hik-Connect cannot generate a QR code.

Upgrade Device View device status in the Firmware Upgrade column, check one or more
upgradable devices, and click Upgrade Device Firmware to upgrade the
selected devices. For details, refer to Upgrade Device Firmware Version .

Get Events from Device Check one device, and click Get Events from Device to synchronize
events. For details, refer to Get Events from Device .

Export Device Click Export Device, set the saving path and select device type to export
the device details (such as device type, IP address, and port No.) to your
local PC.

Note
The super user can enable Password ProtecƟon and enter the
password, then the exported Įle of device informaƟon will be
encrypted.

3.6 Group Management
The client provides groups to manage the added resources in diīerent groups. You can group the
resources into diīerent groups according to the resources' locaƟons.

Example
For example, on the 1st Ňoor, there mounted 64 cameras, 16 doors, 64 alarm inputs, and 16 alarm
outputs. You can organize these resources into one group (named 1st Floor) for convenient
management. You can get the live view, play back the video Įles, control door status, and do some
other operaƟons of the devices aŌer managing the resources by groups.

3.6.1 Group Resources

The client provides two methods of adding a group: customizing a group or creaƟng a group by
device name. AŌer customizing a group, you need to import resources into this group manually.
AŌer creaƟng a group by the device name, the resources of the device will be imported into the
group automaƟcally. You can choose one method to group your resources according to actual
needs.
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Steps
1. In the Maintenance and Management area, click Device Management → Group to enter the

group management page.
2. Add a group.

- Customize a Group: Click Add Group and create a name for the new group.
- Create a Group by Device Name: Click Create Group by Device Name and select an added

device to create a new group by the name of the selected device. AŌer creaƟng a group by
the device name, the resources (such as encoding channels, alarm inputs, alarm outputs, and
access points) of the device will be automaƟcally imported to the group.

Note
● Up to 256 groups can be added.
● You can select mulƟple groups by pressing and holding ShiŌ or Ctrl key on the keyboard.

3. AŌer adding a group, you need to import resources into the group.

Note
For one resource, it can be added to diīerent groups.

1) Select the type of resources to be imported, and click Import.
2) Select the resources to be imported, and click Import to import all the selected resources into

this group.
4. OpƟonal: AŌer adding a group, perform one of the following operaƟons if needed.

Expand or Fold
Resource List

Click  /  to expand or fold the resource list in the group.

Search Resource Enter the keyword and click  to search target resources.

Remove
Resource from
Group

Select resource(s) and click Delete to remove the selected resource(s)
from the group.

Update
Resource Name

You can update all the resource names in a group or in a channel.
● Select a group, and click Update Resource Name to update all the

resource names in the selected group.
● Select a channel in one group, and update all the resource names in this

channel. For example, click Encoding Channels → Update Camera Name
to update all the camera names in encoding channels.

Note
This funcƟon should be supported by the device.
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3.6.2 Edit Resource Parameters

AŌer imporƟng the resources to the group, you can edit the resource parameters. For encoding
channel, you can edit the channel name, stream type, protocol type, etc. For access point, you can
edit the access point name. For alarm input, you can edit the alarm input name. Here we take
encoding channel as an example.

Before You Start
Import the resources to group.

Steps
1. Enter the Device Management module.
2. Click Device Management → Group to enter the group management page.

All the added groups are displayed on the leŌ.
3. Select a group on the group list and click Encoding Channel.

The encoding channels imported to the group will display.
4. Click  in the OperaƟon column to open the Edit Resource window.
5. Edit the camera informaƟon, including the camera name, the stream type, etc.

Video Stream
Select the stream type for live view of the camera as desired.

Note
You should start live view again to take eīect.

Playback Stream Type
Select the stream type for playback of the camera as desired.

Note
● This Įeld will display if the device supports dual-stream.
● You should start live view again to take eīect.

RotaƟon Type
Select the rotate type for the live view or playback of the camera as desired.

Protocol Type
Select the transmission protocol for the camera.

Note
You should start live view again to take eīect.

Streaming Protocol
Select the protocol as RTSP or private for geƫng stream when live view.
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Note
You should start live view again to take eīect.

Copy to…
Copy the conĮgured parameters to other camera(s).

Refresh
Get a new captured picture for the live view of the camera.

6. Click OK to save the new seƫngs.
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Chapter 4 Hik-Connect

The client soŌware also supports to register a Hik-Connect account, log into your Hik-Connect
account and manage the devices which support the Hik-Connect service.

4.1 Register a Hik-Connect Account
The client supports registering a Hik-Connect account to manage devices which supports Hik-
Connect service.

Steps
1. Enter the login page of a Hik-Connect account.

- Click Log in in the upper-right corner of the client.
- a. Click Device Management → Device to enter the Device Management page.

b. Click Cloud P2P Device → Add to open the adding device pane.
c. Select the region to log in.
d. Click Login.

The Login window pops up.
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Figure 4-1 Login Window
2. Click Register to open the Register Account window.
3. Enter the required informaƟon, including user name, password, conĮrm password, and phone

number/email address.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case leƩers, lower case leƩers, numbers, and special
characters) in order to increase the security of your product. And we recommend you change
your password regularly, especially in the high security system, changing the password monthly
or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

4. Click Send Message to get a veriĮcaƟon code.
The system will send veriĮcaƟon code to your phone or email.

5. Enter the received veriĮcaƟon code in the VeriĮcaƟon Code text Įeld.
6. Check I have read and agreed Terms of Service Privacy Policy.
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7. Click Register to Įnish the registraƟon.

4.2 Log into Hik-Connect Account
You can log into Hik-Connect account via the client, so as to operate devices managed by Hik-
Connect account.

Before You Start
Register a Hik-Connect account.

Note
For details, refer to Register a Hik-Connect Account .

Steps
1. Enter the login page of a Hik-Connect account.

- Click Log in in the upper-right corner of the client.
- a. Click Device Management → Device to enter the Device Management page.

b. Click Cloud P2P Device → Add to open the adding device pane.
c. Select the region to log in.
d. Click Login.

The Login window pops up.
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2. Enter user name/phone number, and password.
3. Click Log in to log into your account.

Log in will turn to Logged in.
4. OpƟonal: Click Logged in → Log out to log out of your account.

Note
● Devices added by Hik-Connect will be hidden aŌer logging out the Hik-Connect.
● Alarm-related pictures saved in Hik-Connect will be valid for 2 hours.
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Chapter 5 Live View

You can view the live video of the added network cameras and video encoders on the Main View
page. And some basic operaƟons are supported, including picture capturing, manual recording,
window division, PTZ control, Auto-Switch in live view, etc.

5.1 Live View Toolbar
The live view toolbar can help you operate and manage the live-view window more convenient and
quick. For example, you can capture picture, record the audio, adjust the volume, split the window
by the one-click of the tools on the toolbar.

DescripƟon of Global Toolbar Icons

Icon FuncƟon Name FuncƟon DescripƟon and OperaƟon

Save View Save the view you create currently, which is convenient
for quick viewing the cameras.
Click  to pop up the window of saving view. Select
Create View or Current View, and name for the view.

Stop Live View Stop the all the live view cameras.

 / Mute/Cancel
Mute

Click  to pop up the volume bar，click  to cancel the
mute and you can adjust the volume.
Click  to pop up the volume bar, click  again to set
the live-view cameras as mute.

Window Division Select the diīerent window division mode for live view.
Click  to select one window division mode (e.g. 9
window division).
You can also click Add to customize a window division
mode.

Full Screen Display the live view in full screen. Press Esc key to exit
full screen mode.

ConĮguraƟon Enter the live view parameters seƫng mode, conĮgure
for live view and playback, image, Įles and toolbar.

Audible and
Visual Alarm

Enable Audible Warning or Strobe Light for warnings and
deterrence. For example, if audible warning is enabled, in
warehouse security monitoring, when the system detects
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Icon FuncƟon Name FuncƟon DescripƟon and OperaƟon

unauthorized intrusion via infrared device, sounder
broadcast content will be played to deter intruders and
noƟfy on-duty staī.

Note
This funcƟon should be supported by device.

DescripƟon of Live View Toolbar ConĮguraƟon
1. Click  on the lower-right corner of Main View page, and select Live View Toolbar in the

popping up pane on the right.
2. (OpƟonal) Switch on Enable Screen Toolbar Display, the live view toolbar will appear when you

hover the cursor on the live view window. Then you can switch on Lock Toolbar, the live view
toolbar will be stuck on the live view window all the Ɵme.

Note
The funcƟon of locking toolbar is not supported when there are more than 9 windows in the
live view image.

3. In General Toolbar and Device Exclusive Toolbar, you can select the icon(s) as needed. Also, you
can drag an icon to move its locaƟon.

Note
The supported icons in device exclusive toolbar vary according to diīerent devices.

Table 5-1 DescripƟon of Live View General Toolbar

Icon FuncƟon Name FuncƟon DescripƟon and OperaƟon

Capture Manually capture the pictures for the live view window.

 / Start Recording/
Stop Recording

Click the Įrst Ɵme to start recording and click again to
stop recording, and automaƟcally save the recording Įles
to the path you have set.

Switch to Instant
Playback

On the current Ɵme, you can select to play back the video
in previous 30 s, 1 min, 3 min, 5 min, 8 min, 10 min.

5.2 Add Custom View
A view is a window division with cameras conĮgured to each window; View mode enables you to
save the window division and the correspondence between cameras and windows as favorite to
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quickly access the related cameras later. For example, you can link camera 1, camera 2, and camera
3 located in your oĸce to display windows and save them as a view called oĸce.

Steps
1. Enter the Main View page.
2. Click Resource tab.
3. Move the cursor to the Custom View in the resource panel and click  to create a new view.

Figure 5-1 Add Custom View
4. Enter a name for the view.
5. OpƟonal: Click  in the live view toolbar to set window division mode for the new view.
6. Start live view for speciĮed camera in speciĮed window according to actual needs.
7. Click  to save the current view or save it as a new view.

Note
Up to 16 custom views are allowed to add to the client.

8. OpƟonal: Perform the following operaƟons aŌer adding the custom view.

Edit View Name Move the cursor over the new view and click  to edit the view name.

Delete View Move the cursor over the new view and click  to delete the view.

What to do next
Click  again to select the custom window division.

5.3 Start Live View
You can start live view aŌer adding device(s) to the client so that you can get to know the
monitored area well. You can start the live view of one camera or all cameras in a group. You can
also start the live view in custom view mode.

Click Main View → Resource to enter Main View page. On the leŌ resource list, select resource(s)
and start live view by the following ways.
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Available
Ways

DescripƟon OperaƟon

Start Live View
for One
Camera

Start the live view of only one
camera in a group.

● Select a camera and drag it to the window.
● Double-click the camera in a group.
● Move your cursor over the camera name, and

click  .

Start Live View
for Camera
Group

Start the live view of all
cameras in one group
synchronously.

● Select a group and drag it to the window.
● Double-click the group.
● Move your cursor over the group name, and

click  , or click  → View All Cameras in
Group .

Start Live View
in Custom
View Mode

Start the live view of the
cameras in the custom view.

● Select a custom view and drag it to the
window.

● Double-click the custom view.

Note
Customize a view which containing informaƟon
such as window division, camera and
correspondence between cameras and
windows. See Add Custom View for details.

Note
If the device supports stream encrypƟon, and the stream of its live view is encrypted, you are
required to enter a stream key for double veriĮcaƟon.
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Figure 5-2 Start Live View

During live view, you can view the bitrate, frame rate and resoluƟon informaƟon on the image. In
the full-screen live view, you can drag any camera to any other windows.

5.4 Auto-Switch in Live View
You can display live view of cameras or display the custom views in turn, which is called "auto-
switch". If you want to perform live view of a large amount of cameras, you can auto-switch the
cameras in a group in a single screen or all cameras in mulƟple screens. You can also add an auto-
switch schedule, which means you can add the selected cameras or custom views to windows,
then the client will automaƟcally switch live view of the selected cameras or custom views by the
window No..

When auto-switching in live view, three modes are available:
● Auto-Switch All Cameras in Default View
● Auto-Switch Cameras in a Group
● Auto-Switch Cameras or Custom Views by Schedule
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5.4.1 Auto-Switch Cameras in a Group

The video stream of the cameras from the same group can switch automaƟcally in a selected
display window. For example, if you start auto-switch of a group containing 5 cameras, the live
view of the 5 cameras will be displayed in turn with an interval which can be conĮgured. You can
also switch to playback and perform other operaƟons on the display window.

Steps
1. Enter the Main View page.
2. Click Auto-Switch → Single Window Auto-Switch on the leŌ panel to show the groups.
3. Select a display window on the right panel.
4. Hover the cursor on a group name and click  .

Figure 5-3 Start Auto-Switch of Cameras in a Group

The cameras in the selected group starts auto-switch in the display window.

Note
The audio is oī by default aŌer auto-switch starts.

5. OpƟonal: Perform the following operaƟons.

OperaƟon DescripƟon

Pause/Resume
Auto-Switch

Click  or  to pause/resume auto-switch.
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Go to Previous/
Next Page

Click  or  to display cameras of the previous/next group.

Set Dwell Time AŌer stopping the current auto-switch, click  or  to decrease/
increase auto-switch dwell Ɵme, or click 20s at the boƩom of the page to
change the auto-switch dwell Ɵme. You can also click Custom Dwell Time
to set the dwell Ɵme according to your need. For example, if you set the
interval as 10 seconds, the image of each group will be displayed for 10
seconds and then switch to next group.

5.4.2 Auto-Switch All Cameras

The video of all the cameras in the camera list can switch automaƟcally in a self-adapƟve mode. If
you start auto-switch of all cameras, the live view of all cameras can be displayed quickly, which is
an eīecƟve way for live view. The auto-switch is performed with an interval which can be
conĮgured. You can also switch to playback and perform other operaƟons on the auto-switch
window.

Steps
1. Enter the Main View page.
2. Click Auto-Switch → MulƟ-Window Auto-Switch on the leŌ panel.
3. Hover the cursor on Auto-Switch All Cameras, and then click  .

Figure 5-4 Start Auto-Switch of All Cameras
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All cameras in the camera list start auto-switching in a self-adapƟve mode.
4. OpƟonal: Perform the following operaƟons.

OperaƟon DescripƟon

Pause/Resume
Auto-Switch

Click  or  to pause/resume auto-switch.

Go to Previous/
Next Page

Click  or  to display cameras on the previous/next page.

Set Dwell Time AŌer stopping the current auto-switch, click  or  to decrease/
increase auto-switch dwell Ɵme, or click 20s at the boƩom of the page to
change the auto-switch dwell Ɵme. You can also click Custom Dwell Time
to set the dwell Ɵme according to your need. For example, if you set the
interval as 10 seconds, the image of each camera will be displayed for 10
seconds and then switch to next camera.

5.4.3 Auto-Switch Cameras or Custom Views by Schedule

You can add an auto-switch schedule by adding mulƟple windows, the window content include the
selected cameras or custom views. Then, the client will automaƟcally switch live view of the
selected cameras or custom views by the window No.

Before You Start
Add the custom views. See Add Custom View for details.

Steps
1. Enter the Main View page.
2. Click Auto-Switch → Auto-Switch Schedule on the leŌ pane.
3. Select a camera group or a custom view on the right list, click  or drag the camera group or the

custom view to the leŌ window to add.
Add the Įrst window.

4. Repeat the previous step to add a new window.

Note
● You can add no more than 20 windows in total.
● You can drag other resources to replace the original content in the added window.
● No more than 64 window can be supported in a window.

Add an auto-switch schedule.
5. OpƟonal: Click  on the right side of a custom view or camera to replace the original content in

the window.
6. Click  to start window auto-switch.

The cameras or the custom views in windows start auto-switch by the window No.
7. OpƟonal: Perform the following operaƟons.
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OperaƟon DescripƟon

Pause/Resume
Auto-Switch

Click  or  to pause/resume auto-switch.

Display Window in
Full Screen

Click  to display the window in full screen. Press Esc key to exit full
screen mode.

Go to Previous/
Next Page

Click  or  to display the previous/next window.

Set Dwell Time Click  or  to decrease/increase auto-switch dwell Ɵme, or click 20s
at the boƩom of the page to change the auto-switch dwell Ɵme. You
can also click Custom Dwell Time to set the dwell Ɵme according to
your need. For example, if you set the interval as 10 seconds, the image
of each window will be displayed for 10 seconds and then switch to
next window.

5.5 PTZ Control
The soŌware provides PTZ control for cameras with pan/Ɵlt/zoom funcƟonality. During the PTZ
control, you can set preset, patrol, and paƩern, and you can also open a new window for
controlling the PTZ.

CauƟon
● Some funcƟons should be supported by the device.

5.5.1 PTZ Control Panel

The soŌware provides PTZ control operaƟons via control panel, such as detecƟon, speed, zoom in,
zoom out, etc. You can also open a new window for controlling the PTZ.

Note
Hik-Connect device only supports the PTZ movements to the direcƟons of up, down, leŌ, and right.

Enter the Main View module, and select Resource → PTZ Control to open the PTZ control panel.
The following icons are available on the PTZ control panel.

Table 5-2 Icons on PTZ Control Panel

Icon Name DescripƟon

DirecƟon BuƩons Click or hold the leŌ mouse buƩon to turn the
PTZ around.
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Icon Name DescripƟon

Click  to turn around the PTZ horizontally
and conƟnuously;​ click again to stop turning.

Speed Control Drag the slider to adjust the PTZ moving
speed.

Zoom in/out Zoom in to view close image for details; zoom
out to view a panoramic image.

Focus +/- Click Focus + move the focal point forward,
and click Focus - to move the focal point
backward.

Iris +/- Used for adjusƟng the luminance of the
image. The larger the iris is, the more the light
enters, and the brighter the image will be.

3D PosiƟoning Use the leŌ key of mouse to click on the
desired posiƟon in the video image and drag a
rectangle area in the lower right direcƟon,
then the dome system will move the posiƟon
to the center and allow the rectangle area to
zoom in. Use the leŌ key of mouse to drag a
rectangle area in the upper leŌ direcƟon to
move the posiƟon to the center and allow the
rectangle area to zoom out.

Auxiliary Focus Click to focus automaƟcally.

Lens IniƟalizaƟon IniƟalize the lens and focus again for a clear
image.

Light Click to Įll light.

Note
This funcƟon needs to be supported by the
device.

Wiper Use the wiper to clear the dust on the camera
lens.

Manual Tracking For speed dome with auto-tracking funcƟon,
enable the auto-tracking (via right-click menu)
for it and click the icon to manually track the
target by clicking on the video.
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Icon Name DescripƟon

Menu For analog speed dome, click the icon to
display its local menu. For detailed operaƟon
of the menu, refer to user manual of the
speed dome.

One-Touch Patrol For speed dome with one-touch patrol
funcƟon, click the icon and the speed dome
starts patrol from the predeĮned preset No.1
to preset No.32 in order aŌer a period of
inacƟvity (park Ɵme). For seƫng the park
Ɵme, refer to user manual of the speed dome.

One-Touch Park For the speed dome with one-touch park
funcƟon, click the icon and the speed dome
saves the current view to the preset No.32.
The device starts to park at preset No. 32
automaƟcally aŌer a period of inacƟvity (park
Ɵme). For seƫng the park Ɵme, refer to user
manual of the speed dome.

Enable Manual Lens De-
Icing Heater

Enable this funcƟon to ensure the camera
performance by heaƟng.

Note
We suggest you enable this funcƟon when
the environment temperature is under 0 °C,
otherwise the high temperature may aīect
the camera work.

Enable Manual PT De-Icing Enable this funcƟon to ensure the camera
performance by wiping oī the ice adhered on
the PTZ camera.

Manual Face Capture Click this buƩon, and hold the leŌ mouse
buƩon to select a face in the image to capture
it. The picture will be uploaded to the server
for viewing.

Synchronize FOV For thermal cameras, click the icon to
synchronize the opƟcal channel's Įeld of view
with that of the thermal channel.
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Icon Name DescripƟon

Regional Exposure For speed domes, click the icon and draw a
rectangle on the image to opƟmize the
exposure eīect in this region.

Regional Focus For speed domes, click the icon and draw a
rectangle on the image to opƟmize the focus
eīect in this region.

Arming and Tracking For cameras support arming and tracking,
click the icon and select the target (person or
vehicle) in the live view to arm and track this
target.

Hazardous Gas DetecƟon When you click the buƩon, the device starts
hazardous gas detecƟon, and then the client
displays hazardous gas informaƟon on the live
view image.

5.5.2 Set Preset, Patrol, and PaƩern

PTZ control supports seƫng and calling a preset, patrol, and paƩern.

On the Home Page, click Main View → PTZ Control to show the PTZ Control panel.

Task DeĮniƟon OperaƟon

Preset A preset links the key regions
to mobile PTZ posiƟon and
status. Monitoring people uses
it to posiƟoning to key regions
rapidly. By sending seƫng
preset command, mobile PTZ
records the posiƟon and status
of zoom, focus, and iris. When
execuƟng calling preset
command, mobile PTZ rapidly
rolls to the set posiƟon and
resume to set status.

How to Set: select a preset from the
preset list→turn the camera to a desired
posiƟon→click  。

How to Call: click  。

PaƩern By recording paƩern, the
movement path and the dwell
Ɵme in a certain posiƟon can
be recorded precisely. By

How to Set: click  to start recording a
paƩern→click the direcƟon buƩons to
shape the paƩern→click  .
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Task DeĮniƟon OperaƟon

calling paƩern, mobile PTZ
starts move totally according to
the recorded path.

How to Call: click  。

Patrol Patrol is the funcƟon that users
specify a scan track with a
group of deĮned presets. The
patrol between two presets is
performed with the set speed
and Ɵme.

How to Set: click  →select presets, and
set speed and Ɵme→click OK.

How to Call: click  .

Note
You should set at least two presets beforehand.

5.6 Sensor Control
Supports remote control of the furnace combusƟon monitoring camera (referred to as sensors),
including sensor advancement/retracƟon.

On the Resource panel, double-click a camera and click the live view window to open the Sensor
Control panel in the lower-leŌ corner.
AŌer entering the panel, a list of sensors will be displayed. You can perform advance/retract
operaƟons on the sensors. AŌer the operaƟon, the current status of the sensors will be shown:
Retracted / Advanced.
Advance

Move the camera forward to get a closer view of the inside of the furnace.
Retract

Move the camera backward to expand the viewing range or move away from high-temperature
areas.

5.7 Customize Window Division
The client soŌware provides mulƟple kinds of predeĮned window divisions. You can also set
custom the window division as desired.

Steps

Note
Up to 5 window divisions can be customized.
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1. Open the Main View or Remote Playback page.
2. Click  on the live view or playback toolbar to open the window division panel.
3. Click Add to open the Add Custom Window Division dialog.
4. Enter the window numbers in both horizontal and verƟcal dimension in the Dimension Įeld, and

then press Enter on your keyboard.

Note
For remote playback, up to 16 windows can be played at the same Ɵme, so the custom window
division with more than 16 windows is invalid.

5. OpƟonal: Drag your mouse to select the adjacent windows, and click Joint to joint them as a
whole window.

6. OpƟonal: Select the joint window and click Restore to cancel the joint.
7. Click Save.
8. OpƟonal: Click or drag a division mode to the displaying window to apply the mode for

displaying.
9. OpƟonal: Edit a customized window division mode.

1) Click  on the live view or playback toolbar to open the window division panel.
2) Click Edit to open the Add Custom Window Division.
3) Select a customized division mode and perform operaƟons including renaming, seƫng

dimension, joinƟng/undo joinƟng windows.

5.8 Manually Record and Capture
During live view, you can record videos and capture pictures manually, and then view the recorded
video Įles and captured pictures in the local PC.

5.8.1 Manually Record Video

Manual recording funcƟon allows to record the live video on the Main View page manually, and
you can store the video Įles in the local PC.

Steps

Note
Manual recording is not supported by Hik-Connect device during live view.

1. Open the Main View page.
2. Start the live view.
3. Perform one of the following operaƟons to start manual recording.

- Move the cursor to the display window in live view to show the toolbar and click  on the
toolbar.

- Right-click on the display window and click Start Recording on the right-click menu.
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The icon  turns to  . An indicator   appears in the upper-right corner of the display
window.

4. Click  to stop the manual recording.
The recorded video Įle is automaƟcally saved to the local PC, and a small window with the
saving path informaƟon appears in the lower-right corner of desktop.

Note
The saving path of the recorded video Įles can be set on the System ConĮguraƟon page. See Set
File Saving Path for details.

5.8.2 View Local Videos

You can view the recorded video Įles stored in your local PC.

Before You Start
Record the live video.

Steps
1. Click  → File → Open Video File in the upper-right corner to open the Video Files page.
2. Select the camera to search the recorded video Įles from the Camera Group list.
3. Specify the start Ɵme and end Ɵme in the lower-leŌ corner for the searching.
4. Click Search.

The video Įles recorded between the start Ɵme and end Ɵme displays in thumbnail format on
the page.

5. OpƟonal: Perform the following operaƟon(s) aŌer the search.

Delete Video
File

Select the video Įle, and click Delete to delete the video Įle.

Send Email Select the video Įle, and click Email to send an email noƟĮcaƟon with the
selected video Įle aƩached.

Note
To send an email noƟĮcaƟon, the email seƫngs need to be conĮgured
before proceeding. For details, refer to Set Email Parameters .

Save Local
Video

Select the video Įle, and click Save as to save a new copy of the video Įle.

Playback Double-click the video Įle to start the local playback.

5.8.3 Capture Pictures

You can capture pictures during the live view.
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Perform this task when you need to capture pictures during the live view.

Steps
1. Open Main View page and start the live view of a camera.
2. Perform one of the following operaƟons to capture pictures.

- Move the cursor to the display window in live view to show the toolbar and click  on the
toolbar.

- Right-click the display window and click Capture on the right-click menu.
The captured picture is automaƟcally saved to the local PC, and a small window with the picture
preview and saving path informaƟon appears in the lower-right corner of desktop.

Note
The saving path of the captured pictures can be set on the System ConĮguraƟon page. For
details, refer to Set File Saving Path .

5.8.4 View Captured Pictures

The pictures captured in the live view are stored in the PC running the soŌware. You can view the
captured pictures if needed.

Before You Start
Capture pictures in the live view.

Steps
1. Click  → File → Open Captured Picture in the upper-right corner to open the Captured Picture

page.
2. Select the camera to search the captured pictures from the Camera Group list.
3. Specify the start Ɵme and end Ɵme in the lower-leŌ corner for the searching.
4. Click Search.

The pictures captured between the start Ɵme and end Ɵme display in thumbnail format on the
page.

5. OpƟonal: Perform the following operaƟon(s) aŌer the search.

Enlarge Picture Double-click the picture thumbnail to enlarge it for a beƩer view.

Print Picture Select the captured picture, and click Print to print the selected picture.

Delete Picture Select the captured picture, and click Delete to delete the selected picture.

Send Email Select the captured picture, and click Email to send an email noƟĮcaƟon
with the selected picture aƩached.

Save Picture Select the captured picture, and click Save as to save a new copy of the
selected picture.
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5.9 Instant Playback
Instant playback shows a piece of the video which is remarkable, or which is unclear on the Įrst
sight. So you can play the video Įles instantly on the Main View page and get an immediate review
if needed.

Before You Start
Record the video Įles and store them on the storage devices, such as the SD/SDHC cards and HDDs
on the DVRs, NVRs, network cameras, etc., or on the storage servers.

Steps
1. Open Main View page and start the live view.
2. Perform one of the following operaƟons to show the pre-play duraƟons' list of instant playback.

- Move the cursor to the display window to show the toolbar and click  .
- Right-click the display window and select Switch to Instant Playback on the right-click menu.
- Move the cursor to default view or custom view node on the View panel and click  .
A list with pre-play duraƟons of 30s, 1 min, 3 min, 5 min, 8 min, and 10 min displays.

3. Select a Ɵme period from the appeared list to start the instant playback.

Example
If you select 3 min, and the current Ɵme of the live view is 09:30:00, then the instant playback
will start from 09:27:00.
During the instant playback, an indicator  appears in the upper-right corner of the display
window.

4. OpƟonal: Click  again to stop the instant playback and go back for the live view.

5.10 Live View for Fisheye Camera
For Įsheye cameras, you can start the live view in Įsheye mode, set presets and patrols, and
perform PTZ control.

5.10.1 Perform Live View in Fisheye Mode

During live view of Įsheye cameras, the whole wide-angle distorted view will be displayed. But you
may have diĸculty to view some details. To solve this problem, you can play the live videos in
Įsheye expansion mode. Fisheye expansion can expand images in various modes: 180° panorama,
360° panorama, PTZ, half sphere, etc. So that you can view the image clearly.

Before You Start
Make sure you have installed MicrosoŌ DirectX component.

Steps
1. Open the Main View page and start the live view of Įsheye camera.
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2. Enter the Fisheye Expansion mode.
- Right-click on the video and select Fisheye Expansion.
- Click  in the toolbar. See Set Icons Shown on Toolbar for details about seƫng the toolbar.

 turns to  .
3. Click  in the lower-leŌ corner of the displaying window to open the MounƟng Type &

Expanding Mode SelecƟon panel.
4. Select the mounƟng type of the Įsheye camera according to its actual mounƟng posiƟon.
5. Select the expanding mode for live view as desired.

Fisheye
In the Fisheye view mode, the whole wide-angle view of the camera is displayed. This view
mode is called Fisheye because it approximates the vision of a Įsh's convex eye. The lens
produce curvilinear images of a large area, while distort the perspecƟve and angles of objects
in the image.

Panorama
In the Panorama view mode, the distorted Įsheye image is transformed to normal
perspecƟve image by some calibraƟon methods.

PTZ
The PTZ view is the close-up view of some deĮned area in the Fisheye view or Panorama
view, and it supports the electronic PTZ funcƟon, which is also called e-PTZ.

Note
Each PTZ view is marked on the Fisheye view and Panorama view with a speciĮc navigaƟon
box. You can drag the navigaƟon box on the Fisheye view or Panorama view to adjust the PTZ
view, or drag the PTZ view to adjust the view to the desired angle.

Half Sphere
By the half sphere mode, you can drag the image and rotate it centering on the diameter, in
order to adjust the view to the desired angle.

AR Half Sphere
AR half sphere mode overlaps images far and near, so that you can view a dimensional image
in a wide angle.

Cylinder
In Cylinder mode, the image is formed into a cylinder page.

6. OpƟonal: Perform the following operaƟon(s) aŌer starƟng live view in Įsheye mode.

Capture Right-click on the window and select Capture to capture the picture in the
live view process.

Enter Full
Screen

Right-click on a playing window and switch the selected window to full-
screen mode.

iVMS-4200 V3.13.1 User Manual

46



5.10.2 PTZ Control in Fisheye Mode

In Įsheye mode, you can control the PTZ to adjust the PTZ window.

Note
The PTZ panel varies according to diīerent devices.

The following funcƟons are available on the PTZ control panel.
● Select a PTZ window, and click the direcƟon buƩons to adjust view angle. Or drag the No. label in

the Įsheye or panorama window to change the view angle of the PTZ window.
● Select a PTZ window, click  to start auto-scan (the camera rotates in a horizontal direcƟon) ,

and click it again to stop auto-scan.
● Drag the slider on  to adjust the speed for PTZ movement.
● Click  , or scroll the mouse wheel to zoom in or zoom out the selected PTZ window.

5.10.3 Set a Preset and Patrol

PTZ supports conĮguring and calling a preset and patrol.

Enter the Main View page, and select Fisheye Expansion aŌer right-clicking a camera.

Task DeĮniƟon OperaƟon

Preset A preset links the key regions
to mobile PTZ posiƟon and
status. Monitoring people uses
it to posiƟoning to key regions
rapidly. By sending seƫng
preset command, mobile PTZ
records the posiƟon and status
of zoom, focus, and iris. When
execuƟng calling preset
command, mobile PTZ rapidly
rolls to the set posiƟon and
resume to set status.

How to Set: select a preset from the
preset list→turn the camera to a desired
posiƟon→click  .

How to Call: click  .

Patrol Patrol is the funcƟon that users
specify a scan track with a
group of deĮned presets. The
patrol between two presets is
performed with the set speed
and Ɵme.

How to Set: click  →select presets, and
set speed and Ɵme→click OK.

How to Call: click  .
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5.11 Perform Smart Linkage
The box or bullet camera which supports smart linkage funcƟon can locate or track the target
according to your demand.

Note
● This funcƟon in only supported by the speciĮc box or bullet camera.
● A speed dome with the auto-tracking funcƟon is required to be installed near the box or bullet

camera.

5.11.1 ConĮgure Smart Linkage Rule

Before performing smart linkage during live view, you should conĮgure the smart linkage rules for
the box or bullet camera, including seƫng VCA detecƟon rule, linking to a speed dome, and
calibraƟng camera and speed dome.

Set Intrusion DetecƟon Rule

You should set the VCA detecƟon rule for the bullet or box camera, and when the VCA event is
triggered, the client can trigger speed dome to track the target. Here we take intrusion detecƟon
as an example.

Steps
1. Open Device Management page and select a box or bullet camera.
2. Click  → Advanced ConĮguraƟon → VCA ConĮg → Rule → Rule Seƫngs to enter rule seƫngs

page.
3. Click Add in Rule List panel to add a rule.
4. Select Intrusion as the event type.
5. Click  to draw a detecƟon region on the live video.
6. Click Save.

Link Speed Dome

When conĮguring the smart linkage for the box or bullet camera, you can link the camera to a
speed dome and set the PTZ posiƟon for the speed dome for tracking.

Perform this task to link the box or bullet camera to a speed dome for smart linkage.

Steps
1. Open Device Management page and select a box or bullet camera.
2. Click  → Advanced ConĮguraƟon → Smart Linkage to enter smart linkage seƫngs page.
3. Click Login on the display window to open the speed dome login window.
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4. Input the speed dome's IP address, port No., user name, and password.
5. Click Login to log in to the speed dome.
6. Click PTZ and use the direcƟon arrows to adjust the speed dome to a horizontal posiƟon.

What to do next
Calibrate the box or bullet camera and the linked speed dome, see Calibrate Camera and Speed
Dome AutomaƟcally or Calibrate Camera and Speed Dome Manually for details.

Calibrate Camera and Speed Dome AutomaƟcally

When seƫng the bullet or box camera's smart linkage rule, you should calibrate the camera and
the speed dome. Two calibraƟon modes, including auto and manual, are available, here we
introduce the auto calibraƟon.

Before You Start
Link the camera to a speed dome, see Link Speed Dome for details.

Steps
1. Open Device Management page and select a box or bullet camera.
2. Click  → Advanced ConĮguraƟon → Smart Linkage to enter smart linkage seƫngs page.
3. Select the calibraƟon mode as Auto CalibraƟng in the lower-right corner of CalibraƟon panel.
4. Move and zoom in/out the view of speed dome to make sure the live views of dome and camera

are mostly same.
5. Click Save.

Calibrate Camera and Speed Dome Manually

When seƫng the bullet or box camera's smart linkage rule, you should calibrate the camera and
the speed dome. Two calibraƟon modes, including auto and manual, are available, here we
introduce the manual calibraƟon.

Before You Start
Link the camera to a speed dome. See Link Speed Dome for details.

Steps
1. Open Device Management page and select a box or bullet camera.
2. Click  → Advanced ConĮguraƟon → Smart Linkage to enter smart linkage seƫngs page.
3. Select the calibraƟon mode as Manual CalibraƟng in the lower-right corner of CalibraƟon panel.
4. Select site No. 1 from the list and click  .

A blue cross appears in the center of the live view page, and the digital zoom view of the
selected site appears on the right.

5. Repeat step 4 to add other manual calibraƟon sites.
6. Adjust the distances among the four calibraƟon sites evenly in the live view page.
7. Select the calibraƟon site No. 1.
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The digital zoom view of site No. 1 appears at the right.
8. Move and zoom in or out the view of speed dome to make sure the live views of speed dome

and the digital zoom view of selected site are mostly same.
9. Click  to save the current site posiƟon informaƟon.
10. Repeat step 7, 8, and 9 to set other sites' posiƟon.
11. Click Save.

5.11.2 Enable Smart Linkage

During live view, you can enable the smart linkage to locate or track the target appeared in the
view of bullet or box camera with a speed dome.

Before You Start
ConĮgure the smart linkage rules for the box or bullet camera.
Perform this task when you need to enable the smart linkage for box or bullet camera.

Steps
1. Enter the Main View page and start the live view of box or bullet camera.
2. Right-click on the live view window and click Enable Smart Linkage.

When the conĮgured VCA rule is triggered by target, the linked speed dome performs the
automaƟc smart linkage and the target frame turns from green into red.

5.12 Live View for Thermal Camera
For thermal camera, you can view the Įre source informaƟon and temperature during live view.
You can also measure the temperature manually to get temperature informaƟon in the live view
image.

5.12.1 View Fire Source InformaƟon during Live View

During the live view, you can view the detected Įre source informaƟon.

Before You Start
ConĮgure the alarm rules for the thermal device, see the user manual of the device for details.

Steps
1. Enter Main View page and start the live view of a thermal camera.

Note
For starƟng live view, refer to Start Live View .

2. Right-click on the live view image and select File Source InformaƟon in the right-click menu to
show the list of informaƟon types.
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Figure 5-5 View Fire Source InformaƟon
3. Select a informaƟon type in the list to display the informaƟon.

Display Fire Source Region
The region in which the temperature is higher than the conĮgured alarm threshold.

Locate Max. Temperature Region
Mark the region in which the temperature is highest in the Įre source region. It is marked in
green.

Display Fire Source Target
The distance between the device and Įre source.

Figure 5-6 Fire Source InformaƟon on Live View Image
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5.12.2 Show Temperature InformaƟon on Live View Image

You can show or hide the real-Ɵme temperature informaƟon of the monitoring scene when
viewing the live video.

Before You Start
● Switch the device VCA source type as Temperature Measurement + Abnormal Event DetecƟon.
● Enable the device temperature measurement funcƟon and set the temperature measurement

rules, see the user manual of the device for details.
Perform this task when you need to show the temperature informaƟon on the live view image.

Steps
1. Enter Main View page and start the live view of a thermal camera.

Note
For starƟng live view, refer to Start Live View .

2. Adjust the scene to the area conĮgured with temperature measurement rule.
3. Right-click on the live view image and select Show Temperature InformaƟon in the right-click

menu.
The temperature displays on the live view image.

4. Click on the image to view the detailed temperature informaƟon.

Figure 5-7 Temperature InformaƟon on Live View Image
5. OpƟonal: Right-click on the live view image and select Hide Temperature InformaƟon to hide

the temperature informaƟon.
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5.12.3 Manually Measure Temperature

During the live view of thermal camera, you can click anywhere on the live view image to show the
temperature of diīerent points to locate the Įre resource quickly.

Steps

Note
● The measured temperature will be displayed on the image for 5 seconds.
● Only one point's temperature can be displayed.
● When mulƟple clients are geƫng the live video of one camera, if one client adds or deletes the

measurement points, other clients' live view will be aīected as well. The measurement points
will be cleared if all users stop live view of the camera.

1. Enter Main View page and start the live view of a thermal camera.

Note
For starƟng live view, refer to Start Live View .

2. Right-click on the live view image and select Show Temperature InformaƟon.
3. Click on the live view image to show the temperature of this posiƟon.

The temperature of the clicked points is shown on the image.

Figure 5-8 Manually Measure Temperature on Points

iVMS-4200 V3.13.1 User Manual

53



4. OpƟonal: Right-click on the live view image and select Hide Temperature InformaƟon on the
menu.

5.12.4 Display Fire Source DetecƟon Shield Area

Fire source detecƟon shield area is a predeĮned area that can be shielded from being detected in
Įre source detecƟon. During live view, you can display the area on the image.

Right-click a live view image and select Display Shield Area. The shield area will be displayed on
the thermal image of the camera.

Note
● This funcƟon needs to be supported by device.
● Make sure you have enabled and conĮgured Fire Source DetecƟon Shield funcƟon for the device.

See the device user manual for details.

Figure 5-9 Fire Source Shield Area

5.12.5 Display Waste Gas InformaƟon

For the device supports waste gas informaƟon detecƟon, you can enable VCA Rule on the System
ConĮguraƟon page to display the waste gas informaƟon during live view.
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See Set Image Parameters for details about how to enable VCA Rule.

Figure 5-10 Display Waste Gas InformaƟon

5.13 Live View in Low Bandwidth
In situaƟon of low network bandwidth, the speed of video streaming might be much slower due to
the bandwidth limit. To provide normal quality in less streaming speed for low bandwidth users,
the client provides live view in low bandwidth mode. Before that, you need to set the streaming
protocol and perform other operaƟons Įrst.

For details about the seƫngs, refer to How to get better performance of live view and playback
when network bandwidth is low? .

5.14 More FuncƟons
This page will introduce the following funcƟons supported in the live view: auxiliary screen
preview, digital zoom, channel-zero, two-way audio, camera status, synchronizaƟon, and enabling/
disabling VCA rules for speciĮc live view windows.

Auxiliary Screen Preview
Display the live video on diīerent auxiliary screens for the convenient preview of mulƟple
monitoring scenes.

Note
Up to 3 auxiliary screens are supported.

Digital Zoom
Drag the mouse to draw a rectangle area in the lower-right/upper-leŌ direcƟon to zoom in or out
the drawn area. Or use the mouse wheel to zoom in or out the view in digital zoom mode.
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Channel-Zero
For the channel-zero of the device, hold the Ctrl key and double-click to display the speciĮc
channel. Hold the Ctrl key and double-click again to restore.

Two-Way Audio
Two-way audio funcƟon enables the voice talk of the camera. You can get not only the live video
but also the real-Ɵme audio from the camera. If the device has mulƟple two-way audio channels,
you can select a channel to start two-way audio.

Note
● The two-way audio can be used for only one camera at one Ɵme.
● Hik-Connect device doesn't support selecƟng channel during two-way audio.

Camera Status
The camera status, such as recording status, signal status, connecƟon number, etc., can be
detected and displayed for checking. The status informaƟon refreshes every 10 seconds.

SynchronizaƟon
The synchronizaƟon funcƟon provides a way to synchronize the device clock with the PC which
runs the client soŌware.

Set Stream Type
Auto-Change Stream Type

Camera selects stream type according to its display window size. When the window division
number is smaller than 9, the stream type will be main stream, otherwise sub stream.

Three ways are provided for seƫng stream type:
● In the resource list, hover the cursor on a camera's name and click  → Stream to select a

stream type, or click Auto-Change Stream Type. Or you can perform this operaƟon for a device
group to set stream type for all devices in this group.

● Click  in the live view tool bar and select a stream type. See Set Icons Shown on Toolbar for
details about ediƟng tool bar.

● Right-click a live view window and click Stream to select a stream type for the camera.

Note
This funcƟon needs to be supported by device.

Lock Client in Full Screen Mode
Press Ctrl and L on your keyboard to lock the client aŌer entering the full screen mode. AŌer
locking the client, you will be unable to operate the client including the other windows in the
current window division mode. Click Unlock on the top and enter the login password for the client
and click Unlock to unlock the client.
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Enable/Disable VCA Rule
To enable/disable VCA rules on speciĮc live view windows, right-click on the windows and select
Enable VCA Rule or Disable VCA Rule.

Note
You can set VCA rules for all live view windows in System ConĮguraƟon. For details, see Set Image
Parameters .

Audio Broadcast
During the live view, click  in the boƩom right corner to start speaking to the added IP Speaker
(online and currently unoccupied), including emergency broadcast and speak in real Ɵme.

Mode ApplicaƟon Scenario OperaƟon

Emergency
Broadcast

Broadcast real-​Ɵme
speaking about
emergency mustering
for guiding persons in
speciĮc areas to
protect themselves.

Click Emergency Broadcast to start real-​Ɵme
speaking of emergency contents.
Click Pause Speaking to pause the broadcast, and
click Resume Speaking to conƟnue the broadcast.

Speak in Real Time Broadcast real-​Ɵme
speaking about
general issues, such as
news broadcast.

Click Speak in Real Time to start real-​Ɵme speaking.
Click Pause Speaking to pause the broadcast, and
click Resume Speaking to conƟnue the broadcast.
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Chapter 6 Remote Playback

The device records the video according to the recording schedule. You can view the video Įles
stored in the storage server and the local device, to restore the event occurrence process for
postmortem analysis and make the further judgment. Storing the valued video footage can provide
basic materials for video analysis and video proof. The client supports mulƟple playback modes,
such as: VCA playback, event playback, etc.

Note
There are two playback modes: one is the instant playback in the Main View module (refer to
Instant Playback for details), another one is searching video Įles and play the video Įles in the
Remote Playback module. In this chapter, we only introduce the playback in the Remote Playback
module.

6.1 Flow Chart
Please follow the steps in the following Ňow chart for playback.

Figure 6-1 Flow Chart of Playback
● Storage Seƫngs: Set recording schedule to deĮne when the cameras start recording and where

the video footage are stored. For details, refer to Remote Storage ConĮguraƟon .
● Search and Play Video Footage: Start playback. For details, refer to the contents in this chapter.
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6.2 Remote Storage ConĮguraƟon
The video Įles and captured pictures can be stored on the HDDs, Net HDDs, or SD/SDHC cards on
the local device, or on the storage server connected.

Note
This funcƟon should be supported by the device.

6.2.1 Store Picture and Video on DVR, NVR, or Network Camera

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such
as the HDDs, Net HDDs and SD/SDHC cards for video and picture Įles. You can set a recording
schedule or capture schedule for the channels of the local devices.

Before You Start
Make sure the newly installed storage devices have be formaƩed. Refer to Format Storage Server's
HDD for details.
Perform this task when you need to store the picture and video Įles on the encoding device such
as DVR, NVR, or network camera.

Steps

Note
The pictures captured through the capture schedule are stored on the local device and can be
searched on the remote conĮguraƟon page of the device.

1. Enter the Storage Schedule module.
2. Select the camera in the Camera Group list.
3. Set Recording Schedule switch or Capture Schedule switch to ON on Storage on Encoding

Device area to enable device local recording or capture.
4. Select the recording or capture schedule template from the drop-down list.

All-day Template
All-day conƟnuous recording.

Weekday Template
Working-hours conƟnuous recording from 8:00 AM to 8:00 PM.

Event Template
All-day event triggered recording.

Template 01 to 08
Fixed templates for speciĮc schedules. You can edit the templates if needed.

Custom
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Customize a template as you want.

Note
If you need to edit or customize the template, refer to ConĮgure Recording Schedule Template
or ConĮgure Capture Schedule Template .

5. Click Advanced of Recording Schedule to set the recording advanced parameters.

Note
The displayed items vary according to the devices.

Pre-record
Normally used for the event triggered record, when you want to record before the event
happens.

Post-record
AŌer the event Įnished, the video can also be recorded for a certain Ɵme.

Keep Video Files for
The Ɵme for keeping the video Įles in the storage device, once exceeded, the Įles will be
deleted. The Įles will be saved permanently if the value is set as 0.

Redundant Recording
Save the video Įles not only in the R/W HDD but also in the redundant HDD.

Record Audio
Record the video Įles with audio or not.

Video Stream
Select the stream type for the recording.

Note
For speciĮc type of devices, you can select Dual-Stream for recording both main stream and
sub-stream of the camera. In this mode, you can switch the stream type during remote
playback. Refer to Normal Playback for stream switch during playback.

6. Click Advanced of Capture Schedule to set the capture advanced parameters.
ResoluƟon

Select the resoluƟon for the conƟnuous or event captured pictures.
Picture Quality

Set the quality for the conƟnuous or event captured pictures.
Interval

Select the interval which refers to the Ɵme period between two capturing acƟons.
Captured Picture Number

Set the picture number for event capture.
7. OpƟonal: Click Copy to... to copy the recording schedule seƫngs to other channels.
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8. Click Save to save the seƫngs.

6.2.2 Store Video on Storage Device

You can store the video footage recorded by the added encoding devices on the storage devices
managed in the client.

You can add storage device to the client for storing the video Įles of the added encoding devices
and you can search the Įles for remote playback. The storage device can be CVR (Center Video
Recorder) or NVR.

Add Storage Server to Client

You can add storage server to the client for storing the video Įles of the added encoding devices.

Steps
1. Enter the Device Management module.
2. Click Device tab.

The added devices are displayed in the list.
3. Add iVMS-4200 Storage Server.

- You can add online storage server. For details, refer to Add Single or MulƟple Online Devices .
- You can add storage server via IP address or domain name. For details, refer to Add Device by

IP Address or Domain Name

Format Storage Server's HDD

You should format the HDDs of the storage server for the video Įle storage.

Perform this task to format storage server's HDD.

Steps

Note
Formaƫng the HDDs is to pre-allocate the disk space for storage and the original data of the
formaƩed HDDs will not be deleted.

1. Enter the Device Management module.
2. Click Device tab.

The added devices are displayed in the list.
3. Select the added storage server from the list.
4. Click  .
5. Click Storage → General to enter the HDD Formaƫng window.
6. Select the HDD from the list and click Format.
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You can check the formaƫng process from the process bar and the status of the formaƩed HDD
changes from UnformaƩed to Normal Status.

ConĮgure Storage Seƫngs

When the storage server is available, you can set the recording schedule for the cameras.

Before You Start
The newly installed storage devices need to be formaƩed.

Steps
1. Enter Storage Schedule module.
2. Select the camera in the Camera Group list.
3. Select a storage server from the Storage Server drop-down list.
4. Set Recording Schedule switch to ON to enable storing the video Įles.
5. Select the schedule template for recording from the drop-down list.

Note
If you need to edit or customize the template, refer to ConĮgure Recording Schedule Template .

6. OpƟonal: For Recording Schedule, click Advanced to set the pre-record Ɵme, post-record Ɵme,
video stream, and other parameters.

Note
The iVMS-4200 Storage Server only supports main-stream.

7. Click Save to save the seƫngs.

6.2.3 Store Picture and AddiƟonal InformaƟon on Local PC

You can store the pictures and the addiƟonal informaƟon, such as the heat map, people counƟng
data, and road traĸc data, to the local PC.

Perform this task when you need to store pictures and addiƟonal informaƟon on local PC.

Steps
1. Enter Storage Schedule module.
2. Select the camera in the Camera Group list.

Note
This funcƟon should be supported by the device.

3. Select storage content.
Picture Storage

Store the alarm pictures of the camera when event occurs. You can click System
ConĮguraƟon → File to modify the saving path of pictures.
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AddiƟonal InformaƟon Storage
Store the addiƟonal informaƟon (e.g., heat map, people counƟng data, etc.) on local PC.

4. Click Save to save the seƫngs.

6.2.4 ConĮgure Recording Schedule Template

You can edit the recording schedule template, or customize a recording schedule template.

Steps
1. Enter the Storage Schedule module.
2. Open the template seƫngs window.

- Select Template 01 to Template 08 from the drop-down list and click Edit.
- Select Custom from the drop-down list.

3. Drag on the Ɵme-line to set the Ɵme periods for the selected template when the cursor turns to
 .

ConƟnuous
Normal and conƟnuous recording. The schedule Ɵme bar is marked with  .

Event Recording
The recording is triggered by event. The schedule Ɵme bar is marked with  .

Command
The recording triggered by command. The schedule Ɵme bar is marked with  .

Note
Command triggered recording is only available for the ATM transacƟons when the ATM DVR is
added to the client.

Note
Up to 8 Ɵme periods can be set for each day in the recording schedule.

4. OpƟonal: AŌer seƫng the Ɵme periods, you can do one or more of the following:

Move Drag a Ɵme period to move it when the cursors turns to  .

Lengthen or
Shorten

Select a Ɵme period and then lengthen or shorten it when the cursor
turns to  .

Set Accurate Time Click a Ɵme period to set the accurate start Ɵme and end Ɵme of the
period.

Delete Select the conĮgured schedule Ɵme period and click  to delete it.

Delete All Click  to delete all the conĮgured Ɵme periods.

Copy to Select one date and click  to copy the date's Ɵme period seƫngs to the
other dates.

5. OpƟonal: For template 01 to 08, you can edit the template name as you want.
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6. Click OK to save the seƫngs.

Note
If you select Custom to customize a template, you can click Save as Schedule Template, and
then the custom template can be saved as template 01 to 08.

6.2.5 ConĮgure Capture Schedule Template

You can edit the capture schedule template, or customize a capture schedule template.

Steps
1. Enter the Storage Schedule module.
2. Open the template seƫngs window.

- Select Template 01 to Template 08 from the drop-down list and click Edit.
- Select Custom from the drop-down list.

3. Drag on the Ɵme-line to set Ɵme periods for the selected template when the cursor turns to  .
ConƟnuous Capture

Normal and conƟnuous capture. The schedule Ɵme bar is marked with  .
Event Capture

The capture is triggered by event. The schedule Ɵme bar is marked with  .
4. OpƟonal: AŌer seƫng the Ɵme period, you can do one or more of the followings

Move When the cursor turns to  , you can move the Ɵme period you just
edited. You can also edit the displayed Ɵme point to set the accurate Ɵme
period.

Lengthen or
Shorten

When the cursor turns to  , you can lengthen or shorten the selected
Ɵme period.

Delete Select a Ɵme period and click  to delete it.

Delete All Click  to delete all the conĮgured Ɵme periods.

Copy to Select one date and click  to copy the date's Ɵme period seƫngs to the
other dates.

5. OpƟonal: For template 01 to 08, you can edit the template name as you want.
6. Click OK to save the seƫngs.

Note
If you select Custom to customize a template, you can click Save as Schedule Template, and
then the custom template can be saved as template 01 to 08.
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6.3 Toolbar for Playback
When playing back video on the Remote Playback module, you can operate the tools in the toolbar
to implement diīerent funcƟons.

Note
The tools in diīerent playback modes might be diīerent. In this secƟon, the tools in the Camera
Playback module will be introduced.

Figure 6-2 Tool for Playback

Table 6-1 Toolbar for Playback

Icon Icon Name DescripƟons

Reverse Playback Play back the video Įle(s) reversely.

 / Pause/Play Pause/play the video Įle(s).

Close All Close all the playing video Įle(s).

Single
Frame(Reverse)

Play the video Įle(s) by frame reversely.

Single Frame Play the video Įle(s) by frame.

 / Slow Forward/
Fast Forward

Set the rate of playing, and play back the video Įle(s)
slowly or fast according to the rate.

Volume Click this icon to open/close the audio and adjust the
volume.

Clip Set the start and end Ɵme for clipping and download the
clipped video Įle to the local disk.

Download for
MulƟple Cameras

Set the start Ɵme and end Ɵme for mulƟple cameras and
download the video Įles of mulƟple cameras
simultaneously.

Window Division Set the window division.

Full Screen Play back video Įle(s) in full screen. Press ESC to exit.

 / Asynchronous
Playback/

Switch to asynchronous/synchronous playback mode.
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Icon Icon Name DescripƟons

Synchronous
Playback Note

For details, refer to Synchronous Playback .

Seƫngs Enter the Video Parameters Seƫngs module, conĮgure
the parameters for live view and playback, image, Įles
and toolbar.

Filter Filter the video Įles by the recording type.

Accurate
PosiƟoning

Set the accurate Ɵme to play back video Įle(s).

Video Date The date of the playing video Įle(s) currently. You can
switch to play back the video Įle(s) on the other date
quickly.
For example, if you switch the date to 07/30, the video
will be automaƟcally displayed from 00:00 on July 30 (if
there is video at this Ɵme).

Filter Human or
Vehicle Related
Video

Check Human or Vehicle to Įlter the video with human
body detected or vehicle detected. The human or vehicle
related video will be remarked in orange on the Ɵme bar,
and you can quickly locate the video on the Ɵme bar.

Note
This funcƟon should be supported by the device,
otherwise the Human or Vehicle is gray and can not be
checked.

Smart Search You can Įlter Human or Vehicle related video before
searching for recordings with targets via the Region or
Line searching mode.
1. Check Human or Vehicle to Įlter the video with human

body detected or vehicle detected.
2. Follow the guidance during iniƟal use. For details

about smart search, see VCA Playback .

Target Retrieval
(AcuSearch)

Search targets by picture. See Search Targets by Picture
for more informaƟon.
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Icon Icon Name DescripƟons

Keyboard Control / ● Space: Start or pause playback.
● LeŌ Arrow / Right Arrow: Rewind or fast forward one

frame. For details, see Play Video Footage .

Privacy ProtecƟon / Disable privacy protecƟon. Right-click on the image and
select Disable Privacy ProtecƟon. When privacy
protecƟon is enabled on the device conĮguraƟon page, it
will apply mosaic blurring (low/medium/high levels) to
privacy informaƟon in the original stream. When it is
disabled on the client, the original stream funcƟon must
be enabled on the device conĮguraƟon page to view
unblurred recordings.

Note
Privacy protecƟon funcƟon should be supported by
device. You can go to the remote conĮguraƟon page of
the device to enable privacy protecƟon.

6.4 Normal Playback
You can search video Įles by camera or group for normal playback and download found video Įles
to local PC. You can also add a tag to mark important video footage, and so on.

You can right-click the playback window to select the required operaƟons from the shortcut menu.
Some are listed as follows:

Name DescripƟon

Show/Hide Temperature
InformaƟon

Show/Hide Temperature InformaƟon

Note
The temperature informaƟon overlay is only supported by
thermal camera.

Tag Control Add default (the default tag name is TAG) or custom tag (the tag
name is customized) for the video Įle to mark the important
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Name DescripƟon

video point. You can also edit the tag or go to the tag posiƟon
conveniently.

Other Capture Modes ● Print Captured Picture: Capture a picture and print it.
● Send Email: Capture the current picture and then send an

Email noƟĮcaƟon to one or more receivers. The captured
picture can be aƩached.

● Custom Capture: Capture the current picture. You can edit its
name and then save it.

Note
● The Hik-Connect device only supports normal playback and it also does not support the
funcƟons of reverse playback, slow forward or fast forward, and adding tag.

● For NVR which is added to the client by device's other user name (except admin), if Double
VeriĮcaƟon is enabled on this NVR, when playing back videos on the client, you are required to
enter the user name and password created for double veriĮcaƟon. For details about double
veriĮcaƟon, refer to the user manual of the NVR.

6.4.1 Search Video Footage

You can search the video footage by date, and you can also enter keyword to Įlter the matched
results for normal playback.

Steps
1. Enter the Remote Playback module.
2. Click  on the leŌ to enter the Camera Playback page.
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Figure 6-3 Search Video Footage
3. On the leŌ Camera pane, start the playback of camera (s) to search the video footage of the

selected camera (s).
- Drag the camera or group to a display window.
- Select a display window and double-click the camera or group to start playback in the selected

window.
- Double-click the cameras in turn to select the display window automaƟcally and start

playback in the windows.

Note
Up to 16 cameras can be searched simultaneously.

4. OpƟonal: On the boƩom Ɵmeline, click  to set the start date and end date of searching Ɵme
period.

Note
In the calendar, the date which has video footage recorded by schedule will be marked with  ,
and the date which has video footage recorded based on event will be marked with  .

6.4.2 Play Video Footage

AŌer searching the video footage for the normal playback, you can play the video via Ɵme line.

Steps
1. Search the video footage. For details, refer to Search Video Footage .
2. Select a date with videos to start playing video and show the Ɵmeline aŌer searching the video

Įles.
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The video footage will play automaƟcally. You can click on the Ɵme line to posiƟon the desired
video segment of speciĮed Ɵme for normal playback.

3. Play video in speciĮed Ɵme period by Ɵmeline or thumbnails.
- Drag the Ɵmeline forward or backward to posiƟon the desired video segment.
- Move the cursor over the Ɵmeline to take a quick view of video thumbnails (if supported by

the device) and click the appearing thumbnail to play the speciĮc video segment.

Note
Make sure the device supports this funcƟon and you have enable it by clicking  in the
lower-right corner.

Figure 6-4 Play Video Footage
4. OpƟonal: Perform the following operaƟons on the toolbar to control the playback.

Switch Stream
Type

Click Stream → Main Stream / Sub Stream to switch the stream type for
playback according to your actual need.

Scale Up/Down
Time Line Bar

Use mouse wheel or click  /  to scale up or scale down the Ɵme line
bar.

Single Frame
(Reverse)

Click   or scroll down the mouse wheel to play the video footage
frame by frame (reversely).

Audio Control Click  or  to turn oī/on the sound. You can also adjust the volume
when turning on.

Download for
MulƟple Cameras

Click  to download video footage or captured pictures.

Note
For more details, refer to Download for MulƟple Cameras .

iVMS-4200 V3.13.1 User Manual

70



Download Video/
Picture Files by
Date

Click  to download video footage or captured pictures of the camera
by date and Ɵme, and store them to local PC. The downloading progress
is displayed on the right-upper corner of the page, and you can manually
pause downloading.

Keyboard Control ● Space: Start or pause playback.
● LeŌ Arrow / Right Arrow: Rewind or fast forward one frame. For

details, see Play Video Footage .

Disable Privacy
ProtecƟon

Right-click on the playback image to select Disable Privacy ProtecƟon.
When enabled on the device conĮguraƟon page, it will apply mosaic
blurring (low/medium/high levels) to privacy informaƟon in the original
stream. When it is disabled on the client, the original stream funcƟon
must be enabled on the device conĮguraƟon page to view unblurred
recordings. This funcƟon should be supported by device.

6.5 Alarm Input Playback
When the alarm input is triggered and the linked video can be searched for alarm input playback.
This funcƟon requires the support of the connected device.

For the descripƟon of the alarm input playback toolbar and right-click menu of display window,
refer to Normal Playback .

Note
Some icons may be not available for alarm input playback.

6.6 Event Playback
The recorded video Įles triggered by event, such as moƟon detecƟon, VCA detecƟon, or abnormal
event detecƟon, can be searched for event playback. This funcƟon requires the support of the
connected device.

For the descripƟon of the event playback toolbar and right-click menu of display window, refer to
Normal Playback .

Note
Some icons may be not available for event playback.

6.7 ATM Playback
You can search the video Įles of ATM DVR for ATM playback. This funcƟon requires the support of
the connected device which is conĮgured with transacƟon rule.
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For the descripƟon of the ATM playback toolbar and right-click menu of display window, refer to
Normal Playback .

Note
Some icons may be not available for ATM playback.

6.8 POS Playback
You can search the video Įles which contain POS informaƟon for POS playback. This funcƟon
requires the support of the connected device which is conĮgured with POS text overlay.

For the descripƟon of the POS playback toolbar and right-click menu of display window, refer to
Normal Playback .

Note
Some icons may be not available for POS playback.

6.9 VCA Playback
For the searched video Įles, you can set VCA rule to Įnd the video footage that VCA event occurs,
such as moƟon detecƟon, line crossing detecƟon, and intrusion detecƟon. This funcƟon helps to
search out the video that you may be more concerned and mark it with red color.

Before You Start
Make sure the device with VCA funcƟon has been installed.

Steps

Note
VCA playback is only supported in a single window, synchronous and asynchronous playback are
not supported.

1. Enter the Remote Playback module.
2. Click  on the leŌ to enter the Camera Playback page.
3. Select the camera and start the camera's video playback.
4. Enter the VCA Search menu.

- Right-click the playback window to pop up the shortcut menu, and then click VCA Search.
- Click  on the lower-right corner of the playback window.

5. Enable the VCA type, draw the detecƟon region and set the sensiƟvity.
MoƟon DetecƟon

When the view of the video changes (such as a person passes, the lens is moved), the video
footage will be marked as red color on the Ɵme line, which is used for the automaƟc alarm
scene or no-guard scene.
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Line Crossing DetecƟon
You can draw a virtual line on the video, and the video footage will be marked as red color on
the Ɵme line when the client bi-direcƟonally detects people, vehicles and other moving
objects that cross the virtual line.

Intrusion DetecƟon
You can draw a virtual region on the video, and the video footage will be marked as red color
on the Ɵme line when there are people, vehicles and other moving objects intruding into the
pre-deĮned region.

VCA Seƫngs
Set the sensiƟvity and Įlter the searched video Įles by seƫng the target characters. The
video footage will be marked as red color on the Ɵme line when a person (whose aƩributes
match the seƫng aƩributes) occurs in the video.

Note
The higher the sensiƟvity, the more accurate the matched person is.

6. OpƟonal: Click  to set the start date and end date of searching Ɵme period.
7. Click  to search for recordings with targets via the Region or Line searching mode.

Follow the guidance during iniƟal use. You can check Human or Vehicle to Įlter the video with
human body detected or vehicle detected.

8. Start the VCA playback.
The VCA events occurred in the deĮned area will be red marked on the Ɵmeline.

Note
● By default, the playback speed of concerned video will be 1X, and the playback speed of

unconcerned video will be 8X.
● You can set to skip the unconcerned video during VCA playback in System ConĮguraƟon and

the unconcerned video won't be played during VCA playback. Refer to Set Live View and
Playback Parameters for details.

● If you need to disable VCA playback, right-click the VCA playback window and click VCA Search
to disable VCA playback.

6.10 Synchronous Playback
Be default, the client play the video Įles of mulƟple cameras in asynchronous playback mode: the
playback Ɵme of diīerent video Įles might be diīerent. In synchronous playback, the video Įles
can be played back in synchronizaƟon.
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Steps

Note
● Video Įles from up to 16 cameras can be played back simultaneously.
● Synchronous and asynchronous playback are not supported in ATM video playback and VCA

playback mode.
● Event video playback and POS video playback only support synchronous playback. To link
mulƟple cameras, enter Maintenance and Management → Event Management , enable the
linked camera according to event type.

1. Enter the Remote Playback module.
2. Start playback of at least two cameras.
3. Click  in the toolbar to enable the synchronous playback.

The camera under playback will start synchronous playback.
4. Click  to disable the synchronous playback.

6.11 Fisheye Camera's Video Playback
When playing back the Įsheye camera's video, there might be distorƟon in the view. To observe
the details beƩer, you can enable the Įsheye expansion funcƟon, to recƟfy the view as an
undistorted view. The client supports mulƟple Įsheye expansion modes, such as: panorama, half
sphere, PTZ, Įsheye+PTZ mode.

Before You Start
Make sure you have installed MicrosoŌ DirectX component.

Steps

Note
For other playback control instrucƟon, refer to Normal Playback . Some icons may not be available
for Įsheye playback.

1. Enter the Remote Playback module.
2. Select a Įsheye camera to start playback.

Note
For detailed conĮguraƟon about playback and playback control, refer to Normal Playback .

3. Enter the Fisheye Expansion mode.
- Right-click on the display window and select Fisheye Expansion.
- Click  in the toolbar. See Set Icons Shown on Toolbar for details about seƫng the toolbar.

iVMS-4200 V3.13.1 User Manual

74



Note
The mounƟng type in playback of Įsheye expansion is set according to the mounƟng type in live
view. For details, refer to Perform Live View in Fisheye Mode

 turns to  .
4. Click  in the lower-leŌ corner of the display area to select an expanding mode for playback as

you desired.
Fisheye

In the Fisheye view mode, the whole wide-angle view of the camera is displayed. This view
mode is called Fisheye because it approximates the vision of a Įsh's convex eye. The lens
produces curvilinear images of a large area, while distorƟng the perspecƟve and angles of
objects in the image.

Panorama / Dual-180° Panorama / 360° Panorama
In the Panorama view mode, the distorted Įsheye image is transformed to normal perspecƟve
image by some calibraƟon methods.

PTZ
The PTZ view is the close-up view of some deĮned area in the Fisheye view or Panorama view,
and it supports the electronic PTZ funcƟon, which is also called e-PTZ.

Note
Each PTZ view is marked on the Fisheye view and Panorama view with a speciĮc navigaƟon
box. You can drag the navigaƟon box on the Fisheye view or Panorama view to adjust the PTZ
view, or drag the PTZ view to adjust the view to the desired angle.

Half Sphere
By the half sphere mode, you can drag the image and rotate it centering on the diameter, in
order to adjust the view to the desired angle.

AR Half Sphere
AR half sphere mode overlaps images far and near, so that you can view a dimensional image
in a wide angle.

Cylinder
In Cylinder mode, the image is formed into a cylinder page, and you can drag the image to any
direcƟon Ňexibly to view everywhere of the detecƟon area.

5. OpƟonal: Right-click on a playing window in the Fisheye view mode and you can switch the
selected window to full-screen mode.

Note
You can right-click on the window and select Quit Full Screen to exit the full-screen mode.
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6.12 Playback in Low Bandwidth
In situaƟon of low network bandwidth, the speed of video streaming might be much slower due to
the bandwidth limit. To provide normal quality in less streaming speed for low bandwidth users,
the client provides playback in low bandwidth mode. Before that, you need to set the streaming
protocol and perform other operaƟons Įrst.

For details about the seƫngs, refer to How to get better performance of live view and playback
when network bandwidth is low? .

6.13 Search Targets by Picture
Search for similar targets by the given picture for target tracking, recogniƟon,crowd Ňow
management, etc.

Steps
1. Enter the Remote Playback page.
2. Double-click the camera to play the video Įle.
3. Click  in the lower leŌ corner for image analysis.
4. Click  on the target frame to search.

Green frames are for faces, blue frames for bodies, and orange frames for vehicles.
5. AŌer jumping to the search results page, you can perform the following operaƟons:

● Filter: Sort by similarity, Ɵme, favorites, etc.
● Export: Including exporƟng pictures, exporƟng current page, and exporƟng all.
● View Target Pictures: Click the target picture to view the playback. You can click  to conduct

a secondary analysis.

6.14 Download Video Footage
During playback, you can download the video Įles or captured pictures of one camera or mulƟple
cameras to the local PC.

Note
● You can download the video Įles of the devices added by Hik-Connect.
● For NVR which is added to the client by device's other user name (except admin), if Double
VeriĮcaƟon is enabled on this NVR, when playing back videos on the client, you are required to
enter the user name and password created for double veriĮcaƟon. For details about double
veriĮcaƟon, refer to the user manual of the NVR.
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6.14.1 Download Video Footage by Date

During playback, you can download the video footage or captured pictures of the camera and save
in the local PC.

Steps
1. Enter Remote Playback page and select a camera to start playback.

Note
For details about starƟng playback, refer to Remote Playback .

2. Right click on the image and click Download.
3. OpƟonal: Check Original Stream to download the original stream video; otherwise, the blurred

video will be downloaded.
The feature should be supported by the device and make sure you have checked it on the Device
Access → Device ConĮguraƟon → Device Parameter → Privacy ProtecƟon → Original Stream
Permission → Storage, Forward, and Export page.

4. OpƟonal: Select human or vehicle to download only relevant segments.
5. Set the start and end Ɵme of the video footage to download.
6. Enter a name for the video footage.
7. OpƟonal: Check oī Download Player to download the player.
8. OpƟonal: Check oī Capture to download the captured pictures.
9. Click OK to download the video footage or captured pictures to the local PC.

Note
Video download supports downloading either the original stream or the blurred video. If the
original stream video will be downloaded;

6.14.2 Download for MulƟple Cameras

During the playback of mulƟple cameras, you can download the video Įles and captured pictures
of mulƟple cameras by date simultaneously.

Steps
1. Enter Remote Playback page and select mulƟple cameras to start playback.

Note
For details about starƟng playback, refer to Remote Playback .

2. Click  to open the Download for MulƟple Cameras window.
All the cameras in playback will be displayed.

3. Select the cameras you want to download video Įles for.
4. OpƟonal: Select human or vehicle to download only relevant segments.
5. Set the start Ɵme and end Ɵme of video duraƟon for each camera.
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You can batch seƫng the download Ɵme. AŌer selecƟng mulƟple cameras, adjusƟng one
selected camera's download Ɵme will syncs changes to others.

6. OpƟonal: Check oī Download Player to download the player.
7. OpƟonal: Check oī Capture to download the captured pictures.
8. Click Download to start downloading videos or pictures to the local PC.
9. OpƟonal: Click Stop to stop downloading manually.

Note
Up to 16 cameras' video Įles can be downloaded simultaneously.
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Chapter 7 Event ConĮguraƟon

Event is used to noƟfy security personnel of the parƟcular situaƟon which helps handle the
situaƟon promptly. Event can trigger a series of linkage acƟons (e.g., audible warning and sending
email ) for noƟĮcaƟon and event handling. You can enable the event and set linkage acƟon(s) for
the resources added to the client. If the selected events happen, the client will receive event
noƟĮcaƟons in real-Ɵme and you can check the details and handle the events accordingly.

Video Event
The video events refer to the special events triggered by video excepƟon, monitoring area's
excepƟon, alarm input, encoding device's excepƟon, etc. For more details, refer to ConĮgure
Event for Camera , ConĮgure Event for Alarm Input , and ConĮgure Event for Encoding Device .

Access Event
The access control events refer to the special events triggered at the access control devices,
doors, card readers, elevators, video intercom devices, etc. For more details, refer to ConĮgure
Client AcƟons for Access Event .

Security Control Event
The security control events refer to the special events triggered by the zones of the security
control panels. For more details, refer to ConĮgure Client Linkage for Zone Event .

AI Open Plaƞorm Event
The AI open plaƞorm event refers to the event triggered by the AI model package on the device.
For more details, refer to ConĮgure Plaƞorm Event .

7.1 ConĮgure Event for Camera
The event for camera refers to the video excepƟon or the events detected in the monitoring area
of the camera, such as moƟon detecƟon, video loss, line crossing, and so on. You can enable an
event for the cameras in the client. When the event is triggered on the camera, the client can
receive and record event for checking and trigger a series of linkage acƟons (e.g., sending email)
for noƟĮcaƟon.

Steps
1. Click Event ConĮguraƟon → Video Event → Camera .

Figure 7-1 Display Camera Resource
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2. Unfold the group and select a camera as event source.

Note
Make sure the resource is online.

All the event types supported by the selected camera will appear.

Figure 7-2 ConĮgure Events for Camera
3. OpƟonal: Enter keywords in Filter Įeld to locate the desired event quickly.
4. OpƟonal: Turn on the switch on the Enable column to enable the event type, or click Enable All

to enable all the event types of this camera.

Note
AŌer enabled, the event can be received by the client and trigger the linkage acƟon(s). You can
also disable an event type or disable all event types.

5. OpƟonal: Select the event(s), and then perform the following operaƟons.

Edit
Priority

Click Edit Priority to set the priority of the event(s).
Priority represents the emergency degree of the event.

Edit Event
Linkage

Click Edit Event Linkage to set the linkage acƟon(s) of the event(s).
Audible Warning

Trigger the client's audible warning when the event is triggered.
You can select the audio Įle on the drop-down list, or click Add to add new
audio Įle (in WAV format).
You can click  to make an audiƟon of the selected audio Įle.
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Send Email
Send an email noƟĮcaƟon of the alarm informaƟon to one or more
receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Pop-up Window
Pop-up window to display the event related informaƟon (including event
details, live video of the source camera, captured pictures of the linked
camera) on the client when the event is triggered. You can also enter
remarks about how to the handle the event.

Display on Map
When the event source is added as a hot spot on the map, the hot spot will
be displayed with  twinkling aside when the event is triggered, which
helps security personnel view the locaƟon of the event.
You can also click the hot spot to view the event details and the live video of
the linked camera.

Linked Camera
Link the selected camera to capture picture or record video when the event
is triggered.

Note
Up to 4 cameras can be selected.

Broadcast Linkage
Link the selected camera to broadcast certain audio Įle(s) when the event is
triggered.

Note
Up to 100 speaker units, and up to 5 audio Įles can be selected.

PTZ Linkage
When the events are triggered, the cameras' Preset, Patrol, and PaƩern will
be called.

Note
Make sure you have conĮgured presets, patrols, or paƩerns for the camera.

Copy Event
Seƫngs

Click Copy to to copy the event seƫngs of this camera to other camera(s).

Note
You can only copy the event seƫngs to the resource(s) of the same type.
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What to do next
You need to arm the device which the camera belongs to, otherwise the client cannot receive the
conĮgured events. For details, see Enable Receiving Event from Devices .

7.2 ConĮgure Event for Alarm Input
The event for alarm input refers to the event triggered by alarm input. You can enable an event for
the alarm inputs in the client. When the alarm input is triggered, the client can receive and record
event for checking and trigger a series of linkage acƟons (e.g., sending email) for noƟĮcaƟon.

Steps
1. Click Event ConĮguraƟon → Video Event → Alarm Input .

Figure 7-3 Display Alarm Input Resource
2. Unfold the group and select an alarm input as event source.

Note
Make sure the resource is online.

All the event types supported by the selected alarm input will appear.
3. OpƟonal: Enter keywords in Filter Įeld to locate the desired event quickly.
4. OpƟonal: Turn on the switch on the Enable column to enable the event type, or click Enable All

to enable all the event types of this alarm input.

Note
AŌer enabled, the event can be received by the client and trigger the linkage acƟon(s). You can
also disable an event type or disable all event types.

5. OpƟonal: Select the event(s), and then perform the following operaƟons.

Edit
Priority

Click Edit Priority to set the priority of the event(s).
Priority represents the emergency degree of the event.

Edit Event
Linkage

Click Edit Event Linkage to set the linkage acƟon(s) of the event(s).
Audible Warning

Trigger the client's audible warning when the event is triggered.
You can select the audio Įle on the drop-down list, or click Add to add new
audio Įle (in WAV format).
You can click  to make an audiƟon of the selected audio Įle.

Send Email
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Send an email noƟĮcaƟon of the alarm informaƟon to one or more
receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Pop-up Window
Pop-up window to display the event related informaƟon (including event
details, live video of the source camera, captured pictures of the linked
camera) on the client when the event is triggered. You can also enter
remarks about how to the handle the event.

Display on Map
When the event source is added as a hot spot on the map, the hot spot will
be displayed with  twinkling aside when the event is triggered, which
helps security personnel view the locaƟon of the event.
You can also click the hot spot to view the event details and the live video of
the linked camera.

Linked Camera
Link the selected camera to capture picture or record video when the event
is triggered.

Note
Up to 4 cameras can be selected.

Broadcast Linkage
Link the selected camera to broadcast certain audio Įle(s) when the event is
triggered.

Note
Up to 100 speaker units, and up to 5 audio Įles can be selected.

PTZ Linkage
When the events are triggered, the cameras' Preset, Patrol, and PaƩern will
be called.

Note
Make sure you have conĮgured presets, patrols, or paƩerns for the camera.

Copy Event
Seƫngs

Click Copy to to copy the event seƫngs of this alarm input to other alarm
input(s).

Note
You can only copy the event seƫngs to the resource(s) of the same type.
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What to do next
You need to arm the device which the alarm input belongs to, otherwise the client cannot receive
the conĮgured events. For details, see Enable Receiving Event from Devices .

7.3 ConĮgure Event for Encoding Device
The event for encoding device refers to encoding device's excepƟon, such as device oŋine. You can
enable an event for the encoding devices added in the client. When the event is triggered on the
device, the client can receive and record event for checking and trigger a series of linkage acƟons
(e.g., sending email) for noƟĮcaƟon.

Steps
1. Click Event ConĮguraƟon → Video Event → Device .

Figure 7-4 Display Device Resource
2. Select a device as event source.

Note
Make sure the resource is online.

All the event types supported by the selected device will appear.
3. OpƟonal: Enter keywords in Filter Įeld to locate the desired event quickly.
4. OpƟonal: Turn on the switch on the Enable column to enable the event type, or click Enable All

to enable all the event types of this device.

Note
AŌer enabled, the event can be received by the client and trigger the linkage acƟon(s). You can
also disable an event type or disable all event types.

5. OpƟonal: Select the event(s), and then perform the following operaƟons.

Edit
Priority

Click Edit Priority to set the priority of the event(s).
Priority represents the emergency degree of the event.

Edit Event
Linkage

Click Edit Event Linkage to set the linkage acƟon(s) of the event(s).
Audible Warning

Trigger the client's audible warning when the event is triggered.
You can select the audio Įle on the drop-down list, or click Add to add new
audio Įle (in WAV format).
You can click  to make an audiƟon of the selected audio Įle.

iVMS-4200 V3.13.1 User Manual

84



Send Email
Send an email noƟĮcaƟon of the alarm informaƟon to one or more
receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Broadcast Linkage
Link the selected camera to broadcast certain audio Įle(s) when the event is
triggered.

Note
Up to 100 speaker units, and up to 5 audio Įles can be selected.

PTZ Linkage
When the events are triggered, the cameras' Preset, Patrol, and PaƩern will
be called.

Note
Make sure you have conĮgured presets, patrols, or paƩerns for the camera.

Copy Event
Seƫngs

Click Copy to to copy the event seƫngs of this device to other device(s).

Note
You can only copy the event seƫngs to the resource(s) of the same type.

What to do next
You need to arm this device, otherwise the client cannot receive the conĮgured events. For details,
see Enable Receiving Event from Devices .
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Chapter 8 Event Center

The event informaƟon (for example, device oŋine) received by the client displays. In the Event
Center, you can check the detailed informaƟon of the real-Ɵme and historical events, view the
event linked video, handle the events, and so on.

Before the client can receive the event informaƟon from the device, you need to enable the events
of the resource and arm the device Įrst. For details, refer to Event ConĮguraƟon and Enable
Receiving Event from Devices .
Before the you can view the pop-up alarm informaƟon, you need to enable event triggered pop-up
image in the event center. For details, refer to View Pop-up Event InformaƟon .

8.1 Enable Receiving Event from Devices
Before the client soŌware can receive event noƟĮcaƟons from the device, you need to arm the
device Įrst.

Steps
1. Click  → Tool → Device Arming Control to open Device Arming Control page.

All the added devices appear on this page.
2. OpƟonal: If there are to many devices, enter the key words in Filter Įled to Įlter the device(s)

you want.

Note
For the Įltered devices, you can click Arm All or Disarm All to enable receiving event of these
devices.

3. In the Auto-Arming column, turn on the switch to enable auto-arming.
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Figure 8-1 Arm Device

AŌer turned on, the device(s) will be armed. And noƟĮcaƟons about the events triggered by the
armed device(s) will be automaƟcally sent to the client soŌware in real-Ɵme.

8.2 View Real-Time Events
The real-Ɵme event informaƟon received by the client of the connected resources are displayed.
You can check the real-Ɵme event informaƟon, including event source, event Ɵme, and priority.

Before You Start
Enable receiving events from devices before the client can receive event from the device, see
Enable Receiving Event from Devices for details.

Steps
1. Click Event Center → Real-Ɵme Event to enter the real-Ɵme event page and you can view the

real-Ɵme events received by the client.
Event Time

For encoding device, event Ɵme is the client Ɵme when it receives the event. For other device
types, event Ɵme is the Ɵme when the event is triggered.

Priority
Priority represents the emergency degree of the event.

2. Filter the events.
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Filter by Device Type and (or)
Priority

Select device type(s) and (or) prioriƟes to Įlter
events.

Filter by Keywords Enter the keywords to Įlter the events.
3. OpƟonal: Right-click the table header of the event list to customize the event related items to be

displayed in the event list.
4. Select an event in the event list to view the event details.

Figure 8-2 Real-Time Events

Note
When Save Pictures in Structure Data Format is enabled, no pictures will be displayed in Event
Details in Event Center. For details about Save Pictures in Structure Data Format, refer to Set
General Parameters .

Note
● The event details include the captured picture(s), video (recorded video triggered by the event

or live view of the device), and other event descripƟons.
● To view the recorded video triggered by the event, you should link camera(s) with the device

in event conĮguraƟon. For details, refer to Event ConĮguraƟon .
● On the Details pane, click Handling Records to view the handling records about the selected

event.
● To view the captured picture(s), you need to conĮgure picture storage in storage schedule.

5. OpƟonal: Perform the following operaƟons if necessary.

Handle Single Event Click Handle to enter the processing suggesƟon, and then click OK.
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Note
AŌer an event is handled, the Handle buƩon will become Add
Remark. Click Add Remark to add more remarks for this handled
event.

Handle Events in a
Batch

Select events that need to be processed, and then click Handle in
Batch. Enter the processing suggesƟon, and then click OK.

Enable/Disable Alarm
Audio

Click Audio On/Mute to enable/disable the audio of the event.

Select the Latest
Event AutomaƟcally

Check Auto-Select Latest Event to select the latest event
automaƟcally and the event informaƟon details is displayed.

Remove Events Select the event(s) you want to remove from the list, and click
Remove. You can search for the removed event(s) in the Event
Search module.

Import to Self-
Learning Library

Click Import to Self-Learning Library, the false alarm picture will be
automaƟcally imported into the self-learning library of front-end
device or back-end device to avoid false alarms of line crossing
detecƟon and intrusion detecƟon.

Note
This funcƟon should be supported by the device.

Send Email Select an event and then click Send Email, and the informaƟon
details of this event will be sent by email.

Note
You should conĮgure the email parameters Įrst, see Set Email
Parameters for details.

Auto-Play Video Check Auto-Play Video to automaƟcally play video when displaying
event details.

Enlarge Video or
Picture

● Double click the video image to view video in a larger window.
● Put the cursor on the picture, and click  to view picture in a

larger window.

Download Captured
Picture

Hover the cursor on the captured picture, and click the download
icon on the lower right corner of the picture to download it to the
local PC.

Download Event
Triggered Video

Hover the cursor on the recorded video, click  to download the
video (30s before the event happens) triggered by the event.

iVMS-4200 V3.13.1 User Manual

89



Enable/Disable Alarm
Triggered Pop-up
Image

If it is enabled, a window will pop up when the event happens,
showing the event informaƟon, related pictures, and related videos.

8.3 Search Historical Events
You can search and view historical events by seƫng search condiƟons such as Ɵme, device type,
and priority in the client. For the searched events, you can handle and export them.

Before You Start
Enable receiving events from devices before the client can receive event informaƟon from the
device, see Enable Receiving Event from Devices for details.

Steps
1. Click Event Center → Event Search to enter the event search page.
2. Set the Įlter condiƟons to display the required events only.

Time
The Ɵme when the event starts.

Search by
Device

Search the events by device or the device's resource channels. If searched by device, you
need to set the followings:
● Device Type: Select the device from which you want to search events.
● Include Sub-Node: Search the events of the device and all resource channels.

Group
Search the events by resource channels in the group.

Note
● For video intercom device, select Search Scope: All and Locking Log.
● For access control device, click Show More to set more condiƟons: status, event type,

card reader type, person name, employee No., card No., and organizaƟon.

Priority
The priority including low, medium, high and uncategorized which indicates the emergency
degree of the event.

Event Type
Select one or more event types to be searched from the drop-down list.
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Note
You can enter a key word (supports fuzzy search) in the search box to search the target event
type(s).

Status
The handling status of the event.

Search by Keyword
Enter a key word (supports fuzzy search) to quickly search the target historical event(s). For
example, you can enter a person's name to search the events related with this person.

3. Click Search to search for events according the condiƟons you set.

Note
When Save Pictures in Structure Data Format is enabled, no pictures will be displayed in Event
Details Įeld in Event Center. For details about Save Pictures in Structure Data Format, refer to
Set General Parameters .

Figure 8-3 Search Historical Events
4. OpƟonal: Right click the table header of the event list to customize the event related items to be

displayed in the event list.
5. Select an event in the event list to view the event details.
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Note
● The event details include the captured picture(s), video (recorded video triggered by the event

or live view of the device), and other event descripƟons.
● To view the recorded video triggered by the event, you should link camera(s) with the device

in event conĮguraƟon. For details, refer to Event ConĮguraƟon .
● On the Details pane, click Handling Records to view the handling records about the selected

event.
● To view the captured picture(s), you need to conĮgure picture storage in storage schedule.

6. OpƟonal: Perform one of the following operaƟons.

Handle Single
Event

Select one event that needs to be handled, and then click Handle in the
event informaƟon details page, and enter the handling suggesƟon.

Note
AŌer an event is handled, the Handle buƩon will become Add Remark,
click Add Remark to add more remarks for this handled event.

Batch Handle
Events

Select the events which need to be handled, and then click Handle in
Batch, and enter the handling suggesƟon.

Note
AŌer an event is handled, the Handle buƩon will become Add Remark,
click Add Remark to add more remarks for this handled event.

Auto-Play Video Check Auto-Play Video to automaƟcally play video when displaying event
details.

Enlarge Video or
Picture

● Double click the video image to view video in a larger window.
● Put the cursor on the picture, and click  to view picture in a larger

window.

Import to Self-
Learning Library

Click Import to Self-Learning Library, the false alarm picture will be
automaƟcally imported into the self-learning library of front-end device
or back-end device to avoid false alarms of line crossing detecƟon and
intrusion detecƟon.

Note
This funcƟon should be supported by the device.

Send Email Select an event and then click Send Email, and the informaƟon details of
this event will be sent by email.
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Note
You should conĮgure the email parameters Įrst, see Set Email
Parameters for details.

Export Event
InformaƟon

Click Export to export the event log or event pictures to the local PC in
CSV/Excel Įle. You can set the saving path manually.

Download
Captured Picture

Hover the cursor on the captured picture, and click the download icon on
the lower right corner of the picture to download it to the local PC.

Download Event
Triggered Video

Hover the cursor on the recorded video, click  to download the video
(30s before the event happens) triggered by the event.

8.4 Get Events from Device
For some scenarios (e.g., the client cannot start up, access control device has been armed by other
client, etc.), the events received by the client and triggered on access control device are not
consistent. You can get events from device remotely to synchronize the events from device to
Event Center of the client。

Click Device Management → Device → Device , select access control device(s), and click Get
Events from Device.
Synchronize the events by the two ways:
● Online: When the device is online and the device can communicate with client at real Ɵme, you

can select Online and set the start Ɵme and end Ɵme to get the events during this period.
● Import File: If the network is not good or the device cannot communicate with the client at real
Ɵme, you can export the event Įle from the selected device Įrstly, and import this exported Įle
on the client later by selecƟng Import File and entering the password of the encrypted Įle.

Note
○ For data security, you should encrypt the Įle when exporƟng on the device. Meanwhile, the

selected access control device should be the one you exported the Įle from.
○ The funcƟon should be supported by the device.
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Figure 8-4 Get Events from Device

Note
If you want to get the events related with aƩendance only, you can also enter Time & AƩendance
→ AƩendance StaƟsƟcs → AƩendance Records , click Get Events from Device and select Online
or Import File to get the events.

8.5 View Pop-up Event InformaƟon
If you have enabled event noƟĮcaƟon and set Event Triggered Pop-up Image as its linkage acƟon, a
window will pop up when the event happens, showing the event informaƟon, related pictures, and
related videos.

Go to Event Center → Real-Time Event , and then click Enable Alarm Triggered Pop-up Image to
enable the funcƟon.

iVMS-4200 V3.13.1 User Manual

94



Figure 8-5 The Pop-up Event InformaƟon

You can view the event related video footage (from 30 s before the event to the end of the event),
the picture captured when the event happens, as well as the event details such as event source,
linked camera, event type, etc.

Note
● When the window is not closed, you should click Next to view the new event informaƟon if a

new event is triggered.
● If you haven't clear the event informaƟon, you can click Previous to view the previous event
informaƟon.

● When Save Pictures in Structure Data Format is enabled, pictures will not be displayed in the
event informaƟon. See Set General Parameters for more details.

Click  to search targets by picture. See Search Targets by Picture for more informaƟon.
You can check Auto-Update Event to enable the window to automaƟcally switch to the latest event
informaƟon when a new event is triggered.
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Chapter 9 Map Management

The E-map funcƟon gives a visual overview of the locaƟons and distribuƟons of the installed
cameras and alarm input devices. You can get the live view of the cameras on the map, and you
will get a noƟĮcaƟon message from the map when alarm is triggered.

E-map is a staƟc image (it do not have to be geographical maps, although they oŌen are.
Depending on your organizaƟon's needs, photos and other kinds of image Įles can also be used as
e-maps) which gives you a visual overview of the locaƟons and distribuƟons of the hot spots
(resources (e.g., camera, alarm input) placed on the map are called hot spots). You can see the
physical locaƟons of the cameras and alarm inputs, and in what direcƟon the cameras are poinƟng.
With the funcƟon of hot region, e-maps can be organized into hierarchies to navigate from large
perspecƟves to detailed perspecƟves, e.g., from Ňoor level to room level.

9.1 Add Map
You should add a map as the parent map for the hot spots and hot regions.

Steps

Note
Only one map can be added to one group.

1. Open the E-map page.
2. Select a group for which you want to add a map.

Note
For details about seƫng the group, refer to Group Management .

3. Click Add Map to open the map adding window.
4. Enter a descripƟve name of the added map.
5. Select a map picture from the local path.

Note
The picture format of the map can only be PNG, JPEG or BMP.

6. Click OK.
7. OpƟonal: Perform the following tasks aŌer adding the map.

Zoom in/out Use the mouse wheel or click + or - to zoom in or zoom out on the map.

Adjust Map
Area

Drag the yellow window in the lower-right corner or use the direcƟon
buƩons and zoom bar to adjust the map area for view.
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9.2 Edit Map Scale
The scale of a map is the raƟo of a distance on the map to the corresponding distance on the
ground. The client can calculate two locaƟons' distance on the map according to the distance on
the ground. An accurate map scale is essenƟal for deĮning radar's monitoring range.

Before You Start
Make sure you have added a map. See Add Map for details.
Perform this task if you need to add a security radar to the map.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. Click Map CalibraƟon → Edit Scale to select two locaƟons on the map.

The cursor will turn to  if you hover it on the map.

Figure 9-1 Edit Map Scale
4. Click on the map to select two locaƟons.

The Edit Scale window pops up.
5. Enter the ground distance between the two locaƟons, and then click OK.

The client will calculate the map scale automaƟcally.

iVMS-4200 V3.13.1 User Manual

97



9.3 Longitude and LaƟtude CalibraƟon
AŌer calibraƟng the longitude and laƟtude of two points on the E-map, you can drag the radar in
the group to the E-map. The radar will automaƟcally move to the correct posiƟon on the E-map
according to the longitude and laƟtude calibraƟng result.

Before You Start
1. Make sure you have added radar on the Client. For details, refer to Add Single or MulƟple

Online Devices .
2. Make sure you have set the longitude and laƟtude parameters of the radar by web browser.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. Click Map CalibraƟon → LongitudeLaƟtude CalibraƟon .
4. Click Add CalibraƟon Point.
5. Click a point on the map, enter the longitude and laƟtude of the point in the pop-up window,

and then click Save.
6. Click Add CalibraƟon Point and repeat the previous step to add the second calibraƟon point.
7. Drag the radar in the leŌ resources group to the map.

The radar will automaƟcally move to the correct posiƟon on the map according to the longitude
and laƟtude of two points calibraƟon.

9.4 Manage Hot Spot
The devices added to the map are called hot spots. The hot spots show the locaƟons of the
devices, and you can also get the live view or alarm informaƟon of the monitoring scenarios
through the hot spots.

9.4.1 Add Camera as Hot Spot

You can add cameras to the map as hot spots.

Before You Start
Make sure you have added an e-map and a camera to the client. See Add Map and Device
Management for details.

Steps
1. Enter the E-map page.
2. Click Edit in the upper-right corner to enter the map ediƟng mode.
3. Click Add Hot Spot → Camera Hot Spot to open the Add Hot Spot window.
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Figure 9-2 Add Hot Spot Panel
4. Select the cameras to be added to the map.
5. OpƟonal: Edit the hot spot name, select the name color and select the hot spot icon.
6. Click OK to save the seƫngs.

Note
You can also drag the camera icons from the group list to the map directly to add the hot spots.

Figure 9-3 Camera on the Map

The camera icons are added on the map as hot spots and the icons of the added cameras in the
group list change from  to  . The sector indicates the camera's Įeld of view.

7. Perform the following operaƟon(s).
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Move the Hot Spot Drag the hot spot to move it to a certain posiƟon.

Change the FOV Angle Drag  /  and revolve to change the camera's Įeld of view.

Change the FOV Size Drag  to change the FOV size.

9.4.2 Add Alarm Input as Hot Spot

You can add the alarm inputs to the map as hot spots.

Steps
1. Enter the E-map module.
2. Click Edit in the upper-right corner to enter the map ediƟng mode.
3. Click Add Hot Spot → Alarm Input Hot Spot to open the Add Hot Spot window.
4. Select the alarm inputs to be added to the map.
5. OpƟonal: Edit hot spot name, select the name color and select the hot spot icon by double-

clicking the corresponding Įeld.
6. Click OK.

Note
You can also drag the alarm input icons from the group list to the map directly to add the hot
spot.
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Figure 9-4 Alarm Input on the Map

The alarm input icons are added to the map as hot spots and the icons of the added alarm
inputs in the group list change from  to  .

7. OpƟonal: Drag the hot spot to move it to a certain posiƟon.

9.4.3 Add Alarm Output as Hot Spot

You can add alarm outputs to the map as hot spots for management. AŌer that, you can enable or
disable it in a quick manner. If you enable an alarm output on the map, the security control devices
(e.g. sirens, bells) connected to it will alarm for aƩenƟon.

Before You Start
Make sure you have added an e-map and alarm output to the client. See Add Map and Device
Management for details.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. Click Add Hot Spot → Alarm Output Hot Spot to open the Add Hot Spot panel.
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Figure 9-5 Add Hot Spot Panel
4. Select the alarm output to be added to the map.
5. OpƟonal: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.

Note
You can also drag an alarm output icon from the alarm output list to the map to add the hot
spot.
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Figure 9-6 Alarm Output on the Map

The alarm output is added to the map as a hot spot and its icon in the group list changes from 
to  .

7. OpƟonal: Drag the alarm output to move it to a certain posiƟon.

9.4.4 Add Zone as Hot Spot

You can add zones to the map so that you can quickly locate the zone when an alarm is triggered.

Before You Start
Make sure you have added a map and zone to the client. See Add Map and Add Device for details.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. Click Add Hot Spot → Zone Hot Spot to open the Add Hot Spot panel.
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Figure 9-7 Add Hot Spot Panel
4. Select the zone(s) to be added to the map.
5. OpƟonal: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.

Note
You can also drag the alarm output icons from the alarm output list to the map to add the hot
spot.
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Figure 9-8 Zone on the Map

The zone is added to the map as a hot spot and its icon in the group list changes from  to  .
7. OpƟonal: Drag the zone hot spot to move it to a certain posiƟon.

When alarms are triggered, the number of the newest alarms will be displayed on the zone's
icon. You can click the number to see the alarms details.

Note
No more than 10 newest alarms can be displayed.

8. OpƟonal: Click Clear Alarms to mark the alarms of the zones on the current map as read.

9.4.5 Add Access Point as Hot Spot

You can add access points to the map as hot spots, so that you can Įnd the hot spots and view
their status and alarm numbers.
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Before You Start
Make sure you have added a map and an access point to the client. See Add Map and Add Device
for details.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. Click Add Hot Spot → Access Point Hot Spot to open the Add Hot Spot window.

Figure 9-9 Add Hot Spot Panel
4. Select the access point(s) to be added to the map.
5. OpƟonal: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.

Note
You can also drag an access point icon from the access point list to the map.
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Figure 9-10 Access Point on the Map

The access point is added to the map as a hot spot and its icon in the group list changes from 
to  .

7. OpƟonal: Drag the access point hot spot to move it to a certain posiƟon.
When alarms are triggered, the number of the newest alarms will be displayed on the hot spot
icon. You can click the number to see the alarms details.

Note
No more than 10 newest alarms can be displayed.

9.4.6 ConĮgure Security Radar Hot Spot

The client supports adding a security radar to the map to work as a hot spot. AŌer that, you can
conĮgure parameters (including drawing zones and trigger lines, seƫng smart linkage, map
calibraƟon, etc.) for the radar and the parameters you set will take eīect on the device. In this way,
an intelligent monitoring in the radar’s detecƟon area can be realized by the client.
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Figure 9-11 Scenario of Radar

Add Security Radar as Hot Spot

For an eīecƟve monitoring, you can add a security radar to the map as a hot spot and paint zones
in its monitoring Įled. So that when someone intrudes the zone, an alarm will be triggered for
aƩenƟon.

Before You Start
Make sure you have added an e-map and a security radar to the client. See Add Map and Device
Management for details.

Steps
1. Enter the E-map module.
2. Click Edit on the E-map toolbar to enter the map ediƟng mode.
3. OpƟonal: Edit map scale. See Edit Map Scale .
4. Select a security radar in the device list and drag it to the map.
5. OpƟonal: Click the added radar and then click  to edit the hot spot name, select the hot spot

color, and select the hot spot icon.
6. Click OK.

The security radar is added to the map as a hot spot and its icon in the group list changes from
 to  . The sector indicates the monitoring Įeld of the radar.
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Figure 9-12 Radar on the Map

Note
● Orange sector indicates an armed radar, while black sector indicates a disarmed radar.
● Red point indicates the detected intruder.

7. OpƟonal: Drag the security radar to move it to a certain posiƟon.

Draw a Zone

Zone is a basic concept in the security control system. It refers to a protecƟon area in a radar's
detecƟon area, and is regarded as the maximum recognizable unit to disƟnguish the alarm event,
determining whether to trigger an alarm according to the zone type and radar's arming status. You
can see the target's locaƟon on the map the minute an alarm is triggered so as to take quick
acƟons accordingly.

Before You Start
Make sure you have disarmed the radar: click Finish，and select Disarm aŌer clicking the radar's
icon.
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Steps
1. Enter the E-Map module, and click Edit on the top right to enter the Edit mode.
2. OpƟonal: Enable Field Assistance on the top leŌ of the map. The target track will appear on the

radar detecƟon area. You can draw a zone with reference to the track.
3. Draw a zone.

Method Step

Draw a
Zone
Manually

Click Radar Seƫngs → Draw Zone Manually on the top of the map, and draw a zone
on the radar detecƟon area.

Figure 9-13 Draw a Zone Manually

Draw a
Zone
Quickly

Click Radar Seƫngs → Draw Quick Zone on the top of the map, and leŌ-click on the
radar detecƟon area to conĮrm the posiƟon of the zone.

Note
Currently, the default shape of the zone is square and it is not editable.
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Figure 9-14 Draw a Quick Zone
4. Right-click to complete drawing, and a window will pop up. Enter the zone name, and select

Early Warning Zone, Warning Zone, or Disabled Zone as the zone type.
Early Warning Zone

The early warning zone will idenƟfy target that has potenƟal risks in advance and trigger an
alarm, but will not store alarm track. The early warning zone is green.

Warning Zone
The warning zone will idenƟfy the targets entering the area and trigger alarm. The warning
zone is orange.

Disabled Zone
The disabled zone will block the target track in the area. The disabled zone is black.

Note
● Adding zones is a batch operaƟon. If you plan to add zones for only one radar, you need to

right-click on the remaining radar detecƟon area to cancel drawing a zone in detecƟon area of
other radars aŌer drawing the desired zone.

● When drawing a zone, the actual lengths of the edges of the zone will be displayed; aŌer
drawing a zone, you can double-click it to view the actual lengths of its edges.

● Zones can overlap, the priority of the eīecƟve overlapping zone is: Disabled Zone>Warning
Zone>Early Warning Zone. That is, Early Warning Zone can contain Warning Zone and Disabled
Zone, and Warning Zone can contain Disabled Zone.

● You can zoom in/out to adjust the size of the displayed radar area.
5. Click OK.
6. Click Finish on the top right of the map.
7. OpƟonal: AŌer adding the zone and disarming the radar, double-click the zone to enter the

ediƟng mode, and perform the following operaƟon(s) if needed.
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Add a Marker Hover the cursor on the line of the zone and it will change to a
cross, and then click to add a marker.

Change the Zone Shape Drag the marker to change the shape of the zone.

Move a Zone Select a zone and drag the zone to move it.

Delete a Zone Click  to delete a zone.

Edit a Zone Click  to edit the zone name and type.

Draw Trigger Line

A trigger line refers to a virtual line drawn in a radar’s detecƟon area on the map. An alarm will be
triggered when someone crosses it in its pre-deĮned direcƟon.

Before You Start
The radar is added to the map. Click Finish on the top right to exit the ediƟng mode. Click on the
radar icon and select Disarm to disarm the radar.

Steps
1. On the E-map page, click Edit to enter the ediƟng mode.
2. Click Radar Seƫngs → Draw Trigger Line , and select Trigger Line or Dual-Trigger Line.

Note
Drawing a dual-trigger line that is too tortuous will cause a failure.

3. Draw trigger line.
1) Click on the radar detecƟon area to draw a trigger line.
2) Select LeŌ -> Right, LeŌ <- Right or LeŌ <-> Right in the pop-up window.
3) OpƟonal: Enter the distance between two lines. (Only for dual-trigger line)

Note
●

Alarm rules: A single arrow  indicates that the target triggers an alarm when it crosses the

trigger line in the direcƟon of the arrow; a double arrow  indicates that the target triggers
an alarm when it crosses the trigger line in any direcƟon.

● The alarm can be triggered by crossing the Trigger Line according to the alarm rule; the
alarm can be triggered only aŌer crossing double lines of Dual-trigger Line according to the
alarm rule.

● DirecƟon determinaƟon: suppose you stand at the penulƟmate marker facing the last
marker, the area on your leŌ indicates the LeŌ, while the area on your right indicates the
Right.

● Up to 4 trigger lines can be drawn.
● Up to 1 dual-trigger line can be drawn.
● The trigger line cannot cross each other.

iVMS-4200 V3.13.1 User Manual

112



Figure 9-15 Draw Trigger Line
4. Click OK.
5. OpƟonal: Click on the trigger line will appear diīerent opƟons: Edit, Delete and Move. You can

edit the trigger line by clicking on it.
- Add a Marker: Click on the line to add a marker.
- Drag a Marker: Drag a marker on the trigger line to move it.
- Move the Trigger Line: Hold the ediƟng area to move the trigger line.
- Edit: Click  to edit the trigger line name, trigger line rule and distance (only for Dual-trigger

Line).
- Delete: Click  to delete the trigger line.

Add Track Filter Zone

Track Filter Zone is an area in radar's detecƟon area. When an object enters the track Įlter zone,
alarms will not be triggered, and the object's moving paƩern will not be uploaded to the client.
This funcƟon is applicable for places with plenty of disturbing factors (such as trees) that may
cause wrong alarms.

Before You Start
Make sure you have added a radar to map and have disarmed the radar. See Add Security Radar as
Hot Spot for details.

Steps

Note
● This funcƟon should be supported by the device.
● Up to 32 track Įlter zones are supported.
● The size of track Įlter zone depends on device capability.
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1. On the top right of the map, click Edit to enter the ediƟng mode of the map.
2. Click Radar Seƫngs → Track Filter Zone → Add Track Filter Zone .
3. On the map, hold the mouse and drag to set the semi-diameter of the track Įlter zone. Right-

click to end drawing.

Figure 9-16 Track Filter Zone
4. OpƟonal: Perform the following operaƟons.

Edit Track Filter Zone Double-click the track Įlter zone, hover the cursor on the border.
When the cursor turns to a blue +, hold the mouse and drag to adjust
the area.

Move Track Filter
Zone

Double-click the track Įlter zone, and drag it to move it.

Display/Hide Track
Filter Zone

Click Radar Seƫngs → Track Filter Zone → Display/Hide Track Filter
Zone to display or hide the track Įlter zone on/from the map.

Delete Track Filter
Zone

Double-click the track Įlter zone, and click  .

Add Point Cloud Filter Zone

AŌer the radar detects the object, mulƟple points will be reported to the device and form the
point cloud. Point cloud Įlter zone is an area in radar's detecƟon area. ConĮguring it before
environment learning can improve the accuracy of environment learning. When the object enters
the point cloud Įlter zone, the point will not be reported to the device. This funcƟon is applicable
for places with plenty of disturbing factors to reduce false alarms.

Before You Start
Make sure you have added a radar to map and have disarmed the radar. See Add Security Radar as
Hot Spot for details.

Steps

Note
● This funcƟon should be supported by the device.
● Up to 16 point cloud Įlter zones are supported.
● The size of point cloud Įlter zone depends on device capability.
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1. On the top right of the map, click Edit to enter the ediƟng mode of the map.
2. Click Radar Seƫngs → Point Cloud Filter Seƫngs → Draw Point Cloud Filter Zone .
3. On the map, leŌ-click to start drawing and right-click to end drawing.

Figure 9-17 Point Cloud Filter Zone
4. Enter the name of the point cloud Įlter zone.
5. Click OK.
6. OpƟonal: Perform the following operaƟons.

Edit Point Cloud Filter
Zone

Double-click the point cloud Įlter zone, hover the cursor on the
border. When the cursor turns to a blue +, drag to adjust the area.

Move Point Cloud Filter
Zone

Double-click the point cloud Įlter zone, and drag it.

Delete Point Cloud Filter
Zone

Double-click the point cloud Įlter zone, and click  .

Set Smart Linkage

Smart linkage works based on the calibraƟon points you adds to the radar's detecƟon area. That is
the calibraƟon points can tell the PTZ camera linked to the radar which direcƟon to turn to when a
target is detected so as to get the live view and track of the target by the client.

Note
Make sure you have performed the following operaƟons before calibraƟon:
● You need to disarm the radar before calibraƟon: click Finish on the top right to exit the ediƟng

mode. Click the radar icon and select Disarm to disarm the radar.
● You need to link the PTZ camera to the zone before calibraƟon, and set the PTZ camera iniƟal
posiƟon. See the PTZ camera user manual for details about how to set the PTZ camera iniƟal
posiƟon.

● Import the PTZ camera linked to the radar to the radar's group. See Group Resources for details.
● The installaƟon height of the linked PTZ camera should be higher than 3 meters.
● Only PTZ camera supports this funcƟon.
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According to the relaƟve installaƟon posiƟon of the radar and the camera, it is necessary to select
a schedule (One-Point CalibraƟon or MulƟ-Point CalibraƟon)͘ for the calibraƟon point selecƟon.
One-Point CalibraƟon

Applicable to the scenario where the radar and the camera are installed on the same pole or
the camera is installed within a radar-centered range of 2 meters (regardless of the alƟtude
diīerence between the camera and the radar).

Figure 9-18 Scenario of One-Point CalibraƟon

MulƟ-Point CalibraƟon
The scenario which is not applicable to the one-point calibraƟon needs to adopt the mulƟ-point
calibraƟon.
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Figure 9-19 Scenario of MulƟ-Point CalibraƟon

One-Point CalibraƟon

One-point calibraƟon is applicable to the scene where the radar and the camera are installed on
the same pole or the camera is installed within a radar-centered range of 2 meters (regardless of
the alƟtude diīerence between the camera and the radar).

Before You Start
To perform this funcƟon, a cooperaƟon between two persons is required. Person A enters the
detecƟon area so that person B (the operator of the client) can see A's track on the client. And
then B sets calibraƟon points by the client according to A's track.

Steps
1. Click Edit on the top right of the map.
2. Click Radar Seƫngs → Smart Linkage Seƫngs → Linked PosiƟoning Seƫngs .
3. On the Smart Linkage Seƫngs page, select a radar from the drop-down list on the top leŌ.
4. Click a live view window at the boƩom and select a camera in the Linked Camera list. The live

view window displays the camera's live view.
5. Double-click the camera's live view window to enlarge it.

Note
You can click + or - to zoom in/out the map.

6. Select One-Point CalibraƟon as the calibraƟon mode.
7. Select the track of person A. Ask person A to move into the radar detecƟon area. By comparing

the moving object in the live view window of the camera and the track in the radar detecƟon
area, person B needs to select the track of person A and click it. The color of the selected track
will turn from red to white.
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Figure 9-20 Select the Track
8. Ask person A to move to the calibraƟon point within 20 to 40 m directly in front of the radar, and

then stand at the calibraƟon point.
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9. Adjust the PTZ buƩons in the live view window to get the PTZ posiƟon: Click + and - to adjust the
alƟtude of person A to two-thirds of the alƟtude of the window, and click the direcƟon buƩons
to align the central sign  with person A (For precise alignment, click on the center of the object
and the screen will adjust automaƟcally)͘.

10. Click Add CalibraƟon to add a calibraƟon point. The PTZ posiƟon and the radar posiƟon of
person A will be shown in the InformaƟon list. The opƟon The smart linkage will be enabled
aŌer compleƟng the seƫngs. will be checked automaƟcally.
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Figure 9-21 Add a CalibraƟon
11. Click Save.
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MulƟ-Point CalibraƟon

MulƟ-point calibraƟon is applicable to the scenario where the distance of the radar and the
cameras linked to it is more than 2 meters.

Before You Start
This funcƟon needs the cooperaƟon between 2 persons. Person A enters the detecƟon area so that
person B (the operator of the client) can see A's track according to which B set the calibraƟon
points by the client.

Steps
1. On the Smart Linkage Seƫngs page, select MulƟ-Point CalibraƟon as the calibraƟon mode.
2. Select calibraƟon points (equally distributed) on the center line of the radar's detecƟon area,

you can refer to the following Įgure to select points.

Figure 9-22 MulƟ-Point DistribuƟon Instance

Note
At least 4 calibraƟon points are required.

3. According to the calibraƟon points, person A moves to a calibraƟon point, and refer to step 2 to
step 5 in One Point CalibraƟon to calibrate the calibraƟon point.

4. When the Įrst calibraƟon point is set, let person A move to the next calibraƟon point aŌer the
yellow track disappears. And then refer to step 2 to step 5 in One Point CalibraƟon to set the
next calibraƟon point. Follow this process to set all other calibraƟon points in turn.
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Figure 9-23 MulƟ-Point CalibraƟon Radar Page
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Note
Click Delete to delete a calibraƟon point aŌer selecƟng the calibraƟon point in the InformaƟon
list.

5. Click Save aŌer all calibraƟon points are set.

Note
You can save the calibraƟon informaƟon successfully only if there are 4 calibraƟon points,
otherwise you cannot save it.

GPS CalibraƟon

GPS CalibraƟon refers to calibraƟng by device longitudes and laƟtudes, radar's orientaƟon, and
linked PTZ camera's posiƟon angle.

Before You Start
● Record the radar's longitude, laƟtude, and orientaƟon.
● Record the linked PTZ camera's longitude, laƟtude, and posiƟon angle.

Steps
1. On the Smart Linkage Seƫngs page, click Set Longitude and LaƟtude to open the Set Longitude

and LaƟtude window.
2. Enable Enable GPS CalibraƟon.
3. Enter Radar Longitude and Radar LaƟtude, and Radar OrientaƟon.

Note
See radar user manual for details about seƫng radar orientaƟon.

4. Enable Network PosiƟoning System.

Note
You can also enable or disable this funcƟon on the Smart Linkage Seƫngs page.

5. Enter Camera Longitude, Camera LaƟtude, and PosiƟon Angle.

Note
See PTZ camera user manual for details about seƫng posiƟon angle.

6. Click OK.

Set Auxiliary Linkage

Auxiliary Linkage is to add presets to the camera linked to the radar to help the radar accurately
turn to the target with the assistance of presets. AŌer adding presets, the camera will
automaƟcally turn to the presets if a target is detected, and in this way you can view the image of
the target via the Client.
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Before You Start
● Make sure you have calibrated the linked camera. For detailed informaƟon, see One-Point
CalibraƟon or MulƟ-Point CalibraƟon .

● Make sure you have conĮgured zones. For detailed informaƟon, see Draw a Zone .

Steps
1. Click E-map.
2. Click Radar Seƫngs → Smart Linkage Seƫngs → Auxiliary Linkage .

Figure 9-24 Auxiliary Linkage
3. Select a radar and a camera from the drop-down list.
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Note
Make sure you have set the Linked Camera on the Smart Linkage Seƫngs page, and saved the
seƫngs.

4. Click Add Preset.
5. Select a zone in the list.
6. OpƟonal: Edit preset.

BuƩon DescripƟon

PTZ Check P/T/Z, the checked value of the camera will remain unchanged.

Delete Delete the preset.

Live View Use the camera to view the presets.

Update Update the preset coordinate to the current camera coordinate.

Note
The situaƟon when you need to set PTZ is that if the calibrated camera cannot turn to the preset
accurately, you can set P/T/Z to make it more accurate. You can check them all to Įx the camera
if the region is small or the terrain is not very undulaƟng.

7. Use funcƟon buƩons on the right to adjust the camera screen center posiƟon (cross icon
posiƟon) to the watch point. You can click a posiƟon in the image and the posiƟon will become
the center of the image.

8. Click ConĮrmed.

Set Environment Learning

To improve the accuracy of radar detecƟon, you need to make the radar complete the environment
learning.

Note
Make sure you have added the radar to the e-map.

Select a radar on the e-map in the client soŌware, and click Environment Learning to start the
environment learning.

Note
● The Ɵme for the environment learning is 10 seconds by default.
● Every Ɵme the radar starts to learn the environment, the previous learning data will be
overwriƩen automaƟcally.

● You can log in to the radar's remote conĮguraƟon page via a web browser to conĮgure the
environment learning parameters. For details, refer to the user manual of the device.
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Terrain Learning

By terrain learning, the radar can get the terrain of its detecƟon area and make more accurate
smart linkage.

Before You Start
Make sure you have completed calibraƟon. See One-Point CalibraƟon and MulƟ-Point CalibraƟon
for details.

Steps

Note
● This funcƟon should be supported by the device.
● To use this funcƟon, a cooperaƟon between two persons is needed. Person A enters the radar's
detecƟon area, while person B operates the PTZ camera linked with the radar and display person
A in the live view of the PTZ camera on the Smart Linkage Seƫngs panel.

1. On the Smart Linkage Seƫngs panel, click Terrain Learning → Start Terrain Learning .
2. In the radar's detecƟon area, select person A's moving paƩern.
3. Control the PTZ camera to keep person A in the center of the live view page by the buƩons on

the right.
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Figure 9-25 Terrain Learning
4. Click Terrain Learning → Finish Terrain Learning to end terrain learning.

Note
Old terrain learning results will be overwriƩen by new results.
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5. OpƟonal: Click Terrain Learning → Clear Terrain Learning to clear exisƟng terrain learning
results.

CalibraƟon CompensaƟon

CalibraƟon CompensaƟon makes calibraƟon more accurate by adjusƟng Pan, Tilt, and Zoom of
radar-linked PTZ camera.

Before You Start
Make sure you have Įnished a calibraƟon.

Steps
1. On the Smart Linkage Seƫngs page, click CalibraƟon CompensaƟon to open the CalibraƟon

CompensaƟon window.
2. Select a camera from the Camera list.

Figure 9-26 CalibraƟon CompensaƟon
3. Select a CalibraƟon Mode.
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GPS CalibraƟon
If you had conducted GPS calibraƟon before, select this mode.

PTZ CalibraƟon
If you had conducted one-point calibraƟon or mulƟ-point calibraƟon before, select this mode.

4. Enter the Pan, Tilt, and Zoom.

Note
The Pan, Tilt, and Zoom you entered here will be added to the former Pan, Tilt, and Zoom.

5. Click OK.

Set Parking Points for Linked Camera

AŌer enabling the radar parking mode, the radar will control the linked camera to turn to the
predeĮned parking point when no target detected within 10s in the radar detecƟon area.

Before You Start
● Add the radar to the map.
● Link the camera to the radar, and add the camera to the client.
● Calibrate the camera and enable camera smart linkage.
● You need to disarm the radar before the operaƟon. Click Finish on the E-map page to exit the
ediƟng mode. Click the radar icon and select Disarm to disarm the radar.

Steps

Note
This funcƟon is only applicable for cameras with PTZ control funcƟon.

1. Click Edit on the top right of the map to enter ediƟng mode.
2. Click Radar Seƫngs → Set Parking Point .
3. Select a radar from the Radar drop-down list.
4. Select a linked camera from the following list.
5. Use buƩons on the right to adjust the camera screen center posiƟon (cross icon posiƟon) to the

watch point. You can click on the screen and the screen will automaƟcally adjust to the clicked
center. You can also click the image to make the posiƟon you clicked the center.

Adjust the rotaƟon speed of the camera. 1 is the slowest and 7 is the fastest.
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Figure 9-27 Set Parking Point
6. Click Set as Parking Point.

Set Preset Point

You can set a preset point for a zone or a trigger line. When an alarm is triggered in the zone or
trigger line, the camera will automaƟcally turn to the corresponding preset point.
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Before You Start
● Add the radar to the map.
● Link the camera to the radar, and add the camera to the client.
● Zones and trigger lines are conĮgured.
● You need to disarm the radar before the operaƟon. Click Finish on the E-map page to exit the
ediƟng mode. Click the radar icon and select Disarm to disarm the radar.

Steps

Note
This funcƟon is only applicable for cameras with PTZ control funcƟon.

1. Click E-map and click Edit to enter the ediƟng mode.
2. Click Radar Seƫngs → Preset Point Seƫngs .
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Figure 9-28 Preset Point Seƫngs
3. Switch on Enable.
4. Select a radar and a camera from the drop-down list.
5. Use funcƟon buƩons on the right to adjust the camera screen center (cross icon posiƟon) to the

watch point.

Note
You can also click on the image and the clicked point will be the camera screen center.

OperaƟon DescripƟon
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Adjust the camera direcƟon. Hold to move the camera direcƟon
conƟnuously.

Rotate the camera horizontally. Hold to conƟnuously rotate the
camera horizontally.

Adjust the rotaƟon speed of the camera. 1 is the slowest and 7 is the
fastest.

Zoom the screen.

6. Click Add Preset.
7. Select a zone or trigger line from the list.
8. OpƟonal: Edit the preset point(s).

BuƩon DescripƟon

Delete Delete the preset point.

Live View Use the camera to view the preset point.

Update Update the coordinate of the preset point according to the coordinate of the
current camera.

9. Click ConĮrmed.

Map CalibraƟon

Map calibraƟon is used to get the accurate scale of the map by the cooperaƟon of three persons.

Before You Start
Make sure you have added the radar (when adding the device, check Import to Group) to the
client and the map, and have set a scale for the map.

Steps
1. Click Edit to enter the ediƟng mode.
2. Click Radar Seƫngs → Map CalibraƟon .
3. To perform this operaƟon, an cooperaƟon between three persons is needed. Person A and

person B move into the radar's detecƟon area. Person C selects their tracks by the client. A and B
stop at the calibraƟon points and the system will generate 2 markers at the terminal of tracks.
Click OK on the pop-up window to conĮrm the terminal of the track or click Delete to select a
new track.
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Figure 9-29 ConĮrm Terminals
4. Click on the map to conĮrm the actual locaƟons of marker 1 and marker 2.
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Figure 9-30 ConĮrm Actual LocaƟons
5. A window pops up saying Make sure the locaƟon on the map is correct and calibrate with the

track terminal? Click Delete to delete all calibraƟon points. Click OK on pop-up window. The
system will automaƟcally match the markers to the actual locaƟons.
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Figure 9-31 Finish Map CalibraƟon

Other FuncƟons

When using the radar, you can perform some auxiliary funcƟons such as arming/disarming,
refreshing radar parameters, displaying OSD and PTZ camera's FOV (Įeld of view), and enabling
alarm output to meet diīerent needs.

Note
Make sure you have exited the map ediƟng mode before using the following funcƟons.

Environment Learning
Click Environment Learning to enable the environment learning mode for the radar. For details,
refer to Set Environment Learning .

Arm/Disarm All Radars
Click Arm Radar → Arm All Radars/Disarm All Radars to arm or disarm all radars on the map.

Arm/Disarm Single Radar
AŌer exiƟng the ediƟng mode, click the radar's icon to show its operaƟon menu.
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Arm a Radar
Arm the radar's detecƟon area. A quesƟon will pop up saying There are targets in the zone,
enable mandatory arming? if you arm the radar when a target exists in the warning zone. You
can click OK to arm the radar mandatorily.

Note
The radar cannot be edited if it is armed.

Disarm a Radar
Disarm the radar’s detecƟon area.

Event
Search alarms triggered by certain cameras during certain Ɵme range, and view the alarm
related videos. See Preview Hot Spot for details.

Figure 9-32 Radar's FuncƟon List

Enable Alarm Output
An alarm output refers to sirens linked to a radar. It Ňashes or generates alarm sound when an
alarm or pre-alarm is triggered if you enable it.
OperaƟon: click Radar Seƫngs → Alarm Output aŌer entering ediƟng mode. Select a relay, and
switch on  in the OperaƟon column; or click Enable All to enable all the relays in the list.

Target Number Display
AŌer exiƟng the ediƟng mode, Move your cursor on the radar's icon to show the number of
person, vehicle and other target.

Display 3D DetecƟon Area
Move your cursor on the radar's icon in the ediƟng mode, click 3D to enter the view page of
detecƟon area. You can click on diīerent direcƟon of the Radar's 3D view to adjust the display
angle.

Note
This funcƟon should be supported by the device.
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Figure 9-33 3D DetecƟon Area View

Display 3D DetecƟon Area View
Move your cursor on the radar's icon in the non-ediƟng mode, click 3D to enter the view page of
detecƟon area, including 3D view, original point cloud diagram, laser beam diagram, and
background outline.

Note
● You can click diīerent direcƟon of the Radar's 3D view to adjust the display angle.
● On the original point cloud diagram, you can switch on Environment InformaƟon on the top-

right corner to view the added point cloud Įlter zone. For details about drawing the point cloud
Įlter zone, refer to Add Point Cloud Filter Zone .
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Figure 9-34 Original Point Cloud Diagram

PaƩern Playback
AŌer exiƟng the ediƟng mode, click the radar and then click Event to enter the Event Search
window on the right. You can search for the event according to the condiƟons you set, including
Ɵme period and the zone. The paƩern playback video will be played in the middle of the page.

Note
Make sure the PTZ camera has been linked to the radar.

Display OSD
On the top of the map, click Display → Display OSD to display the detected target No., target's
moving speed, distance and duraƟon between the target and radar.

Figure 9-35 OSD on the Map
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Display PTZ Camera's FOV
On the top of the map, click Radar Seƫngs → Camera FOV to display the linked PTZ camera's Įled
of view (FOV) and camera's IP address on the map.

Figure 9-36 PTZ Camera's Field of View

Refresh
Click Radar Seƫngs → Refresh on the top of the map to refresh the radar’s newest detecƟon
angle, detecƟon distance, trigger lines, and arming status.

9.4.7 Edit Hot Spot

You can edit the informaƟon of the added hot spots on the map, including the name, the color, the
icon, etc.

Steps
1. Enter the E-map module.
2. Click Edit in the upper-right corner to enter the map ediƟng mode.
3. Select the hot spot icon on the map and then click  to open the Edit Hot Spot window.
4. Edit the hot spot name in the text Įeld, select the hot spot name's color and hot spot icon

shown on the map.
5. Check Apply to Other Camera Hot Spots/Apply to Other Alarm Input Hot Spots/Apply to Other

Alarm Output Hot Spots/Apply to Other Zone Hot Spots to apply the color and icon seƫngs to
other hot spots.
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6. Click OK.
7. OpƟonal: Select the hot spot icon and click  to delete the hot spot.

9.4.8 Preview Hot Spot

AŌer adding hot spots (including camera, alarm input/output, zone, security radar, and zone) to
the map, you can view the live view of the camera hot spot and the triggered alarm informaƟon of
all the types of hot spots on the map.

Before You Start
Make sure you have added hot spots to the map. See Manage Hot Spot for details.

Steps
1. Enter the E-map module.

Note
If you are in the ediƟng map mode, click Exit on the upper-right corner to enter the map preview
mode.

2. Click Display to show the hot spots on the map.

Note
Hot spot type with  will be shown on the map.

3. Click a hot spot to perform the following operaƟon(s).

Hot Spot
Type

OperaƟons

Camera Live View: Click  to pop up the live view window of the camera.

Note
● When an alarm is triggered during live view, the client will play a video Įle of

30 s Įrst.
● You can capture, start recording and instant playback during live view.

Alarm
Output

Click an alarm output, and select Open/Close.

Note
The security control channels managed by the alarm output will also be
opened/closed.

Access
Point

View door status: the current door status of the access point is displayed on the
icon. Click the icon to switch the door status.
Open Door
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When the door is locked, unlock it and it will be open for once. AŌer the open
duraƟon, the door will be closed and locked again automaƟcally.

Close Door
When the door is unlocked, lock it and it will be closed. The person who has
the access authorizaƟon can access the door with credenƟals.

Remain Open
The door will be unlocked (no maƩer closed or open). All the persons can
access the door with no credenƟals required.

Remain Closed
The door will be closed and locked. No person can access the door even if
he/she has the authorized credenƟals, except the super users.

Security
Radar

Arm/Disarm zones in the monitoring Įeld of the radar: AŌer exiƟng ediƟng, click
the icon of a security radar, and then select Arm/Disarm; or click Event to
search events triggered during certain Ɵme range.

Note
● You can sƟll arm the radar even if there is a target in the radar's detecƟon area.
● The warning zone and early warning zone will be armed aŌer arming the radar, which means

an alarm will be triggered and reported to the Event Center once a target enters the warning
zone and early warning zone.

● For the camera linked with radar, you can select the linked radar and move the camera
through the operaƟons keys on the PTZ control panel. The real-Ɵme locaƟon will be applied to
the linked radar. For details about icons of PTZ control panel, refer to PTZ Control Panel .
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Figure 9-37 Live View of Camera on the Map
4. OpƟonal: Perform the following operaƟon(s).

View Alarm
InformaƟon

Click the alarm number on a hot spot icon to open the alarm
informaƟon page to view the alarm type and triggering Ɵme.

Clear Alarm Click Clear Alarm on the top of the map to mark all the alarms of the
hot spot as read.

View MulƟple
Cameras' Live View
on the Map

a. Click Live View to show 4 small windows on the boƩom of the
client.

b. Drag a camera from the device list to a window to start the live
view.

Note
Up to 4 cameras' live view is supported at the same Ɵme.
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Figure 9-38 Preview Camera Hot Spot

9.5 Manage Hot Region
The hot region funcƟon links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called
child map while the map to which you add the hot region is the parent map.

AŌer linking a child map to a parent map, a hot region icon will display on the parent map. You can
click it to enter the child map to view the resources on the child map for convenience.
With the funcƟon of hot region, e-maps can be organized into hierarchies to navigate from large
perspecƟves to detailed perspecƟves, e.g., from Ňoor level to room level.

9.5.1 Add Hot Region

You can add a map to another map as a hot region and an icon of the link to the added map is
shown on the main map. The added map is called child map while the map to which you add the
hot region is the parent map.
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Before You Start
At least two maps should be added. Refer to Add Map for details about adding maps.

Steps

Note
A map can only be added as the hot region for once.

1. Enter the E-map page.
2. Click Edit on the upper-right corner to enter the map ediƟng mode.
3. Select an added map as the parent map.
4. Click Add Hot Region to open the Add Hot Region window.
5. Select the child map.
6. OpƟonal: Edit the hot region name, and select the hot region color and icon by double-clicking

the corresponding Įeld.
7. Click OK.

The child map icons are added on the parent map as the hot regions.

9.5.2 Edit Hot Region

You can edit the informaƟon of the hot regions on the parent map, including name, color, icon, etc.

Steps
1. Enter the E-map module.
2. Click Edit on the upper-right corner to enter the map ediƟng mode.
3. Select a hot region icon on the parent map and click  to open the Edit Hot Region window.
4. Edit the hot region name in the text Įeld, select the hot region name's color and hot region icon.
5. Check Apply to Other Hot Regions to apply the color and icon seƫngs to other hot regions.
6. Click OK.

9.5.3 Preview Hot Region

AŌer adding a hot region, you can click the hot region icon on the parent map to enter the child
map. You can view the resources and alarms on the child map.

Steps
1. Enter the E-map page.

Note
If you are in the ediƟng map mode, click Exit on the upper-right corner to enter the map preview
mode.

2. Click the hot region icon on the parent map to enter the linked child map.
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You can view the resources on the child map. If there is any alarm triggered on the child map,
you can view the alarm details.

3. OpƟonal: Click Back to Parent Map on the upper-leŌ corner to go back to the parent map.
4. OpƟonal: Click Clear Alarm Info. on the upper-right corner to clear the alarm informaƟon

triggered by the resources on the current map.

9.6 View Person's Moving PaƩern
With the help of facial recogniƟon devices, you can view the target person's moving paƩern on the
map, which is generated by several cameras' locaƟons. E-map allows you to search and view the
moving paƩern of an individual (such as a suspect, a missing child, etc.) on the map to help Įnding
him/her.

Before You Start
Make sure you have added a map for a group and added the cameras in the group to the map. See
Add Map and Add Camera as Hot Spot for details.

Steps
1. Enter the E-map module.
2. Click a group name in the resource list on the leŌ column.

The group's map and resources on the map appear in the display area.
3. OpƟonal: Click Add Map to add a map for the group and add cameras in the group to the map.
4. Click Moving PaƩern on the top of the map to open the Search Moving PaƩern page.
5. Click  to set a Ɵme period for searching moving paƩern.
6. Check face picture analysis device in the list.

Note
The picture you upload in Step 7 will be compared with pictures stored in the checked devices.

7. Click Select Picture to select a face picture to upload or drag a picture to the picture area.

Note
You can upload a picture containing mulƟple face pictures from which you need to select one for
comparison.

8. Drag the slider or enter a number to select a similarity.

Note
The client will search face pictures stored in the selected face picture analysis devices whose
similarity with the uploaded picture is higher than the conĮgured similarity, and then display the
moving paƩern of the matched person on the map.

9. Click Search.
Moving paƩern of the person who is similar to the uploaded picture is displayed on the map, the
cameras captured pictures will be numbered showing the person's arriving order, and the
capture records will be displayed on the leŌ with the captured picture thumbnail displayed also.
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10. OpƟonal: Perform the following operaƟon(s) aŌer searching moving paƩern.

OperaƟon DescripƟon

Filter Capture
Records

Click  and check Show Last Record to show the last record of every
camera through the moving paƩern.

View Person
Related Videos
and Pictures

Click a captured picture thumbnail to open the Capture Details window
and you can view the detailed informaƟon of the picture you clicked.
All pictures of the person captured by the camera will be displayed on
the right. Select a captured picture to show its related video of 10
seconds on the leŌ, including the 5 seconds before the capturing Ɵme
and the 5 seconds aŌer the capturing Ɵme. Click  to start displaying
the video.

Disable PaƩern Click  on the top of the record list or Disable PaƩern to exit moving
paƩern mode.
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Chapter 10 StaƟsƟcs

Reports, created for a speciĮed period, are essenƟal documents, which are used to check whether
a business runs smoothly and eīecƟvely. In this soŌware, reports can be generated daily, weekly,
monthly, annually, and by custom Ɵme period. You can use reports as basis in creaƟng decisions,
addressing problems, checking tendency and comparison, etc.

10.1 People CounƟng Report
People counƟng staƟsƟcs is to calculate the number of line crossing people in a speciĮc area and a
certain Ɵme period by the people counƟng camera(s) or abnormal event detecƟon server(s), which
can help the storekeeper to analyze the customers Ňow and number in diīerent Ɵme, and the
storekeeper can Ňexibly do some business adjustment according to the report.

10.1.1 People CounƟng Report by Encoding Device

People counƟng report by encoding device displays people counƟng data collected by encoding
devices. You can search the people counƟng data in diīerent dimensions.

Before You Start
Add an encoding device with people counƟng funcƟon to the soŌware and properly conĮgure the
corresponding area and people counƟng rule. Refer to Add Device for details about adding people
counƟng device.

Steps
1. Click Report → People CounƟng to enter People CounƟng page.
2. Select Encoding Device as the Device Type.
3. Select daily report, weekly report, monthly report, or annual report as the report type.

Daily Report
Daily report shows data on a daily basis. The system will calculate the number of people in
each hour of one day.

Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less-
Ɵme consuming, since they are not to be submiƩed every day. The system will calculate the
number of people in each day of one week, in each day of one month, in each month of one
year.

Custom Report
Users can customize the days in the report to analyze the number of people in each day or
month of the custom Ɵme interval.
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Note
You can select no more than 31 days on the calendar.

4. Select the staƟsƟcs Ɵme type and click  to set the Ɵme.
One Period

Generate the staƟsƟcs in one Ɵme period.
MulƟple Periods

Generate the staƟsƟcs in two Ɵme periods, which can help you to compare the people Ňow
and number in two Ɵme periods.
For example, if you set the report type as month report, and set the March and April as the
staƟsƟc Ɵme, the people counƟng results in March and April will be displayed in a same chart
with diīerent color, and you can compare the data in diīerent day of each month.

5. Select StaƟsƟcs Type.
Display by Device

Display the report by device.
For example, if you select one NVR (with 4 people counƟng cameras), the report will display
the total number of people summed by the 4 people counƟng cameras.

Display by Camera
Display the report by camera.
For example, if you select one NVR (with 4 people counƟng cameras), the report will display
the each camera's staƟsƟcs respecƟvely, namely display the staƟsƟcs in 4/8 colors (each one
or two colors represenƟng one camera).

Display by Grouping StaƟsƟcs
Display the report by grouping staƟsƟcs.
For example, if you select one device group (the group is created on the Client), the report
will display the total number of people summed by the total people counƟng cameras in the
group.

Note
● For details of device group, refer to Group Resources .
● This funcƟon should be supported by the device.

6. Select Įltering mode.
Channel

Display people counƟng data collected by channels of an encoding device.
Region

Display number of people in selected regions of a camera.
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Note
You need to conĮgure regions for the camera beforehand. See user manual of the device for
details.

7. Select camera(s) or region(s) from the Camera list.
8. Set the content to be displayed.

DirecƟon
Calculate the number of people in diīerent direcƟons, such as enter, exit, or enter and exit.
Enter

The people entered will be counted.
Exit

The people exited will be counted.
Enter and Exit

Both people entered and exited will be counted.

Figure 10-1 People CounƟng by DirecƟon

Facial Features
Generate the report based on the facial feature.
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Figure 10-2 People CounƟng by Facial Features
9. OpƟonal: Check Children Only to generate report of recognized children.

Note
● The client counts detected people shorter than a predeĮned height which can be conĮgured

on device's remote conĮguraƟon page. See the device user manual for details about
conĮguring height threshold.

● This funcƟon needs to be supported by the device.
10. Click Search to get the people counƟng staƟsƟcs and detailed data for each hour, day, or

month.
By default, the staƟsƟcs are shown in histogram form.

11. OpƟonal: For the report by direcƟon, you can check People Duplicate on the right-upper
corner of the report page to display the number of duplicate people.

Note
The number of duplicate people is calculated by the device. If the same face is recognized more
than once, he/she will be calculated as duplicate person.
For example, if a cashier enter or exit the supermarket more than once, he/she will be
calculated as duplicate person. In this way, the supermarket can get the actual number of
people shopping.

12. OpƟonal: Perform the following operaƟons aŌer search.

Switch to Line Chart Click  to switch it to line chart.

Note
By default, the staƟsƟcs are shown in bar chart.
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Switch to Bar Chart Click  to switch it to bar chart.

Save to Local PC Click Export to save the detailed data of people counƟng to your
PC.

10.1.2 View People CounƟng Report by DeepinMind Server

People counƟng data by DeepinMind server are data counted based on predeĮned calculaƟon
rules. Data not conformed to the calculaƟon rules will be omiƩed in the people counƟng report.
This gives you more accurate people counƟng data.

Before You Start
Add a DeepinMind server to the soŌware and properly conĮgure a calculaƟon rule. See Add Device
for details about adding a DeepinMind server. See the device user manual about conĮguring
calculaƟon rule.

Steps
1. Click Report → People CounƟng .
2. Select DeepinMind Server as the device type.
3. Select hourly report, daily report, monthly report, or annual report as the report type.

Hourly Report
Hourly Report can be used for analyzing people counƟng data generated during peak Ɵme.

Daily Report
Daily report shows data on a daily basis. The system will calculate the number of people in
each hour of one day.

Monthly Report and Annual Report
Compared with daily report, monthly report and annual report can be less Ɵme consuming,
since they are not submiƩed every day. The system will calculate the number of people in
each day of one month and in each month of one year.

4. Click  to select Ɵme.
5. Select a calculaƟon rule.
6. Select the content to be displayed.

DirecƟon
Calculate the number of people moving in diīerent direcƟons, including enter, exit, and enter
& exit.

Enter
The number of people entered will be displayed.

Exit
The number of people exited will be displayed.

Enter and Exit
The number of people entered and exited will be displayed.
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7. Click Search to get the people counƟng data of each minute, hour, day, or month.

Note
By default, the report will be shown in a line chart.

Figure 10-3 People CounƟng Report by DeepinMind Server

8. OpƟonal: Click Export to save the report to your PC.

10.2 View People CounƟng in IntersecƟons Report
IntersecƟon analysis is used to monitor people Ňow and number in an intersecƟon-like scene. The
arrows in the image refer to diīerent direcƟons. By selecƟng one direcƟon (e.g. A) as the entrance,
the other direcƟons will be set as the exits by default, so that mulƟple paths are generated (e.g., A
to A, A to B, A to C, and A to D). You can view the people counƟng who passed by each path,
respecƟvely, which can help the shopkeeper to analyze the people Ňow in diīerent door. The
staƟsƟcs result can show in daily, weekly, monthly, and annual report.
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Before You Start
Make sure a Įsheye camera which supports intersecƟon analysis funcƟon has been conĮgured
properly and be added to the soŌware. Refer to Add Device for details about adding the device.

Steps

Note
Up to 10 intersecƟons can be analyzed.

1. Click Report → IntersecƟon Analysis to enter the intersecƟon analysis module.
2. Select daily report, weekly report, monthly report, or annual report as the report type.

Daily Report
Daily report shows data on a daily basis. The system will calculate the number of people in
intersecƟon report in a each hour of one day.

Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less-
Ɵme consuming, since they are not to be submiƩed every day. The system will calculate the
number of people in intersecƟon report in each day of one week, in each day of one month,
in each month of one year.

3. Set the start Ɵme for the report.
4. Select the camera for generaƟng the report.
5. Select one direcƟon as the entrance from the drop-down list in the Flow in Įled.
6. Click Search to get the staƟsƟcs result.

Figure 10-4 Results

The people number for each path will show on the right.
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10.3 Queue Management
Queue management supports data analysis and report output from mulƟple dimensions.

Commonly Used Data Analysis
● To see queuing-up people number of a certain waiƟng Ɵme level in a queue/region, use

queuing-up Ɵme analysis, check a target region and set a waiƟng Ɵme level.
● To compare queuing-up people number of a certain waiƟng Ɵme level in mulƟple queues/

regions, use queuing-up Ɵme analysis, check target regions and set a waiƟng Ɵme level.
● To compare queuing-up people number of diīerent waiƟng Ɵme levels in mulƟple queues/

regions, use queuing-up Ɵme analysis, check target regions and set waiƟng Ɵme levels.
● To see the Ɵme and duraƟon that a queue stays a certain length in a queue/region, use queue

status analysis, check a target region and set a queue length level.
● To compare the Ɵme and duraƟon that a queue stays a certain length in mulƟple queues/

regions, use queue status analysis, check target regions and set a queue length level.
● To compare the Ɵme and duraƟon that a queue stays at diīerent length in mulƟple queues/

regions, use queue status analysis, check target regions and set queue length levels.

10.3.1 Queuing-Up Time Analysis

Queuing-Up Time Analysis calculates people number of diīerent waiƟng Ɵme levels. Regional
comparison and mulƟple waiƟng Ɵme level comparison are supported.

Compare Queuing-up People Amount for Diīerent Regions

With cameras for queuing-up people amount counƟng, you can search the queuing-up people
amount during Ɵme period of certain length in diīerent regions, helping the storekeeper to Įnd
areas where customers tend to go. For example, the regions with larger people amount are more
popular than the regions with lower people amount, so that you can put goods in these regions to
sell more of them.

Before You Start
● Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add

Device for details about adding the device.
● Make sure you have conĮgured no more than 3 regions in the detecƟon area of a camera on

device remote conĮguraƟon page. See device user manual for details about conĮguring regions.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Report → Queue Management → People Amount in Region .
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2. Select Daily Report/Weekly Report/Monthly Report/Custom Report as the report type.
Daily Report

Daily report shows data on a daily basis. The system will calculate the queuing-up duraƟon for
diīerent regions in a each hour of one day.

Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less-Ɵme consuming,
since they are not to be submiƩed every day. The system will calculate the queuing-up
duraƟon for diīerent regions in each day of one week, in each day of one month.

Custom Report
Users can customize the days in the report to analyze the number of people on each day or
month of the custom Ɵme interval.

Note
You can select no more than 31 days on the calendar.

3. Click  to set Ɵme period for searching.
4. Select cameras and no more than 3 regions for every camera in the Region list.
5. Select Regional Comparison as the staƟsƟcs type.
6. Select a waiƟng Ɵme level based on which the report is generated.
7. Click Search to generate the staƟsƟcs result.

The line chart of the calculated people amount in the speciĮed waiƟng Ɵme will show on the
result area. The lines with diīerent colors indicate the people from the selected regions.
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Figure 10-5 Result
8. OpƟonal: Click Export to export the data in Excel Įle.

Compare Queuing-up People Amount for Diīerent WaiƟng Time Levels

With cameras for queuing-up people amount counƟng, you can search the queuing-up people
amount during Ɵme periods of diīerent length in a certain region, helping analyzing percepƟon of
crowding in diīerent regions to make it easy to know when and how to change service window
amount, staī amount, and whether to set a guider for people, etc.

Before You Start
● Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add

Device for details about adding the device.
● Make sure you have conĮgured no more than 3 regions in the detecƟon area of a camera on

device remote conĮguraƟon page. See device user manual for details about conĮguring regions.
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Steps

Note
This funcƟon should be supported by the connected device.

1. Click Report → Queue Management → Regional People CounƟng .
2. Select Daily Report/Weekly Report/Monthly Report/Custom Report as the report type.

Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing-up duraƟon for
diīerent regions in a each hour of one day.

Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less-Ɵme consuming,
since they are not to be submiƩed every day. The system will calculate the queuing-up
duraƟon for diīerent regions in each day of one week, in each day of one month.

Custom Report
Users can customize the days in the report to analyze the number of people on each day or
month of the custom Ɵme interval.

Note
You can select no more than 31 days on the calendar.

3. Click  to set Ɵme period for searching.
4. Select cameras and no more than 3 regions in the Region list.
5. Select MulƟ-Level Comparison as the staƟsƟcs type.
6. Select the waiƟng Ɵme level and enter the seconds for calculaƟng people amount waiƟng for

the speciĮed Ɵme period.
7. Click Search to generate the staƟsƟcs result.

The line chart of the calculated people amount in the same region will show on the result area.
The lines with diīerent colors match the waiƟng Ɵme levels.
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Figure 10-6 Result
8. OpƟonal: Click Export to export the data in Excel Įle.

10.3.2 Queue Status Analysis

Queue Status Analysis calculates the Ɵme and duraƟon that a queue stays with a certain length.
Regional comparison and mulƟple queue length level comparison are supported.

Compare Queuing-up DuraƟon for Diīerent Regions

With cameras for queuing-up duraƟon counƟng, you can search and compare the queuing-up
duraƟons in diīerent regions during the same Ɵme period, helping analyzing percepƟon of
crowding in diīerent regions to make it easy to know when and how to change service window
amount, staī amount, and whether to set a guider for people, etc.
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Before You Start
● Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add

Device for details about adding the device.
● Make sure you have conĮgured no more than 3 regions in the detecƟon area of a camera on

device remote conĮguraƟon page. See device user manual for details about conĮguring regions.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Report → Queue Management → WaiƟng DuraƟon .
2. Select Daily Report/Weekly Report/Monthly Report/Custom Report as the report type.

Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing-up duraƟon for
diīerent regions in a each hour of one day.

Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less-Ɵme consuming,
since they are not to be submiƩed every day. The system will calculate the queuing-up
duraƟon for diīerent regions in each day of one week, in each day of one month.

Custom Report
Users can customize the days in the report to analyze the queuing-up duraƟon on each day or
month of the custom Ɵme interval.

Note
You can select no more than 31 days on the calendar.

3. Click  to set Ɵme period for searching.
4. Select cameras and no more than 3 regions for every camera in the Region list.
5. Select Regional Comparison as the staƟsƟcs type.
6. Set the length of queue based on which the report is generated.
7. Click Search to generate the staƟsƟcs result.

The line chart of the calculated duraƟon for staying the speciĮed queue length will show on the
result area. The lines with diīerent colors match the selected regions.
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Figure 10-7 Result
8. OpƟonal: Click Export to export the data in Excel Įle.

Compare Queuing-up DuraƟon for Diīerent Queue Length Levels

With cameras for queuing-up duraƟon counƟng, you can search and compare the queuing-up
duraƟons of queues of diīerent length during the same Ɵme period, helping analyzing percepƟon
of crowding in diīerent regions to make it easy to know when and how to change service window
amount, staī amount, and whether to set a guider for people, etc.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add Device
for details about adding the device.
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Steps

Note
This funcƟon should be supported by the connected device.

1. Click Report → Queue Management → WaiƟng DuraƟon .
2. Select Daily Report/Weekly Report/Monthly Report/Custom Report as the report type.

Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing-up duraƟon for
diīerent regions in a each hour of one day.

Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less-Ɵme consuming,
since they are not to be submiƩed every day. The system will calculate the queuing-up
duraƟon for diīerent regions in each day of one week, in each day of one month.

Custom Report
Users can customize the days in the report to analyze the queuing-up duraƟon on each day or
month of the custom Ɵme interval.

Note
You can select no more than 31 days on the calendar.

3. Click  to set Ɵme period for searching.
4. Select cameras and no more than 3 regions in the Region list.
5. Select MulƟ-Level Comparison as the staƟsƟcs type.
6. Set the length of queue based on which the report is generated.
7. Click Search to generate the staƟsƟcs result.

The line chart of the calculated duraƟon in the same region will show on the result area. The
lines with diīerent colors match the queue length levels.
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Figure 10-8 Result
8. OpƟonal: Click Export to export the data in Excel Įle.

10.4 Heat Map
Heat map is a graphical representaƟon of data represented by colors and the heat map data can be
displayed in line chart. You can use the heat map funcƟon of the camera to analyze the visit Ɵmes
and dwell Ɵme of customers in a conĮgured area, which can help the storekeeper analyze the
customers' interested area and make the arrangement of goods.

Before You Start
Add a heat map network camera to the soŌware and properly conĮgure the corresponding area.
The added camera should have been conĮgured with heat map rule. See Add Device for details
about adding heat map network camera.
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Steps
1. Click Report → Heat Map to enter the heat map page.
2. Select Daily Report/Weekly Report/Monthly Report/Annual Report/Custom Report as the

report type.
Daily Report

Daily report shows data on a daily basis. The system will calculate the data of heat map in a
each hour of one day.

Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less-
Ɵme consuming, since they are not to be submiƩed every day. The system will calculate the
data of heat map in each day of one week, in each day of one month, in each month of one
year.

Custom Report
You can customize the days in the report to analyze the dwell Ɵme or crowd trend on each
day or month of the custom Ɵme interval.

Note
The Ɵme period in the custom report should be no more than 31 days.

3. Select By Dwell Time or By Crowd Trend as the staƟsƟcs type.
By Dwell Time

The system calculates the heat map value (the ordinate value in the line chart or the color in
pictures) according to the people's dwell Ɵme.

By Crowd Trend
The system calculates the heat map value (the ordinate value in the line chart or the color in
pictures) according to the number of detected people.

4. Set the Ɵme period for searching.
5. Select a heat map camera in the camera list.
6. Click Generate Heat Map to show the heat map of the camera.
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Figure 10-9 Results
7. OpƟonal: AŌer generaƟng heat map report, you can perform the following operaƟons.

Display in Line Chart Click  to display the staƟsƟcs in line chart.

Display in Picture
Mode

Click  to display the staƟsƟcs in picture mode.
The red color block (255, 0, 0) indicates the most welcome area, and
blue color block (0, 0, 255) indicates the less-popular area.

Save StaƟsƟcs Data Click Export to save the detailed data of heat map to your PC.

10.5 Skin-Surface Temperature StaƟsƟcs
The system can calculate the total number of people, the number of people whose skin-surface
temperature is abnormal and the number of people who do not wear mask. The system provides
the staƟsƟcs report per day, per week and per month, to help you judge the trend of the number
of people whose skin-surface temperature is abnormal and the number of people who do not wear
mask.

Before You Start
Add the devices which support skin-temperature measurement, such as the intelligent device with
face skin-temperature measurement funcƟon.

Steps
1. Select Report → Skin-Surface Temperature.
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2. Select the report type by the drop-down list, including Daily Report, Weekly Report,Monthly
Report or Annual Report.

3. Click  to select the Ɵme range.
4. Select a camera, device or group.
5. Click Search.

Display the report in histogram on the right area.

Note
The All、Abnormal、No Mask and Normal Skin-Surface Temperature is displayed on the upper
area of the report, you can select the detecƟon aƩribute(s) to be displayed.

Figure 10-10 Report of Skin-Surface Temperature StaƟsƟcs
6. OpƟonal: Click Export to save the data in local by CSV format.

10.6 Real-Time Density and People CounƟng
Real-Ɵme density and people counƟng supports generaƟng people density analysis report and
real-Ɵme people counƟng report.

Before You Start
Add a DeepinMind server to the soŌware and properly conĮgure a calculaƟon rule. See Add Device
for details about adding a DeepinMind server. See the device user manual about conĮguring
calculaƟon rule.

Steps
1. Click Report → Real-Time Density and People CounƟng .
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2. Select hourly report, daily report, monthly report, or annual report as the report type.
Hourly Report

Hourly Report can be used for analyzing data generated during peak Ɵme.
Daily Report

Daily report shows data on a daily basis. The system will calculate the number of people in
each hour of one day.

Monthly Report and Annual Report
Compared with daily report, monthly report and annual report can be less Ɵme consuming,
since they are not submiƩed every day. The system will calculate the number of people in
each day of one month and in each month of one year.

3. Click  to select Ɵme.
4. Select event type.

People Density Analysis
The density of people in an area at diīerent Ɵmes.

Real-Time People CounƟng
The numbers of people in an area at diīerent Ɵmes.

5. Select a calculaƟon rule.
6. Click Search.

Note
By default, the report will be shown in a line chart.
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Figure 10-11 People Density Analysis Report
7. OpƟonal: Click Export to save the report to your PC.

10.7 Temperature Map
A temperature map displays the temperature trend of a region during a certain day. If you have
conĮgured temperature monitoring regions, you can generate temperature map of speciĮc regions
to see the overview of each region's temperature trend.

Before You Start
● Make sure you have drawn regions for temperature map on the device conĮguraƟon page. See

user manual of the device for details.
● Make sure you have added at least one device for temperature map to the client. See Add

Device for details.

Steps

Note
This funcƟon should be supported by device.
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1. Click Report → Temperature Map .
2. Select a date from the calendar.
3. In the Camera list, select a camera.

Note
You can enter a keyword in the searching Įeld to search a camera.

4. Select a unit.
5. Select a preset.

Figure 10-12 Temperature Map
6. On the right panel, check region(s) for generaƟng the report.

Note
No more than 8 regions can be checked.

7. Click Search.
The temperature map will be displayed in a line chart with each line represenƟng a region.

8. OpƟonal: Select another unit to display the temperature map in another unit.
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Chapter 11 Data Retrieval

In the Data Retrieval module, you can search the face pictures captured by the face recogniƟon
camera, search the human body pictures captured by DeepinMind device, view abnormal event
detecƟon related pictures and videos, search the vehicle pictures captured by DeepinMind device,
search the frequently appeared person pictures captured by DeepinMind device, and search the
not wearing hard hat pictures.

11.1 Video Search
You can search for videos by Ɵme period and speciĮed cameras. AŌer search, you can export the
matched video Įles to the local PC.

Steps
1. Click Data Retrieval → Video Search to enter the Video Search page.
2. Set search condiƟons.

Search By
By Time

Search by speciĮed the Ɵme period, you should set the start and end Ɵme.
By Event Type

Search by speciĮed event type, you should set the event type and start/end Ɵme.
By Tag

Search by speciĮed tags, you should set the tag type and start/end Ɵme.

Note
If you select Custom as the tag type, you should set the corresponding tag name.

Camera
Select a device from the camera list.

Note
You can enter a key word (supports fuzzy search) in the search box to quickly search for the
target device.

3. Click Search to start searching.
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Figure 11-1 Video Search

The videos which meet the search condiƟons are displayed on the right panel.
4. OpƟonal: Perform the following operaƟons if needed.

Export Video
Footage

● Hover on the target video, click  to export the single video.
● Check target videos and click Export to export the videos to the local

PC.
● Click Export All to export

View Video
Details

Hover on a target video, click  to view the video details.

Filter Click  to Įlter the videos by camera.

Switch Display
Mode

Click  or  to display the videos by thumbnails or by list.

11.2 Target Retrieval
Target retrieval (AcuSearch) can quickly locate and extract targets, including face retrieval, human
retrieval, vehicle retrieval, and search by picture.

11.2.1 Face Picture Retrieval

When the connected device (e.g. NVR or HDVR) supports face search, you can search the related
picture and play the picture related video Įle.
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Search Face Pictures by Uploaded Picture

You can upload a face picture from your PC and compare the uploaded picture with the captured
face pictures.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. Refer to Add
Device for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Data Retrieval → Face Picture Retrieval to enter the face picture retrieval page.
2. Click  to set the start Ɵme and end Ɵme for searching the captured face pictures or video Įles.
3. Select device(s) in the camera panel.
4. Select Picture from the drop-down list.
5. Select a face picture for search.

1) Click Select Picture to upload the pictures from your PC.
2) Select a detected face from uploaded picture for matching the captured face pictures.

Note
● The resoluƟon of the picture should be smaller than 4096×4080.
● Only JPG and JPEG formats are supported.

6. Set the similarity level.

Example
If you set the similarity as 40, the captured pictures have no less than 40% similarity with the
uploaded face picture will list.

7. Set the maximum number of displayed results.
8. Click Search to start searching.

The search results of the pictures are displayed on the right.
9. Export the pictures and save them in your PC.

Export Picture
Select the pictures to be exported and save them in local PC.

Export Current Page
Export all the pictures in the current page.

Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.

Export All
Export all searched pictures.
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10. Select a searched face picture to show the captured picture and person informaƟon.

Figure 11-2 Result
11. OpƟonal: AŌer searching, you can do one or more the following operaƟons.

View
Details

View the captured face picture, and the person informaƟon (similarity,
temperature status, captured Ɵme, etc.) on the page.
You can also click  to show the large picture, and click  to restore.

Play
Related
Videos

Click  to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.

Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įles frame by frame, click  to enable audio, double-
click the playback window to maximize the window.

● You can click  to view the captured picture.

Export
Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, or capture
details of single record to local PC.

Add Picture
to Face
Picture
Library

Click  to add the captured picture to the face picture library.
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Note
You can select the face picture library and enter the person informaƟon for
the captured picture, such as person name, mobile phone, etc.

12. OpƟonal: Perform secondary search based on the search result.
1) In the person informaƟon page, click  .

All the faces in this picture will be analyzed and displayed.
2) In the pop-up window, move the red frame to select a face you want to do secondary search.

Note
If there are mulƟple faces in the picture, the window will pop up for selecƟng.
If there is only one face in the picture, skip this step.

3) Click OK.
The client will search and compare the faces in the captured pictures based on the face
picture you selected.

Search Face Pictures by Event Type

You can search the device's captured face pictures by Įltering diīerent event types.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. Refer to Add
Device for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Data Retrieval → Face Search to enter the face picture retrieval page.
2. Click  to set the start Ɵme and end Ɵme for searching the captured face pictures or video Įles.
3. Select device(s) in the camera panel.
4. Select Event Type from drop-down list to search by event type.
5. Select event type.

No Limit
Search all captured face pictures.

Matched Face
Search the captured pictures the face in which matched with the face in face library.

Mismatched Face
Search the captured pictures the face in which mismatched with the face in face library.

Stranger DetecƟon Alarm
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Search the pictures captured when the stranger detecƟon alarm is triggered.
6. Set the maximum number of displayed results.
7. Click Search to start searching.

The search results of the pictures are displayed on the right.
8. Export the pictures and save them in your PC.

Export Picture
Select the pictures to be exported and save them in local PC.

Export Current Page
Export all the pictures in the current page.

Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.

Export All
Export all searched pictures.

9. Select a searched face picture to show the captured picture and person informaƟon.

Figure 11-3 Result
10. OpƟonal: AŌer searching, you can do one or more the following operaƟons.

View
Details

View the captured face picture, and the person informaƟon (similarity,
temperature status, captured Ɵme, etc.) on the page.
You can also click  to show the large picture, and click  to restore.

Play
Related
Videos

Click  to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.
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Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įles frame by frame, click  to enable audio, double-
click the playback window to maximize the window.

● You can click  to view the captured picture.

Export
Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, or capture
details of single record to local PC.

Add Picture
to Face
Picture
Library

Click  to add the captured picture to the face picture library.

Note
You can select the face picture library and enter the person informaƟon for
the captured picture, such as person name, mobile phone, etc.

11. OpƟonal: Perform secondary search based on the search result.
1) In the person informaƟon page, click  .

All the faces in this picture will be analyzed and displayed.
2) In the pop-up window, move the red frame to select a face you want to do secondary search.

Note
If there are mulƟple faces in the picture, the window will pop up for selecƟng.
If there is only one face in the picture, skip this step.

3) Click OK.
The client will search and compare the faces in the captured pictures based on the face
picture you selected.

Search Face Pictures by Person Name

You can search the device's captured face pictures by person name.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. Refer to Add
Device for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Data Retrieval → Face Search to enter the face picture retrieval page.
2. Select device(s) in the camera panel.
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3. Select Name from the drop-down list to search by person name.
4. Click  to set the start Ɵme and end Ɵme for searching the captured face pictures or video Įles.
5. Enter a keyword for the person name.
6. Set the maximum number of displayed results.
7. Click Search to start searching.

All the persons whose name match the search condiƟon (fuzzy match is supported) will be
displayed.

Figure 11-4 Results
8. Select one picture to search, and then click ConĮrm.

The search results of the pictures are displayed on the right.
9. Export the pictures and save them in your PC.

Export Picture
Select the pictures to be exported and save them in local PC.

Export Current Page
Export all the pictures in the current page.

Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.

Export All
Export all searched pictures.

10. Select a searched face picture to show the captured picture and person informaƟon.
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Figure 11-5 Results
11. OpƟonal: AŌer searching, you can do one or more the following operaƟons.

View
Details

View the captured face picture, and the person informaƟon (similarity,
temperature status, captured Ɵme, etc.) on the page.
You can also click  to show the large picture, and click  to restore.

Play
Related
Videos

Click  to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.

Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įles frame by frame, click  to enable audio, double-
click the playback window to maximize the window.

● You can click  to view the captured picture.

Export
Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, or capture
details of single record to local PC.

Add Picture
to Face
Picture
Library

Click  to add the captured picture to the face picture library.

Note
You can select the face picture library and enter the person informaƟon for
the captured picture, such as person name, mobile phone, etc.
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12. OpƟonal: Perform secondary search based on the search result.
1) In the person informaƟon page, click  .

All the faces in this picture will be analyzed and displayed.
2) In the pop-up window, move the red frame to select a face you want to do secondary search.

Note
If there are mulƟple faces in the picture, the window will pop up for selecƟng.
If there is only one face in the picture, skip this step.

3) Click OK.
The client will search and compare the faces in the captured pictures based on the face
picture you selected.

Search Face Pictures by Facial Features

The client supports searching detected face pictures by facial features.

Steps
1. Click Data Retrieval → Face Picture Retrieval .
2. Select a Ɵme period for searching.
3. Select a camera in the camera list.
4. Select Facial Features as the searching type.
5. ConĮgure facial features to be searched, including wear glasses, smiling and wear mask.
6. Enter the maximum number of results to show.
7. Click Search.

The searched face pictures are displayed on the right.
8. Export the pictures and save them in your PC.

Export Picture
Select the pictures to be exported and save them in local PC.

Export Current Page
Export all the pictures in the current page.

Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.

Export All
Export all searched pictures.

9. OpƟonal: Select a searched face picture to show the captured picture and person informaƟon.
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Figure 11-6 Result
10. OpƟonal: AŌer searching, you can do one or more the following operaƟons.

View
Details

View the captured face picture, and the person informaƟon (similarity,
temperature status, captured Ɵme, etc.) on the page.
You can also click  to show the large picture, and click  to restore.

Play
Related
Videos

Click  to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.

Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įles frame by frame, click  to enable audio, double-
click the playback window to maximize the window.

● You can click  to view the captured picture.

Export
Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, or capture
details of single record to local PC.

Add Picture
to Face
Picture
Library

Click  to add the captured picture to the face picture library.

Note
You can select the face picture library and enter the person informaƟon for
the captured picture, such as person name, mobile phone, etc.
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11. OpƟonal: Perform secondary search based on the search result.
1) In the person informaƟon page, click  .

All the faces in this picture will be analyzed and displayed.
2) In the pop-up window, move the red frame to select a face you want to do secondary search.

Note
If there are mulƟple faces in the picture, the window will pop up for selecƟng.
If there is only one face in the picture, skip this step.

3) Click OK.
The client will search and compare the faces in the captured pictures based on the face
picture you selected.

11.2.2 Human Body Retrieval

For the DeepinMind device, you can search the captured human body pictures by seƫng search
condiƟons including uploading a picture from local PC and seƫng features, and view related videos
of the picture.

Search Human Body by Uploaded Picture

For the DeepinMind device, you can upload a human body picture from local PC and compare the
uploaded picture with the device's captured human body pictures, or search all the human body
pictures captured by the speciĮc camera(s) during a speciĮc Ɵme.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. Refer to Add
Device for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Data Retrieval → Human Body Retrieval to enter the human body retrieval page.
2. Click  to set the start Ɵme and end Ɵme for searching the captured human body pictures or

video Įles.
3. Select device(s) in the camera panel.
4. Select the search condiƟon in the Search by Įeld.

Picture
Upload a picture to compare the uploaded picture with the device's captured human body
pictures. All the human bodies in this picture will be analyzed and displayed.
a. Click Select Picture to select a picture for comparison from the computer.
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Note
- The picture should be smaller than 4 MB.
- The resoluƟon of the picture should be smaller than 4096*4080.
- Only JPG and JPEG formats are supported.

b. Set the similarity level. For example, if you set the similarity as 40, the captured pictures
have no less than 40% similarity with the uploaded human body picture will list.

All
Search all the pictures captured by the selected camera(s) during the Ɵme duraƟon.

5. Set the maximum number of displayed results.

Note
If the number of pictures captured by the selected cameras(s) during the selected Ɵme duraƟon
exceeds the number of maximum number to be displayed, only the lasted pictures will be
displayed.
For example, if the number of pictures captured by the selected cameras during the selected
Ɵme duraƟon is 2000, and the maximum number to be displayed is 1000, only the lasted 1000
pictures will be displayed.

6. Click Search to start searching.
The search results of the pictures are displayed in list.

7. OpƟonal: Perform secondary search based on the search result
1) Move to the searched picture and click 

All the human bodies in this picture will be analyzed and displayed.
2) Select a human body you want to do secondary search.
3) Set the similarity and Ɵme period.
4) Click Search.

The client will search and compare the human bodies in the captured pictures based on the
human body picture you selected.

8. OpƟonal: AŌer searching human body, you can do one or more the following operaƟons.

View Details Click on a picture from the list to view details. You can also click  to show
the large picture, and click  to restore.

Play Related
Videos

Click Playback to play the picture's related video Įle (5s before and 5s aŌer
the capture) in the view window on the boƩom right.

Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įles frame by frame, click  to enable audio, double-click
the playback window to maximize the window.
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Export Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, and capture
details of single record to local PC.

Export
Segments of
Pictures

For the searched pictures, you can click Export Segment, then select the
range (segmented by every 1000 pictures, e.g., 1 to 1000, 1001 to 2000) to
export the pictures in batch.

Search Human Body by Personnel Features

You can search the device's captured human body pictures by seƫng the personnel features as the
search condiƟons.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. Refer to Add
Device for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Click Data Retrieval → Human Body Retrieval to enter the human body retrieval page.
2. Click  to set the start Ɵme and end Ɵme for searching the captured human body pictures or

video Įles.
3. Select device(s) in the camera panel.
4. Select Features as the search mode.
5. Set the person features such as top's color, wearing glasses or not, etc.
6. Select the event type of the human body pictures you want to search.
7. Set the maximum number of displayed results.
8. Click Search to start searching.

The search results of the pictures are displayed in list.
9. OpƟonal: Perform secondary search based on the search result

1) Move to the searched picture and click  .
All the human bodies in this picture will be analyzed and displayed.

2) Select a human body you want to do secondary search.
3) Set the similarity and Ɵme period.
4) Click Search.

The client will search and compare the human bodies in the captured pictures based on the
human body picture you selected.

10. OpƟonal: AŌer searching, you can do one or more the following operaƟons.

View Details Click on a picture from the list to view details. You can also click  to
show the large picture, and click  to restore.
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Play Related
Videos

Click  to play the picture's related video Įle in the view window on the
boƩom right.

Note
● You can click  to show the large video, and click  to restore.
● You can click  to adjust the play speed of the playback, click  to

play back the video Įles frame by frame, click  to enable the audio,
double-click the playback window to maximize the window.

Export Single
Record

In the enlarged picture page, click  and then click Export Picture,
Export Video File or Export Details to export the picture, video Įle, or
capture details of single record to local PC.

Export
Segments of
Pictures

For the searched pictures, you can click Export Segment, then select the
range (segmented by every 1000 pictures, e.g., 1 to 1000, 1001 to 2000)
to export the pictures in batch.

11.2.3 Vehicle Retrieval

For devices that support vehicle retrieval, you can search the related vehicle pictures and videos by
seƫng the search condiƟons such as plate number and captured Ɵme.

Before You Start
Add the device that supports vehicle retrieval to the client and properly conĮgure the
corresponding seƫngs. See Add Device for details about adding the device.

Steps
1. Click Data Retrieval → Vehicle Retrieval to enter the vehicle retrieval page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select the search type.

Vehicle
Search and display the captured vehicle pictures by entering the vehicles' license plate
number.

Mix-traĸc DetecƟon
Search and display the mix-traĸc detecƟon related pictures of the speciĮc vehicle by entering
the vehicle's license plate number.

Note
The camera should support mix-traĸc detecƟon.

Traĸc ViolaƟons
Search and display the traĸc violaƟon related pictures of the speciĮc vehicle by entering the
vehicle's license plate number.
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Note
The camera should support traĸc violaƟon.

4. Select a device from the camera list.

Note
You can enter a key word (supports fuzzy search) in the search box to quickly search the target
device.

5. OpƟonal: Check Vehicle Features and select the related vehicle features such as brand and color
from drop-down list to search vehicles with speciĮc features.

Note
This funcƟon should be supported by the device. For diīerent devices, you can search diīerent
vehicle features.

6. OpƟonal: Enter the license plate number (support fuzzy search) for search.
7. OpƟonal: Set the maximum number of searched results to be displayed.
8. Click Search to start searching.

The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

9. OpƟonal: Perform the following operaƟons if needed.

Export
Picture

You can export one or more searched pictures.
a. Click Export Picture.
b. Check one or more picture(s), or check Select All on the page below.
c. Click Export to export the selected picture(s) to local PC.

View
Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.

Play
Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įle frame by frame, and click  to enable audio.

Export
Single
Record

In the enlarged picture page, click  and then click Export Picture, Export
Video File or Export Details to export the picture, video Įle, and capture
details of single record to local PC.
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11.2.4 Search Target Pictures by Picture

Searching target pictures by picture uses recogniƟon and retrieval tech to swiŌly Įnd speciĮc
targets. It supports face, human, and vehicle picture uploads for search.

1. Go to Data Retrieval → AcuSearch → Search by Picture .
2. Select Time and Channel.
3. Select a picture to upload for analysis. Suitable for searching faces, individuals, and vehicles.
4. Click  on the target frame to search.

Green frames are for faces, blue frames for bodies, and orange frames for vehicles.
5. AŌer jumping to the search results page, you can perform the following operaƟons:

- Filter: Sort by similarity, Ɵme, favorites, etc.
- Export: Including exporƟng pictures, exporƟng current page, and exporƟng all.
- View Target Pictures: Click the target picture to view the playback. You can click  to conduct

a secondary analysis.

11.3 Abnormal Event DetecƟon
AŌer adding the device that supports abnormal event detecƟon, you can search the related events
such as line crossing, people gathering and loitering in the client. You can view the event details
including the captured pictures and related videos.

Before You Start
Add the device that supports abnormal event detecƟon to the client and properly conĮgure the
corresponding seƫngs. See Add Device for details about adding the device.

Steps
1. Click Data Retrieval → Abnormal Event DetecƟon to enter the abnormal event detecƟon page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select the search type as camera, task or rule from the drop-down list.

Camera
Search and display abnormal event detecƟon related informaƟon detected by the camera.

Task
Search and display the results according to the tasks you have added for the abnormal event
detecƟon server.

Rule
Search and display the results according to the rules you have conĮgured for a task of the
abnormal event detecƟon server.
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Note
Searching by task and rule should be supported by the device. You should have added tasks to
the abnormal event detecƟon server and conĮgure related rules for the tasks. For each task, you
can conĮgure mulƟple rules such as line crossing and region entrance.

4. Select a search method.
- When selecƟng Camera as the search type, select a camera from the camera list.
- When selecƟng Task as the search type, select a task or a abnormal event detecƟon server

from the task list.
- When selecƟng Rule as the search type, select a rule from the rule list.

Note
You can enter a key word in the search box (supports fuzzy search) to quickly Įnd the target
camera, task, or rule.

5. OpƟonal: Check False Alarm DeducƟon to remove the false alarms from the results.

Example
The camera might someƟmes take tree-shaking as a moƟon detecƟon alarm or take an animal as
a person triggering line crossing alarm probably for high sensiƟvity, which will be taken as false
alarms by an NVR or DVR.

6. OpƟonal: Select one or more event types from the drop-down list for search.

Note
You can skip this step if you select Rule in step 3.

7. Click Search to start searching.
The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

8. OpƟonal: For the searched pictures, you can perform the following operaƟons.

Export Picture You can export one or more searched pictures.
a. Click Export Picture.
b. Check one or more picture(s), or check Select All on the page below.
c. Click Export to export the selected picture(s) to local PC.

Export
Segments of
Pictures

For the searched pictures, you can click Export Segment, then select the
range (segmented by every 1000 pictures, e.g., 1 to 1000, 1001 to 2000) to
export the pictures in batch.

View Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.
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Play Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer
the capture) in the view window.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play

back the video Įle frame by frame, and click  to enable audio.

11.4 Hard Hat Retrieval
AŌer adding the hard hat detecƟon device to the client, when the device detects a person who
doesn't wear a hard hat, it will trigger an event and capture some pictures to noƟfy the managers.
You can search the alarm pictures in which the detected person doesn't wear a hard hat. By this
way, you can remind the builders to wear hard hats, and thus to improve builders' safety
awareness.

Before You Start
Add the device(s) with hard hat detecƟon funcƟon to the client. See Add Device for details about
adding the device.

Steps
1. Click Data Retrieval → Hard Hat Search to enter the hard hat search page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select the camera for search.

Note
You can enter a key word (support fuzzy search) in the search box to quickly search the target
camera(s).

4. OpƟonal: Select the hard hat detecƟon status.
5. OpƟonal: Select the face picture comparison result.

Note
When selecƟng the results of succeeded face picture comparison, you can search by the person
name or the face picture library.

6. OpƟonal: Set the maximum number of searched results to be displayed.
7. Click Search.

The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

8. OpƟonal: Perform the following operaƟons if needed.

Export
Picture

You can export one or more searched pictures.
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a. Click Export Picture.
b. Select one or more picture(s), or check Select All on the page below.
c. Click Export on the page below to export the selected picture(s).

View
Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.

Play
Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play back

the video Įle frame by frame, and click  to enable audio.

11.5 People Frequency Search
People frequency refers to the appearance frequency of a person happened in the detecƟon area
during a certain period of Ɵme. Frequently appeared person refers to a person whose appearance
frequency exceeds the predeĮned threshold, while rarely appeared person refers to a person
whose appearance frequency is lower than the predeĮned threshold. The client supports searching
frequently appeared people to protect places requiring high security and rarely appeared people
who may be in trouble if they rarely appear during a certain Ɵme period.

11.5.1 Search Frequently Appeared Person

The person's captured face picture can be compared with the face pictures in the face picture
library. If mismatched, he/she will be judged as frequently appeared person, and trigger an event
to noƟfy the security person. For example, in some high-safety demanded scene (e.g. bank), if a
stranger appears frequently, the event can be triggered to noƟfy the security personnel or related
person. If matched, he/she will be judged as a person in allowlist and will not trigger frequently
appeared person alarm. You can search the event informaƟon in a certain Ɵme, such as the
captured pictures, captured Ɵme, and you can view the detailed pictures and play back the related
video.

Before You Start
Make sure the frequently appeared person alarm has been conĮgured on the device.

Steps
1. Click Data Retrieval → People Frequency Search → Frequently Appeared Person .
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2. Set the start Ɵme and end Ɵme for searching.
3. Select the device(s) for searching.
4. Click Search.

The frequently appeared person alarm related pictures will be displayed on the right panel.

Figure 11-7 Results
5. OpƟonal: Click the picture to view the whole captured picture, the captured Ɵme, etc.
6. OpƟonal: Export the picture(s) to the local PC.

- Click Export Picture, and then select the picture to be exported, and then click Export.
- Click Export Current Page to export all the pictures and informaƟon on the current page.
- Click Export Segment to download the pictures and capturing informaƟon by packages. Each

package contains up to 1,000 pictures.
7. OpƟonal: Perform the following operaƟons if needed.

Add to Face Picture
Library

Click Add to face picture library to add current face picture to the
library .

View Detailed
InformaƟon

Click View to view the historical captured pictures of this person, the
captured Ɵme.

Playback Click Playback to play back the video of 5-seconds before and aŌer
the capturing Ɵme.

Export Click the picture to be exported, and then click Export to export this
picture.

11.5.2 Search Rarely Appeared Person

The device will send rarely appeared person report to the client regularly giving informaƟon
including who did not appear for enough Ɵmes so that security persons will know on Ɵme and go
to check the person. This funcƟon is oŌen used for seniors living alone and prisoners. If they have
not appear for a period of Ɵme, security persons need to Įnd them and conĮrm they are not in
trouble or escaped.
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Before You Start
● Make sure the frequently appeared person alarm has been conĮgured on the device.
● Make sure you have conĮgured detecƟng Ɵme, staƟsƟc period, frequency threshold, and face

picture library on the device remote conĮguraƟon page.

Steps
1. Click Data Retrieval → People Frequency Search → Rarely Appeared Person .
2. Set the start Ɵme and end Ɵme for searching.
3. Select the device(s) for searching.
4. Click Search.

The rarely appeared person reports will be displayed on the right panel.

Figure 11-8 Result
5. Double-click a report to show the rarely appeared persons.
6. OpƟonal: Click the picture to view the captured picture's details.
7. OpƟonal: Export the picture(s) to the local PC.

- Click Export Picture, and then select the picture to be exported, and then click Export.
- Click Export Current Page to export all the pictures and informaƟon on the current page.
- Click Export Segment to download the pictures and capturing informaƟon by packages. Each

package contains up to 1,000 pictures.
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11.6 AI Dashboard Retrieval
You can search result for video and captured picture task and imported picture task, to view the
detailed informaƟon of the task.

Note
The video analysis task is only conĮgured on web client, while picture analysis task can be
conĮgured on web client or control client.

11.6.1 Search Analysis Result for Video and Captured Picture Task

You can search result for video and captured picture analysis task, to view the related video and
pictures.

Before You Start
Add the device that support AI Dashboard Plaƞorm to the plaƞorm.

Steps
1. Enter Data Retrieval module.
2. Select AI Dashboard Retrieval.
3. Click  to set the Ɵme range for task searching.
4. Select Video & Capture Analysis Task as task type.
5. Select Task or Camera as the major type.
6. Select a task or camera.
7. Select one or mulƟple algorithms or device engines.
8. Click Search, and the task list will be displayed on the right area.

Note
If the device has been conĮgured combined rule alarm, the combined rule will displayed on the
result.

iVMS-4200 V3.13.1 User Manual

192



Figure 11-9 Combine Rule Alarm
9. OpƟonal: Perform the following operaƟons according to actual requirement.

Export Picture Select the picture or informaƟon record on the right area and then
clickExport Picture to save the picture to the designed path.

Export
Segments of
Pictures

For the searched pictures, you can click Export Segment, then select the
range (segmented by every 1000 pictures, e.g., 1 to 1000, 1001 to 2000) to
export the pictures in batch.

View Details Select one picture or informaƟon record and then click it to view the alarm
informaƟon or video footage.

Note
The video is recorded 5 seconds before or aŌer the capture Ɵme. Supports
playing, pausing, single frame playing and volume adjusƟng.

Display Mode Click  or  to display the task by thumbnails or by list.

11.6.2 Search Analysis Result for Imported Picture Task

You can search result for imported picture analysis task, to view the related picture Įles and
picture informaƟon.

Before You Start
Add the device that support AI Dashboard Plaƞorm to the plaƞorm.

Steps
1. Enter Data Retrieval module.
2. Select AI Dashboard Retrieval.
3. Click  to set the Ɵme range for task searching.
4. Select Picture ImporƟng Analysis Task as task type.
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5. Select Task or Camera as the major type.
6. Select a task or camera.
7. Select one or mulƟple algorithms or device engines.
8. Click Search.

The task list is displayed on the right area.
9. OpƟonal: Perform the following operaƟons according to actual requirement.

Export Picture Select the picture or informaƟon record on the right area and then
clickExport Picture to save the picture to the designed path.

Export Segments
of Pictures

For the searched pictures, you can click Export Segment, then select the
range (segmented by every 1000 pictures, e.g., 1 to 1000, 1001 to 2000)
to export the pictures in batch.

View Picture
Details

Select one picture or informaƟon record, click it to amplify the picture or
tag informaƟon (such as vehicle).

Display Mode Click  or  to display the task by thumbnails or by list.

11.7 Facial RecogniƟon Check-in
For the device that supports facial recogniƟon, the person can check in on the device by facial
recogniƟon. By comparing the recognized face with the face picture library, if matched, the system
will record it as a successful face comparison record. If the successful face comparison record is
during the check-in period, it will be regarded as a check-in record. Further more, the aƩendance
records can also be calculated based on the successful face comparison records.

According to your requirement, you can search facial recogniƟon check-in records or facial
recogniƟon aƩendance records.

11.7.1 Search Facial RecogniƟon Check-in Records

You can search for the check-in records of the persons who checked in by facial recogniƟon during
the speciĮed period and export the data to the local PC.

Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add Device
for details about adding the device.

Steps

Note
This funcƟon should be supported by the connected device.

1. Enter Data Retrieval → Face RecogniƟon Check-in → Check-In Search .
2. Click  to set the start Ɵme and end Ɵme for searching.
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Example
If you need to search the check-in records in march, you can set the Ɵme as
2020-03-01--2020-03-31.

3. Set the Check-In Period.
4. Check cameras used for face recogniƟon check-in.
5. Check one or mulƟple face picture libraries to search the persons aƩendance in the selected

library.
6. Enter the maximum number of the results to show.
7. Click Search to start searching.

The searched results show the aƩendance records including the face picture, face library, name,
and check-in counts.

Figure 11-10 Result
8. OpƟonal: Click Export All in the upper right corner to export the data to local PC.

11.7.2 Search Facial RecogniƟon AƩendance Records

You can search the aƩendance records of the persons who checked in by facial recogniƟon. You can
search the daily, monthly, yearly aƩendance records of the persons who checked in successfully on
the face picture library to help you know the aƩendance status (normal, late, leave early or absent)
of the staīs. AƩendance status is the result calculated by comparing the check-in period on the
search condiƟon with the successful face comparison records (earliest and latest). You can export
the aƩendance records to view the aƩendance data of the staīs.
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Before You Start
Add the device to the soŌware and properly conĮgure the corresponding seƫngs. See Add Device
for details about adding the device.

Steps
1. Select Data Retrieval → Facial RecogniƟon Check-in → AƩendance Search .
2. Set Ɵme range of records for searching.

Example
If you need to search the aƩendance records of march, you can set the Ɵme as 2020-03-01 -
2020-03-31.

3. Set the Check-In Period.

Example
If the Check-in Period is set as 08:00 - 17:00, the check-in earlier than 08:00 and check-out later
than 17:00 will be regarded as normal aƩendance.

4. Select AƩendance Period according to the work day.

Example
If the weekend is for rest, you can select Monday, Tuesday, Wednesday, Thursday and Friday as
AƩendance Period.

5. Select the camera for facial recogniƟon check-in.

Note
You can only select the camera(s) in the same NVR.

6. Select the Face Picture Library.
AŌer selecƟng the face picture library, only the aƩendance records of the persons in the library
will be searched. You conĮgure the face picture library on the remote conĮgure page of device,
or log into the device to conĮgure.

7. Set the Max. Number of Results to show.
8. Click Search.
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Figure 11-11 Face RecogniƟon AƩendance Search

Normal
The earliest check-in record (the earliest facial recogniƟon comparison successful record)
should not be later than the check-in start Ɵme, while the latest check-out record (the latest
facial recogniƟon comparison successful record) should not be earlier than the check-in end
Ɵme.
For example, if the Check-in Period is set as 08:00 - 17:00, the check-in earlier than 08:00 and
check-out later than 17:00 will be regarded as normal aƩendance.

Late
The check-in record (the earliest facial recogniƟon comparison successful record) is later than
the check-in start Ɵme.
If you set the Check-in Period as 08:00- 17:00, the check-in between 08:00-17:00 and check-
out later than 17:00 will be regarded as late.

Leave Early
The check-out record (the latest facial recogniƟon comparison successful record) is earlier
than the check-in end Ɵme.
If you set the Check-in Period as 08:00- 17:00, the check-in earlier than 08:00 and check-out
between08:00- 17:00 will be regarded as late.

Absent
If no facial recogniƟon comparison successful record is found during the check-in period, the
aƩendance record will be regarded as absent.
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The searched results show the aƩendance records including face picture, face library, name and
check-in counts.

9. OpƟonal: Click Export by Segment, to export the aƩendance records to the local PC.

11.8 Community InspecƟon
For the added device that supports community inspecƟon, you can search the captured pictures
and the related video Įle for community related events, including Įre engine access detecƟon,
elevator detecƟon, and urban management event.

11.8.1 Detect Fire Engine Access

When the added device detects a place (such as the stairway and passage) where the Įre engine
access is occupied, an event will be triggered, and the device will capture pictures and videos. You
can search and view the device's captured pictures and related videos via the client. This can help
to remove the objects that occupy the Įre engine access and perform rescue operaƟons when a
Įre happens.

Before You Start
You should have added the device to the client and properly conĮgure the corresponding seƫngs.
See Add Device for details about adding the device.

Steps
1. Click Data Retrieval → Fire Engine Access DetecƟon to enter the Įre engine access detecƟon

page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select a camera in the camera list.

Note
You can enter a key word (supports fuzzy search) in the search box to quickly Įnd the target
camera(s).

4. OpƟonal: Set the maximum number of searched results to be displayed.
5. Click Search to start searching.

The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

6. OpƟonal: For the searched pictures, you can perform the following operaƟons.

Export
Picture

You can export one or more searched pictures.
a. Click Export Picture.
b. Check one or more picture(s), or check Select All on the page below.
c. Click Export to export the selected picture(s) to local PC.
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View
Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.

Play
Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play back

the video Įle frame by frame, and click  to enable audio.

11.8.2 Detect Elevator

When the added device detects an electric moped entering the elevator, an event will be triggered,
and the device will capture pictures and videos. You can view the device's captured pictures and
the related video in the client. This can help to ease the loading burden of elevators.

Before You Start
You should have added the device to the client and properly conĮgure the corresponding seƫngs.
See Add Device for details about adding the device.

Steps
1. Click Data Retrieval → Elevator DetecƟon to enter the elevator detecƟon page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select a camera in the camera list.

Note
You can enter a key word (supports fuzzy search) in the search box to quickly Įnd the target
camera(s).

4. OpƟonal: Set the maximum number of searched results to be displayed.
5. Click Search to start searching.

The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

6. OpƟonal: For the searched pictures, you can perform the following operaƟons.

Export
Picture

You can export one or more searched pictures.
a. Click Export Picture.
b. Check one or more picture(s), or check Select All on the page below.
c. Click Export to export the selected picture(s) to local PC.
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View
Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.

Play
Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play back

the video Įle frame by frame, and click  to enable audio.

11.8.3 Retrieve Urban Management Event

AŌer adding the device that supports urban management analysis, you can search the related
events such as unregistered street vendor and packed package in the client. The event details
include the captured picture and related video Įle. It is an intelligent way to help the urban
management department to manage environment and improve the overall living quality of the city.

Before You Start
You should have added the device to the client and properly conĮgure the corresponding seƫngs.
See Add Device for details about adding the device.

Steps
1. Click Data Retrieval → Urban Management Event Retrieval to enter urban management event

retrieval page.
2. Click  to set the start Ɵme and end Ɵme for search.
3. Select a camera in the camera list.

Note
You can enter a key word (supports fuzzy search) in the search box to quickly Įnd the target
camera(s).

4. Select an event type such as unregistered street vendor and packed package from the drop-
down list for search.

5. OpƟonal: Set the maximum number of searched results to be displayed.
6. Click Search to start searching.

The captured pictures which meet the search condiƟons are displayed on the right panel. Up to
30 pictures can be displayed on one page.

7. OpƟonal: For the searched pictures, you can perform the following operaƟons.
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Export
Picture

You can export one or more searched pictures.
a. Click Export Picture.
b. Check one or more picture(s), or check Select All on the page below.
c. Click Export to export the selected picture(s) to local PC.

View
Capture
Details

Click a picture to view its capture details such as captured Ɵme and camera
name.

Note
You can click  to view an enlarged picture.

Play
Related
Video

Click Playback to play the picture's related video Įle (5s before and 5s aŌer the
capture) in the view window on the boƩom right.

Note
● You can click  to view the video in a larger window.
● You can click  to adjust the play speed of the playback, click  to play back

the video Įle frame by frame, and click  to enable audio.
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Chapter 12 AcuSeek

The AcuSeek's key features include:
● Natural language search: Enables open-ended queries (e.g., "a person in red clothing") to

pinpoint targets instantly via text input.
● Rapid object search: Quick lookup of people or vehicles.
● Advanced Įlters: Filters results by cameras, Ɵme range, or similarity; supports playback,

AcuSearch, and exporƟng target images.

Search
The AcuSeek supports instant searches for people/vehicles or text-based queries, boosted by smart
recommendaƟons and favorites for faster retrieval.

Figure 12-1 Search Page

Table 12-1 IntroducƟon of Search Page

Number DescripƟon

1 ● History: Supports up to 20 records. You can hover the cursor on a record
and click  to add it to the Favorites.

● Favorites: Displays favorite search records. You can click a favorite word
to search. A maximum of 100 words are allowed in Favorites.

2 SuggesƟons: Provides words that you may also search for quick searches.
For example, behaviors (making phone calls, using a mobile phone, etc.)
and transportaƟon methods (bicycle, shared bike, etc.).

3 Quickly Įnd people or vehicles.
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Number DescripƟon

4 Enter keywords or a text descripƟon to locate speciĮc targets, such as "a girl
walking her dog".

5 Filter by Ɵme and cameras.

View Search Results
AŌer retrieving search results, you can Įlter them by similarity or Ɵme, view or export video clips
containing the targets, or perform an image-based search. Using the query "Person in Red
Clothing", you can perform the following operaƟons:
Export Images

Select one or more images, then click Export to save the selected images.
Use Export Current Page or Export All to save images to an Excel Įle, where the images will be
presented as hyperlinks.

Note
Upon the Įrst export, a usage statement will pop up: To beƩer protect your rights and interests,
please ensure that you abide by relevant laws and regulaƟons when using the data you export,
and do not infringe upon the legiƟmate rights and interests of other organizaƟons or
individuals.

View Videos
Click an image to view the video displayed on the top right.

AcuSearch
Hover the cursor on a video and click  to perform an image-based search.
Click the red search box over the target to search for similar images across the channels
selected on the top right.
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Figure 12-2 Search Results
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Chapter 13 AI Dashboard

The client provides AI Dashboard module through which you can experience the advanced
funcƟons of the devices with AI features, such as face comparison and linked capture of Įxed
camera and panoramic camera, traĸc accident alarm, AI open plaƞorm to access to third-party
applicaƟons.

13.1 Face ApplicaƟon
For some devices, such as DeepinMind NVRs, DeepinView cameras, and dual-lens camera, Face
ApplicaƟon funcƟon provides showing face comparison alarm for the persons in the blocklist, VIP
or regular costumers during live view. If the detected face pictures are matched with the persons in
the blocklist or VIP face picture library, the security center will receive relaƟve alarms to take
appropriate acƟons quickly and eīecƟvely. It can also help you to evaluate the regular costumers,
which is widely used in the hospital, supermarket, shopping mall and so on.

13.1.1 Set List Types for Face Picture Libraries

You can conĮgure list type for each face picture library of the device(s), so that the soŌware can
check whether the persons detected during live view are in the blocklist, very important person, or
the regular costumers.

Click AI Dashboard → Face ApplicaƟon , and then click  in the upper-right corner to select the
list type for each face picture library on the devices.
Blocklist

If the alarm type is set to Blocklist, AI dashboard will show the blocklist alarm once the
captured pictures are matched with the ones in the face picture library.

VIP
If the face picture library is set to VIP , AI dashboard will show the VIP alarm once the captured
pictures are matched with the ones in the face picture library.

Normal
The face pictures libraries which belong to neither blocklist nor the VIP can be set to Normal. AI
dashboard will not show any alarms when the captured face pictures are matched with the ones
in the face picture library.

Note
This funcƟon should be supported by the device and the face picture library need be conĮgured in
the device Įrstly.
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13.1.2 Set Cameras for Showing AI InformaƟon

You can specify the displaying camera(s) or other cameras in the camera list to show AI informaƟon
during live view. For example, if you select a camera (not in live view in the displaying window) for
showing VIP informaƟon, this camera will perform staƟc detecƟon in the background and show the
AI informaƟon about VIP.

Click AI Dashboard → Face ApplicaƟon , and then click  in the upper-right corner to select
cameras for showing the AI informaƟon in real-Ɵme.
Select the alarm type to be displayed for diīerent cameras: Blocklist Alarm, VIP Alarm or Regular
Customer Alarm.
All Cameras in Live View

If check All Cameras in Live View, only the AI informaƟon of the camera(s) in live view in the
displaying window can be shown.

Custom Cameras
If check Custom Cameras and select the desired cameras, the AI informaƟon of the selected
camera(s) can be shown, whether the cameras are in live view or not.

13.1.3 Show AI InformaƟon

AŌer seƫng the cameras for showing AI informaƟon and list type for face picture libraries, you can
view the AI informaƟon.

Click AI Dashboard → Face ApplicaƟon , and then select the camera(s) from the camera list to start
live view and show AI informaƟon.

Note
This funcƟon should be supported by the device.

Camera List
The camera list on the leŌ panel shows all the resources added to the client soŌware, and you can
select the appropriate window division and desired camera(s) to show AI informaƟon.

Note
The channels for live view at the same Ɵme are limited by the performance of the PC running the
client.

Right-click the camera in the camera list, you can switch stream type between main stream and
sub-stream.

Display Intelligent InformaƟon on Live View
You can view the real-Ɵme video of the selected camera(s).
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Click  in the global toolbar of the live view area and select the window to enable the desired
intelligent display. For example, if the blocklist alarm is enabled for all live view windows, the
recognized targets will be marked dynamically on the images of all windows. You can also click  at
the boƩom of each window to enable the intelligent display for the camera in this window.

Face Comparison
If you set Face Comparison switch to ON, when detecƟng blocklist person, VIP, or regular customer,
the related alarm noƟĮcaƟon with corresponding colors will list on the right panel. You can view
the alarm Ɵme, camera, and other details of the alarm.

Historical Captured Picture
You can view the historical captured pictures at the boƩom of the page.

Figure 13-1 Show AI InformaƟon

Enable Alarm Triggered Pop-up Window
Click  to enable alarm triggered pop-up window, and aŌer that, a window will be pop up when
the blocklist alarm is triggered, including the captured pictures and alarm details informaƟon.

13.2 MulƟ-Target-Type DetecƟon
MulƟ-Target-Type DetecƟon refers to a funcƟon that recognizing and capturing mulƟple types of
detecƟon targets including faces, human bodies, motor vehicles, and non-motor vehicles. When
the device detects targets, you can view live view, captured pictures, and target features. Alarms
can be triggered for high similarity between captured face/human body picture and the one in
picture library, or high/low appearing frequency of a person/vehicle, or an appearance of a vehicle
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in the blocklist, etc. It is oŌen used in places such as crossroad and train staƟon where there are
large amount of people and vehicles showing and places requiring strong security.

13.2.1 Set Target DetecƟon Parameters

The client supports customizing the display layout of detected targets and their details, selecƟng
which feature to display with the detected targets, and selecƟng cameras of which alarms will be
displayed.

Set Display Mode

You can customize the display layout and select informaƟon to display according to your needs.

Steps
1. Click AI Dashboard → MulƟ-Target-Type DetecƟon .
2. Click  on the upper-right corner to open the ConĮgure window.
3. Click Basic Seƫngs tab.
4. Select a live view mode.

- Select Single Channel to display one live view window.
- Select Dual Channels to display two live view windows.
- Select Channel 4 to display four live view windows.

5. Check informaƟon to be displayed in the corresponding posiƟons.

Note
● The Face Arming funcƟon should be supported by the device.
● Up to 2 items can be selected to be displayed on the boƩom of the page.

The checked informaƟon will be displayed in the following window.
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Figure 13-2 Display on Right

Figure 13-3 Display on BoƩom
6. OpƟonal: Enable Save Picture so that all the captured pictures will be saved in a speciĮed folder

and then click the saving path to change it.
7. Click Save to save the seƫngs.

Set Capture Parameters

For captured pictures, the device will analyze the features of the captured targets. You can select
features to be displayed according to your needs. Take face detecƟon as an example, you can select
the feature: glasses wearing to display with the picture.

Steps
1. Click AI Dashboard → MulƟ-Target-Type DetecƟon .
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2. Click  on the upper-right corner to open the ConĮgure window.
3. Click Capture Parameters tab.
4. Enable Display Features.
5. Enable Features in Face DetecƟon/Features in Motor Vehicle DetecƟon/Features in Human

Body DetecƟon/Features in Non Motor Vehicle DetecƟon and check corresponding features.

Note
No more than 6 features of each funcƟon can be selected.

Figure 13-4 Displayed Features
6. Click Save to save the seƫngs.

Set Cameras Receiving Alarm

For cameras conĮgured with detecƟon alarm, you can select cameras to display their alarms on the
right panel with detailed alarm informaƟon provided.

Before You Start
Make sure you have conĮgured alarms for the cameras whose alarms you select to display.

Steps
1. Click AI Dashboard → MulƟ-Target-Type DetecƟon .
2. Click  on the upper-right corner to open the ConĮgure window.
3. Click Receiving Alarm Seƫngs tab.
4. Check cameras whose alarms will be displayed on the right panel.
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Note
Alarms of checked cameras will be displayed on the right panel with detailed alarm informaƟon.

5. Click Save to save the seƫngs.

13.2.2 Display MulƟ-Target-Type DetecƟon

MulƟ-Target-Type DetecƟon supports displaying detected informaƟon (including live view of
capture cameras, captured pictures, target details, target amount, and alarm details) aŌer
conĮguring corresponding parameters.

Note
This funcƟon needs to be supported by device.

Live View

Figure 13-5 MulƟ-Target DetecƟon Display
Supports displaying live view in single channel mode, dual-channel mode, or 4-channel mode. You
can capture a picture or start recording quickly with tool bar in the live view window when
something important happens. You can also perform PTZ control or 3D posiƟon by a right-clicking
for a panoramic detailed view.

Human Body/Non Motor Vehicle
Captured human body/non motor vehicle pictures will be displayed in this area with a highlight box
on the target. Meanwhile, features of the captured target will be displayed with the pictures.
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Captured Face Analysis
Display captured face pictures with face features (glasses wearing, etc.) displayed.

Motor Vehicle
Display captured motor vehicle picture with vehicle features (such as plate No., vehicle color,
vehicle type, etc.) displayed.

Facial RecogniƟon/Frequently/Rarely Appeared Person
Display facial comparison or face arming results, captured face pictures of strangers, human body
with captured face picture, and appearing frequency.
● Display captured face picture and the similar face picture in face picture library if the two faces

match.
● Display captured face pictures that mismatched with that in the face picture library.

Note
For a device supporƟng stranger recogniƟon, the captured faces will be compared with pictures
in face picture library. The person will be recognized as a stranger if her/his face matches with no
faces in the face picture library.

● For captured human body pictures, the face picture of the person will also be displayed.
● Appearing Frequency: Frequently Appeared People will be displayed whose appeared Ɵmes is

larger than the threshold, while Rarely Appeared People will be displayed whose appearance
amount is less than the threshold.

Note
Person informaƟon including the last captured face picture, appearance amount, and alarm Ɵme
will show aŌer clicking the alarm informaƟon. You can add the detected person to face picture
library.

● Display the human features of the detected persons. For example, the person who wears glasses
is marked in highlight icon (  ), and the person who does not wear glasses is marked in
highlight icon with diagonal (  ), and the undetected feature is marked in gray icon (  ).

13.3 AI Open Plaƞorm
AI Open Plaƞorm is a soŌware plaƞorm that can be accessed to third-party soŌware applicaƟon,
algorithm, etc. By this way, diīerent intelligent objects can be connected by network, and more
soŌware developer can work eĸciently on this plaƞorm.
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13.3.1 ConĮgure Plaƞorm Parameters

You can add intelligent devices to the client for displaying on the AI Open Plaƞorm. On the AI Open
Plaƞorm, you can get model package, select the cameras to be displayed, set the saving path for
picture storage and set the storage mode.

ConĮgure Local Storage

You can select to save the alarm informaƟon and pictures to the local path, and set the saving path
and storage mode.

Steps
1. Click AI Dashboard, and then select AI Open Plaƞorm.
2. Click  on the right-upper corner to open the Local Storage Seƫngs window.
3. Set Local Storage to ON.
4. Click the entering box of Saving Path to select the saving path.

Note
Make sure the storage space is larger than 2 GB, otherwise the pictures can not be stored.

5. Select the Storage Mode.
Overlap Earliest Alarm(Max. 10000 Alarms for Each Channel)

In this mode, up to 10000 alarms (including pictures) can be stored for each channel, and if
the storage space is full, the new alarm and pictures will overlap the earliest alarm.

Do Not Overlap
In this mode, up to 10000 alarms (including pictures) can be stored for each channel, and if
the storage space is full, the new alarm and picture will not be saved.

6. Click OK.
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Figure 13-6 ConĮgure Local Storage

Get Model Package

Model package is a product generated by algorithm model training on AI Algorithm Training
Plaƞorm. The model package can be imported to devices for task analysis. If the model package
saved in device is modiĮed, you can synchronize the model package from the device, to make the
data informaƟon accordant.

Steps
1. Click AI Dashboard, and then select AI Open Plaƞorm.
2. Click  on the right-upper corner to open the model package selecƟng window.
3. Check the cameras to get model package from the cameras.
4. Click OK.

Set Objects to Be Displayed

By default, the AI Open Plaƞorm receives alarm informaƟon from all cameras and all tasks. You can
also choose speciĮc camera(s) or task(s) to display received alarms.

Steps
1. Click AI Dashboard, and then select AI Open Plaƞorm.
2. Click  on the right-upper corner to open the camera(s) selecƟng window.
3. Choose the camera(s) or task(s) to display received alarms.
4. Click OK.
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13.3.2 ConĮgure Plaƞorm Event

The AI open plaƞorm event refers to the event triggered by the AI model package on the device.
When the device triggers an alarm of a corresponding AI model package, such as AI open plaƞorm
alarm, the client can receive all of the events for the same alarm, trigger the linkage acƟon, and
display the name and triggering Ɵme of the AI model package. To disƟnguish an alarm of the same
corresponding AI model package, you can edit the alarm name on the client, then the edited alarm
name will be displayed on the Real-Time Event page and Event Search page.

Steps
1. Enter the Maintenance and Management page.
2. Click Event ConĮguraƟon → AI Open Plaƞorm Event .

Figure 13-7 AI Open Plaƞorm Event Page
3. Select a device as the event source.

Note
Make sure the resource is online.

All the event types supported by the selected device will appear.
4. OpƟonal: Switch on the buƩon in the Enable column to enable the event type, or click Enable

All to enable all the event types of the AI model package.

Note
AŌer enabled, the event can be received by the client and trigger the linkage acƟon(s). You can
also disable an event type or click Disable All to disable all event types.
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5. OpƟonal: Select the AI model package(s), and then perform the following operaƟons.

Edit Alarm
Name

Select an event, click Edit Alarm Name to set a custom alarm name for the
corresponding AI model package.
The edited alarm name will be displayed on Real-Ɵme Event page, refer to View
Real-Time Events for details.

Edit Event
Linkage

Select an event, click Edit Linkage to set the linkage acƟon(s) of the event(s).
Audible Warning

Trigger the client's audible warning when the event is triggered.
You can select the audio Įle on the drop-down list, or click Add to add new
audio Įle (in WAV format).
You can click  to make an audiƟon of the selected audio Įle.

Send Email
Send an email noƟĮcaƟon of the alarm informaƟon to one or more receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Pop-up Window
A window pops up to display the event related informaƟon (including event
details, live video of the source camera, captured pictures of the linked
camera) on the client when the event is triggered. You can also enter remarks
about how to the handle the event.

What to do next
You need to arm the device which the alarm input belongs to, otherwise the client cannot receive
the conĮgured events. For details, see Enable Receiving Event from Devices .

13.3.3 Analyze Picture Task

AI Open Plaƞorm can analyze and recognize objects in the picture(s). The client can apply the
picture(s) to the device. The device will analyze the picture(s) and upload the results (e.g. object
classiĮcaƟon, aƩribute) to the client for displaying.

Steps
1. Click AI Dashboard, and then select AI Open Plaƞorm.
2. Click  in the right-upper corner of the page.

The Picture ImporƟng & Analysis window pops up.
3. Select the Device to analyze the oŋine picture(s).

Note
Only the device supporƟng oŋine picture analysis funcƟon will be displayed in the drop-down
list.

4. Select Device Engine or Algorithm List for selecƟng the model package.
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5. Enter the path of folder, which stores the oŋine pictures for analyzing.

Note
The supported picture format and size vary according to diīerent devices.

6. OpƟonal: Check Display Alarm Target Frame to display the frame on the target which is
recognized.

Note
If you select the Device Engine as OCR model package, the Display Alarm Target Frame funcƟon
is gray, and you can not check this funcƟon.

7. OpƟonal: Set the detecƟon frame for the target to be analyzed, thus to improve the accuracy
rate.

Note
When selecƟng a single classiĮcaƟon model package, the detecƟon frame is required.

8. Click Start.
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Figure 13-8 Picture ImporƟng and Analysis

13.3.4 AI Plaƞorm Real-Time Display

The AI Plaƞorm can display the live video of the camera, and display the uploaded pictures and
alarm informaƟon from the device.

Matched Results Display
On the AI Plaƞorm, the monitoring scene is compared with the scene learned by model to
generate the result. In the Matched Results area, the results are displayed, including alarm
pictures, camera informaƟon, alarm Ɵme, category, detecƟon result, tags and aƩributes of the
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target. When the object is recognized, you can move the cursor to the object to view the category
or detecƟon result, and click the alarm picture to view the details.

Note
The alarms in the Įgure above is OCR alarm, which are uploaded to the client when the devices
recognize characters in the video. If there are more than 3 characters recognized, only 3 characters
are displayed, and you can click  to view more character(s) in the next page.

Live View
In the lower-leŌ corner of the page, the live video of the camera is displayed.

Figure 13-9 Live View in AI Open Plaƞorm
Click  to switch the window division to 1 window or 4 window.
Click  to hide the live view window.
Click  to pop up the live view window. AŌer the window is popped up, you can click  to display
the window in full screen.

Note
Live view is not supported by DeepinMind Server.

13.4 MulƟdimensional People CounƟng
MulƟdimensional People CounƟng funcƟon includes live view and real-Ɵme staƟsƟcs display of
people counƟng data. The real-Ɵme staƟsƟcs includes the number of people entry or exit, the real-
Ɵme people number, etc. Accurate business strategies can be provided by analyzing the staƟsƟcs to
boost store operaƟon eĸciency.

iVMS-4200 V3.13.1 User Manual

219



Note
● This funcƟon should be supported by the device.
● For the historical data of people counƟng, refer to People CounƟng Report by Encoding Device .

Click AI Dashboard → MulƟdimensional People CounƟng .

Figure 13-10 MulƟdimensional People CounƟng

13.4.1 ConĮgure People CounƟng Group

ConĮguring people counƟng group to enable the live view and real-Ɵme staƟsƟcs display of people
counƟng data based on deĮned group parameters.

Steps
1. Go to AI Dashboard → MulƟdimensional People CounƟng → ConĮguraƟon .
2. Click Add, enter the group name, and select camera(s) previously added to the client.
3. Once added, groups are visible in the leŌ-side list.

13.4.2 Display People CounƟng Data by Group

AŌer conĮguring people counƟng group(s), people counƟng data can be displayed by group,
including live view and real-Ɵme data.
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MulƟdimensional People CounƟng Live View
1. Select camera(s) in the leŌ list, double-click the selected camera or drag it to the live view

window to view its live view.
2. Perform the following operaƟon(s) if needed.

- Click  , and then select one window division mode.

Note
Supports up to 4 window divisions.

- Click  to stop all live views.
- Click  to display the live view in full screen. Press Esc key to exit from full screen mode.

MulƟdimensional People CounƟng Real Time Data
Click Enter or Exit to view the total number, real-Ɵme number and other data for the people entry
or exit.
Number of People Enter/Exit

Display the number of people entry or exit within 24 hours. Check Display All Types to view the
total number.

Real Time People Number
Display the real-Ɵme number of people entry or exit reported by the device within 24 hours.

Note
You can log in to the web browser to conĮgure the report interval. For details, refer to the user
manual of the device.

13.5 Linked Capture Alarm
This funcƟon allows the users to view two diīerent channels (one Įxed channel and one PTZ
channel) of a device simultaneously. Therefore, you can view the panoramic image and captured
details at the same Ɵme when an alarm is triggered.

Note
This funcƟon needs to be supported by the device.

13.5.1 Set Basic Parameters

The capture saving funcƟon can be enabled or disabled manually, and you can also set the saving
path of the captured picture, so that you can view the captured pictures in your PC.

Steps
1. Enter the AI Dashboard module.
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2. Select Linked Capture Alarm to open the Linked Capture Alarm window.
3. Click  to open the seƫng window.

The introducƟon of the displayed content shows.
4. Switch Save Picture on to enable picture saving funcƟon.
5. Click the Saving Path to select a saving path of the captured pictures.
6. Click Save to save the seƫngs.

The pictures captured when events and alarms are triggered will be saved in the conĮgured
path.

13.5.2 View Live View and Alarms

When Įxed camera triggers an alarm, the Įxed camera will capture a panoramic picture related to
the alarm, which will be displayed in the panoramic linked alarm window; and the linked PTZ
camera will capture a picture with details about the alarm, and the picture will be displayed in the
linked channel alarm window. In this way, the user views the panoramic image with details
displayed simultaneously.

Generally speaking, Panoramic Channel Live View window is used to display the live view of Įxed
camera, while Linked Channel Live View window is used to display the live view of PTZ camera
connected to the Įxed camera.
1. Enter the AI Dashboard and select Linked Capture Alarm to open the Linked Capture Alarm

window.
2.

Click  to expand the device list.
3. Select a window and double-click a camera to start live view, or drag a camera from the device

list to a window, or hover the cursor on a camera name and then click  .
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Figure 13-11 View Live View and Alarms

13.6 Traĸc Accident Alarm
The intelligent traĸc device (e.g. traĸc speed dome) can be added to the client for real-Ɵme live
view of the traĸc violaƟons or abnormal traĸc events happened on the road. When the camera
detects the accident, the camera will capture the picture and upload the picture and accident
alarm to the client, which is convenient for the enforcement. The client can display the
enforcement alarm, traĸc accident alarm and road traĸc alarm.

13.6.1 ConĮgure Display Parameter

You can conĮgure the displaying parameters of traĸc accident event, which will be displayed on
the right panel of the live-view window. If the Save Picture funcƟon is enabled, you can double-
click the picture to show the original picture. If the Save Picture funcƟon is not enabled, you can
double-click the picture to show the traĸc accident event alarm. Make sure you can conĮgure the
traĸc accident alarm rule for the traĸc device added to the client.

Before You Start
Make sure you can conĮgure the traĸc accident alarm rule for the traĸc device added to the
client.

Steps
1. Select AI Dashboard → Traĸc Accident Alarm to enter the traĸc accident alarm page.
2. Click  on the right-upper corner of the page to enter the parameter conĮguraƟon page.
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Figure 13-12 Parameter ConĮguraƟon Page
3. Click the drop-down list, select the Display Content, such as Enforcement&Traĸc Event.
4. ConĮgure the parameters of the display content.

Example
For example, you can select parking over lane line, angled parking for enforcement.

Note
Up to 6 items can be selected for displaying.

5. OpƟonal: Enable Save Picture and set the saving path.
6. Click Save.
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13.6.2 View Traĸc Accident Alarm

On the Traĸc Accident Alarm Module, you can view the real-Ɵme traĸc monitoring view, and
receive the alarm informaƟon triggered by the traĸc device. You can view the monitoring video by
1 channel or 2 channels, and display the enforcement alarms, traĸc accident alarms or road
alarms from the corresponding camera(s).

Select AI Dashboard Traĸc → Accident Event to enter the Traĸc Accident Event page.
Click  on the leŌ of the page to select the cameras for live view.

Live View Window
The live view window display the real-Ɵme traĸc monitoring video. Click 1 or 2 on the right-lower
corner to set the window division. Up to 2 cameras can be viewed simultaneously.

Note
Display live video of 1 or 2 cameras in main stream mode. Stream switch is not supported.

Click  or  on the right-lower corner of the live window，to manually record the video or
capture picture of the camera.

Display Traĸc Event
Display the parameters informaƟon of traĸc event, enforcement or road traĸc event informaƟon
in real-Ɵme. Up to 6 parameters can be displayed for each event, such as alarm Ɵme, vehicle type,
event type, etc.
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13.7 Arming and Tracking
For the devices that support arming and tracking, the devices can be conĮgured in a designed
order to detect and track the target (human or vehicle), and display the video or captured picture
of the target on the client. This is suitable for the situaƟon that the target (vehicle) should be
conƟnuously tracked. For example, the vehicle with traĸc violaƟon can be armed, and then it will
be tracked and monitored by mulƟple cameras.

13.7.1 Vehicle Arming and Control

For the devices that support vehicle arming and control, the vehicle can be armed by license plate
number on the device or on the client, and the devices can be installed and conĮgured in a
designed order to detect the armed vehicle and track this vehicle. When the Įrst camera detects
this vehicle (the recognized license plate number matches the armed one), the vehicle will be
conƟnuously tracked by the other cameras in the designed order, and the related videos and
recognized license plate number will be displayed on the client to track this vehicle conƟnuously.

Before You Start
Make sure the devices support vehicle arming and control.

Steps
1. Enter the AI Dashboard module, and then select Arming and Control to enter the Arming and

Control module.
2. Click  to switch to Vehicle.
3. Click  to open the ConĮgure window.
4. Click Add Device to add the devices to be armed.
5. Click  /  in the OperaƟon column to adjust the order of the devices to be armed.
6. OpƟonal: Click Add License Plate in the License Plate sheet to add the license plate number of

the vehicle(s) to be armed.

Note
● The vehicle can be armed both on the device and on the client. Only the vehicle that is not

armed on the device should be armed here on the client.
● Up to 100 license plate number can be added for arming.
● Only the license plate number added in the latest Ɵme will be armed and take eīect.

7. OpƟonal: For the license plate number that do not need to be armed, click  in the OperaƟon
column to delete it.

8. Click  to arm the devices.
The videos of the detected vehicle will be displayed.
The license plate number of the detected vehicle is displayed in the right-upper corner of the
middle window.
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Figure 13-14 Vehicle Arming and Control

Note
● The video of the camera which detects the vehicle recently is always displayed in the middle

window of the page. The previous video will be switched to the leŌ by one window.
● For example, when camera1 recognizes the vehicle for the Įrst Ɵme, the video of camera1 is

displayed in the middle window. When camera2 recognizes the vehicle, the video of camera2
is displayed in the middle window, and the video of camera1 will be switched to the leŌ
window. When camera3 recognizes the vehicle, the video of camera3 is displayed in the
middle window, the video of camera2 will be switched to the leŌ window, the video of
camera1 will be switched to the right window.

9. OpƟonal: Click  to switch the view to the following video.
10. OpƟonal: Click  to switch the view to the previous video.
11. OpƟonal: If you want to disarm the device, click  to disarm the device.

13.7.2 Face/Human Body Arming and Control

For the devices that support face/human body arming and control, the person can be armed on
the devices and the devices can be installed and conĮgured in a designed order to detect the
person and track the person. When the Įrst camera detects this person (the facial picture or
human body picture captured by the device matches the armed one), the person will be
conƟnuously tracked by the other cameras in the designed order, and the related videos and
comparison result (captured picture and armed picture) will be displayed on the client to track this
person conƟnuously.
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Before You Start
Make sure the devices support arming and control, and the related face picture or human body
picture are correctly armed on the device. For details, refer to the user manual of the device.

Steps
1. Enter the AI Dashboard module, and then select Arming and Control to enter the Arming and

Control module.
2. Click  to switch to Face/Human Body.
3. Click  to open the ConĮgure window.
4. Click Add Device to add the devices to be armed.
5. Click  /  in the OperaƟon column to adjust the order of the devices to be armed.

The videos of the detected person will be displayed on the middle window and right window.
The comparison result (the captured facial picture, the armed picture and similarity) will be
displayed on the leŌ window.

Figure 13-15 Face/Human Body Arming and Control

Note
The video of the camera which detect the person recently is always displayed in the middle
window of the page. The previous video will be switched to the right window.

6. OpƟonal: Click  to switch the view to the following video.
7. OpƟonal: Click  to switch the view to the previous video.
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13.8 Skin-Surface Temperature
In some special scene, you can supervise the human body's skin-surface temperature. When the
Client receives alarm informaƟon of abnormal skin-surface temperature or no mask, it will trigger
the linkage of alarm audio or pop-up window. This is suitable for the scene that requires people
wearing mask and skin-temperature measurement.

Note
The funcƟon should be supported by the devices.

13.8.1 Start Live View of Skin-Surface Temperature DetecƟon

In the Skin-Surface Temperature page, you can view the persons in the live view, and get the
staƟsƟc number of the persons whose temperature are abnormal, normal and the persons do not
wear mask. You can also view the alarm informaƟon of the face picture comparison, temperature
measurement picture, face capture alarm, and the historical captured face pictures.

Click AI Dashboard → Skin-Surface Temperature to enter the Skin-Surface Temperature page. Start
live view in the Skin-Surface Temperature page.
● Click  on the leŌ panel and double-click the camera to display the live video of the camera.
● Click  on the leŌ panel, and then click  on the right side of the camera to display the live

video of the camera.

Figure 13-16 Skin-Surface Temperature Page
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13.8.2 Display Skin-Surface Temperature InformaƟon

In the Skin-Surface Temperature page, you can select the alarm types (face comparison alarm,
temperature measurement picture and face capture alarm) to be displayed on the right area. The
staƟsƟc number of persons are displayed on the top of the page. The captured face pictures are
displayed on the boƩom of the page. You can set the audio linkage Įle for received alarms.

Enable InformaƟon Display
You can select the alarm types (face comparison alarm, temperature measurement picture and
face capture alarm) to be displayed on the Client. The alarm types are disƟnguished by diīerent
color.
1. In the Skin-Surface Temperature page, click  to select the alarm type(s) to be displayed.

Face Comparison Alarm
AŌer enabled, the captured face picture and the comparison picture in the face picture
library will be displayed, as well as the related classiĮcaƟon (e.g. person name, stranger or
unrecognized) in the library. Click View Details to view the detailed person informaƟon,
including person name, ID No., etc.

Temperature Measurement Picture
AŌer enabled, the measured temperature will be displayed on the captured face picture, and
the alarm is disƟnguished as normal or abnormal by diīerent color.

Face Picture Alarm
Display the captured face picture detected in the detecƟon area.

2. Set Display switch to ON to display the event informaƟon in the right area.
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Table 13-1 DescripƟons of Diīerent Color

Picture DescripƟon

Blue indicates no temperature informaƟon.
Blue is displayed in the following cases:
- No skin-surface temperature informaƟon +

wear mask
- No skin-surface temperature informaƟon +

the mask aƩribute is not detected by the
device

Green indicates the person is normal
temperature.
Green is displayed in the following cases:
- Normal skin-surface temperature + wear

mask
- Normal skin-surface temperature + the

mask aƩribute is not detected by the device
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Picture DescripƟon

Yellow indicates the person does not wear
mask.
Yellow is displayed in the following cases:
- No mask + normal skin-surface temperature
- No mask + the device does not support

temperature measurement funcƟon.

Red indicates the person's skin-surface
temperature is abnormal.
Red is displayed in the following cases:
- Abnormal skin-surface temperature + wear

mask
- Abnormal skin-surface temperature + no

mask
- Abnormal skin-surface temperature + the

mask aƩribute is not detected by the device

Note
The threshold of the skin-surface temperature
abnormal can be set on the device.

StaƟsƟc Number of Persons
In the Skin-Surface Temperature page, the Client calculate the number of persons based on the
received alarms, to get the number of passing persons, the number of persons whose skin-
temperature are abnormal and the number of persons who do not wear mask.

Note
Turn the Display switch to ON to get the real-Ɵme staƟsƟc number of persons.

● All: the total number of alarms received in the Skin-Surface Temperature page.
● Abnormal: the number of persons whose skin-temperature are abnormal. When a camera

detects a person whose skin-temperature is abnormal, it will trigger the alarm of abnormal
temperature, and the number of Abnormal and All will be added by 1.
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● No Mask: the number of persons in the live view who do not wear mask. When a camera detects
a person who does not wear mask, it will trigger the alarm of no mask, and the number of No
Mask and All will be added by 1.

● Normal: the number of persons in the live view whose skin-temperature is normal. When a
camera detects a person whose skin-temperature is normal, it will trigger the alarm of normal
temperature, and the number of Normal and All will be added by 1.

Captured Face Pictures Display
On the boƩom of the Skin-Surface Temperature page, the captured face pictures can be displayed
in real-Ɵme.

Note
● Turn the Display switch to ON to receive and display the captured face pictures in real-Ɵme.
● The displayed pictures are the captured face pictures for the face comparison alarm,

temperature measurement alarm or face capture alarm. Make sure at least one alarm is selected
by clicking  .

Drag the slider under the captured face pictures to view the previous captured face pictures.
On the boƩom of the captured face picture, click  to add the face picture to the face picture
library and enter the person informaƟon.

Audio Linkage Seƫngs
You can set audio linkage Įle(s) for the received alarms.
1. Click  on the upper-right corner of the Skin-Surface Temperature page.
2. Set the switch(es) to ON to enable audio linkage for diīerent alarms.

Note
By default, audio linkages of all the alarms (no mask, normal temperature, abnormal
temperature) are enabled.

3. Click  to select the audio Įle in .wav format to modify the audio Įle.

Note
Upload the audio Įle to the designed path of the Client. In Audio ConĮguraƟon window, click

 to view the designed path of the Client.
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Figure 13-17 Audio ConĮguraƟon

13.8.3 View Alarm InformaƟon

When the devices detect alarm of abnormal skin-surface temperature or no mask, it will trigger
alarm pop-up window to display the alarm informaƟon. Besides, the duraƟon of window pop-up
can be set, which can help you to Ňexibly control the duraƟon of viewing the alarm informaƟon.

Figure 13-18 Alarm Pop-up Window

No Mask
The alarm window pops up to show the captured face picture of the person who does not wear
mask.

Abnormal Temperature
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The alarm window pops up to show the captured face picture of the person whose skin-surface
temperature is abnormal.

Note
The priority of abnormal temperature alarm is higher than the priority of no mask alarm. If No
Mask and Abnormal Temperature are both enabled, when the client receives the alarm of no
mask and abnormal temperature, the abnormal temperature alarm window will pop up and the
audio of abnormal temperature (if enabled. Refer to Display Skin-Surface Temperature
InformaƟon for details.) will be played.

Note
● Before viewing alarm informaƟon, make sure enabling receiving alarm informaƟon. For details,

refer to Enable Receiving Event from Devices .
● Before receiving alarm window pop-up, make sure enabling alarm pop-up window.

In the skin-surface temperature page, click  on the upper-right corner to pop up the window
of Alarm Pop-up Window to set the conĮguraƟon.

Figure 13-19 Alarm Pop-up Window ConĮguraƟon

13.9 Abnormal Event DetecƟon
The abnormal event detecƟon server can be added to the client to display the analysis results of
mulƟple analysis tasks. The following analysis tasks are supported: perimeter prevenƟon related
alarms (e.g. line crossing detecƟon, intrusion detecƟon, parking detecƟon), street behavior related
alarms (e.g. , geƫng up detecƟon, climbing alarm), indoor behavior related alarms (e.g. in-toliet
overƟme, absence detecƟon), and people density analysis, etc. The analysis results (alarms) will be
displayed.
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Enter the AI Dashboard module, and then select Abnormal Event DetecƟon to enter the Abnormal
Event DetecƟon page. In the task list, double-click the task, or select and drag the task to the live
view window, and the video of the task will be displayed in the live view window.
The people density analysis results are displayed by 3 parts in the same window. The live video is
displayed in the upper-leŌ part of the window. The heat map of the video is displayed in the upper-
right part of the window. The number of people is displayed in the boƩom part of the window in
real Ɵme.

Figure 13-20 People Density Analysis Task Display

For the other tasks (not people density analysis task), only the task related video is displayed in the
window.
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Figure 13-21 Other Analysis Task Display
● Click the view and then click Capture to capture the picture of current video.
● Click the view and then click Start Recording to record the video.

Note
The video is saved in the path that is conĮgured in the System Seƫngs module. For details about
seƫng the path to save video, refer to Set File Saving Path .

● Click  to end the live view of the video.
● Click  to change the window division of the video. Up to 6 windows are supported to be

viewed simultaneously.
● Click  to view the video in full screen.

13.10 Event Dashboard
When the abnormal event detecƟon server detects events, the client can receive the events from
the server. The client can calculate the number of diīerent events, the event Ɵme distribuƟon and
risk assessment (the total number of events and frequently-occurred events of diīerent tasks), and
display the staƟsƟc data in the same page, to help you get a overview of the behavior events. For
example, if one event was mainly detected in a certain Ɵme period, you can invesƟgate the reason
in that Ɵme period and adopt measures to solve the problem.

Set Filter CondiƟons
Enter the AI Dashboard module, and then select Event Dashboard to enter the Event Dashboard
module. Click  to set the Įlter condiƟon as follows:
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Device
Select the abnormal event detecƟon server to display its events staƟsƟc data.

Note
Only the abnormal event detecƟon server can be selected here.

Event Type
Select the event(s) to be calculated and displayed.

StaƟsƟc Time
Display the staƟsƟc data of the events in last 7 days or last 31 days.

Refresh Frequency
Get the staƟsƟc data of the events from the devices every 0.5 hour or 1 hour.

Abnormal Event DetecƟon Overview

Figure 13-22 Abnormal Event DetecƟon Overview

Event CounƟng
In the bar chart, display the number of diīerent events in bar chart. You can view the event that
happened a lot and mainly invesƟgate the reason that caused this event.

Event Time
In the line chart, display the Ɵme distribuƟon of diīerent events in last 7 days or 31 days. You
can view the date that the events happened a lot and mainly invesƟgate the reason that caused
the events in this date.
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Risk Assessment
In the list, display the total number of events and frequently occurred events of diīerent tasks.

iVMS-4200 V3.13.1 User Manual

239



Chapter 14 Video Tracing

The system links workstaƟons with connected cameras to automaƟcally capture video footage
before and aŌer each scan operaƟon. This enables end-to-end visibility and real-Ɵme management
of items throughout the logisƟcs process. You can select a designated camera, deĮne pre-/post-
recording intervals, input an ID (via scanner or manual entry) to access and download records.

Go to Video ApplicaƟon → Video Tracing .

14.1 ConĮguraƟon
Link cameras with each workstaƟon to record videos and conĮgure general seƫngs such as ID
length, code-scanning interval, and voice prompt. AŌer conĮguraƟon, click Save to proceed to the
Scanning Record page. For mulƟple workstaƟons, repeat the process unƟl all conĮguraƟons are
complete.
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Figure 14-1 ConĮguraƟon

14.1.1 WorkstaƟon ConĮguraƟon

The conĮguraƟon ensures each scan record can be traced to the speciĮc workstaƟon locaƟon, the
device used, and the operator, while allowing custom scenarios for workstaƟons to facilitate
management.
WorkstaƟon No.

The speciĮc workstaƟon on the logisƟcs line.
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Device No.
The device bound to this workstaƟon.

Scene Name
Customize the workstaƟon's purpose (e.g., "Packaging InspecƟon Area").

Operator ID
The personnel responsible for this workstaƟon.

14.1.2 Basic ConĮguraƟon

ConĮgure general seƫngs for logisƟcs ID, code-scanning intervals, and voice prompts.
ID Length

Set vaild ID length.
Exclude ID by Fixed Field

Exclude preĮxes/suĸxes (e.g., "SN-") to extract core ID.
Code Scanning Interval(S)

Minimum interval (seconds) between scans to prevent duplicate records.
Voice Prompt

The input voice prompt will play when the linked device receives scan commands.

14.1.3 Linked Device

Select the linked device for recording scanning operaƟons.

14.2 Retrieve Scanning Records
On the main panel, select a device, set the interval before/aŌer scanning (or a custom span), and
input an ID (via scanner or manual entry). Click Search to retrieve records.
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Figure 14-2 Sacnning Record

The search results will display ID, start Ɵme, end Ɵme, device, and video recordings. You can:
● Click  to play related videos. Supports playback controls (fast-forward/rewind, Ɵmeline

scrubbing, speed adjustment, etc).
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Figure 14-3 Playback
● Click  to download single/mulƟple records or an enƟre page. If Transcoding is enabled, videos

will be converted to 1080P resoluƟon. If not, the videos will retain the original resoluƟon. You
can also customize watermarks (ID, workstaƟon, start/end Ɵme) and font size.
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Figure 14-4 Download

iVMS-4200 V3.13.1 User Manual

245



Chapter 15 Security Control Panel

The Security Control Panel module provides remote control and conĮguraƟon of the parƟƟons and
zones via the client soŌware.

Note
For the users with security control panel permissions, they can enter the Security Control Panel
module to manage the security control panel and real-Ɵme alarm. For seƫng the user permission
of Security Control Panel module, refer to Add User .

15.1 Flow Chart

Figure 15-1 Flow Chart of Security Control Panel
● Add Security Control Device: You can add security control devices on the client. AŌer adding

devices, you can view the device status. For more details, refer to Add Device .
● Group Zones/Radars: You can group the added zones/radars into groups for convenient

management. For more details, refer to Group Management .
● ConĮgure Zone Event: By conĮguring linked acƟons of zone event on the client, you will be
noƟĮed once the event is triggered. For more details, refer to ConĮgure Client Linkage for Zone
Event .

● Remotely Control Security Panel: You can remotely security control panel, including parƟƟon,
zone, relay, and siren. For more details, refer to Remotely Control Security Control Panel .
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● Add Zone/Radar on Map: You can add zone/radar to the map as hotspots. For more details,
refer to Add Zone as Hot Spot and Add Security Radar as Hot Spot .

● Map ApplicaƟon: You can locate the resources, view alarm informaƟon and perform related
control. Refer to Map Management .

15.2 ConĮgure Security Control Panel Remotely
AŌer adding security control panel to the client, you can go to the remote conĮguraƟon page to
conĮgure related parameters of the device via the client. For the device added by Hik-Connect, if
the second veriĮcaƟon is enabled, you need to enter the user name and password of the device for
remote conĮguraƟon. It is widely used for the batch device maintenance scenario. For example,
the installer can log in via Hik-Connect account and remotely maintain the devices of the end user.

Steps
1. Select Device Management → Device → Device .
2. Select the added security control panel, and click  on OperaƟon column.
3. OpƟonal: For the device with the second veriĮcaƟon enabled, enter the user name and

password of the device, and click OK.

Result

The remote conĮguraƟon page will be displayed.

15.3 ConĮgure Client Linkage for Zone Event
Even if you are far away from a zone, you can sƟll know what happens and how urgent the event is
in a zone by conĮguring linked acƟons of zone event on the client. You will be noƟĮed on the client
once an event is triggered, so that you can response to the event instantly. You can also conĮgure
client acƟons of mulƟple zones in a batch at a Ɵme.

Before You Start
● Make sure you have added a security control panel.
● Make sure zones have been deĮned beforehand.
● Make sure events have been conĮgured beforehand.

Steps
1. Click Event ConĮguraƟon → Alarm Event .
2. Expand the zone list of a security control panel, and then select a zone from the list.
3. Check one or more event.
4. Click Edit Linkage to conĮgure client acƟons.

Audible Warning
The client soŌware gives an audible warning when an event is triggered. You can select the
alarm sound for audible warning.
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Note
Click Add to enter the alarm sound name and select a sound in your PC. For details, refer to
Set Alarm Sound .

Send Email
Send an email of the alarm informaƟon to one or more receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Pop-up Window
Pop-up window to display the event related informaƟon (including event details, captured
pictures of the linked camera, process record, and process Įeld) on the soŌware client when
the event is triggered.

Display on Map
When the event source is added as a hot spot on the map, the hot spot will be displayed with
red number (indicates the number of events, and the maximum number is 10) aside when
the event is triggered, which helps the security guard to view the locaƟon of the event.
You can also click the hot spot to view the event details and the live video of the linked
camera (s).

Linked Camera
Link the selected camera(s) to capture picture when the zone event is triggered.
Select the camera(s) in the drop-down list.

Note
Up to 4 cameras can be selected as the linked cameras for a zone event.

5. OpƟonal: Click Edit Priority to set event priority as Uncatergorized/Low/Medium/High.
6. OpƟonal: Click Copy to... to copy the event seƫngs (including event priority, triggered client

acƟons, and enabling/disabling the event) to other zones.
7. ConĮgure linkage camera and linkage PTZ.

Note
● The linked camera will turn to the selected preset or perform the selected patrol or paƩern

when an alarm is triggered in the radar's detecƟon area.
● This funcƟon needs to be supported by the device.

1) Check cameras in the linked camera list.
2) Switch the Linkage PTZ on to enable the funcƟon.

The cameras linked to the radar displayed below.
3) Select a camera and select Preset/Patrol/PaƩern from the drop-down list on the right.

The Preset/Patrol/PaƩern list is displayed.
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Note
Make sure you have conĮgured presets, patrols, or paƩerns for the camera.

4) Select a preset, patrol, or paƩern.
8. Click OK.
9. OpƟonal: Enable or disable client acƟons for zone event.

- Click Enable All or Disable All to enable or disable client acƟons of all zone events.
- Switch Enable to ON/OFF to enable or disable client acƟons of one zone event.
Enable Client AcƟons

When client acƟons are enabled, client acƟons will be triggered when client receives zone
event.

Disable Client AcƟons
When client acƟons are disabled, client acƟons will not work and acƟons will not be triggered
when client receives zone event.

10. Click Save.

15.4 Remotely Control Security Control Panel
AŌer adding the security control panel to the client, you can remotely control the parƟƟons, zones,
relays, and sirens of security control panel via the client soŌware. For instance, you can arm,
disarm, bypass, group bypass, etc. for both parƟƟons and zones, and you can enable or disable
relays.

Note
● The displayed interface is subject to the types of added security control panels.
● By default, AX Hub device uses HTTP port, and it does not support private ports.

15.4.1 Remotely Control ParƟƟons

You can perform operaƟons remotely on security control panel's parƟƟons using the client such as
away arming, stay arming, instant arming, disarming, clearing alarm, group bypass, and recovering
group bypass.

Steps

Note
● The supported funcƟons are subject to the added devices.
● If a zone of a parƟƟon does not work, you should bypass it before arming/disarming the
parƟƟon, and then recover bypass when the zone works.

1. Enter Security Control Panel module.
2. Select a security control panel and click ParƟƟon.
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The name, status, arming status and linked zone of the parƟƟons will be displayed in the list.
3. Select one or mulƟple parƟƟons and click the following buƩon(s).

Away Arming
An arming mode that works when all persons are absent from the monitored region. When
away arming is enabled, all zones of the parƟƟon work properly.

Stay Arming
An arming mode that works when persons stay in the monitored region. When stay arming is
enabled, zones inside of the region are armed while zones outside of the region will be
bypassed where you can move in the zones without triggering any event.

Instant Arming
AŌer arming a parƟƟon, its zone will alarm instantly when an event is triggered.

Disarming
All the zones (except 24-hour zones) in the parƟƟons does not work any more aŌer clicking,
so that no event will be triggered in the disarmed zones.

Note
24-hour zones (e.g. 24-hour annunciaƟng zones, 24-hour silent alarm zone, etc.) sƟll can
detect events and then alarm even if the parƟƟon is disarmed.

Clear Alarm
Stop the alarming of alarming devices.

Group Bypass
Bypass all the zones in one or more parƟƟon so that no event will be triggered in the
bypassed zones before group bypass recovery.

Note
You should disarm the parƟƟon before bypassing it.

Group Bypass Recovery
Recover a group bypass to make all the zones in a parƟƟon work, so that you can arm the
group.

15.4.2 Remotely Control Zones

You can use the client to remotely control the security control panel's zones including bypassing
and recovering bypass.

Steps
1. Enter Security Control Panel module.
2. Select a security control panel and click ParƟƟon.

The name, status, arming status and linked zone of the parƟƟons will be displayed in the list
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.
3. Click  to open the Zone OperaƟon panel.

The zones linked with the parƟƟon, zone No., zone name, zone status, zone alarm status, baƩery
will be displayed.

Figure 15-2 Zone OperaƟon

Zone Status
Zone status can be unassociated, armed, disarmed, fault, shield, tamper-proof, etc.

BaƩery
The power of a zone's detector.

4. Check one or more zone in the list and click the following buƩons.
Bypass

When a zone is bypassed, no event will be triggered in the zone, and you are not allowed to
arm or disarm the zone, while other zones can be armed or disarmed.

Note
You should disarm the zone before bypassing it.

Bypass Recovery
AŌer recovering bypass for a zone, you can arm it.
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15.4.3 Remotely Control Relay

You can use the client to remotely change the on/oī status of relay, and view the linked event of
the relay.

Steps
1. Enter Security Control Panel module.
2. Select a security control panel, and then click Relay.

The name, status, and linked event of the relay will be displayed.
3. Check one or mulƟple relays and click Open or Close.

Note
For AX Hub, you should set the Relay Associated Event as Manual Control in Device
Management module.

15.4.4 Remotely Control Siren

You can control the siren status via the client remotely, including open and close. When the status
of the siren is open, the detected alarm will trigger the alarm sound on the siren.

Enter Security Control Panel module, select a security control panel , and click Siren tab. Select
one or mulƟple sirens, click Open or Close to open or close the sirens.
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Chapter 16 Person Management

You can add person informaƟon to the system for further operaƟons such as access control, video
intercom, Ɵme and aƩendance, etc. You can manage the added persons such as issuing cards to
them in a batch, imporƟng and exporƟng person informaƟon in a batch, etc.

16.1 Add OrganizaƟon
You can add an organizaƟon and import person informaƟon to the organizaƟon for eīecƟve
management of the persons. You can also add a surbodinate organizaƟon for the added one.

Steps
1. Enter Person module.
2. Select a parent organizaƟon in the leŌ column and click Add in the upper-leŌ corner to add an

organizaƟon.
3. Create a name for the added organizaƟon.

Note
Up to 10 levels of organizaƟons can be added.

4. OpƟonal: Perform the following operaƟon(s).

Edit OrganizaƟon Hover the mouse on an added organizaƟon and click  to edit its name.

Delete
OrganizaƟon

Hover the mouse on an added organizaƟon and click  to delete it.

Note
● The lower-level organizaƟons will be deleted as well if you delete an
organizaƟon.

● Make sure there is no person added under the organizaƟon, or the
organizaƟon cannot be deleted.

Show Persons in
Sub OrganizaƟon

Check Show Persons in Sub OrganizaƟon and select an organizaƟon to
show persons in its sub organizaƟons.

16.2 Add a Single Person
You can add persons to the client soŌware one by one. The person informaƟon contains basic
informaƟon, detailed informaƟon, proĮles, access control informaƟon,credenƟals, custom
informaƟon, etc.
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16.2.1 ConĮgure Basic InformaƟon

You can add person to the client one by one and conĮgure the person's basic informaƟon such as
name, email, phone number, etc.

Steps
1. Enter Person module.

Note
For the Įrst Ɵme you enter Person module, a window pops up, and you can set the rules to
generate person ID (leƩers and numbers supported) when adding person. When geƫng person
informaƟon from device, if there are no person IDs, the person IDs will be generated according
to the rule.

2. Select an organizaƟon in the organizaƟon list to add the person.
3. Click Add to open the adding person window.

The Person ID will be generated automaƟcally.
4. Enter the basic informaƟon including person name, telephone number, email address, validity

period, etc.
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Figure 16-1 ConĮgure Basic InformaƟon

Note
● ConĮgure Default Validity Period: Upon compleƟon of the conĮguraƟon, the default validity

period (access control) for any subsequent person will be set to this period.
● Once validity period expired, the credenƟals and access control seƫngs of the person will be

invalid and the person will have no authorizaƟon to access the doors\Ňoors. You can click
Extend to extend the person's validity period for 1 month, 3 months, 6 months, or 1 year.

5. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

6. Delete Registered Face Picture
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Figure 16-2 Delete Registered Picture

Note
If Save Pictures in Structure Data Format is enabled, the Delete Registered Picture buƩon will
be added to the Person page. In general, the registered face picture will be deleted
automaƟcally once the person's informaƟon is applied to the device. By double clicking the
person, the Edit Person window will pop up, and you can check whether the registered face
picture has been deleted. If not, you can select this person and click Delete Registered Picture to
delete the picture manually.

16.2.2 Issue a Card to One Person

When adding a person, you can issue a card to him/her as a credenƟal to access the door(s).
Before issuing a card to one person, you need to set the card issuing mode to get the card number.
Except for manually entering the card number, the client also provides the other two modes for
reading the card number: by local mode (via card enrollment staƟon) or by remote mode (via the
card reader of the access control device).

Note
Up to Įve cards can be issued to one person.

Issue a Card by Entering Card Number

When there is no device (card enrollment staƟon/card reader) available to read card number, you
can issue a card by manually entering card number.
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Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add to enter Add

Person panel.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Card area, click  .

Figure 16-3 Add Card Page
4. Manually enter the card number in the Add page.
5. Click Add.

The card will be issued to the person.

Issue a Card by Local Mode

If a card enrollment staƟon is available, you can issue a card by local mode. To read the card
number, you should connect the card enrollment staƟon to the PC running the client by USB
interface or COM, and place the card on the card enrollment staƟon.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add to enter Add

Person panel.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Card area, click  .
4. Click Seƫngs to enter the Seƫngs page.
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5. Select Local as the card issuing mode.

Figure 16-4 Issue a Card by Local Mode
6. Set other related parameters.

Card Enrollment StaƟon
Select a model of card enrollment staƟon from the drop-down list. You can connect the card
enrollment staƟon to the PC, and transfer the basic informaƟon about the added person
between the two devices through USB.

RF Card Type
When choosing Enrollment StaƟon, you can select the RF card type as EM card, CPU card,
FeliCa card, etc.

Card Type
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This Įeld is only available when the model is DS-K1F100-D8E or DS-K1F180-D8E. Select the
card type as EM card or M1 card according to the actual card type.

Buzzing
Enable or disable the buzzing when the card number is read successfully.

Card No. Type
Select the type of the card number according to actual needs.

M1 Card EncrypƟon
This Įeld is only available when the model is DS-K1F100-D8, DS-K1F100-D8E, or DS-K1F180-
D8E. If the card is M1 card, then you can enable the M1 Card EncrypƟon funcƟon and select
the sector of the card to encrypt.

7. Click OK to conĮrm the operaƟon.
8. Place the card on the card enrollment staƟon, and click Read to get the card number.

The card number will display in the Card No. Įeld automaƟcally.
9. Click Add.

The card will be issued to the person.

Issue a Card by Remote Mode

Except for issuing a card by local mode, you can also swipe the card on the card reader of the
added access control device to get the card number. This is applicable when the client and the
persons need issuing cards are not in the same locaƟon. For example, you can issue cards for
employees in the branch company by remote mode via the client.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add to enter Add

Person panel.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Card area, click  .
4. Click Seƫngs to enter the Seƫngs page.
5. Select Card Reader as the card issuing mode.
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Figure 16-5 Issue a Card by Remote Mode
6. Select an access control device added in the client.
7. Select an added access control device or the enrollment staƟon from the drop-down list.

Note
● If you select access control device, make sure you have armed the devices.
● If you select the enrollment staƟon, you should click Log In to set related parameters of the

device including IP address, port No., user name, and password. Also, you should check RF
card type(s) as needed.

8. Click OK to conĮrm the operaƟon.
9. Place the card on the card reader, and click Read to get the card number.

The card number will display in the Card No. Įeld automaƟcally.
10. Click Add.

The card will be issued to the person.

16.2.3 Upload a Face Photo from Local PC

When adding person, you can upload a face photo stored in local PC to the client as the person's
proĮle.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. Click Add Face in the Basic InformaƟon panel.
4. Select Upload.
5. Select a picture from the PC running the client.
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Note
The picture should be in JPG or JPEG format and smaller than 200 KB.

6. OpƟonal: Enable Verify by Device to check whether the facial recogniƟon device managed in
the client can recognize the face in the photo.

Note
This funcƟon is hidden or shown according to the device capacity.

7. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons .

16.2.4 Take a Photo via Client

When adding a person, you can take a photo of a person by the client integrated camera, USB
camera or enrollment staƟon, and set this photo as the person's proĮle.

Before You Start
Make sure the PC running the client meets one of the following condiƟons:
● The client has a camera.
● You have connected USB camera to the PC.
● You have connected enrollment staƟon to the PC by USB interface.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add to enter Add

Person window.

Note
Enter the person's basic informaƟon Įrst. For details, refer to ConĮgure Basic InformaƟon .

3. Click Add Face in the Basic InformaƟon area.
4. Select Take Photo to enter Take Photo window.
5. Click  to select the integrated camera or enrollment staƟon from the drop-down list.

When enrollment staƟon is selected, live view is supported.
6. OpƟonal: Enable Verify by Device to check whether the captured face photo can meet the

uploading requirements.

Note
This funcƟon is hidden or shown according to the device capacity.

7. Take a photo.
1) Face to the camera and make sure your face is in the middle of the collecƟng window.
2) Click  to capture a face photo.
3) OpƟonal: Click  to capture again.
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4) Click OK to save the captured photo.

Figure 16-6 Captured Photo
8. ConĮrm to add the person.

- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.5 Collect Face via Access Control Device

When adding person, you can collect the person's face via access control device added to the client
which supports facial recogniƟon funcƟon.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. Click Add Face in the Basic InformaƟon panel.
4. Select Remote CollecƟon.
5. Select an added access control device or the enrollment staƟon from the drop-down list.
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Note
If you select the enrollment staƟon, you should click Log In to set related parameters of the
device including IP address, port No., user name, and password. Also, you can check Face AnƟ-
SpooĮng and select the liveness level as Low, Medium, or High. Live view is supported.

Face AnƟ-SpooĮng
If you check this funcƟon, then the device can detect whether the face to be collected is an
authenƟc one.

6. OpƟonal: Click Card Reader, select the card reader ID, click OK.

Note
This funcƟon should be supported by device.

7. Collect face.
1) Face to the camera of the selected access control device and make sure your face is in the

middle of the collecƟng window.
2) Click  to capture a photo.
3) Click OK to save the captured photo.

8. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons .

16.2.6 Collect Fingerprint via Client

CollecƟng Įngerprints locally means you can collect the Įngerprint via the Įngerprint recorder or
the enrollment staƟon connected directly to the PC running the client. The Įngerprints recorded
can be used as credenƟals of the persons to access the authorized doors.

Before You Start
Make sure the PC running the client meets one of the following condiƟons:
● The Įngerprint recorder has been connected to the client.
● The enrollment staƟon has been connected to the client.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Fingerprint panel, click  .
4. In the pop-up window, select the collecƟon mode as Local.
5. Select the model of the connected Įngerprint recorder or the enrollment staƟon.
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Note
If the Įngerprint recorder is DS-K1F800-F, you can click Seƫngs to select the COM the
Įngerprint recorder connects to.

6. Collect the Įngerprint.
1) Click Start.
2) Place and liŌ your Įngerprint on the Įngerprint recorder to collect the Įngerprint.
3) Click Add to save the recorded Įngerprint.

7. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.7 Collect Fingerprint via Access Control Device

When adding person, you can collect Įngerprint informaƟon via the access control device's
Įngerprint module. The Įngerprints recorded can be used as credenƟals of the persons to access
the authorized doors.

Before You Start
Make sure Įngerprint collecƟon is supported by the access control device.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Fingerprint panel, click  .
4. In the pop-up window, select the collecƟon mode as Card Reader.
5. Select an added access control device or the enrollment staƟon from the drop-down list.

Note
If you select the enrollment staƟon, you should click Log In, and set IP address, port No., user
name and password of the device.

6. Collect the Įngerprint.
1) Click Start.
2) Place and liŌ your Įngerprint on the Įngerprint scanner of the selected access control device

to collect the Įngerprint.
3) Click Add to save the recorded Įngerprint.

7. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons .
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16.2.8 Collect Iris via Client

When adding a person, you can collect the iris informaƟon by the iris recorder connected to the
Client via USB. The iris recorded can be used as credenƟals of the persons to access the authorized
doors.

Before You Start
Make sure the iris recorder has been connected to the Client.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Iris panel, click  .
4. In the pop-up window, select the collecƟon mode as USB.
5. Collect the iris.

1) Click Start to recording the iris.
2) Click Add to save the recorded iris.

6. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.9 Collect Iris via Access Control Device

When adding person, you can collect the person's iris informaƟon via access control device which
supports iris recogniƟon funcƟon.

Before You Start
Make sure iris collecƟon is supported by the access control device.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Iris panel, click  .
4. In the pop-up window, select the collecƟon mode as Card Reader.
5. Select an added access control device from the drop-down list.
6. Collect the iris.
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1) Click Start to recording the iris.
2) Click Add to save the recorded iris.

7. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.10 Collect Voiceprint via Access Control Device

When adding person, you can collect voiceprint informaƟon via the access control device's
voiceprint module. The voiceprints recorded can be used as credenƟals of the persons to access
the authorized doors.

Before You Start
Make sure voiceprint collecƟon is supported by the access control device.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Voiceprint panel, click  .
4. In the pop-up window, select the collecƟon mode as Card Reader.
5. Select an added access control device or the enrollment staƟon from the drop-down list.

Note
If you select the enrollment staƟon, you should click Log In, and set IP address, port No., user
name and password of the device.

6. Collect the voiceprint.
1) Click Start.
2) Record the voice on the selected access control device to collect the voiceprint.
3) Click Add to save the recorded voiceprint.

7. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.11 Collect Palm Print via Client

When adding a person, you can collect the palm print by the palm print collector connected to the
Client via USB. The palm print collected can be used as credenƟals of the persons to access the
authorized doors.
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Before You Start
Make sure the palm print collector has been connected to the Client via USB.

Steps
1. Enter Person module.
2. Select an organizaƟon in the leŌ bar to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Palm Print panel, click  .
4. In the pop-up window, select the collecƟon mode as USB.
5. Collect the palm print.

1) Click Start to collect the palm print.
Click Re-Collect when the palm print collecƟon result is unsaƟsfactory.

2) Click Add to save the palm print.

16.2.12 Collect Palm Print via Access Control Device

When adding person, you can collect the person's palm print via the access control device
supporƟng palm print collecƟon. This is suitable for scenarios where the person being collected
and the operator are in diīerent locaƟons, or where the palm print collector is Įxed and cannot be
connected to a computer via USB.

Before You Start
Make sure the access control device supporƟng palm print collecƟon has been added to the Client.

Steps
1. Enter Person module.
2. Select an organizaƟon in the leŌ bar and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the CredenƟal → Palm Print panel, click  .
4. In the pop-up window, select the collecƟon mode as Card Reader.
5. Select an added access control device from the drop-down list.
6. Collect the palm print.

1) Click Start to collect the palm print.
Click Re-Collect when the palm print collecƟon result is unsaƟsfactory.

2) Click Add to save the palm print.
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16.2.13 ConĮgure Access Control InformaƟon

When adding a person, you can set her/his access control informaƟon, such as binding an access
control group with the person, conĮguring PIN code, seƫng the person as a visitor, a blocklist
person, or a super user, etc.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.
3. In the Access Control area, click  to select access group(s) for the person.

Note
For details, refer to Assign Access Levels to Persons in Access Groups .

Figure 16-7 ConĮgure Access Control InformaƟon
4. Set a unique PIN code for the person which can be used for access authenƟcaƟon.

- Manually enter a PIN code containing 4 to 8 digits.

Note
Persons' PIN codes cannot be repeated.
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- Click Generate to randomly generate an unrepeated PIN code of 6 digits.

Note
If there are repeated PIN codes, a prompt will pop up on the client. The admin can generate a
new PIN code to replace the repeated PIN code and noƟfy related persons.

5. Check the person's operaƟon permissions.
Super User

If the person is set as a super user, he/she will have authorizaƟon to access all the doors/
Ňoors and will be exempted from remaining closed restricƟons, all anƟ-passback rules, and
Įrst person authorizaƟon.

Extended Door Open Time
Use this funcƟon for persons with reduced mobility. When accessing the door, the person will
have more Ɵme than others to pass through doors.
For details about seƫng the door's open duraƟon, refer to ConĮgure Parameters for Door/
Elevator .

Add to Blocklist
Add the person to the blocklist and when the person tries to access doors/Ňoors, an event
will be triggered and sent to the client to noƟfy the security personnel.

Mark as Visitor
If the person is a visitor, you should set the her/his valid Ɵmes for visit.

Note
The valid Ɵmes for visit is between 1 and 100. You can also check No Limit, then there are no
limited Ɵmes for the visitor to access doors/Ňoors.

Device Operator
For person with device operator role, he/she is authorized to operate on the access control
devices.

Custom
Custom person type for speciĮc requirements.

6. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.

16.2.14 Customize Person InformaƟon

You can customize the person properƟes which are not pre-deĮned in the client according to actual
needs, e.g., place of birth. AŌer customizing, when add a person, you can enter the custom
informaƟon to make the person informaƟon complete.
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Steps
1. Enter Person module.
2. Set the Įelds of custom informaƟon.

1) Click Custom Property.
2) Click Add to add a new property.
3) Enter the property name.
4) Click OK.

3. Set the custom informaƟon when adding a person.
1) Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

2) In the Custom InformaƟon panel, enter the person informaƟon.
3) Click Add to add the person and close the Add Person window, or click Add and New to add

the person and conƟnue to add other persons.

16.2.15 ConĮgure Resident InformaƟon

If the person is resident, for video intercom purpose, you need to set the room number for
her/him and bind an indoor staƟon. AŌer bound, you can call this person by calling the indoor
staƟon and perform video intercom with her/him.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the Resident InformaƟon panel, select the indoor staƟon to bind it to the person.

Note
If you select Analog Indoor StaƟon, the Door StaƟon Įeld will display and you are required to
select the door staƟon to communicate with the analog indoor staƟon.

4. Enter the Ňoor No. and room No. of the person.
5. ConĮrm to add the person.

- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons.
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16.2.16 ConĮgure AddiƟonal InformaƟon

When adding person, you can conĮgure the addiƟonal informaƟon for the person, such as person's
idenƟty type, idenƟty No., country, etc., according to actual needs.

Steps
1. Enter Person module.
2. Select an organizaƟon in the organizaƟon list to add the person and click Add.

Note
Enter the person's basic informaƟon Įrst. For details about conĮguring person's basic
informaƟon, refer to ConĮgure Basic InformaƟon .

3. In the AddiƟonal InformaƟon panel, enter the addiƟonal informaƟon of the person, including
person's ID type, ID No., job Ɵtle, etc., according to actual needs.

4. ConĮrm to add the person.
- Click Add to add the person and close the Add Person window.
- Click Add and New to add the person and conƟnue to add other persons .

16.3 Import and Export Person IdenƟfy InformaƟon
You can import the informaƟon and pictures of mulƟple persons to the client soŌware in a batch.
Meanwhile, you can also export the person informaƟon and pictures and save them in your PC.

16.3.1 Import Person InformaƟon

You can enter the informaƟon of mulƟple persons in a predeĮned template (CSV/Excel Įle) to
import the informaƟon to the client in a batch.

Steps
1. Enter the Person module.
2. Select an added organizaƟon in the list, or click Add in the upper-leŌ corner to add an

organizaƟon and then select it.
3. Click Import to open the Import panel.
4. Select Person InformaƟon as the imporƟng mode.
5. Click Download Template for ImporƟng Person to download the template.
6. Enter the person informaƟon in the downloaded template.

Note
● If the person has mulƟple cards, separate the card No. with semicolon.
● Items with asterisk are required.
● By default, the Hire Date is the current date.

7. Click  to select the CSV/Excel Įle with person informaƟon from local PC.
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8. Click Import to start imporƟng.

Note
● If a person No. already exists in the client's database, delete the exisƟng informaƟon before
imporƟng.

● You can import informaƟon of no more than 2,000 persons.

16.3.2 Import Person Pictures

AŌer imporƟng face pictures for the added persons to the client, the persons in the pictures can be
idenƟĮed by an added face recogniƟon terminal. You can either import person pictures one by
one, or import mulƟple pictures at a Ɵme according to your need.

Before You Start
Be sure to have imported person informaƟon to the client beforehand.

Steps
1. Enter the Person module.
2. Select an added organizaƟon in the list, or click Add in the upper-leŌ corner to add an

organizaƟon and then select it.
3. Click Import to open the Import panel and check Face.
4. OpƟonal: Enable Verify by Device to check whether face recogniƟon device managed in the

client can recognize the face in the photo.
5. Click  to select a face picture Įle.

Note
● The (folder of) face pictures should be in ZIP format.
● Each picture Įle should be in JPG format and should be no larger than 200 KB.
● Each picture Įle should be named as "Person ID_Name". The Person ID should be the same

with that of the imported person informaƟon.
6. Click Import to start imporƟng.

The imporƟng progress and result will be displayed.

16.3.3 Export Person InformaƟon

You can export the added persons' informaƟon to local PC as a CSV/Excel Įle.

Before You Start
● Make sure you have added persons to an organizaƟon.
● Make sure you have enabled the Export Person InformaƟon funcƟon to display the Export
buƩon. See Set General Parameters for details.

Steps
1. Enter the Person module.
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2. OpƟonal: Select an organizaƟon in the list.

Note
All persons' informaƟon will be exported if you do not select any organizaƟon.

3. Click Export.
4. Enter the super user name and password for veriĮcaƟon.

The Export panel is displayed.
5. Check Person InformaƟon as the content to export.
6. Check desired items to export.
7. Click Export to save the exported Įle in CSV/Excel Įle on your PC.

16.3.4 Export Person Pictures

You can export face picture Įle of the added persons and save in your PC.

Before You Start
● Make sure you have added persons and their face pictures to an organizaƟon.
● Make sure you have enabled the Export Person InformaƟon funcƟon to display the Export
buƩon. See Set General Parameters for details.

Steps
1. Enter the Person module.
2. OpƟonal: Select an organizaƟon in the list.

Note
All persons' face pictures will be exported if you do not select any organizaƟon.

3. Click Export on the top menu bar.
4. Enter the super user name and password for veriĮcaƟon.

The Export panel is displayed.
5. Check Face as the content to export.
6. Click Export and set an encrypƟon key to encrypt the exported Įle.

Note
● The exported Įle is in ZIP format.
● The exported face picture is named as "Person ID_Name_0" ("0" is for a full-frontal face).

16.4 Get Person InformaƟon from Access Control Device
If the access control device has been conĮgured with person informaƟon (including person details,
Įngerprint, and issued card informaƟon), you can get the person informaƟon from the added
device and import them to the client for further operaƟons.
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Steps

Note
● If the person name stored in the device is empty, the person name will be Įlled with the issued

card No. aŌer imporƟng to the client.
● Persons will be Male by default.
● If the card number or person ID (employee ID) stored on the device already exists in the client

database, the person with this card number or person ID will not be imported to the client.

1. Enter Person module.
2. Select an organizaƟon to import the persons.
3. Click Get from Device.
4. Select an added access control device or the enrollment staƟon from the drop-down list.

Note
If you select the enrollment staƟon, you should click Login, and enter IP address, port No., user
name and password of the device.

5. Select the Geƫng Mode.

Note
The geƫng mode varies according to diīerent devices. The access control device supports
geƫng the person informaƟon by employee ID. Up to 5 employee IDs can be speciĮed each
Ɵme.

6. Click Import to start imporƟng the person informaƟon to the client.

Note
Up to 2,000 persons and 5,000 cards can be imported.

The person informaƟon, including person details, person's Įngerprint informaƟon (if
conĮgured), and the linked cards (if conĮgured), will be imported to the selected organizaƟon.

16.5 Move Persons to Another OrganizaƟon
You can move the added persons to another organizaƟon if you need.

Before You Start
● Make sure you have added at least two organizaƟons.
● Make sure you have imported person informaƟon.

Steps
1. Enter Person module.
2. Select an organizaƟon in the leŌ panel.

The persons under the organizaƟon will be displayed in the right panel.
3. Select the person to move.
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4. Click Change OrganizaƟon.
5. Select the organizaƟon to move persons to.
6. Click OK.

16.6 Batch Edit Persons' Validity Period
Supports batch modiĮcaƟon of validity periods for mulƟple personnel in the personnel list.

Before You Start
You have added persons.

Steps
1. Go to the Person page.
2. Select mulƟple personnel and click Edit Validity Period.
3. Extend the validity period or reset it as needed.
4. AŌer saving, double-click any personnel row to check updated validity.

16.7 Batch Issue Cards to Persons
The client provides a convenient way to issue cards to mulƟple persons in a batch.

Steps
1. Enter Person module.
2. OpƟonal: Select a person group, and select the persons with no card issued.

● The selected persons with no card issued in the person group will be displayed in the right
panel.

● If you do not select the persons with no card issued in a person group, all the added persons
with no card issued will be displayed in the right panel.

3. Click Batch Issue Cards.
4. OpƟonal: Enter key words (name or person ID) in the input box to Įlter the person(s) that need

issuing cards.
5. OpƟonal: Click Seƫngs to set the card issuing parameters. For details, refer to Issue a Card to

One Person .
6. Click IniƟalize to iniƟalize the card enrollment staƟon or card reader to make it ready for issuing

cards.
7. Click the Card No. column and enter the card number.

- Place the card on the card enrollment staƟon.
- Swipe the card on the card reader.
- Manually enter the card number and press the Enter key.
The person(s) in the list will be issued with card(s).
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16.8 Report Card Loss
If the person lost his/her card, you can report the card loss so that the card's related access
authorizaƟon will be inacƟve.

Steps
1. Enter Person module.
2. Select the person you want to report card loss for and click Edit to open the Edit Person window.
3. In the CredenƟal → Card panel, click  on the added card to set this card as lost card.

AŌer reporƟng card loss, the access authorizaƟon of this card will be invalid and inacƟve. Other
person who gets this card cannot access the doors by swiping this lost card.

4. OpƟonal: If the lost card is found, you can click  to cancel the loss.
AŌer cancelling card loss, the access authorizaƟon of the person will be valid and acƟve.

5. If the lost card is added in one access group and the access group is applied to the device
already, aŌer reporƟng card loss or cancelling card loss, a window will pop up to noƟfy you to
apply the changes to the device. AŌer applying to device, these changes can take eīect on the
device.

16.9 View Resource StaƟsƟcs
AŌer applying persons and access control credenƟals (including faces, cards, irises, Įngerprints,
voiceprints, and palm prints) to device, you can view resource staƟsƟcs on client and on device to
know whether the resources have been successfully applied.

You have applied persons and credenƟals to device. For details, refer to Assign Access Levels to
Persons in Access Groups .
Click Person Management → Resource StaƟsƟcs to enter Resource StaƟsƟcs window.
In Overview on Device area, select a device from drop-down list, and click CounƟng to view device
resources. By comparing resources on client and that on device, you can know whether the client
resources have been applied to device.

Note
This funcƟon should be supported by device. If the device does not support face or Įngerprint, a
prompt will pop up on the boƩom right corner of the PC desktop.
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Chapter 17 Access Control

The Access Control module is applicable to access control devices and video intercom device. It
provides mulƟple funcƟonaliƟes, including access group conĮguraƟon, video intercom, and other
advanced funcƟons.

Note
For the user with access control module permissions, the user can enter the Access Control
module and conĮgure the access control seƫngs. For seƫng the user permission of Access Control
module, refer to Add User .

17.1 Flow Chart

Figure 17-1 Flow Chart of Access Control
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● Add Access Control Device: You can add access control devices on the client. For more details,
refer to Add Device .

● Group Access Points: You can group the added access points into groups for convenient
management. For more details, refer to Group Management .

● Add OrganizaƟon: You can add an organizaƟon and import person informaƟon to the
organizaƟon for managing persons. For more details, refer to Add OrganizaƟon .

● ConĮgure Schedule and Template: You can conĮgure the template including holiday and week
schedule. For more details, refer to ConĮgure Schedule and Template .

● Set Access Group and Access Authority: You can set an access group to deĮne which person(s)
can get access to which door(s) and then apply the access group to the access control device to
take eīect. For more details, refer to Assign Access Levels to Persons in Access Groups .

● ConĮgure Device Parameters: You can conĮgure parameters for the access control device,
including device Ɵme, linkage seƫngs, maintenance seƫngs, etc. For more details, refer to
ConĮgure Access Control Parameters .

● ConĮgure Remaining Open/Closed: You can set the status of the door as open or closed and set
the elevator controller as free and controlled. For more details, refer to ConĮgure Remaining
Unlocked/Locked .

● ConĮgure Card Reader AuthenƟcaƟon Mode: You can set the passing rules for the card reader
of the access control device according to your actual needs. For more details, refer to ConĮgure
Card Reader AuthenƟcaƟon Mode and Schedule .

● ConĮgure Individual AuthenƟcaƟon Mode: You can set the passing rules for person to the
speciĮed the access control device according to your actual needs. For more details, refer to
ConĮgure Person AuthenƟcaƟon Mode .

● ConĮgure Other Parameters: You can set parameters for access control devices such as network
parameters, capture parameters, RS-485 parameters, Wiegand parameters, etc. For more details,
refer to ConĮgure Other Parameters .

● ConĮgure Linkage AcƟons: You can conĮgure linkage acƟon for access control, so that the
events can trigger a series of linkage acƟons to noƟfy the security personnel. For more details,
refer to ConĮgure Linkage AcƟons for Access Control .

● Door/Elevator Control: You can view the real-Ɵme status of the doors or elevators managed by
the added access control device. For more details, refer to Door/Elevator Control .

17.2 ConĮgure Schedule and Template
You can conĮgure the template including holiday and week schedule. AŌer seƫng the template,
you can adopt the conĮgured template to access groups when seƫng the access groups, so that
the access group will take eīect in the Ɵme duraƟons of the template.

Note
For access group seƫngs, refer to Assign Access Levels to Persons in Access Groups .
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17.2.1 Add Holiday

You can create holidays and set the days in the holidays, including start date, end date, and holiday
duraƟon in one day.

Steps

Note
You can add up to 64 holidays in the soŌware system.

1. Click Access Control → Schedule → Holiday to enter the Holiday page.
2. Click Add on the leŌ panel.
3. Create a name for the holiday.
4. OpƟonal: Enter the descripƟons or some noƟĮcaƟons of this holiday in the Remark box.
5. Add a holiday period to the holiday list and conĮgure the holiday duraƟon.

Note
Up to 16 holiday periods can be added to one holiday.

1) Click Add in the Holiday List Įeld.
2) Drag the cursor to draw the Ɵme duraƟon, which means in that duraƟon of Ɵme, the

conĮgured access group is acƟvated.

Note
Up to 8 Ɵme duraƟons can be set to one holiday period.

3) OpƟonal: Perform the following operaƟons to edit the Ɵme duraƟons.
● Move the cursor to the Ɵme duraƟon and drag the Ɵme duraƟon on the Ɵmeline bar to the

desired posiƟon when the cursor turns to  .
● Click the Ɵme duraƟon and directly edit the start/end Ɵme in the appeared dialog.
● Click the Ɵme duraƟon, check Enable AuthenƟcaƟon AƩempts and enter the max.
authenƟcaƟon aƩempts.

● Move the cursor to the start or the end of Ɵme duraƟon and drag to lengthen or shorten
the Ɵme duraƟon when the cursor turns to  .

4) OpƟonal: Select the Ɵme duraƟon(s) that need to be deleted, and then click  in the
OperaƟon column to delete the selected Ɵme duraƟon(s).

5) OpƟonal: Click  in the OperaƟon column to clear all the Ɵme duraƟon(s) in the Ɵme bar.
6) OpƟonal: Click  in the OperaƟon column to delete this added holiday period from the

holiday list.
6. Click Save.
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17.2.2 Add Schedule Template

Template includes week schedule and holiday. You can set week schedule and assign the Ɵme
duraƟon of access authorizaƟon for diīerent person or group. You can also select the added
holiday(s) for the template.

Steps

Note
You can add up to 255 templates in the soŌware system.

1. Click Access Control → Schedule Template → Schedule Template to enter the Template page.

Note
There are two default templates: All-Day Authorized and All-Day Denied, and they cannot be
edited or deleted.
All-Day Authorized

The access authorizaƟon is valid in each day of the week and it has no holiday.
All-Day Denied

The access authorizaƟon is invalid in each day of the week and it has no holiday.

2. Click Add on the leŌ panel to create a new template.
3. Create a name for the template.
4. Enter the descripƟons or some noƟĮcaƟon of this template in the Remark Įeld.
5. Edit the week schedule to apply it to the template.

1) Click Week Schedule tab on the lower panel.
2) Select a day of the week and draw Ɵme duraƟon(s) on the Ɵmeline bar.

Note
Up to 8 Ɵme duraƟon(s) can be set for each day in the week schedule.

3) OpƟonal: Perform the following operaƟons to edit the Ɵme duraƟons.
● Move the cursor to the Ɵme duraƟon and drag the Ɵme duraƟon on the Ɵmeline bar to the

desired posiƟon when the cursor turns to  .
● Click the Ɵme duraƟon and directly edit the start/end Ɵme in the appeared dialog.
● Click the Ɵme duraƟon, check Enable AuthenƟcaƟon AƩempts and enter the max.
authenƟcaƟon aƩempts.

● Move the cursor to the start or the end of Ɵme duraƟon and drag to lengthen or shorten
the Ɵme duraƟon when the cursor turns to  .

4) Repeat the two steps above to draw more Ɵme duraƟons on the other days of the week.
6. Add a holiday to apply it to the template.
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Note
Up to 4 holidays can be added to one template.

1) Click Holiday tab.
2) Select a holiday in the leŌ list and it will be added to the selected list on the right panel.
3) OpƟonal: Click Add to add a new holiday.

Note
For details about adding a holiday, refer to Add Holiday .

4) OpƟonal: Select a selected holiday in the right list and click  to remove the selected one, or
click Clear to clear all the selected holiday(s) in the right list.

7. Click Save to save the seƫngs and Įnish adding the template.

17.3 Assign Access Levels to Persons in Access Groups
AŌer adding the person and conĮguring the person's credenƟals, you can create the access groups
to deĮne which person(s) can get access to which door(s) and then apply the access group to the
access control device to take eīect.

Before You Start
● Add person to the client.
● Add access control device to the client and group access points. For details, refer to Group

Management .
● Add template.

Steps
When the access group seƫngs are changed, you need to apply the access groups to the devices
again to take eīect. The access group changes include changes of template, access group seƫngs,
person's access group seƫngs, and related person details (including card number, Įngerprint, face
picture, iris, voice print, palm print, linkage between card number and Įngerprint, card password,
card eīecƟve period, etc).
1. Click Access Control → AuthorizaƟon → Access Group to enter the Access Group interface.
2. Click Add to open the Add window.
3. In the Name text Įeld, create a name for the access group as you want.
4. Select a template for the access group.

Note
You should conĮgure the template before access group seƫngs. Refer to ConĮgure Schedule
and Template for details.

5. In the leŌ list of the Select Person Įeld, select person(s) to assign access authority.
6. In the leŌ list of the Select Access Point Įeld, select door(s), door staƟon(s) or Ňoor(s) for the

selected persons to access.
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7. Click Save.

Note
Up to 50 access groups can be added.

You can view the selected person(s) and the selected access point(s) on the right side of the
interface.

Figure 17-2 Display the Selected Person(s) and Access Point(s)
8. AŌer adding the access groups, you need to apply them to the access control device to take

eīect.
1) Select the access group(s) to apply to the access control device.
2) Click Apply All to Devices start applying all the selected access group(s) to the access control

device or door staƟon.
3) Click Apply All to Devices or Apply Changes to Devices.

Apply All to Devices
This operaƟon will clear all the existed access groups of the selected devices and then
apply the new access group to the device.

Apply Changes to Devices
This operaƟon will not clear the existed access groups of the selected devices and only
apply the changed part of the selected access group(s) to the device(s).

4) View the applying status in the Status column or click Applying Status to view all the applied
access group(s).
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Note
You can check Display Failure Only to Įlter the applying results.

The selected persons in the applied access groups will have the authorizaƟon to enter/exit the
selected doors/door staƟons with their linked card(s) or Įngerprints.

9. OpƟonal: Click  to edit the access group if necessary.

Note
If you change the persons' access informaƟon or other related informaƟon, you will view the
prompt Access Group to Be Applied on the right corner of the client.
You can click the prompt to apply the changed data to the device. You can select either Apply
Now or Apply Later.

Figure 17-3 Data SynchronizaƟon

17.4 Search Access Group
AŌer seƫng access group and assigning access authority to persons, you can search the access
group that the person belongs to and view other related informaƟon including credenƟal No.,
credenƟal type, applying status, etc.

Note
Make sure you have set access group to assign access authorizaƟon to designed persons and
applied it. For details, refer to Assign Access Levels to Persons in Access Groups .

Click Access Control → AuthorizaƟon → Search . Select a device name, and set search condiƟon
(including person name and applying status, opƟonal), and then click Search.
You can view the applicaƟon staƟsƟcs of the access group which counƟng the applied person
informaƟon and credenƟals, and view other informaƟon on the list including the credenƟal type,
door name, credenƟal No., applying status, remark, etc.
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17.5 ConĮgure Advanced FuncƟons
You can conĮgure the advanced funcƟons of access control to meet some special requirements in
diīerent scene, such as mulƟ-factor authenƟcaƟon, anƟ-passback, etc.

Note
● For the card related funcƟons(the type of access control card/mulƟ-factor authenƟcaƟon), only

the card(s) with access group applied will be listed when adding cards.
● The advanced funcƟons should be supported by the device.
● Hover the cursor on the Advanced FuncƟon, and then Click  to customize the advanced
funcƟon(s) to be displayed.

17.5.1 ConĮgure Access Control Parameters

AŌer adding the access control device, you can conĮgure the parameters of access control device
(access controller), access control points (door or Ňoor), alarm inputs, alarm outputs, card readers
and lane controller.

ConĮgure Parameters for Access Control Device

AŌer adding the access control device, you can conĮgure its parameters, including overlaying user
informaƟon on picture, uploading pictures aŌer capturing, saving captured pictures, etc.

Before You Start
Add access control device to the client.

Steps
1. Click Access Control → Advanced FuncƟon → Device Parameter .

Note
If you can not Įnd Device Parameter in the Advanced FuncƟon list, hover the cursor on the
Advanced FuncƟon, and then Click  to select the Device Parameter to be displayed.

2. Select an access device to show its parameters on the right page.
3. Turn the switch to ON to enable the corresponding funcƟons.

Note
● The displayed parameters may vary for diīerent access control devices.
● Some of the following parameters are not listed in the Basic InformaƟon page, click More to

edit the parameters.

RS-485 Comm. Redundancy
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You should enable this funcƟon if you wire the RS-485 card reader to the access control
device redundantly.

Fingerprint RecogniƟon Mode
RecogniƟon on Card Reader

The Įngerprint storage and comparison are performed on the card reader.
RecogniƟon on Access Controller

The Įngerprint storage and comparison are performed on the access controller.

Note
The Įngerprint data for the two modes are not compaƟble. You need to reapply the data
when switching modes.

Display Detected Face
Display face picture when authenƟcaƟng.

Display Card Number
Display the card informaƟon when authenƟcaƟng.

Display Person InformaƟon
Display the person informaƟon when authenƟcaƟng.

Overlay Person Info. on Picture
Display the person informaƟon on the captured picture.

Voice Prompt
If you enable this funcƟon, the voice prompt is enabled in the device. You can hear the voice
prompt when operaƟng in the device.

Upload Pic. AŌer Linked Capture
Upload the pictures captured by linked camera to the system automaƟcally.

Save Pic. AŌer Linked Capture
If you enable this funcƟon, you can save the picture captured by linked camera to the device.

Press Key to Enter Card Number
If you enable this funcƟon, you can input the card No. by pressing the key.

Wi-Fi Probe
If you enable this funcƟon, the device can probe the surrounding communicaƟon devices'
MAC address and upload the MAC address to the system. If the MAC address match the
speciĮed MAC address, the system can trigger some linkage acƟons.

3G/4G
If you enable this funcƟon, the device can communicate in 3G/4G network.

NFC AnƟ-Cloning
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If you enable this funcƟon, you cannot use the cloned card for authenƟcaƟon and further
enhance security.

4. Click OK.
5. OpƟonal: Click Copy to, and then select the access control device(s) to copy the parameters in

the page to the selected device(s).

ConĮgure Parameters for Door/Elevator

AŌer adding the access control device, you can conĮgure its access point (door or Ňoor)
parameters.

Before You Start
Add access control device to the client.

Steps
1. Click Access Control → Advanced FuncƟon → Device Parameter .
2. Select an access control device on the leŌ panel, and then click  to show the doors or Ňoors of

the selected device.
3. Select a door or Ňoor to show its parameters on the right page.
4. Edit the door or Ňoor parameters.

Note
● The displayed parameters may vary for diīerent access control devices.
● Some of the following parameters are not listed in the Basic InformaƟon page, click More to

edit the parameters.

Name
Edit the card reader name as desired.

Door Contact
You can set the door sensor as remaining closed or remaining open. Usually, it is remaining
closed.

Exit BuƩon Type
You can set the exit buƩon as remaining closed or remaining open. Usually, it is remaining
open.

Door Locked Time
AŌer swiping the normal card and relay acƟon, the Ɵmer for locking the door starts working.

Extended Open DuraƟon
The door contact can be enabled with appropriate delay aŌer person with extended accesss
needs swipes her/his card.

Door LeŌ Open Timeout Alarm

iVMS-4200 V3.13.1 User Manual

286



The alarm can be triggered if the door has not been closed in a conĮgured Ɵme period. If it is
set as 0, no alarm will be triggered.

Lock Door when Door Closed
The door can be locked once it is closed even if the Door Locked Time is not reached.

Duress Code
The door can open by inpuƫng the duress code when there is duress. At the same Ɵme, the
client can report the duress event.

Super Password
The speciĮc person can open the door by inpuƫng the super password.

Dismiss Code
Create a dismiss code which can be used to stop the buzzer of the card reader (by entering
the dismiss code on the keypad).

Remind Before Locking Door
Remind users that the door is about to close.

Reminder
Set the Ɵme (seconds) to warn users that the door is about to close. It should be less than the
Open duraƟon and Extended Open DuraƟon.

Passing DetecƟon
Check whether the door has been pushed open or used aŌer the door lock is opened. If it has
not been pushed open or used, an event will be uploaded.

Note
● The duress code, super code, and dismiss code should be diīerent.
● The duress code, super password, and the dismiss code should be diīerent from the
authenƟcaƟon password.

● The length of duress code, super password, and the dismiss code is according the device,
usually it should contains 4 to 8 digits.

5. Click OK.
6. OpƟonal: Click Copy to , and then select the door/Ňoor(s) to copy the parameters in the page to

the selected doors/Ňoor(s).

Note
The door or Ňoor's status duraƟon seƫngs will be copied to the selected door/Ňoor(s) as well.

ConĮgure Parameters for Card Reader

AŌer adding the access control device, you can conĮgure its card reader parameters.

Before You Start
Add access control device to the client.
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Steps
1. Click Access Control → Advanced FuncƟon → Device Parameter .
2. In the device list on the leŌ, click  to expand the door, select a card reader and you can edit the

card reader's parameters on the right.
3. Edit the card reader basic parameters in the Basic InformaƟon page.

Note
● The displayed parameters may vary for diīerent access control devices. There are part of

parameters listed as follows. Refer to the user manual of the device for more details.
● Some of the following parameters are not listed in the Basic InformaƟon page, click More to

edit the parameters.

Name
Edit the card reader name as desired.

OK LED Polarity/Error LED Polarity/Buzzer Polarity
Set OK LED Polarity/Error LED Polarity/Buzzer LED Polarity of main board according to the
card reader parameters. Generally, adopts the default seƫngs.

Minimum Card Swiping Interval
If the interval between card swiping of the same card is less than the set value, the card
swiping is invalid. You can set it as 0 to 255.

Repeated AuthenƟcaƟon Interval
Within the speciĮed interval, repeated authenƟcaƟon of the same card number (uploaded by
diīerent devices) is invalid, and only one authenƟcaƟon is performed. You can set it as 0 to
65535 seconds.

Max. Interval When Entering PWD
When you inpuƫng the password on the card reader, if the interval between pressing two
digits is larger than the set value, the digits you pressed before will be cleared automaƟcally.

Alarm of Max. Failed AƩempts
Enable to report alarm when the card reading aƩempts reach the set value.

Max. Times of Card Failure
Set the max. failure aƩempts of reading card.

Tampering DetecƟon
Enable the anƟ-tamper detecƟon for the card reader.

Communicate with Controller Every
When the access control device cannot connect with the card reader for longer than the set
Ɵme, the card reader will turn oŋine automaƟcally.

Buzzing Time
Set the card reader buzzing Ɵme. The available Ɵme ranges from 0 to 5,999s. 0 represents
conƟnuous buzzing.
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Card Reader Type/Card Reader DescripƟon
Get card reader type and descripƟon. They are read-only.

Fingerprint RecogniƟon Level
Select the Įngerprint recogniƟon level in the drop-down list.

Default Card Reader AuthenƟcaƟon Mode
View the default card reader authenƟcaƟon mode.

Fingerprint Capacity
View the maximum number of available Įngerprints.

ExisƟng Fingerprint Number
View the number of existed Įngerprints in the device.

Score
The device will score the captured picture according to the yaw angle, pitch angle, and
pupillary distance. If the score is less than the conĮgured value, face recogniƟon will be failed.

Face RecogniƟon Timeout Value
If the recogniƟon Ɵme is more than the conĮgured Ɵme, the device will remind you.

Face RecogniƟon Interval
The Ɵme interval between two conƟnuous face recogniƟons when authenƟcaƟng. By default,
it is 2s.

Face 1:1 Matching Threshold
Set the matching threshold when authenƟcaƟng via 1:1 matching mode. The larger the value,
the smaller the false accept rate and the larger the false rejecƟon rate when authenƟcaƟon.

1:N Security Level
Set the matching security level when authenƟcaƟng via 1:N matching mode. The larger the
value, the smaller the false accept rate and the larger the false rejecƟon rate when
authenƟcaƟon.

Live Face DetecƟon
Enable or disable the live face detecƟon funcƟon. If enabling the funcƟon, the device can
recognize whether the person is a live one or not.

Live Face DetecƟon Security Level
AŌer enabling Live Face DetecƟon funcƟon, you can set the matching security level when
performing live face authenƟcaƟon.

Max. Failed AƩempts for Face Auth.
Set the maximum live face detecƟon failed aƩempts. The system will lock the user's face for 5
minutes if the live face detecƟon is failed for more than the conĮgured aƩempts. The same
user cannot authenƟcate via the fake face within 5 minutes. Within the 5 minutes, the user
can authenƟcate via the real face twice conƟnuously to unlock.

Lock AuthenƟcaƟon Failed Face
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AŌer enabling the Live Face DetecƟon funcƟon, the system will lock the user's face for 5
minutes if the live face detecƟon is failed for more than the conĮgured aƩempts. The same
user cannot authenƟcate via the fake face within 5 minutes. Within the 5 minutes, the user
can authenƟcate via the real face twice conƟnuously to unlock.

ApplicaƟon Mode
You can select indoor or others applicaƟon modes according to actual environment.

4. Click OK.
5. OpƟonal: Click Copy to, and then select the card reader(s) to copy the parameters in the page to

the selected card reader(s).

ConĮgure Parameters for Alarm Input

AŌer adding the access control device, you can conĮgure the parameters for its alarm inputs.

Before You Start
Add access control device to the client, and make sure the device supports alarm input.

Steps

Note
If the alarm input is armed, you cannot edit its parameters. Disarm it Įrst.

1. Click Access Control → Advanced FuncƟon → Device Parameter .
2. In the device list on the leŌ, click  to expand the door, select an alarm input and you can edit

the alarm input's parameters on the right.
3. Set the alarm input parameters.

Name
Edit the alarm input name as desired.

Detector Type
The detector type of the alarm input.

Zone Type
Set the zone type for the alarm input.

SensiƟvity
Only when the duraƟon of signal detected by the detector reaches the seƫng Ɵme, the alarm
input is triggered. For example, you have set the sensiƟvity as 10ms, only when the duraƟon
of signal detected by the detector reach 10ms, this alarm input is triggered.

Trigger Alarm Output
Select the alarm output(s) to be triggered.

4. Click OK.
5. OpƟonal: Click the switch on the upper-right corner to arm or disarm the alarm input.
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ConĮgure Parameters for Alarm Output

AŌer adding the access control device, if the device links to alarm outputs, you can conĮgure the
parameters.

Before You Start
Add access control device to the client, and make sure the device supports alarm output.

Steps
1. Click Access Control → Advanced FuncƟon → Device Parameter to enter access control

parameter conĮguraƟon page.
2. In the device list on the leŌ, click  to expand the door, select an alarm input and you can edit

the alarm input's parameters on the right.
3. Set the alarm output parameters.

Name
Edit the card reader name as desired.

Alarm Output AcƟve Time
How long the alarm output will last aŌer triggered.

4. Click OK.
5. OpƟonal: Set the switch on the upper right corner to ON to trigger the alarm output.

ConĮgure Parameters for Lane Controller

AŌer adding the lane controller to the client, you can conĮgure its parameters for passing through
the lane.

Before You Start
Add access control device to the client.

Steps
1. Click Access Control → Advanced FuncƟon → Device Parameter to enter Parameter Seƫngs

page.
2. In the device list on the leŌ, select a lane controller and you can edit the lane controller's

parameters on the right.
3. Edit the parameters.

Passing Mode
Select the controller which will control the barrier status of the device.
● If you select According to Lane Controller's DIP Seƫngs, the device will follow the lane

controller's DIP seƫngs to control the barrier. The seƫngs on the soŌware will be invalid.
● If you select According to Main Controller's Seƫngs, the device will follow the seƫngs of

the soŌware to control the barrier. The DIP seƫngs of the lane controller will be invalid.
Free Passing AuthenƟcaƟon
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If you enable this funcƟon, when both entrance and exit's barrier mode is Remain Open, the
pedestrians should authenƟcate each Ɵme passing through the lane. Or an alarm will be
triggered.

Opening/Closing Barrier Speed
Set the barrier's opening and closing speed. You can select from 1 to 10. The greater the
value, the faster the speed.

Note
The recommended value is 6.

Audible Prompt DuraƟon
Set how long the audio will last, which is played when an alarm is triggered .

Note
0 refers to the alarm audio will be played unƟl the alarm is ended.

Temperature Unit
Select the temperature unit that displayed in the device status.

4. Click OK.

17.5.2 ConĮgure Remaining Unlocked/Locked

You can set the status of the door as unlocked or locked and set the elevator controller as free and
controlled. For example, you can set the door remaining locked in the holiday, and set the door
remaining unlocked in the speciĮed period of the work day.

Before You Start
Add the access control devices to the system.

Steps
1. Click Access Control → Advanced FuncƟon → Remain Locked/Unlocked to enter the Remain

Locked/Unlocked page.
2. Select the door or elevator controller that need to be conĮgured on the leŌ panel.
3. To set the door or elevator controller status during the work day, click the Week Schedule and

perform the following operaƟons.
1) For door, click Remain Unlocked, Remain Locked, InducƟve Mode, or Barrier-Free Mode.
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Note
● InducƟve Mode: The door opening and closing is triggered by infrared inducƟon of human

body.
● Barrier-Free Mode: When a large number of people need to pass the door, the door will

remain open (without frequent authenƟcaƟon) if the person and ID comparison succeeds.
Only when the person and ID comparison fails, the door will be closed.

● InducƟve mode and barrier-free mode should be supported by device.
2) For elevator controller, click Free or Controlled.
3) Drag the cursor to draw the Ɵme duraƟon, which means in that duraƟon of Ɵme, the

conĮgured access group is acƟvated.

Note
Up to 8 Ɵme duraƟons can be set to each day in the week schedule.

4) OpƟonal: Perform the following operaƟons to edit the Ɵme duraƟons.
● Move the cursor to the Ɵme duraƟon and drag the Ɵme duraƟon on the Ɵmeline bar to the

desired posiƟon when the cursor turns to  .
● Click the Ɵme duraƟon and directly edit the start/end Ɵme in the appeared dialog.
● Move the cursor to the start or the end of Ɵme duraƟon and drag to lengthen or shorten

the Ɵme duraƟon when the cursor turns to  .
5) Click Save.
Related OperaƟons

Copy to Whole
Week

Select one duraƟon on the Ɵme bar, click Copy to Whole Week to copy all
the duraƟon seƫngs on this Ɵme bar to other week days.

Delete Selected Select one duraƟon on the Ɵme bar, click Delete Selected to delete this
duraƟon.

Clear Click Clear to clear all the duraƟon seƫngs in the week schedule.
4. To set the door status during the holiday, click the Holiday and perform the following operaƟons.

1) Click Remain Unlocked, Remain Locked, InducƟve Mode, or Barrier-Free Mode.
2) Click Add.
3) Enter the start date and end date.
4) Drag the cursor to draw the Ɵme duraƟon, which means in that duraƟon of Ɵme, the

conĮgured access group is acƟvated.

Note
Up to 8 Ɵme duraƟons can be set to one holiday period.

5) Perform the following operaƟons to edit the Ɵme duraƟons.
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● Move the cursor to the Ɵme duraƟon and drag the Ɵme duraƟon on the Ɵmeline bar to the
desired posiƟon when the cursor turns to  .

● Click the Ɵme duraƟon and directly edit the start/end Ɵme in the appeared dialog.
● Move the cursor to the start or the end of Ɵme duraƟon and drag to lengthen or shorten

the Ɵme duraƟon when the cursor turns to  .
6) OpƟonal: Select the Ɵme duraƟon(s) that need to be deleted, and then click  in the

OperaƟon column to delete the selected Ɵme duraƟon(s).
7) OpƟonal: Click  in the OperaƟon column to clear all the Ɵme duraƟon(s) in the Ɵme bar.
8) OpƟonal: Click  in the OperaƟon column to delete this added holiday period from the

holiday list.
9) Click Save.

5. OpƟonal: Click Copy to to copy the door status seƫngs of this door to other door(s).

17.5.3 ConĮgure MulƟ-Factor AuthenƟcaƟon

You can manage the persons by group and set the authenƟcaƟon for mulƟple persons of one
access control point (door).

Before You Start
Set access group and apply the access group to the access control device. For details, refer to
Assign Access Levels to Persons in Access Groups .
Perform this task when you want to set authenƟcaƟons for mulƟple cards of one access control
point (door).

Steps
1. Click Access Control → Advanced FuncƟon → MulƟ-Factor Auth .
2. Select an access control device in device list on the leŌ panel.
3. Add a person/card group for the access control device.

1) Click Add on the right panel.
2) Create a name for the group as desired.
3) Specify the start Ɵme and end Ɵme of the eīecƟve period for the person/card group.
4) Select members(s) and card(s) in the Available list, and the selected member(s) and card(s)

will be added to the Selected list.

Note
● Make sure you have issue card(s) to the person. For details refer to Issue a Card to One

Person .
● Make sure you have set access group and apply the access group to the access control

device successfully. For details, refer to Assign Access Levels to Persons in Access Groups .
5) Click Save.
6) OpƟonal: Select the person/card group(s), and then click Delete to delete it(them).
7) OpƟonal: Select the person/card group(s), and then click Apply to re-apply access group that

failed to be applied previously to the access control device.
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4. ConĮgure an authenƟcaƟon group.
1) Select an access control point (door) of the selected device on the leŌ panel.
2) Enter the AuthenƟcaƟon Interval (the maximum interval when entering password).
3) Click  in the OperaƟon column to enter the Edit AuthenƟcaƟon Group pane.
4) Select a conĮgured template as the authenƟcaƟon template from the drop-down list.

Note
For seƫng the template, refer to ConĮgure Schedule and Template .

5) Select the authenƟcaƟon mode as Local AuthenƟcaƟon, Local AuthenƟcaƟon and Remotely
Open Door, or Local AuthenƟcaƟon and Super Password from the drop-down list.
Local AuthenƟcaƟon

AuthenƟcaƟon by the access control device.
Local AuthenƟcaƟon and Remotely Open Door

AuthenƟcaƟon by the access control device and by the client. When the person swipes the
card on the device, a window will pop up. You can unlock the door via the client.

Figure 17-4 Remotely Open Door

Note
You can check Oŋine AuthenƟcaƟon to enable the super password authenƟcaƟon when
the access control device is disconnected with the client.

Local AuthenƟcaƟon and Super Password
AuthenƟcaƟon by the access control device and by the super password.

6) Select the added person/card group in the leŌ list below and it will be added to the Selected
list on the right as the authenƟcaƟon group.

7) Switch on Oŋine AuthenƟcaƟon to enable authenƟcaƟon via the super password when the
device is oŋine.

8) Click the added authenƟcaƟon group in the right list to set authenƟcaƟon Ɵmes in the Auth
Times column.
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Note
● The authenƟcaƟon Ɵmes should be larger than 0 and smaller than the added personnel
quanƟty in the personnel group.

● The maximum value of authenƟcaƟon Ɵmes is 16.
9) Click Save.

Note
● For each access control point (door), up to four authenƟcaƟon groups can be added.
● For the authenƟcaƟon group of which authenƟcaƟon type is Local AuthenƟcaƟon, up to 8

person/card groups can be added to the authenƟcaƟon group.
● For the authenƟcaƟon group of which authenƟcaƟon type is Local AuthenƟcaƟon and Super

Password or Local AuthenƟcaƟon and Remotely Open Door, up to 7 person/card groups can
be added to the authenƟcaƟon group.

5.
6. Click Save.

17.5.4 ConĮgure Custom Wiegand Rule

Based on the knowledge of uploading rule for the third party Wiegand, you can set mulƟple
customized Wiegand rules to communicate between the device and the third party card readers.

Before You Start
Wire the third party card readers to the device.

Steps

Note
● By default, the device disables the custom wiegand funcƟon. If the device enables the custom

Wiegand funcƟon, all wiegand interfaces in the device will use the customized wiegand protocol.
● Up to 5 custom Wiegands can be set.
● For details about the custom Wiegand, see Custom Wiegand Rule DescripƟons .

1. Click Access Control → Advanced FuncƟon → Custom Wiegand to enter the Custom Wiegand
page.

2. Select a custom Wiegand on the leŌ.
3. Create a Wiegand name.

Note
Up to 32 characters are allowed in the custom Wiegand name.

4. Click Select Device to select the access control device for seƫng the custom wiegand.
5. Set the parity mode according to the property of the third party card reader.
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Note
● Up to 80 bits are allowed in the total length.
● The odd parity start bit, the odd parity length, the even parity start bit and the even parity

length range from 1 to 80 bit.
● The start bit of the card ID, the manufacturer code, the site code, and the OEM should range

from 1 to 80 bit.
6. Set output transformaƟon rule.

1) Click Set Rule to open the Set Output TransformaƟon Rules window.

Figure 17-5 Set Output TransformaƟon Rule
2) Select rules on the leŌ list.

The selected rules will be added to the right list.
3) OpƟonal: Drag the rules to change the rule order.
4) Click OK.
5) In the Custom Wiegand tab, set the rule's start bit, length, and the decimal digit.

7. Click Save.
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17.5.5 ConĮgure Card Reader AuthenƟcaƟon Mode and Schedule

You can set the passing rules for the card reader of the access control device according to your
actual needs.

Steps
1. Click Access Control → Advanced FuncƟon → AuthenƟcaƟon to enter the authenƟcaƟon mode

conĮguraƟon page.
2. Select a card reader on the leŌ to conĮgure.
3. Set card reader authenƟcaƟon mode.

1) Click ConĮguraƟon.

Figure 17-6 Set Card Reader AuthenƟcaƟon Mode

Note
PIN refers to the PIN code set to open the door. Refer to ConĮgure Access Control
InformaƟon .

2) Check the modes in the Available Mode list and they will be added to the selected modes list.
3) Click OK.

AŌer selecƟng the modes, the selected modes will display as icons with diīerent color.
4. Click the icon to select a card reader authenƟcaƟon mode, and drag the cursor to draw a color

bar on the schedule, which means in that period of Ɵme, the card reader authenƟcaƟon is valid.
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5. Repeat the above step to set other Ɵme periods.

Figure 17-7 Set Time Period
6. OpƟonal: Select a conĮgured day and click Copy to Week to copy the same seƫngs to the whole

week.
7. OpƟonal: Click Copy to to copy the seƫngs to other card readers.
8. Click Save.

17.5.6 ConĮgure Person AuthenƟcaƟon Mode

You can set the passing rules for person to the speciĮed the access control device according to your
actual needs.

Before You Start
● Add access control device to the client, and make sure the access control device support the
funcƟon of person authenƟcaƟon.

● Add person and assign access authorizaƟon to designed person. For details, refer to Person
Management and Assign Access Levels to Persons in Access Groups .

Steps
1. Click Access Control → Advanced FuncƟon → AuthenƟcaƟon .
2. Select an access control device (support the funcƟon of person authenƟcaƟon) on the leŌ panel

to enter the person AuthenƟcaƟon Mode page.

iVMS-4200 V3.13.1 User Manual

299



3. Click Add to enter the Add window.
4. Select the person(s) need to be conĮgured on the leŌ panel.

The selected person(s) will be added to the right panel.
5. Select the authenƟcaƟon mode on the drop-down list of AuthenƟcaƟon Mode.
6. Click OK.

Figure 17-8 Set AuthenƟcaƟon Modes for Persons
7. OpƟonal: Select person(s) on the Person AuthenƟcaƟon mode page, and then click Apply to

apply the person authenƟcaƟon mode to the device.

Note
Person authenƟcaƟon has higher priority than other authenƟcaƟon mode. When the access
control device has been conĮgured person authenƟcaƟon mode, the person should authenƟcate
on this device via person authenƟcaƟon mode.

17.5.7 ConĮgure Relay for Elevator Controller

For elevator controller, you can manage the relaƟonship between the Ňoor and the relay and
conĮgure the Ňoor's relay type. Diīerent relay type can implement diīerent funcƟons. By
conĮguring the relaƟonship between the Ňoor and the relay, you can assign diīerent funcƟons to
the elevator and control the elevator.

ConĮgure RelaƟonship between Relay and Floor

You can assign diīerent relay types to the target Ňoors, and each Ňoor can be assigned with 3 relay
types. By this way, you can call the elevator, and assign the operaƟons for diīerent Ňoors.

Before You Start
Add the elevator controller to the client.
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Steps
1. Click Access Control → Advanced FuncƟon → Elevator ConĮguraƟon to enter the Relay Seƫngs

page.
2. Select an elevator controller on the leŌ.
3. Select an unconĮgured relay in the UnconĮgured Relay panel on the right.

There are three types of relay available.
BuƩon

Control the validity for buƩons of each Ňoor.

Note
 represents buƩon relay.

Call Elevator
Control to call the elevator to go to the speciĮed Ňoor by indoor staƟon or outdoor staƟon.

Note
 represents the call elevator relay.

Auto
Control to press the buƩon when the user swipes card inside the elevator. The buƩon of the
Ňoor will be pressed automaƟcally according to the user's permission.

Note
 represents the auto buƩon relay.

Example
Take the following picture as an example. In the number 1-2, 1 represents the distributed
elevator controller number, 2 represents the relay, and the icon  represents the relay type.
You can change the relay type. For details, refer to ConĮgure Relay Type .

Figure 17-9 Relay
4. ConĮgure the relaƟonship between the relays and the Ňoors.

- Drag the unconĮgured relay from the UnconĮgured Relay panel to the target Ňoor in the Floor
List panel.

- Drag the relay from the Floor List panel to the UnconĮgured Relay panel.
- Drag the relay from one Ňoor to another Ňoor in the Floor List panel. If the target Ňoor has

already conĮgured with a relay of the same type as the dragged one, it will replace the existed
one of the same type.
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Figure 17-10 RelaƟonship Between Relay and Floor

Note
● An elevator controller can link to up to 24 distributed elevator controllers. A distributed

elevator controller can link up to 16 relays.
● By default, the relay total amount is the added Ňoor number *3 (three types of relay).
● Up to 3 types of relay can be dragged to one Ňoor.
● If you change the Ňoor number in the door group management, all relays in the Relay Seƫngs

interface will restore to the default seƫngs.
5. OpƟonal: Click Skip-Floor ConĮguraƟon in the upper-right corner to conĮgure skip-stop

operaƟons by selecƟng target Ňoors as non-stopping Ňoors. Access-forbidden Ňoors (e.g.,
mechanical rooms, staī zones) will be omiƩed from elevator service when designated as non-
stop Ňoors.

6. Click Save to apply the seƫngs to the selected elevator controller.

ConĮgure Relay Type

To implement diīerent funcƟons, you can conĮgure diīerent relay type, including: buƩon relay,
call elevator relay and auto buƩon relay. Diīerent relay type can implement diīerent funcƟons.
The buƩon relay is to control the validity for buƩons of each Ňoor.. The call elevator relay is to call
the elevator to the speciĮed Ňoor by indoor staƟon or outdoor staƟon. The auto buƩon relay is to
control to press the buƩon when the user swipes card inside the elevator, the buƩon of the Ňoor
will be pressed automaƟcally according to the user's permission.
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Steps
1. Click Access Control → Advanced FuncƟon → Elevator ConĮguraƟon to enter the Relay Seƫngs

page.
2. Select an elevator controller on the leŌ of the page.
3. Click Relay Type Seƫngs to open the Relay Type Seƫngs window.

Note
● All relays in the Relay Type Seƫngs window are unconĮgured relays.
● Three types of relay are available:  represents the buƩon relay,  represents the call

elevator relay, and  represents the auto buƩon relay.
4. Drag the relay from one relay type panel to the target one.

Figure 17-11 ConĮgure Relay Type
5. Click OK.
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17.5.8 ConĮgure First Person In

You can set mulƟple Įrst persons for one access control point. AŌer the Įrst person is authorized,
it allows mulƟple persons access the door or other authenƟcaƟon acƟons.

Before You Start
● Add access control device to the client, and make sure the device supports the Įrst person in
funcƟon.

● Add person and assign access authorizaƟon to designed person. For details, refer to Person
Management and Assign Access Levels to Persons in Access Groups .

Steps
1. Click Access Control → Advanced FuncƟon → First Person In to enter the First Person In page.
2. Select an access control device in the list on the leŌ panel.
3. Select the current mode as Enable Remaining Open aŌer First Person, Disable Remaining Open

aŌer First Person, or AuthorizaƟon by First Person from the drop-down list for each access
control point of the selected device.
Enable Remaining Open aŌer First Person

The door remains open for the conĮgured Ɵme duraƟon aŌer the Įrst person is authorized
unƟl the remain open duraƟon ends. If you select this mode, you should set the consecuƟve
authenƟcaƟon Ɵmes and interval of consecuƟve authenƟcaƟon.

Note
The remain open duraƟon should be between 0 and 1440 minutes. By default, the remain
open duraƟon is 10 minutes.

Disable Remaining Open aŌer First Person
Disable the funcƟon of Įrst person in, namely normal authenƟcaƟon.

AuthorizaƟon by First Person
All authenƟcaƟons (except for the authenƟcaƟons of super card, super password, duress
card, and duress code) are allowed only aŌer the Įrst person authorizaƟon.

Note
You can authenƟcate by the Įrst person again to disable the Įrst person mode.

4. Click Add on the First Person List panel.
5. Select person(s) in the leŌ list and the person(s) will be add to the selected persons as the Įrst

person(s) of the doors.
The added Įrst person(s) will list in the First Person List

6. OpƟonal: Select a Įrst person from the list and click Delete to remove the person from the Įrst
person list.

7. Click Save.
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17.5.9 ConĮgure AnƟ-Passback

The anƟ-passback feature is designed to minimizes the misuse or fraudulent use of access
credenƟals such as passing back card to an unauthorized person, or tailed access. The anƟ-
passback funcƟon establishes a speciĮc sequence in which access credenƟals must be used in
order to grant access. You can set the sequence according to the actual path via the client and if
the person uses the credenƟal in wrong sequence, you can also reset the anƟ-password records.

Before You Start
Add access control device to the client, and enable the anƟ-passing back funcƟon of the access
control device.

Steps

Note
Either the anƟ-passing back or mulƟ-door interlocking funcƟon can be conĮgured for an access
control device at the same Ɵme. For the conĮguraƟon of mulƟ-door interlocking, refer to
ConĮgure MulƟ-door Interlocking .

1. Click Access Control → Advanced FuncƟon → AnƟ-Passback to enter the AnƟ-Passpack Seƫngs
page.

2. Select an access control device on the leŌ panel.
3. Select a card reader as the beginning of the path in the First Card Reader Įeld.
4. Click  of the selected Įrst card reader in the Card Reader AŌerward column to open the select

card reader dialog.
5. Select the aŌerward card readers for the Įrst card reader.

Note
Up to four aŌerward card readers can be added as aŌerward card readers for one card reader.

6. Click OK in the dialog to save the selecƟons.
7. Click Save in the AnƟ-Passback Seƫngs page to save the seƫngs and take eīect.

Example
Set Card Swiping Path: If you select Reader In_01 as the beginning, and select Reader In_02,
Reader Out_04 as the linked card readers. Then you can only get through the access control
point by swiping the card in the order as Reader In_01, Reader In_02 and Reader Out_04.

8. Click Reset AnƟ-Passback and select the person(s) to delete the related anƟ-passback records
about the person(s) on the device.

Note
This funcƟon should be supported by the device.
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17.5.10 ConĮgure Cross-Controller AnƟ-Passback

You can set anƟ-passback for card readers in mulƟple access control devices. You should swipe the
card according to the conĮgured swiping card route. And only one person could pass the access
control point aŌer swiping the card. You can conĮgure area anƟ-passback rules or route anƟ-
passback rules for diīerent scenarios.

Note
It should be supported by the device.

ConĮgure Route AnƟ-Passback Based on Card

The route anƟ-passback depends on the card swiping route. You should set the Įrst card reader
and the card readers aŌerwards. It will judge the anƟ-passback according to the entrance and exit
records on the card.

Perform this task if you need to conĮgure route anƟ-passback and judge the anƟ-passback
according to the entrance and exit records on the card.

Steps

Note
It supports M1 card at present and the sector cannot be encrypted. For details about sector
encrypƟon, refers to Enable M1 Card EncrypƟon .

1. Click Access Control → Advanced FuncƟon → Cross-Controller AnƟ-Passback to enter the cross-
controller AnƟ-Passback conĮguraƟon page.

2. Check Enable Cross-Controller AnƟ-Passback to enable the funcƟon.
3. Select Based on Card as the anƟ-passback mode.
4. Select Route AnƟ-Passback as the rule.
5. Set the sector ID.
6. Click Select Access Controller to select a device for anƟ-passback.

Note
Up to 64 devices with anƟ-passback funcƟon can be added.

7. Set the Įrst card reader and aŌer card readers.
1) In the Card Reader area, click the icon on the leŌ of the card reader column to set it as the

Įrst card reader.
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Figure 17-12 Select First Card

The icon will turn to  .
2) Click the card reader aŌerward input Įeld to select the card readers aŌerward in the pop-up

window.

Note
● Up to 16 card readers aŌerward can be added for each card reader.
● The displayed card readers in the card reader aŌerward input Įeld should be in
authenƟcaƟon order.

3) Check the checkbox in the Enable AnƟ-Passback column to enable the AnƟ-Passback
funcƟon.

8. Click Save.

ConĮgure Route AnƟ-Passback Based on Network

The route anƟ-passback depends on the card swiping route. You should set the Įrst card reader
and the card readers aŌerwards. It will authenƟcate the anƟ-passback according to the entrance
and exit informaƟon stored on the card reader.

Perform this task if you need to conĮgure route anƟ-passback and authenƟce the anƟ-passback
result according to the entrance and exit informaƟon stored on the card reader.

Steps
1. Click Access Control → Advanced FuncƟon → Cross-Controller AnƟ-Passback to enter the cross-

controller anƟ-passback conĮguraƟon page.
2. Check Enable Cross-Controller AnƟ-Passback to enable the funcƟon.
3. Select Based on Network as the anƟ-passback mode.
4. Select Route AnƟ-Passback as the rule.
5. Select a server in the drop-down list for judging the anƟ-passback.
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Note
● You can click Delete Card Swiping Record and select the card in the pop-up window to delete

the card swiping informaƟon in all devices.
● Up to 5000 cards' swiping records can be stored in the selected server.

6. Click Select Access Controller to select a device for anƟ-passback.

Note
Up to 64 devices with anƟ-passback funcƟon can be added.

7. Set the Įrst card reader and aŌer card readers.
1) In the Card Reader area, click the icon on the leŌ of the card reader column to set it as the

Įrst card reader.

Figure 17-13 Select First Card

The icon will turn to  .
2) Click the card reader aŌerward input Įeld to select the card readers aŌerward in the pop-up

window.

Note
● Up to 16 card readers aŌerward can be added for each card reader.
● The displayed card readers in the card reader aŌerward input Įeld should be in
authenƟcaƟon order.

3) Check the checkbox in the Enable AnƟ-Passback column to enable the anƟ-passback funcƟon.
8. Click Save.

ConĮgure Area AnƟ-Passback Based on Card

You can set the entrance card reader and the exit card reader only for entering and exiƟng, without
seƫng the Įrst card reader and the card readers aŌerwards. It will judge the anƟ-passback
according to the entrance and exit records on the card.

Perform this task if you need to conĮgure area anƟ-passback and judge the anƟ-passback
according to the entrance and exit records on the card.
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Steps

Note
It supports M1 card at present and the sector cannot be encrypted. For details about sector
encrypƟon, refers to Enable M1 Card EncrypƟon .

1. Click Access Control → Advanced FuncƟon → Cross-Controller AnƟ-Passback to enter the cross-
controller anƟ-passback conĮguraƟon page.

2. Check Enable Cross-Controller AnƟ-Passback to enable the funcƟon.
3. Select Based on Card as the anƟ-passback mode.
4. Select Area AnƟ-Passback as the rule.
5. Set the sector ID.
6. Click Select Access Controller to select a device for anƟ-passback.

Note
Up to 64 devices with anƟ-passback funcƟon can be added.

7. In the Card Reader area, check the checkboxes in the Enable AnƟ-Passback column to select the
entrance card reader and the exit card reader.

Note
Up to one entrance carder and one exit card reader should be checked.

8. Click Save.

ConĮgure Area AnƟ-Passback Based on Network

You can set the entrance card reader and the exit card reader only for entering and exiƟng, without
seƫng the Įrst card reader and the card readers aŌerwards. It will authenƟcate the anƟ-passback
according to the entrance and exit informaƟon on the card reader.

Perform this task if you need to conĮgure area anƟ-passback and judge the anƟ-passback
according to the entrance and exit informaƟon stored on the card reader.

Steps
1. Click Access Control → Advanced FuncƟon → Cross-Controller AnƟ-Passback to enter the cross-

controller anƟ-passback conĮguraƟon page.
2. Check Enable Cross-Controller AnƟ-Passback to enable the funcƟon.
3. Select Based on Network as the anƟ-passback mode.
4. Select Area AnƟ-Passback as the rule.
5. Select a server in the drop-down list for judging the anƟ-passback.
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Note
● You can click Delete Card Swiping Record and select the card in the pop-up window to delete

the card swiping informaƟon in all devices.
● Up to 5000 cards' swiping records can be stored in the selected server.

6. Click Select Access Controller to select a device for anƟ-passback.

Note
Up to 64 devices with anƟ-passback funcƟon can be added.

7. In the Card Reader area, check the checkboxes in the Enable AnƟ-Passback column to select the
entrance card reader and the exit card reader.

Note
Up to one entrance carder and one exit card reader should be checked.

8. Click Save.

17.5.11 ConĮgure MulƟ-door Interlocking

You can set the mulƟ-door interlocking between mulƟple doors of the same access control device.
To open one of the doors, other doors must keep closed. That means in the interlocking combined
door group, up to one door can be opened at the same Ɵme.

Before You Start
Add access control device to the client, and make sure the device supports the mulƟ-door
interlocking funcƟon.

Steps

Note
● MulƟ-door Interlocking funcƟon is only supported by the access control device which has more

than one access control points (doors).
● Either the anƟ-passing back or mulƟ-door interlocking funcƟon can be conĮgured for an access

control device at the same Ɵme. For the conĮguraƟon of anƟ-passing back funcƟon, refer to
ConĮgure AnƟ-Passback .

1. Click Access Control → Advanced FuncƟon → MulƟ-door Interlocking .
2. Select an access control device on the leŌ panel.
3. Click Add on the MulƟ-door Interlocking List panel to open Add Access Control Point to open the

Add window.
4. Select at least two access control points(doors) from the list.

Note
Up to four doors can be added in one mulƟ-door interlocking combinaƟon.

5. Click OK to add the selected access control point(s) for interlocking.
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The conĮgured mulƟ-door interlocking combinaƟon will list on the MulƟ-door Interlocking List
panel.
If the device supports conĮguraƟon of an extended open duraƟon (set during the addiƟon or
ediƟng of a device), the mulƟ-door interlocking list will include a column for Extended Open
DuraƟon.

6. OpƟonal: Select an added mulƟ-door interlocking combinaƟon from the list and click Delete to
delete the combinaƟon.

7. Click Apply to apply the seƫngs to the access control device.

17.5.12 ConĮgure AuthenƟcaƟon Code

You can conĮgure authenƟcaƟon code on the client. And aŌer that, you can open door by entering
authenƟcaƟon code when you forget to bring the card with you.

Before You Start
Add access control device to the client, and make sure the device supports authenƟcaƟon code as
the authenƟcaƟon mode.

Steps
1. Click Access Control → Advanced FuncƟon → AuthenƟcaƟon Code to enter the authenƟcaƟon

code conĮguraƟon page.
2. Select an access control device in the list of Controller List panel.

All the applied cards and persons will display on the Card List panel.

Note
For seƫng and applying the permissions to the device, refer to Assign Access Levels to Persons
in Access Groups .

3. Click the Įeld of each card in the AuthenƟcaƟon Code column to enter the authenƟcaƟon code.

Note
The authenƟcaƟon code should contain 4 to 8 digits.

4. Click Save at the upper-right corner of AuthenƟcaƟon Code page to save the seƫngs.
The authenƟcaƟon code funcƟon of the card will be enabled automaƟcally.
Upon saving, the authenƟcaƟon code syncs to both the device and client, ensuring the client
access to the authenƟcaƟon code even when the device is oŋine.

What to do next
You should set the card reader authenƟcaƟon mode of access control device as Card/
AuthenƟcaƟon Code. Refer to ConĮgure Card Reader AuthenƟcaƟon Mode and Schedule for
details.

iVMS-4200 V3.13.1 User Manual

311



17.6 ConĮgure Other Parameters
AŌer adding the access control device, you can set its parameters such as network parameters,
capture parameters, RS-485 parameters, Wiegand parameters, etc.

17.6.1 Set MulƟple NIC Parameters

If the device supports mulƟple network interfaces, you can set the network parameters of these
NICs via the client, such as IP address, MAC address, port number, etc.

Before You Start
Add access control device to the client, and make sure the device supports mulƟple NICs.

Steps
1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters .
3. Select an access control device in the device list and click NIC to enter MulƟple NIC Seƫngs

page.
4. Select an NIC you want to conĮgure from the drop-down list.
5. Set its network parameters such as IP address, default gateway, subnet mask, etc.

MAC Address
A media access control address (MAC address) is a unique idenƟĮer assigned to the network
interface for communicaƟons on the physical network segment.

MTU
The maximum transmission unit (MTU) of the network interface.

6. Click Save.

17.6.2 Set Device Capture Parameters

You can conĮgure the capture parameters of the access control device, including manual capture
and event triggered capture.

Note
● The capture funcƟon should be supported by the device.
● Before seƫng the capture parameters, you should set the picture storage Įrst to deĮne where

the event triggered pictures are saved. For details, refer to Set Picture Storage .
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Set Triggered Capture Parameters

When an event occurs, the camera of the access control device can be triggered to capture
picture(s) to record what happens when the event occurs. You can view the captured pictures
when checking the event details in Event Center. Before that, you need to set the parameters for
the capture such as number of pictures captured for one Ɵme.

Before You Start
Before seƫng the capture parameters, you should set the picture storage Įrst to deĮne where the
captured pictures are saved. For details, refer to Set Picture Storage .

Steps

Note
This funcƟon should be supported by the device

1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters → Capture .
3. Select an access control device in the device list and select Linked Capture.
4. Set the picture size and quality.
5. Set the capture Ɵmes once triggered which deĮnes how many pictures will be captures for one

Ɵme.
6. If the capture Ɵmes is more than 1, set the interval for each capture.
7. Click Save.

Set Manual Capture Parameters

In Status Monitoring module, you can capture a picture manually the access control device's
camera by clicking a buƩon. Before that, you need to set the parameters for the capture such as
picture quality.

Before You Start
Before seƫng the capture parameters, you should set the saving path Įrst to deĮne where the
captured pictures are saved. For details, refer to Set File Saving Path .

Steps

Note
This funcƟon should be supported by the device

1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters → Capture .
3. Select an access control device in the device list and select Manual Capture.
4. Select the resoluƟon of the captured pictures from the drop-down list.
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5. Select the picture quality as High, Medium, or Low. The higher the picture quality is, the larger
size the picture will be.

6. Click Save.

17.6.3 Set Parameters for Face RecogniƟon Terminal

For face recogniƟon terminal, you can set its parameters including face picture database, QR code
authenƟcaƟon, etc.

Steps

Note
This funcƟon should be supported by the device.

1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters .
3. Select an access control device in the device list and click Face RecogniƟon Terminal.
4. Set the parameters.

Note
These parameters displayed vary according to diīerent device models.

COM
Select a COM port for conĮguraƟon. COM1 refers to the RS-485 interface and COM2 refers to
the RS-232 interface.

Face Picture Database
select Deep Learning as the face picture database.

AuthenƟcate by QR Code
If enabled, the device camera can scan the QR code to authenƟcate. By default, the funcƟon
is disabled.

Blocklist AuthenƟcaƟon
If enabled, the device will compare the person who want to access with the persons in the
blocklist.
If matched (the person is in the blocklist), the access will be denied and the device will upload
an alarm to the client.
If mismatched (the person is not in the blocklist), the access will be granted.

Save AuthenƟcaƟng Face Picture
If enabled, the captured face picture when authenƟcaƟng will be saved on the device.

MCU Version
View the device MCU version.

5. Click Save.
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17.6.4 Enable M1 Card EncrypƟon

M1 card encrypƟon can improve the security level of authenƟcaƟon.

Steps

Note
The funcƟon should be supported by the access control device and the card reader.

1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters .
3. Select an access control device in the device list and click M1 Card EncrypƟon to enter the M1

Card EncrypƟon page.
4. Set the switch to on to enable the M1 card encrypƟon funcƟon.
5. Set the sector ID.

The sector ID ranges from 1 to 100.
6. Click Save to save the seƫngs.

17.6.5 Set RS-485 Parameters

You can set the access control device's RS-485 parameters including the baud rate, data bit, the
stop bit, parity type, Ňow control type, communicaƟon mode, work mode, and connecƟon mode.

Before You Start
Add access control device to the client, and make sure the device supports RS-485 interface.

Steps
1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters .
3. Select an access control device in the device list and click RS-485 to enter the RS-485 Seƫngs

page.
4. Select the serial port number from the drop-down list to set the RS-485 parameters.
5. Set the baud rate, data bit, the stop bit, parity type, communicaƟon mode, working mode, and

connecƟon mode in the drop-down list.

Note
When the connecƟon mode is Connect Access Control Device, you can select Card No. or
Person ID as the output type.

6. Click Save.
● The conĮgured parameters will be applied to the device automaƟcally.
● When you change the working mode or connecƟon mode, the device will reboot
automaƟcally.

iVMS-4200 V3.13.1 User Manual

315



17.6.6 Set Wiegand Parameters

You can set the access control device's Wiegand channel and the communicaƟon mode. AŌer
seƫng the Wiegand parameters, the device can connect to Wiegand card reader via Wiegand
communicaƟon.

Before You Start
Add access control device to the client, and make sure the device supports Wiegand.

Steps
1. Enter the Access Control module.
2. On the navigaƟon bar on the leŌ, enter Advanced FuncƟon → More Parameters .
3. Select an access control device in the device list and click Wiegand to enter the Wiegand

Seƫngs page.
4. Set the switch to on to enable the Wiegand funcƟon for the device.
5. Select the Wiegand channel No. and the communicaƟon mode from the drop-down list.

Note
If you set CommunicaƟon DirecƟon as Sending, you are required to set the Wiegand Mode as
Wiegand 26 or Wiegand 34.

6. Click Save.
● The conĮgured parameters will be applied to the device automaƟcally.
● AŌer changing the communicaƟon direcƟon, the device will reboot automaƟcally.

17.7 ConĮgure Linkage AcƟons for Access Control
You can conĮgure diīerent linkage acƟons for the event detected by the access control device.
AŌer that, linkage acƟons will be triggered once the event happens. This mechanism is used for
noƟfying the security personnel the event, or triggering automaƟc access control in real Ɵme.

Two types of linkage acƟons are supported:
● Client AcƟons: When the event is detected, it will trigger the acƟons on the client, such as the

client making an audible warning..
● Device AcƟons: When the event is detected, it will trigger the acƟons of a speciĮc device, such

as buzzing of a card reader and, opening/closing of a door, ..

17.7.1 ConĮgure Client AcƟons for Access Event

Even if you are far away from an access point, you can sƟll know what happens and how urgent the
event is via the client by conĮguring client acƟons for the access event. Client acƟons here refer to
the acƟons automaƟcally executed by the client itself, such as making an audible warning and
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sending an email. Once an event is triggered, the client will noƟfy the security personnel, so that
he/she can handle the event in Ɵme.

Before You Start
Add access control device to the client.

Steps
1. Click Event ConĮguraƟon → Access Event .

The added access control devices will display in the device list.
2. Select a resource (including device, alarm input, door/elevator, and card reader) from the device

list.
The event types which the selected resource supports appear.

3. Select the event(s) and click Edit Priority to deĮne the priority for the event(s), which can be
used to Įlter events in the Event Center.

4. Set the linkage acƟons of the event.
1) Select the event(s) and click Edit Linkage to set the client acƟons when the event(s) are

triggered.
Audible Warning

The client soŌware gives an audible warning when the event is triggered. You can select
alarm sound for the audible warning.

Note
For details about seƫng the alarm sound, refer to Set Alarm Sound .

Send Email
Send an email noƟĮcaƟon about the event to one or more receivers.
For details about seƫng email parameters, refer to Set Email Parameters .

Pop-up Window
Pop-up a window to display the event informaƟon (including event details, the event-
related video footage, the event-related picture) on the soŌware client when the event is
triggered.

Display on Map
When the event source is added as a hot spot on the map, the hot spot will be displayed
with red number (indicates the number of events, and the maximum number is 10) aside
when the event is triggered, which helps the security personnel to view the locaƟon of the
event.
You can also click the hot spot to view the event details and the live video of the linked
camera.

Linked Camera
Link the selected camera to capture a picture when the access event is triggered.
Select the camera in the drop-down list.
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Broadcast Linkage
Link the selected camera to broadcast certain audio Įle(s) when the event is triggered.

Note
Up to 100 speaker units, and up to 5 audio Įles can be selected.

PTZ Linkage
When the events are triggered, the cameras' Preset, Patrol, and PaƩern will be called.

Note
Make sure you have conĮgured presets, patrols, or paƩerns for the camera.

2) Click OK.
5. Enable the event so that when the event is detected, event will be sent to the client and the

linkage acƟons will be triggered.
6. OpƟonal: Click Copy to to copy the event seƫngs to other access control device, alarm input,

door/elevator, or card reader.

17.7.2 ConĮgure Device AcƟons for Access Event

You can set the access control device's linkage acƟons for the access control device's triggered
event. AŌer that, when an event is triggered, it can trigger the alarm output, buzzer on access
controller, and other acƟons.

Steps

Note
The linkage acƟons should be supported by the device.

1. Click Access Control → Linkage ConĮguraƟon .
2. Select the access control device from the list on the leŌ.
3. Click Add to add a new linkage.
4. Select Event Linkage as the event source.
5. select the event type and detailed event to set the linkage.
6. In the Linkage Target area, set the property target to enable this acƟon.

Buzzer on Controller
The audible warning of access control device will be triggered.

Capture
An event-related picture will be captured when the selected event happens.

Recording
An event-related picture will be captured when the selected event happens.
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Note
The device should support recording.

Buzzer on Reader
The audible warning of card reader will be triggered.

Alarm Output
The alarm output will be triggered for noƟĮcaƟon when the selected event happens

Alarm Input
Arm or disarm the alarm input.

Note
The device should support alarm input funcƟon.

Access Point
The door status of open, close, remain open, or remain close will be triggered.

Note
The target door and the source door cannot be the same one.

Audio Play
The audio prompt will be triggered. And the select audio index related audio content will be
played according to the conĮgured play mode.

7. Click Save.
8. OpƟonal: AŌer adding the device linkage, you can do one or more of the followings:

Edit Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and you can edit its
event source parameters, including event source and linkage target.

Delete Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and click Delete to
delete it.

17.7.3 ConĮgure Device AcƟons for Card Swiping

You enable access control device's linkage acƟons (such as disarming a zone and triggering audio
prompt) for the swiping of a speciĮc card, In this way, you can monitor the card holder's behaviors
and whereabouts.

Steps

Note
It should be supported by the device.

1. Click Access Control → Linkage ConĮguraƟon .
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2. Select the access control device from the list on the leŌ.
3. Click Add to add a new linkage.
4. Select Card Linkage as the event source.
5. Enter the card number or select the card from the drop-down list.
6. Select the card reader where the card swipes.
7. In the Linkage Target area, set the property target to enable this acƟon.

Buzzer on Controller
The audible warning of access control device will be triggered.

Buzzer on Reader
The audible warning of card reader will be triggered.

Capture
An event-related picture will be captured when the selected event happens.

Recording
An event-related picture will be captured when the selected event happens.

Note
The device should support recording.

Alarm Output
The alarm output will be triggered for noƟĮcaƟon.

Alarm Input
Arm or disarm the alarm input.

Note
The device should support alarm input funcƟon.

Access Point
The door status of open, close, remain open, or remain closed will be triggered.

Audio Play
The audio prompt will be triggered. And the select audio index related audio content will be
played according to the conĮgured play mode.

8. Click Save.
When the card (conĮgured in Step 5) swipes on the card reader (conĮgured in Step 6), it can
trigger the linked acƟons (conĮgured in step 7).

9. OpƟonal: AŌer adding the device linkage, you can do one or more of the followings:

Delete Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and click Delete to
delete it.

Edit Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and you can edit its
event source parameters, including event source and linkage target.

iVMS-4200 V3.13.1 User Manual

320



17.7.4 ConĮgure Device AcƟons for Person ID

You can set the access control device's linkage acƟons for the speciĮed person ID. When access
control device detects the speciĮed person ID, it can trigger the alarm output, buzzer on card
reader, and other acƟons, so as to implement special monitoring on the speciĮed person.

Steps

Note
It should be supported by the device.

1. Click Access Control → Linkage ConĮguraƟon .
2. Select the access control device from the list on the leŌ.
3. Click Add to add a new linkage.
4. Select Person Linkage as the event source.
5. Enter the employee number or select the person from the drop-down list.
6. Select the card reader where the card swipes.
7. In the Linkage Target area, set the property target to enable this acƟon.

Buzzer on Controller
The audible warning of access control device will be triggered.

Buzzer on Reader
The audible warning of card reader will be triggered.

Capture
An event-related picture will be captured when the selected event happens.

Recording
An event-related picture will be captured when the selected event happens.

Note
The device should support recording.

Alarm Output
The alarm output will be triggered for noƟĮcaƟon.

Alarm Input
Arm or disarm the alarm input.

Note
The device should support zone funcƟon.

Access Point
The door status of open, close, remain open, or remain closed will be triggered.

Audio Play
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The audio prompt will be triggered. And the select audio index related audio content will be
played according to the conĮgured play mode.

8. Click Save.
9. OpƟonal: AŌer adding the device linkage, you can do one or more of the followings:

Delete Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and click Delete to
delete it.

Edit Linkage
Seƫngs

Select the conĮgured linkage seƫngs in the device list and you can edit its
event source parameters, including event source and linkage target.

17.8 Door/Elevator Control
In Monitoring module, you can view the real-Ɵme status of the doors or elevators managed by the
added access control device. You can also control the doors and elevators such as open/close the
door, or remain the door open/closed via the client remotely. The real-Ɵme access event are
displayed in this module. You can view the access details and person details.

Note
For the user with door/elevator control permission, the user can enter the Monitoring module and
control the door/elevator. Or the icons used for control will not show. For seƫng the user
permission, refer to Add User .

17.8.1 Control Door Status

You can control the status for the door(s), including unlock door, locking door, remaining the door
unlock, remaining the door locked, remain all unlocked, etc.

Before You Start
● Add person and assign access authorizaƟon to designed person, and person will have the access
authorizaƟon to the access points (doors). For details, refer to Person Management and Assign
Access Levels to Persons in Access Groups .

● Make sure the operaƟon user has the permission of the access points (doors). For details, refer
to Add User .

Steps
1. Click Monitoring to enter the status monitoring page.
2. Select an access point group on the upper-right corner.

Note
For managing the access point group, refer to Group Management .

The doors in the selected access control group will display.
3. Click a door icon to select a door, or press Ctrl and select mulƟple doors.
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Note
For Remain All Unlocked and Remain All Locked, ignore this step.

4. Click the following buƩons to control the door.
Unlock Door

When the door is locked, unlock it and it will be open for once. AŌer the open duraƟon, the
door will be closed and locked again automaƟcally.

Lock Door
When the door is unlocked, lock it and it will be closed. The person who has the access
authorizaƟon can access the door with credenƟals.

Remain Unlocked
The door will be unlocked (no maƩer closed or open). All the persons can access the door
with no credenƟals required.

Remain Locked
The door will be closed and locked. No person can access the door even if he/she has the
authorized credenƟals, except the super users.

Controlled
The door will transiƟon from the status of remain unlocked/remain locked to a state where
access is rouƟnely controlled based on permissions.

Remain All Unlocked
All doors in the group will be unlocked (no maƩer closed or open). All the persons can access
the doors with no credenƟals required.

Remain All Locked
All doors in the group will be closed and locked. No person can access the doors even if
he/she has the authorized credenƟals, except the super users.

Capture
Capture a picture manually.

Note
The Capture buƩon is available when the device supports capture funcƟon. The picture is
saved in the PC running the client. For seƫng the saving path, refer to Set File Saving Path .

Remotely Unlocking Door StaƟon
When the group includes door staƟons, you can check Lock1 or Lock2, then click Unlock Door
to unlock the door staƟon.

Note
By default, Lock1 is checked for door staƟons.

Refresh Status
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Click Refresh Status to get the door's newest status.

Result

The icon of the doors will change in real-Ɵme according to the operaƟon if the operaƟon is
succeeded.

17.8.2 Control Elevator Status

You can control the elevator status of the added elevator controller, including opening elevator's
door, controlled, free, calling elevator, etc.

Before You Start
● Add person and assign access authorizaƟon to designed person, and person will have the access
authorizaƟon to the access points (Ňoors). For details, refer to Person Management and Assign
Access Levels to Persons in Access Groups .

● Make sure the operaƟon user has the permission of the access points (Ňoors). For details, refer
to Add User .

Steps

Note
● You can control the elevator via the current client if it is not armed by other client. The elevator

cannot be controlled by other client soŌware if the elevator status changes.
● Only one client soŌware can control the elevator at one Ɵme.
● The client which has controlled the elevator can receive the alarm informaƟon and view the

elevator real-Ɵme status.

1. Click Monitoring to enter the status monitoring page.
2. Select an access point group on the upper-right corner.

Note
For managing the access point group, refer to Group Management .

The elevators in the selected access point group will display.
3. Click a door icon to select an elevator.
4. Click the following buƩons to control the elevator.

Open Door
When the elevator's door is closed, open it. AŌer the open duraƟon, the door will be closed
again automaƟcally.

Controlled
You should swipe the card before pressing the target Ňoor buƩon. And the elevator can go to
the target Ňoor.

Free

iVMS-4200 V3.13.1 User Manual

324



The selected Ňoor's buƩon in the elevator will be valid all the Ɵme.
Disabled

The selected Ňoor's buƩon in the elevator will be invalid and you cannot go to the target
Ňoor.

Result

The icon of the doors will change in real-Ɵme according to the operaƟon if the operaƟon is
succeeded.

17.8.3 Check Real-Time Access Records

The real-Ɵme access records can be displayed in the client, including card swiping records, face
recogniƟon records, skin-surface temperature informaƟon, etc. Also, you can view the person
informaƟon and view the picture captured during access.

Before You Start
You have added person(s) and access control device(s) to the client. For details, refer to Person
Management and Add Device .

Steps
1. Click Monitoring to enter the Monitoring module.

Real-Ɵme access records are displayed on the boƩom of the page. You can view record details,
including card No., person name, event Ɵme, door locaƟon, temperature, authenƟcaƟon type
etc. For access events via card, supports displaying person name and organizaƟon.

Figure 17-14 Real-Ɵme Access Records
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Figure 17-15 Access Events via Card

Note
You can right click the column name of access event table to show or hide the column according
to actual needs.

2. Filter events.
1) In the upper-right corner, select an access point group from the drop-down list to show the

real Ɵme access records of the selected group.
2) Check the event type.
3) OpƟonal: Check Show Latest Event to view the latest access record.

3. OpƟonal: View event records and perform more operaƟons.

Enable Abnormal
Temperature
Prompt

Check Enable Abnormal Temperature Prompt to enable abnormal skin-
surface temperature prompt.
When enabled, if there is abnormal temperature informaƟon, an
Abnormal Temperature window pops up when you enter Monitoring
module, displaying person's picture, skin-surface temperature, card No.,
person name, etc.

View Pictures Click an event to view person pictures (including captured picture and
proĮle).
In Linked Capture Picture Įeld, you can double click the captured
picture to view an enlarged picture.

View Event Details Click  to view monitoring details (including person's detailed
informaƟon and the captured picture).
In the pop-up window, you can click  to view monitoring details in full
screen.

Customize Column
Display

Click Customize Column Display to customize the columns to be
displayed.
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Chapter 18 Time and AƩendance

The Time and AƩendance module provides mulƟple funcƟonaliƟes to track and monitor when
employees start and stop work, and full control of employees working hours such as late arrivals,
early departures, Ɵme taken on breaks and absenteeism.

Note
In this secƟon, we introduce the conĮguraƟons before you can geƫng the aƩendance reports. The
access records recorded aŌer these conĮguraƟons will be calculated in the staƟsƟcs.

18.1 Flow Chart

Figure 18-1 Flow Chart of Time and AƩendance
● Add Access Control Device: You can add access control devices on the client. For more details,

refer to Add Device .
● ConĮgure Person InformaƟon: You should add person informaƟon to the client before
conĮguring Ɵme and aƩendance parameters for them. For more details, refer to Person
Management .
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● Set Weekend: You can select one or more days as the weekends according to actual
requirements on the client. For more details, refer to Set Weekend .

● ConĮgure AuthenƟcaƟon Mode: You can conĮgure authenƟcaƟon mode such as card,
Įngerprint, face, etc. For more details, refer to ConĮgure AuthenƟcaƟon Mode .

● ConĮgure OverƟme Parameters: You can conĮgure the overƟme parameters for workday and
weekend, including overƟme level, work hour rate, etc. For more details, refer to ConĮgure
OverƟme Parameters .

● ConĮgure AƩendance Check Point: You can set the card reader(s) of the access point as the
aƩendance check point on the client. For more details, refer to ConĮgure OverƟme Parameters .

● ConĮgure Holiday: You can add the holiday during which the check-in or check-out will not be
recorded on the client. For more details, refer to ConĮgure Holiday .

● ConĮgure Leave Type: You can customize the leave type according to actual needs. For more
details, refer to ConĮgure Leave Type .

● Add Timetable: You can add general Ɵmetable and Ňexible Ɵmetable for employees on the client
according to actual needs. For more details, refer to Add Flexible Timetable and Add General
Timetable .

● Add ShiŌ: You can add shiŌ for employees including seƫng shiŌ periods and the eīecƟve
aƩendance Ɵme. For more details, refer to Add ShiŌ .

● Manage ShiŌ Schedule: You can set department schedule, person schedule, and temporary
schedule on the client. For more details, refer to Manage ShiŌ Schedule .

● Calculate AƩendance Data: The client can calculate the aƩendance data automaƟcally or you
can manually calculate the aƩendance data. For more details, refer to Calculate Attendance
Data .

● AƩendance Records: You can search and view the employee's aƩendance records on the client,
including aƩendance Ɵme, aƩendance status, check point, etc. For more details, refer to Get an
Overview of Employees' Attendance Data .

● AƩendance Report: The client supports generaƟng aƩendance reports to view the employees'
aƩendance results. Also, you can pre-deĮne the report content and it can send the report
automaƟcally to you via email. For more details, refer to Generate Instant Report and Send
Report Regularly .

18.2 ConĮgure AƩendance Parameters
You can conĮgure the aƩendance parameters, including the general rule, overƟme parameters,
aƩendance check point, holiday, leave type, etc.

18.2.1 Set Weekend

The days of weekends may vary in diīerent countries and regions. The client provides weekends
deĮniƟon funcƟon. You can select one or more days as the weekends according to actual
requirements, and set diīerent aƩendance rules for weekends from workdays.
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Steps

Note
The parameters conĮgured here will be set as default for the newly added Ɵme period. It will not
aīect the existed one(s).

1. Enter Time & AƩendance module.
2. Click AƩendance Seƫngs → General Rule .
3. Select the day(s) as weekend, such as Saturday and Sunday.
4. Click Save.

18.2.2 ConĮgure AuthenƟcaƟon Mode

The client supports conĮguring authenƟcaƟon modes, including card, Įngerprint, face, card or
Įngerprint, etc. AŌer seƫng authenƟcaƟon mode, you can get device events of the conĮgured
authenƟcaƟon mode via the client and the client will calculate aƩendance data of the conĮgured
authenƟcaƟon mode.

Click AƩendance Seƫngs → General Rule .
On the AuthenƟcaƟon Mode area, select the authenƟcaƟon mode from the drop-down list.

Note
● This selected authenƟcaƟon mode should be supported by device.
● AŌer seƫng authenƟcaƟon mode, you can only get aƩendance records of the conĮgured
authenƟcaƟon mode and calculate aƩendance data of the conĮgured authenƟcaƟon mode.

18.2.3 ConĮgure OverƟme Parameters

You can conĮgure the overƟme parameters for workday and weekend, including overƟme level,
work hour rate, aƩendance status for overƟme, etc.

Steps
1. Click Time & AƩendance → AƩendance Seƫngs → OverƟme .
2. Set required informaƟon.

OverƟme Level for Workday
When you work for a certain period aŌer end-work Ɵme on workday, you will reach diīerent
overƟme level: overƟme level 1, overƟme level 2 and overƟme level 3. You can set diīerent
work hour rate for three overƟme levels, respecƟvely.

Work Hour Rate
Work Hour Rate is used to calculate work hours by mulƟplying it by overƟme. When you work
for a certain period aŌer end-work Ɵme on workday, you will reach diīerent overƟme level.
You can set diīerent work hour rates (1-10, can be a decimal) for three overƟme levels. For
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example, your valid overƟme is one hour (in overƟme level 1), and the work hour rate of
overƟme level 1 is set as 2, then the work hours in the period will be calculated as 2 hours.

OverƟme Rule for Weekend
You can enable overƟme rule for weekend and set calculaƟon mode.

3. Click Save.

18.2.4 ConĮgure AƩendance Check Point

You can set the card reader(s) of the access control device as the aƩendance check point(s), so that
the authenƟcaƟon on the card readers will be recorded for aƩendance.

Before You Start
● You have added access control device(s). For details, refer to Add Device .
● You have enabled T&A Status. For details, refer to Add General Timetable .
By default, all card readers of the added access control devices are set as start/end-work check
points. If you need to edit check point funcƟon of card reader(s), you can perform the following
operaƟons.

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance Seƫngs → AƩendance Check Point to enter the aƩendance check point

seƫngs page.
3. Set Set All Card Readers as Check Points switch to oī.
4. Check the desired card reader(s) as aƩendance check point(s) in the list below.
5. Set check point funcƟon as Start/End-Work, Start-Work or End-Work.

Note
When selecƟng Start-Work or End-Work, the aƩendance status uploaded from the device will
be decided by the check point funcƟon you set here.

Start-Work
AƩendance status uploaded from the device will all be calculated as Check-in.

End-Work
AƩendance status uploaded from the device will all be calculated as Check-out.

Start/End-Work
AƩendance status will be calculated as Check in/out according to the actual aƩendance
status on the device.

6. Click Set as Check Point.
The conĮgured aƩendance check point(s) are displayed on the right list.

7. OpƟonal: AŌer seƫng aƩendance check points, and perform the following operaƟons.
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Edit Check
Point

Check one aƩendance check point, click Edit to edit its informaƟon including
name, check point funcƟon, etc.
Check two or more aƩendance check points, click Edit to batch edit check
point funcƟon, enter remark, etc.

Delete Check
Point

Check one or more check points, and click Delete to delete it/them.

18.2.5 ConĮgure Holiday

You can add the holiday during which the check-in or check-out will not be recorded.

Add Regular Holiday

You can conĮgure a holiday which will take eīect annually on regular days during the eīecƟve
period, such as New Year's Day, Independence Day, Christmas Day, etc.

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance Seƫngs → Holiday to enter the Holiday Seƫngs page.
3. Check Regular Holiday as holiday type.
4. Custom a name for the holiday.
5. Set the Įrst day of the holiday.
6. Enter the number of the holiday days.
7. Set the aƩendance status if the employee works on holiday.
8. OpƟonal: Check Repeat Annually to make this holiday seƫng eīecƟve every year.
9. Click OK.

The added holiday will display in the holiday list and calendar.
If the date is selected as diīerent holidays, it will be recorded as the Įrst-added holiday.

10. OpƟonal: AŌer adding the holiday, perform one of the following operaƟons.

Edit Holiday Click  to edit the holiday informaƟon.

Delete Holiday Select one or more added holidays, and click Delete to delete the
holiday(s) from the holiday list.

Add Irregular Holiday

You can conĮgure a holiday which will take eīect annually on irregular days during the eīecƟve
period, such as Bank Holiday.

Steps
1. Enter the Time & AƩendance module.
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2. Click AƩendance Seƫngs → Holiday to enter the Holiday Seƫngs page.
3. Click Add to open the Add Holiday page.
4. Check Irregular Holiday as holiday type.
5. Custom a name for the holiday.
6. Set the start date of the holiday.

Example
If you want to set the forth Thursday in November, 2019 as the Thanksgiving Day holiday, you
should select 2019, November, 4th, and Thursday from the four drop-down lists.

7. Enter the number of the holiday days.
8. Set the aƩendance status if the employee works on holiday.
9. OpƟonal: Check Repeat Annually to make this holiday seƫng eīecƟve every year
10. Click OK.

The added holiday will display in the holiday list and calendar.
If the date is selected as diīerent holidays, it will be recorded as the Įrst-added holiday.

11. OpƟonal: AŌer adding the holiday, perform one of the following operaƟons.

Edit Holiday Click  to edit the holiday informaƟon.

Delete Holiday Select one or more added holidays, and click Delete to delete the
holiday(s) from the holiday list.

18.2.6 ConĮgure Leave Type

You can customize the leave type (major leave type and minor leave type) according to actual
needs. You can also edit or delete the leave type.

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance Seƫngs → Leave Type to enter the Leave Type Seƫngs page.
3. Click Add on the leŌ to add a major leave type.
4. OpƟonal: Perform one of the following operaƟons for major leave type.

Edit Move the cursor over the major leave type and click  to edit the major leave type.

Delete Select one major leave type and click Delete on the leŌ to delete the major leave
type.

5. Click Add on the right to add a minor leave type.
6. OpƟonal: Perform one of the following operaƟons for minor leave type.

Edit Move the cursor over the minor leave type and click  to edit the minor leave type.

Delete Select one or mulƟple major leave types and click Delete on the right to delete the
selected minor leave type(s).
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18.2.7 Synchronize AuthenƟcaƟon Record to Third-Party Database

The aƩendance data recorded on the client can be used by other system for calculaƟon or some
other operaƟons. You can enable synchronizaƟon funcƟon to apply the authenƟcaƟon record from
the client to the third-party database automaƟcally.

Steps
1. Enter Time & AƩendance module.
2. Click AƩendance Seƫngs → Third-Party Database .
3. Set Apply to Database switch to on to enable synchronizaƟon funcƟon.
4. Select database Type as SQLServer or MySQL.

Note
● Supported versions：SQLServer 2008, MySQL V5.7.26.
● You should set the Įeld type of the database type as varchar.
● If you select MySQL, you should import the conĮguraƟon Įle (libmysql.dll) from local PC.

5. Set the other required parameters of the third-party database, including server IP address, port
No., database name, user name and password.

Note
The default port No. of the selected database type is displayed automaƟcally. You can enter a
number ranging from 1 to 65535 to customize the port No if needed.

6. Set table parameters of database according to the actual conĮguraƟon.
1) Enter the table name of the third-party database.
2) Set the mapped table Įelds between the client and the third-party database.

7. Click Save to test whether database can be connected and save the seƫngs for the successful
connecƟon.
● The aƩendance data will be wriƩen to the third-party database.
● During synchronizaƟon, if the client disconnects with the third-party database, the client will

start reconnecƟon every 30 mins. AŌer being reconnected, the client will synchronize the data
recorded during the disconnected Ɵme period to the third-party database.

18.2.8 ConĮgure AƩendance CalculaƟon Accuracy

To calculate the aƩendance data accurately, you can set the aƩendance calculaƟon accuracy for
diīerent aƩendance items, including the minimum unit for aƩendance calculaƟon and round-oī
control rule. For example, you can set the minimum unit as 1 hour for leave duraƟon, and set the
round-oī control rule as round up.

Steps
1. Enter the Time and AƩendance module.
2. Click AƩendance Seƫngs → General Rule .
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3. In the Advanced FuncƟon area, set the minimum units (including min, Hour(s) and Workday) for
diīerent staƟsƟc items.

4. Set the round-oī control rules (including Round Down, Round Oī and Round Up) for diīerent
staƟsƟc items.

5. Set the Display Format as MM or HH:MM.
6. Click Save.

Example
Set the minimum unit as 1 hour and the round-oī control rule as round down for overƟme
duraƟon, and if the overƟme duraƟon is less than 1 hour, it will be calculated as 0. If the overƟme
duraƟon is 1.5 hour, it will be calculated as 1 hour.

18.2.9 ConĮgure Break Time

You can add break Ɵme and set start Ɵme, end Ɵme, duraƟon, calculaƟon mode and other
parameters for the break. The added break Ɵme can also be edited or deleted.

Steps
1. Click Time & AƩendance → Timetable → Break Time .

The added break Ɵme is displayed in the list.
2. Click Break Time Seƫngs to enter Break Time Seƫngs window.
3. Click Add.
4. Enter a name for the break Ɵme.
5. Set related parameters for the break Ɵme.

Start Time / End Time
Set the Ɵme when the break starts and ends.

No Earlier Than / No Later Than
Set the earliest swiping Ɵme for starƟng break and the latest swiping Ɵme for ending break.

Break DuraƟon
The duraƟon from start Ɵme to end Ɵme of the break.

CalculaƟon
Auto Deduct

The break duraƟon will be calculated according to the Ɵme you set.
Must Check

The break duraƟon will be calculated and excluded from work hours according to actual
check-in and check-out Ɵme.
Return from Break Early for

The actual check-in and check-out Ɵme does not exceed the break Ɵme, and can be
marked as normal work or work overƟme.
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Return from Break Late for
The actual check-in and check-out Ɵme exceeds the break Ɵme, and can be marked as
late, absent or early leave.

Calculated by
Each Check in/out: Each check-in Ɵme and check-out Ɵme is valid and the sum of all
periods between adjacent check-in and check-out Ɵme will be recorded as the break
Ɵme duraƟon.
First In & Last Out: The Įrst check-in Ɵme is recorded as start break Ɵme and the last
check-out Ɵme is recorded as the end break Ɵme.

Enable T&A Status
Set Enable T&A Status switch to on to calculate the actual break Ɵme according to
aƩendance status on the device.

Note
This funcƟon should be supported by the device.

Valid AuthenƟcaƟon Interval
During the valid authenƟcaƟon interval, person swiping card for several Ɵmes will only
be calculated as once when calculaƟng aƩendance data.

6. Click Save to save the seƫngs.
7. OpƟonal: Click Add to conƟnue adding break Ɵme.

18.3 Add Flexible Timetable
On the Ɵmetable page, you can add Ňexible Ɵmetable for employees, which does not requires the
check-in/out Ɵme but requires the staīs' working Ɵme (from the start Ɵme you set) is equal or
greater than the predeĮned work hours.

Steps
1. Click Time and AƩendance → Timetable to enter the Ɵmetable seƫngs page.
2. Click Add to enter add Ɵmetable page.
3. Create a name for the Ɵmetable.

Note
You can click the color icon beside the name to customize the color for the valid Ɵmetable on
the Ɵme bar.

4. Select the Ɵmetable type as Ňexible.
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Figure 18-2 Add Flexible Timetable
5. Select calculaƟon method.

First In & Last Out
The Įrst check-in Ɵme is recorded as start work Ɵme and the last check-out Ɵme is recorded
as the end-work Ɵme.

Each Check-In/Out
Each check-in Ɵme and check-out Ɵme is valid and the sum of all periods between adjacent
check-in and check-out Ɵme will be recorded as the valid working duraƟon.
You need to set Valid AuthenƟcaƟon Interval for this calculaƟon method. For example, if the
interval between card swiping of the same card is less than the set value, the card swiping is
invalid.

6. OpƟonal: Enable Enable T&A Status to calculate according to aƩendance status of the device.

Note
This funcƟon should be supported by the device.

7. OpƟonal: Enable Calculate Break Time into AƩended DuraƟon.
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Note
When enabled, break Ɵme will be calculated into the overall aƩendance duraƟon. That is, the
actual aƩendance duraƟon equals to the overall aƩendance duraƟon (includes break Ɵme).

8. Set the related aƩendance Ɵme parameters as the following:
Working Hours

The employees' working hours should be equal or greater than the set value.
Start Time of Timetable

Calculate the working hours of each day from the set value.
For example, if you have set the working hours as 8 hours, and the start Ɵme of Ɵmetable as
9:00 am, and the staī A checked-in at 8:00 am and checked-out at 5:00 pm (eīecƟve working
hours are 9:00 am to 5:00 pm, totally 8 hours), the aƩendance result for staī A will be
calculated as normal.

9. Click Save to add the Ɵmetable.
10. OpƟonal: Perform one or more following operaƟons aŌer adding Ɵmetable.

Edit Timetable Select a Ɵmetable from the list to edit related informaƟon.

Delete Timetable Select a Ɵmetable from the list and click Delete to delete it.

18.4 Add General Timetable
On the Ɵmetable page, you can add general Ɵmetable for employees, which requires the Įxed
start-work Ɵme and end-work Ɵme. Also, you can set valid check-in/out Ɵme, allowable Ɵmetable
for being late and leaving early.

Steps
1. Click Time and AƩendance → Timetable to enter the Ɵmetable seƫngs page.
2. Click Add to enter add Ɵmetable page.
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Figure 18-3 Add Timetable
3. Create a name for the Ɵmetable.

Note
You can click the color icon beside the name to customize the color for the valid Ɵmetable on
the Ɵme bar in the ConĮguraƟon Result area.

4. Select the Ɵmetable type as general.
5. Select calculaƟon method.

First In & Last Out
The Įrst check-in Ɵme is recorded as start work Ɵme and the last check-out Ɵme is recorded
as the end-work Ɵme.
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Each Check-In/Out
Each check-in Ɵme and check-out Ɵme is valid and the sum of all periods between adjacent
check-in and check-out Ɵme will be recorded as the valid working duraƟon.
You need to set Valid AuthenƟcaƟon Interval for this calculaƟon method. For example, if the
interval between card swiping of the same card is less than the set value, the card swiping is
invalid.

6. OpƟonal: Set Enable T&A Status switch to on to calculate according to aƩendance status of the
device.

Note
This funcƟon should be supported by the device.

7. OpƟonal: Enable Calculate Break Time into AƩended DuraƟon.

Note
When enabled, break Ɵme will be calculated into the overall aƩendance duraƟon. That is, the
actual aƩendance duraƟon equals to the overall aƩendance duraƟon (includes break Ɵme).

8. OpƟonal: Enable Count Early Check-In as OverƟme, then the period between your early check-
in and the oĸcial start-work Ɵme will be calculated as overƟme.

9. Count Early Check-In as AƩendance: The Ɵme of early check-in will be counted as the oĸcial
start-work Ɵme.

10. Set the related aƩendance Ɵme parameters as the following:
Start/End-Work Time

Set the start-work Ɵme and end-work-Ɵme.
Valid Check-in/out Time

On the Ɵme bar, adjust the yellow bar to set the Ɵmetable during which the check-in or
check-out is valid.

Calculated as
Set the duraƟon calculated as the actual work duraƟon.

Late/Early Leave Allowable
Set the Ɵmetable for late or early leave.

11. Set absence related parameters.
Check-In, Late for

You can set the late Ɵme duraƟon for the employee who has checked in but is late for work.
If the employee exceeds the required Ɵme period, his/her aƩendance data will be marked
as absent.

Check-Out, Early Leave for
You can set the early leave Ɵme duraƟon for the employee who checks out earlier than the
normal leave Ɵme, and his/her aƩendance data will be marked as absent.

No Check-in
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If the employee does not check in, his/her aƩendance data may be marked as absent or
late.

No Check-Out
If the employee does not check out, his/her aƩendance data may be marked as absent or
early leave.

12. Click Save to add the Ɵmetable.
13. OpƟonal: Perform one or more following operaƟons aŌer adding Ɵmetable.

Edit Timetable Select a Ɵmetable from the list to edit related informaƟon.

Delete Timetable Select a Ɵmetable from the list and click Delete to delete it.

18.5 Add ShiŌ
You can add shiŌ for employees including seƫng shiŌ period (day, week, month) and the eīecƟve
aƩendance Ɵme. According to the actual requirements, you can adding mulƟple Ɵmetables in one
shiŌ for employees, which requires them to check in and check out for each Ɵmetable.

Before You Start
Add a Ɵmetable Įrst. See Add General Timetable for details.

Steps
1. Click Time & AƩendance → ShiŌ to enter shiŌ seƫngs page.
2. Click Add to enter Add ShiŌ page.
3. Enter the name for shiŌ.
4. Select the shiŌ period from the drop-down list.
5. Select the added Ɵmetable and click on the Ɵme bar to apply the Ɵmetable.
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Figure 18-4 Add ShiŌ

Note
You can select more than one Ɵmetables. The start and end work Ɵme and the valid check-in
and out Ɵme in diīerent Ɵme tables can not be overlapped.
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Figure 18-5 Add MulƟple Timetables
6. Click Save.

The added shiŌ lists on the leŌ panel of the page. At most 64 shiŌs can be added.
7. OpƟonal: Assign the shiŌ to organizaƟon or person for a quick shiŌ schedule.

1) Click Assign.
2) Select OrganizaƟon or Person tab and check the desired organizaƟon(s) or person(s) box.

The selected organizaƟons or persons will list on the right page.
3) Set the Expire Date for the shiŌ schedule.
4) Set other parameters for the schedule.

Check-in Not Required
Persons in this schedule do not need to check-in when they come to work.

Check-out Not Required
Persons in this schedule do not need to check-out when they end work.

Scheduled on Holidays
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On the holidays, this schedule is sƟll eīecƟve and the persons needs to go to work
according to the schedule.

EīecƟve for OverƟme
The persons' overƟme will be recorded for this schedule.

5) Click Save to save the quick shiŌ schedule.

18.6 Manage ShiŌ Schedule
ShiŌ work is an employment pracƟce designed to make use of all 24 hours of the clock each day of
the week. The pracƟce typically sees the day divided into shiŌs, set periods of Ɵme during which
diīerent shiŌs perform their duƟes.

You can set department schedule, person schedule, and temporary schedule.

18.6.1 Set Department Schedule

You can set the shiŌ schedule for one department, and all the persons in the department will be
assigned with the shiŌ schedule.

Before You Start
In Time & AƩendance module, the department list is the same with the organizaƟon. You should
add organizaƟon and persons in Person module Įrst. See Person Management for details.

Steps
1. Click Time & AƩendance → ShiŌ Schedule to enter the ShiŌ Schedule Management page.
2. Click Department Schedule to enter Department Schedule page.
3. Select the department from the organizaƟon list on the leŌ.

Note
If Include Sub OrganizaƟon is checked, when selecƟng the organizaƟon, its sub organizaƟons are
selected at the same Ɵme.

4. Select the shiŌ from the drop-down list.
5. OpƟonal: Enable MulƟple ShiŌ Schedules and select the eīecƟve Ɵme period(s) from the

added Ɵmetables for the persons.

Note
This is only available for shiŌ with only one Ɵmetable.
MulƟple ShiŌ Schedules

It contains more than one Ɵmetables. The person can check in/out in any of the Ɵmetables
and the aƩendance will be eīecƟve.
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If the mulƟple shiŌ schedules contains three Ɵmetables: 00:00 to 07:00, 08:00 to 15:00 and
16:00 to 23:00. The aƩendance of the person adopƟng this mulƟple shiŌ schedules will be
eīecƟve in any of the three Ɵmetables. If the person checks in at 07:50, it will apply the
nearest Ɵmetable 08:00 to 15:00 to the person's aƩendance.

6. Set the start date and end date.
7. Set other parameters for the schedule.

Check-in Not Required
Persons in this schedule do not need to check-in when they come to work.

Check-out Not Required
Persons in this schedule do not need to check-out when they end work.

Scheduled on Holidays
On the holidays, this schedule is sƟll eīecƟve and the persons needs to go to work according
to the schedule.

EīecƟve for OverƟme
The persons' overƟme will be recorded for this schedule.

Flexible ShiŌ Schedule on Weekend
The person's aƩendance on the weekend will be recorded as overƟme.

8. Click Save.

18.6.2 Set Person Schedule

You can assign the shiŌ schedule to one or more persons. You can also view and edit the person
schedule details.

Before You Start
Add department and person in Person module. See Person Management for details.

Steps

Note
The person schedule has the higher priority than department schedule.

1. Click Time & AƩendance → ShiŌ Schedule to enter the ShiŌ Schedule page.
2. Click Person Schedule to enter Person Schedule page.
3. Select the organizaƟon and select the person(s).
4. Select the shiŌ from the drop-down list.
5. OpƟonal: Enable MulƟple ShiŌ Schedules and select the eīecƟve Ɵme period(s) from the

added Ɵmetables for the persons.
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Note
This is only available for shiŌ with only one Ɵmetable.
MulƟple ShiŌ Schedules

It contains more than one Ɵmetables. The person can check in/out in any of the Ɵmetables
and the aƩendance will be eīecƟve.
If the mulƟple shiŌ schedules contains three Ɵmetables: 00:00 to 07:00, 08:00 to 15:00 and
16:00 to 23:00. The aƩendance of the person adopƟng this mulƟple shiŌ schedules will be
eīecƟve in any of the three Ɵmetables. If the person checks in at 07:50, it will apply the
nearest Ɵmetable 08:00 to 15:00 to the person's aƩendance.

6. Set the start date and end date.
7. Set other parameters for the schedule.

Check-in Not Required
Persons in this schedule do not need to check-in when they come to work.

Check-out Not Required
Persons in this schedule do not need to check-out when they end work.

Scheduled on Holidays
On the holidays, this schedule is sƟll eīecƟve and the persons needs to go to work according
to the schedule.

EīecƟve for OverƟme
The persons' overƟme will be recorded for this schedule.

Flexible ShiŌ Schedule on Weekend
The person's aƩendance on the weekend will be recorded as overƟme.

8. Click Save.

18.6.3 Set Temporary Schedule

You can add a temporary schedule for the person and the person will be assigned with the shiŌ
schedule temporarily. You can also view and edit the temporary schedule details.

Before You Start
Add department and person in Person module. See Person Management for details.

Steps

Note
The temporary schedule has higher priority than department schedule and person schedule.

1. Click Time & AƩendance → ShiŌ Schedule to enter the ShiŌ Schedule Management page.
2. Click Temporary Schedule to enter Temporary Schedule page.
3. Select the organizaƟon and select the person(s).
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4. Click one date or click and drag to select mulƟple dates for the temporary schedule.
5. Select Workday or Non-Workday from drop-down list.

If Non-Workday is selected, you need to set the following parameters.
Calculated as

Select normal or overƟme level to mark the aƩendance status for temporary schedule.
Timetable

Select a Ɵmetable from drop-down list.
MulƟple ShiŌ Schedule

It contains more than one Ɵmetables. The person can check in/out in any of the Ɵmetables
and the aƩendance will be eīecƟve.
If the mulƟple shiŌ schedules contains three Ɵmetables: 00:00 to 07:00, 08:00 to 15:00 and
16:00 to 23:00. The aƩendance of the person adopƟng this mulƟple shiŌ schedules will be
eīecƟve in any of the three Ɵmetables. If the person checks in at 07:50, it will apply the
nearest Ɵmetable 08:00 to 15:00 to the person's aƩendance.

Rule
Set other rule for the schedule, such as Check-in Not Required, andCheck-out Not Required.

6. Click Save.

18.6.4 Check ShiŌ Schedule

You can check the shiŌ schedule in calendar or list mode. You ca also edit or delete the shiŌ
schedule.

Steps
1. Click Time & AƩendance → ShiŌ Schedule to enter the ShiŌ Schedule Management page.
2. Select the organizaƟon and corresponding person(s).
3. Click  or  to view the shiŌ schedule in calendar or list mode.

Calendar
In calendar mode, you can view the shiŌ schedule for each day in one month. You can click
the temporary schedule for one day to edit or delete it.

List
In list mode, you can view the shiŌ schedule details about one person or organizaƟon, such as
shiŌ name, type, eīecƟve period and so on. Check the shiŌ schedule(s), and click Delete to
delete the selected shiŌ schedule(s).
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18.7 AƩendance Handling
If your aƩendance status appears abnormal due to reasons such as forgeƫng to check in/out,
having business trips, or taking leave, you can recƟfy your aƩendance records by manually
correcƟng check in/out record and add leave or business trips.

18.7.1 Manually Correct Check-in/out Record

If the aƩendance status is not correct, you can manually correct the check-in or check out record.
You can also edit, delete, and export the check-in or check-out record.

Before You Start
● You should add organizaƟons and persons in Person module. For details, refer to Person

Management .
● The person's aƩendance status is incorrect.

Steps
1. Click Time & AƩendance → AƩendance Handling to enter aƩendance handling page.
2. Click Correct Check-in/out to enter adding check-in/out correcƟon page.
3. Select one or more persons from leŌ list for correcƟon.
4. Select the correcƟon date.
5. Select the correcƟon type as Check-in, Check-out, Break-in, Break-out, etc,. and set the correct

Ɵme.

Note
You can click  to add mulƟple correcƟon items. At most 8 check-in/out items can be added.

6. OpƟonal: Enter the remark informaƟon as desired.
7. Click Save to save the above seƫngs.
8. OpƟonal: AŌer adding the check-in/out correcƟon, perform one of the following operaƟons.

View Click  or  to view the added aƩendance handling informaƟon in calendar or list
mode.

Edit ● In calendar mode, click  → Edit to edit the details.
● In list mode, double-click the related Įeld in Date, Handling Type, Time, or Remark

column to edit the details.

Note
The edited check-in/out correcƟon will take aīect.

Delete ● In calendar mode, select one check-in/out correcƟon, and click Delete to delete
the selected item.

● In list mode, check one or more check-in/out correcƟons, and click Delete to
delete the selected items.
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Note
The deleted check-in/out correcƟon will no longer take aīect.

Export In list mode, check one or more check-in/out correcƟons to export the aƩendance
handling details (CSV Įle) to local PC.

18.7.2 Add Leave and Business Trip

You can add leave and business trip when the employee want to ask for leave or go on a business
trip.

Before You Start
You should add organizaƟons and persons in the Person module. For details, refer to Person
Management .

Steps
1. Click Time & AƩendance → AƩendance Handling to enter aƩendance handling page.
2. Click Apply for Leave/Business Trip to enter adding the leave/business trip page.
3. Select person from leŌ list.
4. Set the date(s) for your leave or business trip.
5. Select the major leave type and minor leave type from the drop-down list.

Note
You can set the leave type in AƩendance Seƫngs. For details, refer to ConĮgure Leave Type .

6. Set the Ɵme for leave.
Click Add to set a second leave period for the selected date.

7. OpƟonal: Enter the remark informaƟon as desired.
8. Click Save.
9. OpƟonal: AŌer adding the leave and business trip, perform one of the following operaƟons.

View Click  or  to view the added aƩendance handling informaƟon in calendar or list
mode.

Note
In calendar mode, you need to click Calculate to get the aƩendance status of the
person in one month.

Edit ● In calendar mode, click the related label on date to edit the details.
● In list mode, double-click the Įled in Date, Handling Type, Time, or Remark column

to edit the related informaƟon.

Delete Delete the selected items.

Export Export the aƩendance handling details to local PC.
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Note
The exported details are saved in CSV format.

18.8 Calculate AƩendance Data
You need to calculate the aƩendance data before searching and viewing the overview of the
aƩendance data, employees' detailed aƩendance data, employees' abnormal aƩendance data, the
employees' overƟme working data, and card swiping log.

18.8.1 AutomaƟcally Calculate AƩendance Data

You can set a schedule so that the client can automaƟcally calculate aƩendance data of the
previous day at the Ɵme you conĮgured every day.

Steps

Note

1. Enter the Time & AƩendance module.
2. Click AƩendance Seƫngs → General Rule .
3. In the Auto-Calculate AƩendance area, set the Ɵme that you want the client to calculate the

data.
4. Click Save.

The client will calculate the aƩendance data of the previous day from the Ɵme you have
conĮgured.

18.8.2 Manually Calculate AƩendance Data

You can manually calculate aƩendance data by seƫng condiƟons including aƩendance Ɵme,
department, aƩendance status, etc.

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance StaƟsƟcs → CalculaƟon .
3. Set the start Ɵme and end Ɵme to deĮne the aƩendance data range.
4. Select the department from the drop-down list.
5. OpƟonal: Set other condiƟons, including name and person ID.
6. Check aƩendance status (supports mulƟ-selecƟon).
7. Click Calculate.
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Note
Only the aƩendance data within three months can be calculated.

8. OpƟonal: Perform one of the following operaƟons.

Correct Check-
in/out

Select one person, click Correct Check-in/out to add check-in/out
correcƟon.

Select Items to
Display

Click  on the upper right corner, or right click the table header of the
aƩendance data list to customize the items to be displayed in the list.

Adjust Items
Sequence

Click one item (except Person ID) and move the mouse to customize the
sequence of diīerent items.

Generate Report Click Report to generate the aƩendance report.

Note
The report items will be displayed in the sequence you have set.

Export Report Click Export to export aƩendance data (CSV Įle) to local PC.

Note
The report items will be displayed in the sequence you have set.

18.9 AƩendance StaƟsƟcs
You can check the original aƩendance record, generate and export the aƩendance report based on
the calculated aƩendance data.

18.9.1 Get an Overview of Employees' AƩendance Data

You can search and view the employee's aƩendance data uploaded from devices by the client,
including aƩendance Ɵme, aƩendance status, check point, etc.

Before You Start
● You should add organizaƟons and persons in Person module and the persons have swiped cards.

For details, refer to Person Management .
● Calculate the aƩendance data.
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Note
○ The client will automaƟcally calculate the previous day's aƩendance data at 1:00 am on the

next day.
○ Keep the client running at 1:00 am, or it cannot calculate the previous day's aƩendance data
automaƟcally. If not calculated automaƟcally, you can calculate the aƩendance data manually.
For details, refer to Manually Calculate Attendance Data .

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance StaƟsƟcs → AƩendance Record .
3. Set the aƩendance start Ɵme and end Ɵme that you want to search.
4. Set other search condiƟons, including department, name, and person ID.
5. Select data source as All, Original Records on Device or Manually Handled Records.

Note
AŌer selecƟng Original Records on Device, you can specify the AƩendance Check Point.

6. OpƟonal: Click Get Events from Device to get the aƩendance data from the device.

Note
There are two methods for geƫng aƩendance events from the device, including Online and
Import File. For more details about operaƟons, refer to Get Events from Device .

7. OpƟonal: Click Reset to reset all the search condiƟons and edit the search condiƟons again.
8. Click Search.
9. OpƟonal: For the displayed search results, perform one of the following operaƟons.

Edit AƩendance
Status

Select one incorrect record, double click the Įeld of AƩendance Status
column and select from the drop-down list to edit single piece of
aƩendance status.
Check two or more incorrect records, click Edit AƩendance Status on the
upper leŌ corner and select from the drop-down list to batch edit mulƟple
pieces of aƩendance status.

Generate Report Click Report to generate the aƩendance report.

Export Report Click Export and select saving path to export the aƩendance report (CVS
Įle) to the local PC.

Custom Export Click Custom Report and set condiƟons to export aƩendance records
according to actual needs. For details, refer to Custom Export Attendance
Records .

Custom Columns On the upper right of the report, click  and select columns displayed in
the report.
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18.9.2 Custom Export AƩendance Records

AŌer viewing the employee's aƩendance data, you can export the aƩendance records according to
actual needs.

Before exporƟng the necessary aƩendance records, you should search and get employee's
aƩendance data. For details, refer to Get an Overview of Employees' Attendance Data .
Click Custom Export to set the related informaƟon.
Start/End Time

You can set the start and end Ɵme of exporƟng aƩendance records.
Saving Path

You can select the Įle path for saving aƩendance records.
File Name

The Įle will be named according to the actual exporƟng date. You can select format of the date
such as dd-MM-yyyy and dd-MM-yy.

Format
You can export the original aƩendance records in .TXT and .CVS formats.

Separator
You can select to have/not have separators (including comma, space, tab) for separaƟng
diīerent items in the exported Įle.

Export
You can select the items you need to export including ID, person name, department, date, etc.

Default Value
When there is no informaƟon for the item you have selected to export, you can set a default
value to replace the blank space.

18.9.3 ConĮgure Report Display

You can conĮgure display contents displayed in the aƩendance report, such as the company name,
logo, date format, Ɵme format, and mark.

Steps
1. Enter Time & AƩendance module.
2. Click AƩendance StaƟsƟcs → Report Display .
3. Set the display seƫngs for aƩendance report.

Company Name
Enter a company name to display the name in the report.

AƩendance Status Mark
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Enter the mark and select the color. The related Įelds of aƩendance status in the report will
display with the mark and color.

Weekend Mark
Enter the mark and select the color. The weekend Įelds in the report will display with the
mark and color.

4. Click Save.

18.9.4 Generate Instant Report

It supports to generate the a series of aƩendance reports manually to view the employees'
aƩendance results.

Before You Start
Calculate the aƩendance data.

Note
You can calculate the aƩendance data manually, or set the schedule so that the client can calculate
the data automaƟcally every day. For details, refer to Calculate Attendance Data .

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance StaƟsƟcs → Report .
3. Select a report type.
4. Select the department or person to view the aƩendance report.
5. Set the start Ɵme and end Ɵme during which the aƩendance data will be displayed in the report.
6. Click Report to generate the staƟsƟcs report and open it.

18.9.5 Send Report Regularly

The client supports mulƟple report types and you can pre-deĮne the report content and it can
send the report automaƟcally to the email address you conĮgured.

Steps
1. Enter the Time & AƩendance module.
2. Click AƩendance StaƟsƟcs → Regularly Send Report .
3. Click Add to enter the add custom report page.
4. Set the report content.

Report Name
Enter a name for the report.

Report Type
Select one report type and this report will be generated.
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Report Time
The Ɵme to be selected may vary for diīerent report type.

Person
Select the added person(s) whose aƩendance records will be generated for the report.

Note
You can view the selected person(s) in the right side of the Person area.

5. Set the schedule to send the report to the email address(es) automaƟcally.

Note
The Auto-Send Email funcƟon is enabled by default.

1) Set the EīecƟve Period during which the client will send the report on the selected sending
date(s).

2) Select the Sending Date(s) on which the client will send the report.
3) Set the Sending Time at which the client will send the report.

Example
If you set the eīecƟve period as 2018/3/10 to 2018/4/10, select Friday as the sending date,
and set the sending Ɵme as 20:00:00, the client will send the report at 8 p.m. on Fridays
during 2018/3/10 to 2018/4/10.

Note
Make sure the aƩendance records are calculated before the sending Ɵme. You can calculate
the aƩendance data manually, or set the schedule so that the client can calculate the data
automaƟcally every day. For details, refer to Calculate Attendance Data .

4) Enter the receiver email address(es).

Note
Up to 5 email addresses can be added. You can click + to add a new email address.

5) OpƟonal: Click Preview to view the email details.
6. Click OK.
7. OpƟonal: AŌer adding the custom report, you can do one or more of the followings:

Edit Report Select one added report and click Edit to edit its seƫngs.

Delete Report Select one added report and click Delete to delete it.

Generate Report Select one added report and click Report to generate the report instantly
and you can view the report details.
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Chapter 19 Video Intercom

Video intercom is an audiovisual communicaƟon system used within a building or a small collecƟon
of buildings. With microphones and video camera devices at both sides, it enables the inter-
communicaƟon via video and audio signals. A video intercom system can provide a safe and easy
monitoring soluƟon for apartment buildings and private houses.

Be sure to add video intercom devices to the client and link the indoor staƟons to the persons
beforehand. You should also set the access authorizaƟon for the persons to open doors via the
linked indoor staƟons.

Note
● For details about adding persons, refer to Add a Single Person .
● For details about seƫng person's access authorizaƟon, refer to Assign Access Levels to Persons

in Access Groups .

19.1 Flow Chart

Figure 19-1 Flow Chart of Video Intercom
● Add Video Intercom Device: You can add video intercom devices on the client. For more details,

refer to Add Device .
● Group Access Points: You can group the added access points into groups for convenient

management. For more details, refer to Group Management .
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● Video Intercom Arming Control: You can enable or disable the calling between the added video
intercom devices and the client. For more details, refer to Enable Calling between Video
Intercom Device and Client .

● Apply APP Package to Indoor StaƟon: You can apply the applicaƟon package saved in local PC to
one or mulƟple indoor staƟons remotely via the client. For more details, refer to Apply
ApplicaƟon Package to Indoor StaƟon .

● Call Indoor StaƟon From Client: You can call the added indoor staƟon by the client to perform
video intercom. For more details, refer to Call Indoor StaƟon from Client .

● Answer Call via Client: You can answer call from the added indoor staƟon, door staƟon, etc. via
the client to perform video intercom. For more details, refer to Answer Call via Client .

● View Call Logs: You can view details of all the calls. For more details, refer to View Real-Time
Call Logs .

● Release NoƟce to Resident: You can send a noƟce to the residents by one-touch on the client.
For more details, refer to Release a NoƟce to Resident .

● ConĮgure Video Intercom Event: By conĮguring linked acƟons of video intercom event on the
client, you will be noƟĮed once the event is triggered. For more details, refer to ConĮgure Client
AcƟons for Access Event .

● Search Real-Time/History Event: You can view the real-Ɵme events, search the historical events
on the client. For more details, refer to Event Center .

19.2 Manage Calls between Client SoŌware and an Indoor/Door StaƟon/
Access Control Device
You can call the residents by the client, and vice versa. You can also use an indoor staƟon/door
staƟon or speciĮed access control device to call the client.

Before making calls, you can set the parameters such as ring duraƟon and speaking duraƟon. For
details, refer to Set Access Control and Video Intercom Parameters .

19.2.1 Call Indoor StaƟon from Client

You can call the added indoor staƟon by the client to perform video intercom.

Before You Start
● Be sure to have added a resident to the client. For details, refer to Add a Single Person .
● Be sure to have linked the resident with an indoor staƟon and conĮgured the resident
informaƟon (including Ňoor No. and room No.) in Person module. For details about conĮguring
the linkage and resident informaƟon, refer to ConĮgure Resident InformaƟon .
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Steps

Note
● A video intercom device can be added to more than one client, but perform video intercom with

only one client at a Ɵme.
● You can remotely conĮgure the Max. Ring DuraƟon and the Max. Speaking DuraƟon.

1. Click Access Control → Video Intercom → Contacts .
2. Unfold the organizaƟon list on the leŌ panel and select an organizaƟon.

The informaƟon (including resident name, device name, Ňoor No. and room No.) of all the
residents in the selected group will be displayed on the right panel.

3. Select a resident, or enter a keyword in the Filter Įeld to Įnd the desired resident.
4. Click  to start calling the selected resident.

AŌer the call is answered, you will enter the In Call window.
5. OpƟonal: AŌer the call is answered, perform the following operaƟon(s).

Adjust Loudspeaker Volume Click  to adjust the volume of the loudspeaker.

End Speaking Click Hang Up to end speaking.

Adjust Microphone Volume Click  to adjust the volume of the microphone.

19.2.2 Answer Call via Client

You can answer call from the added indoor staƟon, door staƟon, or speciĮc access control device
via the client and perform video intercom.

Steps

Note
A video intercom device can be added to more than one client, but perform video intercom with
only one client at a Ɵme.

1. Call the client by an indoor staƟon, door staƟon, or speciĮc access control device.
An incoming call dialog will pop up.
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Figure 19-2 Incoming Call
2. Click Answer to answer the call.

AŌer the call is answered, you will enter the In Call window.
3. OpƟonal: In the In Call window, perform the following operaƟon(s).

Adjust Loudspeaker
Volume

Click  to adjust loudspeaker's volume.

End Speaking Click Hang Up to end speaking.

Adjust Microphone
Volume

Click  to adjust the microphone's volume.

Capture Picture Click  to take a screenshot of the current call screen.

Open Door When an indoor staƟon is linked with a door staƟon, click  to
open the door linked with the door staƟon.

19.3 View Real-Time Call Logs
You can view details of all the calls, and you can call the residents or export the logs if they are
needed.

Steps
1. Click Access Control → Video Intercom → Call Log .
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Details of all the calls will be displayed on the right panel including call status, start Ɵme,
speaking duraƟon, device type and name, and organizaƟon and name of resident.

2. OpƟonal: Click  to re-dial the resident.
3. OpƟonal: Set search condiƟons (including call status, device type, and Ɵme) on the top of the

page to Įlter call logs.
4. Click Export to save the logs (a CSV Įle) in your PC.

19.4 Release a NoƟce to Resident
You can send a noƟce to the residents by one-touch. Four noƟce types are available: adverƟsing,
property, alarm, and noƟce informaƟon.

Steps
1. Click Access Control → Video Intercom → NoƟce .
2. Click Add to open the Create NoƟce panel.
3. Click  to select the residents you are going to deliver noƟce to.
4. Enter the required informaƟon.

Note
● Up to 63 characters are allowed in the Subject Įeld.
● Up to 1023 characters are allowed in the Content Įeld.
● You can add up to 6 pictures. Each picture should be in JPG format and smaller than 512 KB.

5. Click Send to send the noƟce to the selected resident(s).
InformaƟon about the sent noƟces will be displayed on the leŌ panel. Click a noƟce to view its
details on the right panel.

6. OpƟonal: Click Export to save all the noƟces in your PC.

19.5 Enable Calling between Video Intercom Device and Client
You can enable or disable the calling between the added video intercom devices and the client. If
enabled, you can call the intercom device via client, and the client can receive the calling from the
device; If disabled, the client and video intercom device cannot call each other.

Note
You needn't enable this funcƟon for the door staƟons added by ISUP for calling.

Click  → Tool → Video Intercom Arming Control to open Video Intercom Arming Control page.
The list shows the status of the video intercom devices. You can set the switch to on for the video
intercom device to enable calling between the video intercom device and the client. If required,
perform the following operaƟons.
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● Filter Device：If there are too many devices, you can enter the key words in the Filter Įeld to
Įlter the device.

● Arm All / Disarm All: Click Arm All to arm all devices. Click Disarm All to disarm all devices.

19.6 Apply ApplicaƟon Package to Indoor StaƟon
If you want to install applicaƟon on indoor staƟon, you can apply the applicaƟon package saved in
local PC to one or mulƟple indoor staƟons remotely via the client. The package will be installed on
the indoor staƟons automaƟcally aŌer the indoor staƟons receive the package.

Note
This funcƟon should be supported by the device.

Click Access Control → Video Intercom → ApplicaƟon to enter the applying applicaƟon page.
Select one or mulƟple added indoor staƟons, and click Apply ApplicaƟon. You can select the
installaƟon package from local folder to apply the applicaƟon package to the selected indoor
staƟons.
AŌer the indoor staƟons receive the package, the applicaƟon will be installed on the devices
automaƟcally.
Up to two applicaƟons can be installed on the indoor staƟon. If two applicaƟons have been
installed, you need to uninstall one for installing another one. Click  to uninstall the applicaƟon
installed on indoor staƟon remotely.
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Chapter 20 Topology Management

The topology management module provides network health status monitor funcƟons based on the
hardware and soŌware, in order to ensure normal link transmission and beƩer usage of the
resources in network. It is mainly used for network maintenance and management. The
administrator can check the status of the device and its connected devices via topology view, and
know real-Ɵme network status.

20.1 Topology Display Overview
The topology display page shows the relaƟonships among diīerent devices obtained by the client,
including the devices added to the client, the devices searched via SADP, and the devices
connected with the added devices or searched devices. You can check device informaƟon, link
transmission status, etc.

Note
● When the devices are searched via SADP, the device names in topology view are consistent with

their IP addresses.
● For the unknown device, the topology view will show the device type only.

Enter Topology module, click  to get the latest device list and display the topology relaƟonship. If
you enter the Topology page for the Įrst Ɵme, you can follow the guide and click Add Topology to
generate the topology view. Then you can click  → Get Topology Again to refresh it according to
actual requirements.

Note
You can also click  → Refresh Status to get the online or oŋine status of the devices.
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Figure 20-1 Topology Display

Device Node
● View Device informaƟon: You can check the device type and IP address.

Note
If the device name, IP address, online status, or other informaƟon of the device is edited, the
device informaƟon in topology view will change synchronously.

● Expand/Hide: You can click  或  to expand or hide the sub node(s) of certain device.
● Adjust Topology View: On the lower right corner, you can click the icons or scroll your mouse

wheel to enlarge or narrow the typology.
● Search Topology: On the top leŌ corner, you can enter another name or IP address of a device to

view the corresponding typology.

Line
On the top right corner, you can view the icon of lines (wireless, opƟcal Įber, and network) and the
meaning of diīerent colors.

20.2 Set Topology Parameters
You can set the parameters for the topology display, including display level and bandwidth alarm
threshold.
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Enter Topology module, and click  in lower leŌ corner to set the related parameters as follows.
Set Display Level

When there are too many devices combined into a complex topology, you can set the display
level to show the main structure more clearly. AŌer changing the typology seƫngs, you need to
click  to view the latest topology. If the device node is hidden, you can click  to expand the
hidden the device node.

Set Upstream Bandwidth L1/L2 Alarm
You can set upstream bandwidth L1 alarm and L2 alarm. The line will turn to yellow (busy)/red
(congesƟon) when the bandwidth exceeds the threshold of L1/L2 alarm.

Figure 20-2 Set Topology Parameters

20.3 View Device Details
You can view the details of the devices in topology, such as basic informaƟon, device usage, device
panel status, and port informaƟon.

On Topology page, double-click the device node to show the device details as follows.
Basic InformaƟon

The basic informaƟon shows the device type, model, and IP address of the device.
Device Panel Status

The device panel status shows the supported port type, and port usage.
Port InformaƟon

The port informaƟon shows the ports of the device, and the peer device informaƟon.
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Figure 20-3 Device Details

20.4 View Link Details
You can view the details of the link between two device nodes, such as transmission rate, device
type, port status, IP address, and port name of each device.

On Topology page, double-click the line between two device nodes to show the link details as
follows.
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Figure 20-4 Link Details
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20.5 View Signal Transmission Path
When the data transmission between the network camera and the switch is abnormal, you can
check the signal transmission path to Įnd the faulted link for link maintenance.

On Topology page, click  in top right corner, and select network camera and NVR/transmission
device to show the Ňash of the signal transmission (including link and devices) between the two
devices.

Figure 20-5 View Signal Transmission Path
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20.6 Export Topology
You can export the topology view as PDF Įle, in order to view the device connecƟon status, level,
type, IP address and other informaƟon.

On Topology page, click  , and select the path to export the typology.

20.7 More FuncƟons
More funcƟons in Topology module are supported, including handling events, viewing device
status, remote conĮguraƟon, etc.

Note
The displayed funcƟons may vary for diīerent devices.

Right-click the device note in topology, and perform one of the following operaƟons.

Event Handling
When the events are detected for the device, a red alarm icon appears on the device node. You can
enter Event Handling page to view the event informaƟon (e.g., event source, event Ɵme, and event
details) .
Select one or mulƟple events in the list, and click Clear Events to delete the selected events. If all
events are cleared, the red alarm icon on device node will disappear.

Note
This funcƟon is supported by the switch, wireless network bridge, and Įber converter.

Remote ConĮguraƟon
The remote conĮguraƟon funcƟon provides a quick entry to conĮgure the related device
parameters, such as system parameters, network parameters, port conĮguraƟon, and link
aggregaƟon.

Edit Name
You can edit the device name as you want.

Set as Root
You can set the device as root node to adjust the topology structure and connecƟon. AŌer the
seƫng, the topology will be refreshed automaƟcally.

Note
This funcƟon is supported by the switch, wireless network bridge, Įber converter, and virtual
switch.
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Chapter 21 Broadcast Management

You can manage the added speaker units and conĮgure the related funcƟons for them, such as
grouping mulƟple speaker units, conĮguring live broadcast, and conĮguring scheduled broadcast.

21.1 Control Speaker Units
AŌer adding speaker units, you can batch control mulƟple speaker units in a group, such as
adjusƟng volume and seƫng linkage acƟons.

Note
● Make sure you have added speaker units on Device Management → Device . Refer to Add

Device .
● Make sure you have grouped speaker units on Device Management → Group . Refer to Group

Resources .

On the leŌ, select Broadcast Console, select a speaker unit group, and all speaker units in the
group will be displayed.

Figure 21-1 Broadcast Console

You can perform the following operaƟons to control speaker units.

OperaƟon DescripƟon

Adjust volume for the selected devices. Or check mulƟple devices and click
Batch Adjust Volume to adjust volume in a batch.
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OperaƟon DescripƟon

You can view the volume change alarms reported by the broadcast device.
For details, go to Event Center → Real-Time Events . When you open the
volume adjustment page or the batch volume adjustment page, the volume
will be updated to match the alarm.

Test the broadcast funcƟon of the selected speaker unit.

Click ConĮgure to go to the event conĮguraƟon page, and conĮgure linked
broadcast tasks for events. Refer to ConĮgure Event for Camera .

ConĮgure more audio parameters such as blue tooth input volume and
output volume.

Time Seƫngs Click More Seƫngs → Time Seƫngs to conĮgure the selected devices' Ɵme.

DST Click More Seƫngs → DST to conĮgure the selected devices' DST.

21.2 Manage Material Library
You can add media library, upload audio Įles, and play the audios.

Steps
1. On the leŌ, select Material Library.
2. Select a media library, or New Directory.
3. Click Add, and select audio Įles (in MP3 and WAV formats) from the local PC for uploading.
4. OpƟonal: AŌer adding materials, click  to play the audio. You can also edit the materiel name

(which cannot be duplicated).

21.3 ConĮgure Live Broadcast
You can select the speaker units and a broadcast mode (emergency broadcast, speak in real-Ɵme,
play audio, and text noƟĮcaƟon) to conĮgure the live broadcast. The corresponding audio Įle,
speech synthesis, or your voice will be played by the speaker units in real Ɵme.

Note
● Make sure you have added speaker units on Device Management → Device . Refer to Add

Device .
● Make sure you have grouped speaker units on Device Management → Group . Refer to Group

Resources .

On the leŌ, select Broadcast Console, select a speaker unit group, and check the desired speaker
units. Select a broadcast mode on the right to start live broadcast.
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Mode ApplicaƟon Scenario OperaƟon

Emergency
Broadcast

Broadcast real-​Ɵme
speaking about
emergency mustering
for guiding persons in
speciĮc areas to
protect themselves.

Click Emergency Broadcast to start real-​Ɵme
speaking of emergency contents.
Click Pause Speaking to pause the broadcast, and
click Resume Speaking to conƟnue the broadcast.

Speak in Real Time Broadcast real-​Ɵme
speaking about
general issues, such as
news broadcast.

Click Speak in Real Time to start real-​Ɵme speaking.
Click Pause Speaking to pause the broadcast, and
click Resume Speaking to conƟnue the broadcast.

Play Audio Play audio Įles such as
class bell and
background music.

Click Play Audio, select the audio Įles on the media
library, and click Start Playing.

Text NoƟĮcaƟon Transmit texts to AI
person voice for
reading and
broadcasƟng.

Click Text NoƟĮcaƟon, enter the text, select the play
mode and audio type, and click Start Playing.

21.4 Add a Scheduled Broadcast Task
You can add a scheduled broadcast task by conĮguring the parameters such as the period type and
play mode to add a scheduled broadcast task in the client and then apply the task to speaker units.
For the added scheduled broadcast tasks, you can view the task details, search for target tasks, etc.

Before You Start
● Make sure you have added speaker units on Device Management → Device , refer to Add

Device .
● Make sure you have grouped speaker units on Device Management → Group , refer to Group

Resources .

Steps
1. On the leŌ, select Scheduled Broadcast.
2. Click Add.
3. Specify the task name, speaker unit, and Ɵme period.
4. OpƟonal: Select a task type.
5. Click Add and set the execuƟon Ɵme.
6. Select the play content and play mode.

- For Audio File: select audio Įles, and set the play mode. For the Loop mode, set the play
duraƟon.
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- For Speech Synthesis, enter the text, select the play mode and audio type, and set the play
duraƟon.

7. OpƟonal: Set the broadcast priority and volume.

Note
If Increase Volume is enabled, the broadcast volume will be doubled.

8. Click OK.
9. OpƟonal: On the Scheduled Broadcast page, perform the following operaƟons.

Apply Task Select a scheduled broadcast task and click  to apply it. Or select
mulƟple tasks, and click Batch Apply to apply them.

View Failure
Records

Click View Failure Records to view the failure records. If necessary,
reapply the failure records.

Edit Task Click  to edit the task informaƟon.
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Chapter 22 Log Search

Two log types are provided: operaƟon log and system log. The operaƟon logs refer to the normal
operaƟons that the user did on the client, such as adding device, reseƫng password, starƟng live
view, etc.; and the system logs record the system informaƟon, such as login, logout, locking and
unlocking, etc. You can search the log Įles and view the log details, including Ɵme, user, etc.

Steps
1. Enter the Log Search module.
2. Click  to specify the start Ɵme and end Ɵme.

Note
You can search the logs within one month.

3. Select a user to search the log Įles which are generated when this user operate on the client.
4. Select OperaƟon Log or System Log as log type.
5. Click Search.

The log Įles between the start Ɵme and end Ɵme will be displayed on the list. You can check the
operaƟon Ɵme, type and other informaƟon of the logs.

6. OpƟonal: Perform the following operaƟons if there are too many log Įles.

Filer Click  on each table header and select to Įlter the logs.

Sort Click the table header to sort the logs by the Ɵme or leƩer sequence.
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Chapter 23 User Management

To improve the system security, the administrator should create diīerent account for diīerent user,
and assign diīerent permissions to the user. To avoid diīerent people sharing the same user
account, we recommend you manage the user accounts periodically.

23.1 Add User
The super user and administrator can add new users, and assign diīerent permissions for diīerent
users if needed.

Perform this task to add an user account.

Steps

Note
The user account you registered to log in the soŌware is set as the super user.

1. Enter the User Management module.
2. Click Add User to show user informaƟon area.
3. Select the user type from the drop-down list.

Administrator
The administrator account has all permissions by default, and can modify the passwords and
permissions of all operators and its own.

Operator
The operator account has no permission by default and you can assign the permissions
manually. An operator can only change the passwords of its own account and the accounts
which are added by it.

4. Enter the user name, password, and conĮrm password as desired.

CauƟon
The password strength of the device can be automaƟcally checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case leƩers, lower case leƩers, numbers, and special
characters) in order to increase the security of your product. And we recommend you change
your password regularly, especially in the high security system, changing the password monthly
or weekly can beƩer protect your product.
Proper conĮguraƟon of all passwords and other security seƫngs is the responsibility of the
service provider and/or end-user.

5. Check the checkboxes to assign the permissions to the created user.
6. OpƟonal: Click Default Value to restore the default permissions of this user.
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7. Click Save.

Note
Up to 50 user accounts can be added for the client soŌware.

AŌer created user account successfully, the user account is added to the user list on the Account
Management page.

8. OpƟonal: Perform the following operaƟons aŌer the user account is created.

Edit User Click a user from the list to edit the user informaƟon.

Note
Only the password of the super user can be edited.

Delete User Select the user from the list and click Delete User.

Note
You cannot delete the super user.

23.2 Change User's Password
The administrator can change normal user's password without entering the old password, while
the administrator should enter the old password when changing the password of itself.

Before You Start
Add user to the soŌware client.

Steps
1. Enter the User Management module.
2. Select the user need to be change password, click Change.
3. OpƟonal: Enter the old password.

Note
When changing the administrator's password, you need to enter the old password Įrst.

4. Enter the new password and conĮrm the password.
5. Click OK.
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Chapter 24 System ConĮguraƟon

24.1 Set General Parameters
You can conĮgure the frequently-used parameters, including log expired Ɵme, network
performance, etc.

Steps
1. Enter the System ConĮguraƟon module.
2. Click General tab to enter the General Seƫngs page.
3. ConĮgure the general parameters.

Date Format / Time Format
The display style of date and Ɵme on related pages.

Log RetenƟon Period
The Ɵme for keeping the log Įles. Once exceeded, the Įles will be deleted.

Maximum Mode
Select Maximize or Full Screen as the maximum mode. Maximize mode can maximize the
display and show the taskbar. Full Screen mode can display the client in full-screen mode.

Network Performance
Set the network condiƟons to Normal, BeƩer or Best.

Save Pictures in Structure Data Format
● AŌer Save Pictures in Structure Data Format is enabled, the Delete Registered Picture in

Person module will be available. If a person's informaƟon is applied to the device(s)
successfully, the person's picture will be automaƟcally deleted and no picture will be
displayed in Basic InformaƟon. The Face column in Person module will display the number
of the added face picture(s).

● When Save Pictures in Structure Data Format is enabled, no pictures will be displayed in
Event Details Įeld in Event Center.

Enable Keyboard and JoysƟck
Enable the keyboard or joysƟck. AŌer enabled, you can set the shortcuts for the keyboard
and joysƟck.

Note
For details, refer to Set Keyboard and JoysƟck Shortcuts .

Export Person InformaƟon
If you enable this, the Export buƩon for exporƟng person informaƟon will be displayed on
the Person Management page. Please pay aƩenƟon to person informaƟon security.

Event RetenƟon Period
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The Ɵme period for keeping the event informaƟon. When the retenƟon period expires, the
event record will be deleted automaƟcally.

AutomaƟc Time SynchronizaƟon
AutomaƟcally synchronize the Ɵme of the added devices with the Ɵme of the PC running the
client at a speciĮed Ɵme point.

Device Auto Refresh Time
Set the Ɵme for automaƟc refresh of the device (Ɵme range: from 1 to 5 minutes, 3 minutes
by default). For example, if you set the Ɵme to 3 minutes, the device automaƟcally refreshes
every 3 minutes.

Detect New SoŌware Version
Enabled

The client automaƟcally checks for soŌware updates upon startup. If a newer version is
detected, click  to choose from Update Now, Upgrade Later, or Ignore the Version. See
OperaƟon and Maintenance for details.

Note
WAN connecƟon is mandatory for successful data transfer.

Disabled

You must manually check for updates: Go to  → Help → About → SoŌware Update .
Auto-Upgrade Device

Set the upgrading mode aŌer the new version of device are detected.
Disable

AŌer enabled, the client will not download the Įrmware package and upgrade even if the
client detects a new version of the client.

Prompt Me If Download and Upgrade
AŌer the client detects a new version of the device, it will prompt the user whether to
download the Įrmware package and upgrade.

Download and Prompt Me If Upgrade
AŌer the client detects the new version of the device, it will download the Įrmware
package automaƟcally, and prompt the user whether to upgrade.

Download and Prompt AutomaƟcally
AŌer the client detects the new version of the devices, it will download the Įrmware
package and upgrade the new version automaƟcally.
You need to set a schedule in the Upgrade Time Įeld, during which the client upgrades the
new version automaƟcally.

Country/Region
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Select the server's region for Hik-Connect, you can select the region you belong to or the
nearest region around.

User Experience Program
If you enable it, we will collect user operaƟon records and soŌware usage data (including
main panel operaƟons and soŌware excepƟons). All data is only used for product
enhancement.
Upon Įrst login to the Client, a pop-up will appear inviƟng you to join the Program. Please
read and agree to the Privacy Policy before enabling the feature.

4. Click Save.

24.2 Set Live View and Playback Parameters
You can set the parameters for live view and playback, including picture format, pre-play duraƟon,
etc.

Steps
1. Enter the System ConĮguraƟon module.
2. Click Live View and Playback tab.
3. ConĮgure the live view and playback parameters.

Picture Format
Select JPEG or BMP as the image format for storing pictures.

Note
If Display Temperature on Captured Pictures switch is set to ON, JPEG is selected as the
image format by default and cannot be changed.

Video Format
Select MP4/AVI as the format of recorded videos.

Merge Downloaded Video Files
Set the maximum size of merged video Įle for downloading the video Įle by date.

Search Video Files Stored in
Search the video Įles stored in the local device, in the storage server, or both in the storage
server and local device for playback.

Pre-play for
Set the pre-play Ɵme for event playback. By default, it is 30s.

PrioriƟze Playback of Video Files on Storage Server
Play back the video Įles recorded on the storage server preferenƟally. Otherwise, play back
the video Įles recorded on the local device.

Resume Latest Live View Status AŌer Restart
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Resume the latest live view status aŌer you log into the client again.
Disconnect Background Videos in Single Live View

In mulƟple-window division mode, double-click a live video to display it in 1-window division
mode, and the other live videos will be stopped for saving the resource.

Enable Wheel for Zoom
Use the mouse wheel for zoom in or out of the video in PTZ mode, or for zoom in or restoring
of the video in digital zoom mode. In this way, you can directly zoom in or out (or restore) the
live video by scrolling the mouse.

Skip Unconcerned Video during VCA Playback
Skip the unconcerned video during VCA playback and the unconcerned video will not be
played during VCA playback.

4. Click Save.

24.3 Set Image Parameters
The image parameters of the client can be conĮgured, such as view scale, play performance, etc.

Steps
1. Open the System ConĮguraƟon page.
2. Click Image tab to enter the Image Seƫngs interface.
3. ConĮgure the image parameters.

View Scale
The view scale of the video in live view or playback. It can be set as Full Screen, 4:3, 16:9, or
Original ResoluƟon.

Note
You can also set the view scale in Live View module. For details, refer to Live View .

Play Performance
The play performance of the live video. It can be set as Shortest Delay, Balanced, or Fluency.
You can also select Custom and conĮgure the frame rate according to actual needs.

Hardware Decoding Preferred
Select D3D9 or D3D11 to enable decoding by hardware for live view and playback. Hardware
Decoding can provide beƩer decoding performance and lower CPU usage when playing the
HD video during live view or playback.

Enable Highlight
Mark the detected objects with green rectangles in live view and playback.

Display TransacƟon InformaƟon
Display the transacƟon informaƟon on the live view image.
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VCA Rule
Display the VCA rule in the live view.

Enable Frame ExtracƟng for High-speed Playback
When playing back the video at high speed (8x speed and above), you can disable this
funcƟon to make the image of playback more Ňuent to view the details.

Display Target's PaƩern
AŌer enabled, you can view the target person's moƟon track on the view window.

Overlay Rules on Captured Picture
For the thermal device, set to display the temperature informaƟon and Įre source
informaƟon on the captured pictures.

Note
AŌer enabled this funcƟon, the Picture Format conĮgured in System ConĮguraƟon → Live
View and Playback will change to JPEG and is not editable.

Noise ReducƟon
Noise reducƟon mode, which can be set as Disable, Self-adapƟve,or Enable.

4. Click Save.

24.4 Set Picture Storage
The captured pictures triggered by the events on the devices, can be saved in the PC running the
iVMS-4200 Service. You can set the picture storage locaƟon here manually.

Steps
1. Enter the System ConĮguraƟon module.
2. Click Event Picture Storage.
3. Set the Store Pictures in Server switch to on.

All the disks of the PC running the iVMS-4200 service will show.
4. Select the disk to save the pictures.

Note
The default saving path is: Disk/iVMS-4200alarmPicture

5. Click Save.

24.5 Set Alarm Sound
When the event is triggered, the client can give an audible warning to noƟfy the security
personnel. You can set the sound of the audible warning in this secƟon.
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Steps
1. Open the System ConĮguraƟon page.
2. Click Alarm Sound tab to enter the Alarm Sound Seƫngs page.
3. OpƟonal: Click  and select the audio Įles from the local path for diīerent events.
4. OpƟonal: Add customized alarm sound.

1) Click Add to add customized alarm sound.
2) Double click the Type Įeld to customize the alarm sound name as desired.
3) Click  and select the audio Įles from the local path for diīerent alarms.

5. OpƟonal: Click  for a tesƟng of the audio Įle.
6. OpƟonal: Click  in the OperaƟon column to delete the custom sound.
7. Click Save.

Note
The format of the audio Įle can only be WAV.

24.6 Set Access Control and Video Intercom Parameters
You can conĮgure the access control and video intercom parameters according to actual needs.

Steps
1. Open the System ConĮguraƟon page.
2. Click the Access Control & Video Intercom tab.
3. Input the required informaƟon.

Ringtone
Click  and select the audio Įle from the local path for the ringtone of indoor staƟon.
OpƟonally, you can click  for a tesƟng of the audio Įle.

Max. Ring DuraƟon
Specify the seconds that the ring will last for at most. The maximum ring duraƟon can be set
from 15s to 60s.

Max. Speaking DuraƟon with Indoor StaƟon
Specify the seconds that the call with indoor staƟon will last for at most. The maximum
speaking duraƟon between indoor staƟon and the client can be set from 120s to 600s.

Max. Speaking DuraƟon with Door StaƟon
Specify the seconds that the call with door staƟon will last for at most. The maximum
speaking duraƟon between door staƟon and the client can be set from 90s to 120s.

Max. Speaking DuraƟon with Access Control Device
Specify the seconds that the call with access control device will last for at most. The
maximum speaking duraƟon between access control device and the client can be set from
90s to 120s.

Card Reading Mode
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Specify the card reading mode as three bytes, four bytes, or full card No..
4. Click Save.

24.7 Set File Saving Path
The video footage (manually recorded during live view and clipped during playback) and captured
pictures are stored on the local PC. The saving path of these Įles can be set.

Steps
1. Open the System ConĮguraƟon page.
2. Click File tab to enter the File Saving Path Seƫngs page.
3. Click  and select a local path for the Įles.
4. Click Save.

24.8 Set Icons Shown on Toolbar
The icons and the order on the toolbar in the live view and playback window can be customized.
You can set to display what icons and set the icon order.

Perform the following task when you need to set icons shown on Toolbar.

Steps
1. Enter the System ConĮguraƟon module.
2. Click Toolbar tab to enter the Toolbar Seƫngs page.
3. Set Enable Screen Toolbar Display switch to ON to enable displaying the toolbar on in the live

view and playback window.
4. Click the required icon to display on the toolbar.
5. OpƟonal: Drag the icon to set the icon order when displaying on the toolbar.

Table 24-1 Icons on Live View Toolbar

Stop Live View Stop the live view in the display window.

Capture Capture the picture in the live view process. The capture
picture is stored in the PC.

Record Start manual recording. The video Įle is stored in the PC.

PTZ Control Start PTZ mode for speed dome. Click and drag in the
view to perform the PTZ control.

Two-way Audio Start the two-way audio with the device in live view.

Digital Zoom Enable the digital zoom funcƟon. Click again to disable
the funcƟon.
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Instant Playback Switch to the instant playback mode.

Remote ConĮguraƟon Open the remote conĮguraƟon page of the camera in live
view.

Table 24-2 Icons on Playback Toolbar

Capture Capture the picture in the live view process. The capture
picture is stored in the PC.

Record Start manual recording. The video Įle is stored in the PC.

Digital Zoom Enable the digital zoom funcƟon. Click again to disable
the funcƟon.

Download Download the video Įles of the camera and the video
Įles are stored in the PC.

VCA Playback Set the VCA rules. For more details, refer to VCA
Playback .

Tag Control Add default or custom tag for the video Įles to mark the
important video point. You can also edit the tag.

6. Click Save.

24.9 Set Keyboard and JoysƟck Shortcuts
The keyboard can be connected to the client and be used to control the PTZ cameras. You can set
the shortcuts for keyboard and joysƟck to get quick and convenient access to the commonly used
acƟons.

Perform this task when you need to set keyboard and joysƟck shortcuts.

Steps

Note
This conĮguraƟon page will display aŌer enabling keyboard and joysƟck in General Seƫngs. For
details, refer to Set General Parameters .

1. Enter the System ConĮguraƟon module.
2. Click Keyboard and JoysƟck to show the Keyboard and JoysƟck Shortcut Seƫngs area.
3. Select the COM port from the drop-down list for keyboard if the keyboard is connected to the PC

installed with the client.

Note
You can enter the Device Manger of the PC to check the COM port, which the keyboard is
connected to.
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4. Set shortcuts for keyboard and joysƟck.
1) Select a certain funcƟon name on FuncƟon column.
2) Double-click the item Įeld under the PC Keyboard, USB JoysƟck or USB Keyboard column.
3) Select the compound keys operaƟon or number from the drop-down list to set it as the

shortcuts for the funcƟon of the keyboard or USB joysƟck.
5. Click Save.

Example
For the Focus (+) funcƟon, if you set Home, 1, and F1 as the shortcuts of the PC Keyboard, USB
JoysƟck and USB Keyboard, you can press the Home key on PC keyboard, control the joysƟck to the
1 direcƟon, or press F1 key on USB keyboard to zoom in.

24.10 Set Email Parameters
When an event is triggered, if you can set Send Email as linkage acƟon for this event, the client will
an email to the recipients for noƟĮcaƟon. You need to set the email seƫngs and specify target
recipients in this secƟon.

Steps
1. Enter the System ConĮguraƟon module.
2. Click Email tab to enter the Email Seƫngs interface.
3. Enter the required informaƟon.

STMP Server
The STMP server IP address of host name (e.g., smtp.263xmail.com)

EncrypƟon Type
You can check the radio to select Non-Encrypted, SSL, or STARTTLS .

Port
Enter the communicaƟon port used for SMTP. The port is 25 by default.

Sender Address
The email address of the sender.

Security CerƟĮcate (OpƟonal)
If your email server requires authenƟcaƟon, check this checkbox to use authenƟcaƟon to log
into the server and enter the login user name and password of your email account.
User Name

Enter the user name of the sender email address if Server AuthenƟcaƟon is checked.
Password

Enter the password of the sender Email address if Server AuthenƟcaƟon is checked.
Receiver 1 to 3

Enter the email address of the receiver. Up to 3 receivers can be set.
4. OpƟonal: Click Send Test Email to send an email to the receiver for test.
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5. Click Save.

24.11 Manage Security AuthenƟcaƟon
For the data security purpose, the security cerƟĮcate of clients and added servers should be same.
You can set the verify cerƟĮcate is required or not when enabling transmission encrypƟon using
TLS (Transport Layer Security) protocol.

Before adding a server to the client, you should export the service cerƟĮcate from the client
service, and import it to the server. If mulƟple clients use the same server, you should make the
security cerƟĮcates of the clients and the server same with each other.

24.11.1 Export CerƟĮcate from Service Management

You can export the security cerƟĮcate from the current client service and import the exported
cerƟĮcate Įle to other clients.

Steps
1. Enter the Service Management.
2. Click Export to save the cerƟĮcate Įle in the local PC.

Note
The cerƟĮcate Įle is in XML format.

What to do next
AŌer exporƟng the cerƟĮcate, you can copy the cerƟĮcate to the PC installed with the client and
import it to other clients.

24.11.2 Import CerƟĮcate to Client

If there are mulƟple clients accessing the same steam media server, you should import the same
cerƟĮcate to the clients and server.

Before You Start
Make sure you have exported the security cerƟĮcate from one of the client service.

Note
For details, refer to Export CerƟĮcate from Service Management .

Steps
1. Copy the cerƟĮcate Įle exported from other client to the local PC.
2. Enter the System ConĮguraƟon module.
3. Click Security AuthenƟcaƟon tab to enter the security authenƟcaƟon seƫng interface.
4. Click Import.
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5. Select the cerƟĮcate Įle from your local PC and click Open.

Note
Please restart the client to take eīect.

24.11.3 CerƟĮcate VeriĮcaƟon for Transmission EncrypƟon

On the Security AuthenƟcaƟon page, you can set the device cerƟĮcate veriĮcaƟon is required or
not for transmission encrypƟon.

Click System ConĮguraƟon → Security AuthenƟcaƟon to enter the security authenƟcaƟon
interface. Select the Verify CerƟĮcate as Yes or No.
Yes

You must put the device cerƟĮcate to the designed directory if you enable transmission
encrypƟon when adding device. And the device will be added with transmission encrypƟon and
the cerƟĮcate will be veriĮed, which improves the security level.

No
The device cerƟĮcate is not required if you enable transmission encrypƟon when adding device.
And the device will be added with transmission encrypƟon.
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Chapter 25 OperaƟon and Maintenance

You can perform maintaining operaƟons in the menu to ensure a smooth and convenient usage of
the client.

File / System / Tool
In the upper-right corner of the client, click  → File / System / Tool .
Open Log File

You can open a log Įle saved in your local PC or log Įles of the client.
Import/Export ConĮguraƟon File

You can import conĮguraƟon Įles from local PC to the client if needed, and vice versa.
When exporƟng conĮguraƟon Įles, you can export all Įles (including all conĮguraƟon
parameters and historical events) or export only conĮguraƟon parameters.

Auto Backup
Select day and Ɵme to backup conĮguraƟon Įles and data in database, or restore the backed up
data.

Note
● When disk space falls below 2 GB, older backup Įles get overwriƩen.
● For disk space between 2 GB and 10 GB, a low storage warning is triggered, yet the backup
funcƟon remains unaīected.

Skin
Change the skin of the client, including bright-color series and black-color series.

Broadcast
Check one or more devices to enable the broadcast funcƟon of the device(s).

Batch Wiper Control
Batch turn on/oī the wiper.

1 VS 1 Face Comparison
Select two face pictures from the local PC for comparison. The similarity between the two
pictures will be shown.

Note
This funcƟon can be used for idenƟty veriĮcaƟon and is only supported by the DeepinMind
device.

Batch Time Sync
Synchronize selected devices' Ɵme with your PC Ɵme.
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Message Queue
AŌer conĮguring email linkage, the triggered event(s) will be displayed here. Select an event
and cancel sending the email to the receiver.

Feedback
In the upper-right corner of the client, click  → Feedback to report usage-related issues by
Įlling in Įelds including Ɵtle, problem type, descripƟon, aƩachment, device, and email.

Note
● WAN connecƟon is mandatory for successful data transfer.
● A maximum of 5 feedback submissions per day is allowed.
● For aƩachments, you can add up to 1 TXT log Įle and 4 JPG/JPEG/PNG pictures simultaneously.
● Up to two linked devices can be selected. Only device model and Įrmware version will be

collected.

Version Update
In the upper-right corner, if a newer version is detected, click  to choose from Update Now,
Upgrade Later, or Ignore the Version.
Update Now

Update to the latest version.
Upgrade Later

You can click  when needed.
Ignore the Version

The update buƩon will not show unƟl the new version is available.
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Appendix A. Custom Wiegand Rule DescripƟons

Take Wiegand 44 as an example, the seƫng values in the Custom Wiegand tab are as follows:

Custom Wiegand
Name

Wiegand 44

Total Length 44

TransformaƟon Rule
(Decimal Digit)

byFormatRule[4]=[1][4][0][0]

Parity Mode XOR Parity

Odd Parity Start Bit  Length  

Even Parity Start Bit  Length    

XOR Parity Start Bit 0 Length per Group 4 Total Length 40

Card ID Start Bit 0 Length 32 Decimal Digit 10

Site Code Start Bit  Length  Decimal Digit  

OEM Start Bit  Length  Decimal Digit  

Manufacturer Code
Start Bit

32 Length 8 Decimal Digit 3

Wiegand Data
Wiegand Data = Valid Data + Parity Data

Total Length
Wiegand data length.

TransportaƟon Rule
4 bytes. Display the combinaƟon types of valid data. The example displays the combinaƟon of Card
ID and Manufacturer Code. The valid data can be single rule, or combinaƟon of mulƟple rules.

Parity Mode
Valid parity for Wiegand data. You can select either odd parity or even parity.

Odd Parity Start Bit, and Length
If you select Odd Parity, these items are available. If the odd parity start bit is 1, and the length is
12, then the system will start odd parity calculaƟon from bit 1. It will calculate 12 bits. The result
will be in bit 0. (Bit 0 is the Įrst bit.)
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Even Parity Start Bit, and Length
If you select Even Parity, these items are available. If the even parity start bit is 12, and the length is
12, then the system will start even parity calculaƟon from bit 12. It will calculate 12 bits. The result
will be in the last bit.

XOR Parity Start Bit, Length per Group, and Total Length
If you select XOR Parity, these items are available. Depending on the table displayed above, the
start bit is 0, the length per group is 4, and the total length is 40. It means that the system will
calculate from bit 0, calculate every 4 bit, and calculate 40 bits in total (10 groups in total). The
result will be in the last 4 bits. (The result length is the same as the length per group.)

Card ID Start Bit, Length, and Decimal Digit
If you use the transformaƟon rule, these items are available. Depending on the table displayed
above, the card ID start bit is 0, the length is 32, and the decimal digit is 10. It represents that from
bit 0, there are 32 bits represent the card ID. (The length here is calculated by bit.) And the decimal
digit length is 10 bits.

Site Code Start Bit, Length, and Decimal Digit
If you use the transformaƟon rule, these items are available. For detailed informaƟon, see the
explanaƟon of the card ID.

OEM Start Bit, Length, and Decimal Digit
If you use the transformaƟon rule, these items are available. For detailed informaƟon, see the
explanaƟon of the card ID.

Manufacturer Code Start Bit, Length, and Decimal Digit
If you use the transformaƟon rule, these items are available. Depending on the table displayed
above, the manufacturer code start bit is 32, length is 8, and decimal digit is 3. It represents that
from bit 32, there are 8 bits are manufacturer code. (The length here is calculated by bit.) And the
decimal length is 3.
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Appendix B. TroubleshooƟng

Here are some common symptoms when operaƟng the client soŌware. We provide the possible
causes and corresponding soluƟons to solve the problems.

B.1 Failed to get the live view of a certain device.

Problem
Failed to get the live view of a certain device.

Possible Reasons
● Unstable network or the network performance is not good enough.
● The device is oŋine.
● Too many accesses to the remote device cause the load of the device too high.
● The current user has no permission for live view.
● The version of the client soŌware is below the needed version.

SoluƟons
● Check network status and disable other not in use process on your PC.
● Check the device network status.
● Restart the device or disable other remote access to the device.
● Log in with the admin user and try again.
● Download the client soŌware of the latest version.

B.2 Local recording and remote recording are confused.

Problem
Local recording and remote recording are confused.

SoluƟons
● The local recording in this manual refers to the recording which stores the video Įles on the

HDDs, SD/SDHC cards of the local device.
● The remote recording refers to the recording acƟon commanded by the client on the remote

device side.

B.3 Failed to download the video Įles or the downloading speed is too
slow.
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Problem
Failed to download the video Įles or the downloading speed is too slow.

Possible Reasons
● Unstable network or the network performance is not good enough.
● The NIC type is not compaƟble.
● Too many accesses to the remote device.
● The current user has no permission for playback.
● The version of the client soŌware is below the required version.

SoluƟons
● Check network status and disable other not in use process on your PC.
● Directly connect the PC running the client to device to check the compaƟbility of the NIC card.
● Restart the device or disable other remote access to the device.
● Log in with the admin user and try again.
● Download the client soŌware of the latest version.
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Appendix C. FAQ (Frequently Asked QuesƟons)

Here are some frequently asked quesƟons when operaƟng the client soŌware. We provide the
corresponding answers to help the users to solve the problems.

C.1 During live view, why an error message with error code 91 prompts ?

QuesƟon
During live view, why an error message with error code 91 prompts ?

Answer
For live view of mulƟple windows, the channel may not support sub stream. You should disable the
funcƟon of Auto-change Stream Type in System ConĮguraƟon → Image , and select the
appropriate steam type for live view.

C.2 During live view, why the image is blurred or not Ňuent?

QuesƟon
During live view, why the image is blurred or not Ňuent?

Answer
Check the driver of video card. We highly recommend you update the driver of video card to the
latest version.

C.3 Why the memory leaked and the client crashed aŌer running for a
while?

QuesƟon
Why the memory leak and the client crashed aŌer running for a while?

Answer
In the installaƟon directory of the client soŌware, open the Setup.xml Įle with Notepad and
modify the value of EnableNetandJoysƟckCheck to false. Restart the client, and if the problem is
sƟll not solved, contact our technique support.
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C.4 How to get beƩer performance of live view and playback when
network bandwidth is low?

QuesƟon
If the network bandwidth is low, how to get beƩer performance of live view and playback?

Answer
This funcƟon should be supported by the device. You can perform the following operaƟons to
realize live view in low bandwidth:

Note
You should disable Auto-Change Stream Type beforehand.

● Firstly, aŌer adding the encoding devices to the client, you need to set the camera's streaming
protocol.
1. Enter Device Management → Group .
2. Select the camera in the Encoding Channel list and click  .
3. In the Edit Camera window, set the Protocol Type (for live view) and Playback Protocol Type

(for playback) as AdapƟve UDP.
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Figure C-1 Set Protocol Type
4. Click OK to save the seƫngs.

● Select stream type for live view.
1. Enter Main View module.
2. In the device list on the leŌ, move the cursor to the camera name and click  → Stream .

Figure C-2 Select Stream Type
3. For network camera, set the stream type as Third Stream.

For DVRs or NVRs, set the stream type as Virtual Stream.
4. Start live view.

iVMS-4200 V3.13.1 User Manual

394



Appendix D. Error Code

Code Error Name DescripƟon

iVMS-4200

317 No videos. It will be prompted when the user has no permission
to play back.

HCNetSDK.dll

1 Invalid user name or password.  

2 No permission. The user in the device has no enough permission.

4 Invalid channel number. It will be prompted in the live view of remote screen
control.

5 No more devices can be
connected.

 

7 Failed to connect the device.  

23 Not supported.  

29 OperaƟon failed.  

43 No buīer. It will be prompted when adding a device and the
device port is occupied by a web server.

55 Invalid IP address.  

56 Invalid MAC address.  

91 The channel does not support the
operaƟon.

It will be prompted when failed to get the sub stream.

96 The device is not registered on
the DDNS.

 

153 The user is locked.  

250 The device is not acƟvated.  

404 Channel No. error or the device
does not support the sub stream.

It will be prompted when failed to get the sub stream
or the sub stream does not exist.

424 Failed to receive the data for
RTSP SETUP.

It will be prompted when adding the live view for the
soŌware DVS via external network.

800 No more bandwidth can be used.  

Playctrl.dll
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Code Error Name DescripƟon

2  The stream is not a Video & Audio stream.

6  The playback window turns black when adopƟng H.265
in the 64-bit operaƟng system.

iVMS-4200 V3.13.1 User Manual

396



UD68689B


	Legal Information
	Chapter 1 Overview
	1.1 Introduction
	1.2 Summary of Changes
	1.3 Symbol Conventions

	Chapter 2 Service Management
	Chapter 3 Device Management
	3.1 Activate Devices
	3.2 Add Device
	3.2.1 Add Single or Multiple Online Devices
	3.2.2 Add Device by IP Address or Domain Name
	3.2.3 Add Devices by IP Segment
	3.2.4 Add a Device via OTAP
	3.2.5 Add Device by Hik-Connect
	3.2.6 Import Devices in a Batch

	3.3 Restore/Reset Device Password
	3.3.1 Reset Device Password
	3.3.2 Restore Device's Default Password

	3.4 Upgrade Device Firmware Version
	3.5 Manage Added Devices
	3.6 Group Management
	3.6.1 Group Resources
	3.6.2 Edit Resource Parameters


	Chapter 4 Hik-Connect
	4.1 Register a Hik-Connect Account
	4.2 Log into Hik-Connect Account

	Chapter 5 Live View
	5.1 Live View Toolbar
	5.2 Add Custom View
	5.3 Start Live View
	5.4 Auto-Switch in Live View
	5.4.1 Auto-Switch Cameras in a Group
	5.4.2 Auto-Switch All Cameras
	5.4.3 Auto-Switch Cameras or Custom Views by Schedule

	5.5 PTZ Control
	5.5.1 PTZ Control Panel
	5.5.2 Set Preset, Patrol, and Pattern

	5.6 Sensor Control
	5.7 Customize Window Division
	5.8 Manually Record and Capture
	5.8.1 Manually Record Video
	5.8.2 View Local Videos
	5.8.3 Capture Pictures
	5.8.4 View Captured Pictures

	5.9 Instant Playback
	5.10 Live View for Fisheye Camera
	5.10.1 Perform Live View in Fisheye Mode
	5.10.2 PTZ Control in Fisheye Mode
	5.10.3 Set a Preset and Patrol

	5.11 Perform Smart Linkage
	5.11.1 Configure Smart Linkage Rule
	Set Intrusion Detection Rule
	Link Speed Dome
	Calibrate Camera and Speed Dome Automatically
	Calibrate Camera and Speed Dome Manually

	5.11.2 Enable Smart Linkage

	5.12 Live View for Thermal Camera
	5.12.1 View Fire Source Information during Live View
	5.12.2 Show Temperature Information on Live View Image
	5.12.3 Manually Measure Temperature
	5.12.4 Display Fire Source Detection Shield Area
	5.12.5 Display Waste Gas Information

	5.13 Live View in Low Bandwidth
	5.14 More Functions

	Chapter 6 Remote Playback
	6.1 Flow Chart
	6.2 Remote Storage Configuration
	6.2.1 Store Picture and Video on DVR, NVR, or Network Camera
	6.2.2 Store Video on Storage Device
	Add Storage Server to Client
	Format Storage Server's HDD
	Configure Storage Settings

	6.2.3 Store Picture and Additional Information on Local PC
	6.2.4 Configure Recording Schedule Template
	6.2.5 Configure Capture Schedule Template

	6.3 Toolbar for Playback
	6.4 Normal Playback
	6.4.1 Search Video Footage
	6.4.2 Play Video Footage

	6.5 Alarm Input Playback
	6.6 Event Playback
	6.7 ATM Playback
	6.8 POS Playback
	6.9 VCA Playback
	6.10 Synchronous Playback
	6.11 Fisheye Camera's Video Playback
	6.12 Playback in Low Bandwidth
	6.13 Search Targets by Picture
	6.14 Download Video Footage
	6.14.1 Download Video Footage by Date
	6.14.2 Download for Multiple Cameras


	Chapter 7 Event Configuration
	7.1 Configure Event for Camera
	7.2 Configure Event for Alarm Input
	7.3 Configure Event for Encoding Device

	Chapter 8 Event Center
	8.1 Enable Receiving Event from Devices
	8.2 View Real-Time Events
	8.3 Search Historical Events
	8.4 Get Events from Device
	8.5 View Pop-up Event Information

	Chapter 9 Map Management
	9.1 Add Map
	9.2 Edit Map Scale
	9.3 Longitude and Latitude Calibration
	9.4 Manage Hot Spot
	9.4.1 Add Camera as Hot Spot
	9.4.2 Add Alarm Input as Hot Spot
	9.4.3 Add Alarm Output as Hot Spot
	9.4.4 Add Zone as Hot Spot
	9.4.5 Add Access Point as Hot Spot
	9.4.6 Configure Security Radar Hot Spot
	Add Security Radar as Hot Spot
	Draw a Zone
	Draw Trigger Line
	Add Track Filter Zone
	Add Point Cloud Filter Zone
	Set Smart Linkage
	One-Point Calibration
	Multi-Point Calibration
	GPS Calibration
	Set Auxiliary Linkage
	Set Environment Learning
	Terrain Learning
	Calibration Compensation

	Set Parking Points for Linked Camera
	Set Preset Point
	Map Calibration
	Other Functions

	9.4.7 Edit Hot Spot
	9.4.8 Preview Hot Spot

	9.5 Manage Hot Region
	9.5.1 Add Hot Region
	9.5.2 Edit Hot Region
	9.5.3 Preview Hot Region

	9.6 View Person's Moving Pattern

	Chapter 10 Statistics
	10.1 People Counting Report
	10.1.1 People Counting Report by Encoding Device
	10.1.2 View People Counting Report by DeepinMind Server

	10.2 View People Counting in Intersections Report
	10.3 Queue Management
	10.3.1 Queuing-Up Time Analysis
	Compare Queuing-up People Amount for Different Regions
	Compare Queuing-up People Amount for Different Waiting Time Levels

	10.3.2 Queue Status Analysis
	Compare Queuing-up Duration for Different Regions
	Compare Queuing-up Duration for Different Queue Length Levels


	10.4 Heat Map
	10.5 Skin-Surface Temperature Statistics
	10.6 Real-Time Density and People Counting
	10.7 Temperature Map

	Chapter 11 Data Retrieval
	11.1 Video Search
	11.2 Target Retrieval
	11.2.1 Face Picture Retrieval
	Search Face Pictures by Uploaded Picture
	Search Face Pictures by Event Type
	Search Face Pictures by Person Name
	Search Face Pictures by Facial Features

	11.2.2 Human Body Retrieval
	Search Human Body by Uploaded Picture
	Search Human Body by Personnel Features

	11.2.3 Vehicle Retrieval
	11.2.4 Search Target Pictures by Picture

	11.3 Abnormal Event Detection
	11.4 Hard Hat Retrieval
	11.5 People Frequency Search
	11.5.1 Search Frequently Appeared Person
	11.5.2 Search Rarely Appeared Person

	11.6 AI Dashboard Retrieval
	11.6.1 Search Analysis Result for Video and Captured Picture Task
	11.6.2 Search Analysis Result for Imported Picture Task

	11.7 Facial Recognition Check-in
	11.7.1 Search Facial Recognition Check-in Records
	11.7.2 Search Facial Recognition Attendance Records

	11.8 Community Inspection
	11.8.1 Detect Fire Engine Access
	11.8.2 Detect Elevator
	11.8.3 Retrieve Urban Management Event


	Chapter 12 AcuSeek
	Chapter 13 AI Dashboard
	13.1 Face Application
	13.1.1 Set List Types for Face Picture Libraries
	13.1.2 Set Cameras for Showing AI Information
	13.1.3 Show AI Information

	13.2 Multi-Target-Type Detection
	13.2.1 Set Target Detection Parameters
	Set Display Mode
	Set Capture Parameters
	Set Cameras Receiving Alarm

	13.2.2 Display Multi-Target-Type Detection

	13.3 AI Open Platform
	13.3.1 Configure Platform Parameters
	Configure Local Storage
	Get Model Package
	Set Objects to Be Displayed

	13.3.2 Configure Platform Event
	13.3.3 Analyze Picture Task
	13.3.4 AI Platform Real-Time Display

	13.4 Multidimensional People Counting
	13.4.1 Configure People Counting Group
	13.4.2 Display People Counting Data by Group

	13.5 Linked Capture Alarm
	13.5.1 Set Basic Parameters
	13.5.2 View Live View and Alarms

	13.6 Traffic Accident Alarm
	13.6.1 Configure Display Parameter
	13.6.2 View Traffic Accident Alarm

	13.7 Arming and Tracking
	13.7.1 Vehicle Arming and Control
	13.7.2 Face/Human Body Arming and Control

	13.8 Skin-Surface Temperature
	13.8.1 Start Live View of Skin-Surface Temperature Detection
	13.8.2 Display Skin-Surface Temperature Information
	13.8.3 View Alarm Information

	13.9 Abnormal Event Detection
	13.10 Event Dashboard

	Chapter 14 Video Tracing
	14.1 Configuration
	14.1.1 Workstation Configuration
	14.1.2 Basic Configuration
	14.1.3 Linked Device

	14.2 Retrieve Scanning Records

	Chapter 15 Security Control Panel
	15.1 Flow Chart
	15.2 Configure Security Control Panel Remotely
	15.3 Configure Client Linkage for Zone Event
	15.4 Remotely Control Security Control Panel
	15.4.1 Remotely Control Partitions
	15.4.2 Remotely Control Zones
	15.4.3 Remotely Control Relay
	15.4.4 Remotely Control Siren


	Chapter 16 Person Management
	16.1 Add Organization
	16.2 Add a Single Person
	16.2.1 Configure Basic Information
	16.2.2 Issue a Card to One Person
	Issue a Card by Entering Card Number
	Issue a Card by Local Mode
	Issue a Card by Remote Mode

	16.2.3 Upload a Face Photo from Local PC
	16.2.4 Take a Photo via Client
	16.2.5 Collect Face via Access Control Device
	16.2.6 Collect Fingerprint via Client
	16.2.7 Collect Fingerprint via Access Control Device
	16.2.8 Collect Iris via Client
	16.2.9 Collect Iris via Access Control Device
	16.2.10 Collect Voiceprint via Access Control Device
	16.2.11 Collect Palm Print via Client
	16.2.12 Collect Palm Print via Access Control Device
	16.2.13 Configure Access Control Information
	16.2.14 Customize Person Information
	16.2.15 Configure Resident Information
	16.2.16 Configure Additional Information

	16.3 Import and Export Person Identify Information
	16.3.1 Import Person Information
	16.3.2 Import Person Pictures
	16.3.3 Export Person Information
	16.3.4 Export Person Pictures

	16.4 Get Person Information from Access Control Device
	16.5 Move Persons to Another Organization
	16.6 Batch Edit Persons' Validity Period
	16.7 Batch Issue Cards to Persons
	16.8 Report Card Loss
	16.9 View Resource Statistics

	Chapter 17 Access Control
	17.1 Flow Chart
	17.2 Configure Schedule and Template
	17.2.1 Add Holiday
	17.2.2 Add Schedule Template

	17.3 Assign Access Levels to Persons in Access Groups
	17.4 Search Access Group
	17.5 Configure Advanced Functions
	17.5.1 Configure Access Control Parameters
	Configure Parameters for Access Control Device
	Configure Parameters for Door/Elevator
	Configure Parameters for Card Reader
	Configure Parameters for Alarm Input
	Configure Parameters for Alarm Output
	Configure Parameters for Lane Controller

	17.5.2 Configure Remaining Unlocked/Locked
	17.5.3 Configure Multi-Factor Authentication
	17.5.4 Configure Custom Wiegand Rule
	17.5.5 Configure Card Reader Authentication Mode and Schedule
	17.5.6 Configure Person Authentication Mode
	17.5.7 Configure Relay for Elevator Controller
	Configure Relationship between Relay and Floor
	Configure Relay Type

	17.5.8 Configure First Person In
	17.5.9 Configure Anti-Passback
	17.5.10 Configure Cross-Controller Anti-Passback
	Configure Route Anti-Passback Based on Card
	Configure Route Anti-Passback Based on Network
	Configure Area Anti-Passback Based on Card
	Configure Area Anti-Passback Based on Network

	17.5.11 Configure Multi-door Interlocking
	17.5.12 Configure Authentication Code

	17.6 Configure Other Parameters
	17.6.1 Set Multiple NIC Parameters
	17.6.2 Set Device Capture Parameters
	Set Triggered Capture Parameters
	Set Manual Capture Parameters

	17.6.3 Set Parameters for Face Recognition Terminal
	17.6.4 Enable M1 Card Encryption
	17.6.5 Set RS-485 Parameters
	17.6.6 Set Wiegand Parameters

	17.7 Configure Linkage Actions for Access Control
	17.7.1 Configure Client Actions for Access Event
	17.7.2 Configure Device Actions for Access Event
	17.7.3 Configure Device Actions for Card Swiping
	17.7.4 Configure Device Actions for Person ID

	17.8 Door/Elevator Control
	17.8.1 Control Door Status
	17.8.2 Control Elevator Status
	17.8.3 Check Real-Time Access Records


	Chapter 18 Time and Attendance
	18.1 Flow Chart
	18.2 Configure Attendance Parameters
	18.2.1 Set Weekend
	18.2.2 Configure Authentication Mode
	18.2.3 Configure Overtime Parameters
	18.2.4 Configure Attendance Check Point
	18.2.5 Configure Holiday
	Add Regular Holiday
	Add Irregular Holiday

	18.2.6 Configure Leave Type
	18.2.7 Synchronize Authentication Record to Third-Party Database
	18.2.8 Configure Attendance Calculation Accuracy
	18.2.9 Configure Break Time

	18.3 Add Flexible Timetable
	18.4 Add General Timetable
	18.5 Add Shift
	18.6 Manage Shift Schedule
	18.6.1 Set Department Schedule
	18.6.2 Set Person Schedule
	18.6.3 Set Temporary Schedule
	18.6.4 Check Shift Schedule

	18.7 Attendance Handling
	18.7.1 Manually Correct Check-in/out Record
	18.7.2 Add Leave and Business Trip

	18.8 Calculate Attendance Data
	18.8.1 Automatically Calculate Attendance Data
	18.8.2 Manually Calculate Attendance Data

	18.9 Attendance Statistics
	18.9.1 Get an Overview of Employees' Attendance Data
	18.9.2 Custom Export Attendance Records
	18.9.3 Configure Report Display
	18.9.4 Generate Instant Report
	18.9.5 Send Report Regularly


	Chapter 19 Video Intercom
	19.1 Flow Chart
	19.2 Manage Calls between Client Software and an Indoor/Door Station/Access Control Device
	19.2.1 Call Indoor Station from Client
	19.2.2 Answer Call via Client

	19.3 View Real-Time Call Logs
	19.4 Release a Notice to Resident
	19.5 Enable Calling between Video Intercom Device and Client
	19.6 Apply Application Package to Indoor Station

	Chapter 20 Topology Management
	20.1 Topology Display Overview
	20.2 Set Topology Parameters
	20.3 View Device Details
	20.4 View Link Details
	20.5 View Signal Transmission Path
	20.6 Export Topology
	20.7 More Functions

	Chapter 21 Broadcast Management
	21.1 Control Speaker Units
	21.2 Manage Material Library
	21.3 Configure Live Broadcast
	21.4 Add a Scheduled Broadcast Task

	Chapter 22 Log Search
	Chapter 23 User Management
	23.1 Add User
	23.2 Change User's Password

	Chapter 24 System Configuration
	24.1 Set General Parameters
	24.2 Set Live View and Playback Parameters
	24.3 Set Image Parameters
	24.4 Set Picture Storage
	24.5 Set Alarm Sound
	24.6 Set Access Control and Video Intercom Parameters
	24.7 Set File Saving Path
	24.8 Set Icons Shown on Toolbar
	24.9 Set Keyboard and Joystick Shortcuts
	24.10 Set Email Parameters
	24.11 Manage Security Authentication
	24.11.1 Export Certificate from Service Management
	24.11.2 Import Certificate to Client
	24.11.3 Certificate Verification for Transmission Encryption


	Chapter 25 Operation and Maintenance
	Appendix A. Custom Wiegand Rule Descriptions
	Appendix B. Troubleshooting
	B.1 Failed to get the live view of a certain device.
	B.2 Local recording and remote recording are confused.
	B.3 Failed to download the video files or the downloading speed is too slow.

	Appendix C. FAQ (Frequently Asked Questions)
	C.1 During live view, why an error message with error code 91 prompts ?
	C.2 During live view, why the image is blurred or not fluent?
	C.3 Why the memory leaked and the client crashed after running for a while?
	C.4 How to get better performance of live view and playback when network bandwidth is low?

	Appendix D. Error Code

